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Os desafios do operador informático de service desk – Da tradução automática  

ao atendimento multilingue 

 
Resumo 

 

A globalização e a crescente diversidade linguística dos usuários de produtos e serviços de 

tecnologia da informação (TI) têm exigido que as empresas de TI se adaptem para atender a essa 

demanda. Um dos desafios enfrentados por essas empresas é o atendimento multilingue de service 

desk, que é o atendimento ao cliente por telefone, e-mail ou chat em diferentes idiomas. 

Por isso, esta dissertação, que faz parte da conclusão do Mestrado em Tradução e Comunicação 

Multilingue, da Universidade do Minho, tem por objetivo geral analisar os desafios do operador 

informático no atendimento multilingue de service desk a partir do ponto de vista linguístico, tendo como 

base conceitos de globalização, localização, tradução, tradução automática e service desk, apontando 

como eles se relacionam. Os objetivos específicos deste estudo são descrever e analisar se e como os 

operadores informáticos utilizam ferramentas de tradução automática e tutoriais da Microsoft no 

atendimento multilingue de service desk; e descrever e analisar se esse agente realiza edição em textos 

gerados por ferramentas de tradução automática no atendimento multilingue de service desk.  

Para atender a esses objetivos, utilizou-se como metodologia o relato de experiência das atividades 

da autora como operadora informática multilingue no atendimento de service desk com o uso da tradução 

automática e dos tutoriais da Microsoft em uma empresa multinacional de tecnologia da informação. 

Além disso, utilizou-se metodologia de análise quantitativa por meio de questionário com 50 operadores 

informáticos nessa mesma empresa, para analisar como eles lidam com a tradução automática e com 

os tutoriais da Microsoft no atendimento multilingue de service desk e testificar a utilidade de tais 

ferramentas durante esse atendimento. Utilizou-se também a metodologia de análise linguística de 

caráter qualitativo, por meio de extração de dados tendo como base de corpora paralelos alguns textos 

tutoriais da Microsoft, nos idiomas português de Portugal, português do Brasil e inglês.  

Os resultados da pesquisa pelo questionário demonstraram que: a maioria dos 50 agentes de 

service desk utiliza alguma ferramenta de tradução automática; uma porcentagem considerável 

confirmou que realiza edição nos textos gerados pelas ferramentas de tradução automática; e uma 

porcentagem, um pouco menor que a metade, confirmou que utiliza os textos de suporte da Microsoft. 

Portanto, com esses resultados da pesquisa, concluiu-se que as ferramentas de tradução automática 

demonstram-se eficazes para uma porcentagem relevante dos profissionais, e que os tutoriais da 

Microsoft demonstraram-se úteis, ainda que de uma forma não predominante, no atendimento 
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multilingue de service desk. Ademais, por meio da extração de dados, a análise qualitativa permitiu 

constatar como a tradução automática e a localização podem ser relevantes para o atendimento 

multilingue de service desk, e como a tradução de textos de natureza altamente técnica é realmente 

necessária.  

Por tudo isso, espera-se que este trabalho colabore para os estudos de tradução e localização e 

para a atuação de profissionais operadores da tecnologia da informação; e contribua para que 

organizações internacionais possam desenvolver novas ferramentas e metodologias de tradução e 

localização para textos técnicos em seu ambiente de trabalho. 

 

Palavras-chave: globalização, localização, tradução automática, service desk, tutoriais da Microsoft. 
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The challenges of the IT service desk operator – From machine translation  

to multilingual support 

 
Abstract 

 

Globalisation and the growing linguistic diversity of users of information technology (IT) products 

and services have required IT companies to adapt to meet this demand. One of the challenges faced by 

these companies is the multilingual service desk, which is customer service by telephone, e-mail or chat 

in different languages. 

For this reason, this dissertation, which is part of the conclusion of the Master's Degree in 

Translation and Multilingual Communication at the University of Minho, has as general objective to 

analyse the challenges faced by IT operators in multilingual service desk support from a linguistic point 

of view, based on the concepts of globalisation, localisation, translation, machine translation and service 

desk, pointing out how they relate to each other. The specific objectives of this study are to describe and 

analyze whether and how computer operators use machine translation tools and Microsoft tutorials in 

multilingual service desk assistance; and to describe and analyse whether this agent edits texts generated 

by machine translation tools in multilingual service desk support. 

In order to meet these objectives, the methodology used was an experience report of the author’s 

activities as a multilingual computer operator in the service desk using machine translation and Microsoft 

tutorials in a multinational information technology company. In addition, a quantitative analysis 

methodology was used by means of a questionnaire with 50 computer operators in the same company, 

to analyse how they deal with machine translation and Microsoft tutorials in multilingual service desk work 

and to test the usefulness of these tools during this service. A qualitative linguistic analysis methodology 

was also used, by means of data extraction based on parallel corpora of Microsoft tutorial texts in 

Portuguese from Portugal, Portuguese from Brazil and English. 

The results of the questionnaire survey showed that: the majority of the 50 service desk agents use 

some kind of machine translation tool; a considerable percentage confirmed that they edit the texts 

generated by machine translation tools; and a percentage, slightly less than half, confirmed that they use 

Microsoft support texts. Therefore, with these survey results, it was concluded that machine translation 

tools have proven to be effective for a significant percentage of professionals, and that Microsoft tutorials 

have proven to be useful, albeit not predominantly, in multilingual service desk support. Furthermore, 

through data extraction, the qualitative analysis made it possible to see how machine translation and 
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localisation can be relevant to multilingual service desk support, and how translation of highly technical 

texts is really necessary. 

Because of all that, it is hoped that this work will contribute to translation and localisation studies 

and to the work of information technology professionals; and that it will help international organisations 

to develop new translation and localisation tools and methodologies for technical texts in their work 

environment. 

 

Keywords: globalisation, localisation, machine translation, service desk, Microsoft tutorials. 
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 Introdução 

Num mundo cada vez mais globalizado, em que as relações comerciais cresceram em nível 

mundial, a tradução tornou-se uma ponte de conexão entre vários países, quebrando as barreiras sociais 

e linguísticas, permitindo uma melhor comunicação entre empresas e pessoas de diferentes 

nacionalidades. Concomitantemente a esse processo, o inglês se tornou a língua universal, 

principalmente no mundo dos softwares, e a figura do tradutor começou a se tornar visível e importante 

no mundo globalizado. Nos últimos anos, a tradução automática foi se desenvolvendo, tornando-se aliada 

aos serviços de tradução humana e em muitos processos empresariais. Um dos campos em que se usa 

a tradução automática é em empresas de tecnologia da informação no atendimento multilingue de 

service desk. 

É nesse contexto que se insere a presente dissertação, redigida no âmbito do Mestrado em 

Tradução e Comunicação Multilingue, da Escola de Letras, Artes e Ciências Humanas, da Universidade 

do Minho, com o intuito de estudar a relação entre globalização, localização, tradução automática e o 

papel do operador informático multilingue no atendimento de service desk.  

O objetivo geral desta dissertação é analisar os desafios do operador informático no atendimento 

multilingue de service desk a partir do ponto de vista linguístico, tendo como base conceitos de 

globalização, localização e tradução automática e apontar como eles se relacionam. Os objetivos 

específicos deste estudo são descrever e analisar se e como os operadores informáticos utilizam 

ferramentas de tradução automática e tutoriais da Microsoft no atendimento multilingue de service desk; 

descrever e analisar se o operador informático realiza edição em textos gerados por ferramentas de 

tradução automática no atendimento multilingue de service desk; e analisar linguisticamente textos 

tutoriais da Microsoft.  

Para atender a esses objetivos, utilizou-se como metodologia o relato de experiência das atividades 

da autora, em um trabalho de dois anos e meio, de maio de 2019 a novembro de 2021, como operadora 

informática no atendimento multilingue de service desk em uma empresa multinacional de tecnologia da 

informação (que, por motivos de segurança de dados e informações, será chamada neste trabalho de 

empresa A), que presta serviços a outra empresa internacional (que aqui chamaremos de empresa B).  

Além disso, utilizou-se metodologia de análise quantitativa por meio de questionário em língua 

portuguesa (Anexos I, II e III), no período de novembro de 2021, com 50 operadores informáticos 

multilingues, num universo de cerca de 100 funcionários (agentes de service desk) da mesma empresa 

multinacional em que a autora trabalhava. Essa pesquisa tinha o intuito de testificar a importância e a 

utilidade da tradução automática no atendimento multilingue de service desk e analisar como esses 
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operadores informáticos lidam com essa ferramenta durante seus serviços, a fim de saber se eles usam 

a tradução automática no momento que prestam atendimento, e, desse modo, confirmar se existe 

relação entre tradução automática e o atendimento multilingue de service desk, para então podermos 

concluir se essa relação é realmente válida, inclusive na pós-edição. A mesma pesquisa quantitativa 

também avaliou se os operadores usavam os tutoriais da Microsoft enquanto prestavam seus serviços, 

a fim de analisar como esses tutoriais podem ser úteis e se relacionar com o atendimento multilingue de 

service desk.  

Para aprofundar a relação entre tradução automática, tutoriais da Microsoft e o atendimento 

multilingue de service desk, ao final desta dissertação, por meio dos programas de extração de dados 

Word Counter, Voyant Tools e Sketch Engine, e realizou-se uma análise linguística de caráter qualitativo 

de alguns tutoriais da Microsoft – empresa que possui tutoriais para suas aplicações em diversos idiomas 

de forma localizada. Os textos escolhidos foram utilizados como corpora paralelos nos idiomas português 

de Portugal (Anexo IV), português do Brasil (Anexo V) e inglês (Anexo VI) – idiomas em que a autora desta 

dissertação tinha que, muitas vezes, prestar atendimento. Ademais, ela escolheu os textos tutoriais da 

Microsoft para essa análise, pois também os utilizava como guia e suporte para envio aos clientes nesses 

idiomas e os considerava de extrema relevância para efetivar e concluir o seu atendimento. 

Por isso, esta dissertação está estruturada da seguinte forma. O primeiro capítulo é dedicado à 

introdução, que tem por objetivo apresentar o tema, definir os seus objetivos e a estrutura da dissertação. 

Posteriormente, fizemos a divisão da dissertação em duas partes: teórica e prática. A parte teórica 

está no segundo capítulo, que contém a revisão da literatura, com a base de textos acadêmicos para o 

tema apresentado “Os desafios do operador informático no atendimento multilingue de service desk” e 

seus subtópicos: i) globalização, seus conceitos e o modelo GILT; ii) localização, seus conceitos e uma 

breve análise sobre a localização desenvolvida pela Microsoft; iii) tradução, conceitos de tradução, 

estudos de tradução e tradução automática, com a diferenciação entre tradução automática neuronal e 

estatística, e entre Google Tradutor e DeepL; iv) service desk e seus conceitos, com a diferenciação entre 

help desk e service desk, o operador informático multilingue de service desk, o modelo GILT e os desafios 

do atendimento multilingue de service desk, especificando os efeitos de globalização, localização e 

tradução automática no atendimento multilingue de service desk. De conteúdo teórico, esta parte visa 

descrever cada um desses itens, apresentando os autores mais importantes sobre o tema escolhido 

como resultado de uma pesquisa conceitual na área de service desk, globalização, localização e tradução 

automática. Entre eles, podemos citar: Held e McGrew (2003), Pym (2005 e 2017), Esselink (2000), 

Lako (2012), Garcia e Gonçalves (2017), Keohane e Nye (2000), Austermühl (1999 e 2007), Brooks 
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(2000), Munday et al. (2022), Kadiu (2019), Alves (2006), Forcada (2010), Bowker e Fisher (2010), Wu 

et al. (2016), LeCun et al. (2015), Cho et al. (2014), Lyra (2020), ITIL® Foundation (2019), Medeiros e 

Soares (2010), Magalhães e Pinheiro (2007). 

A parte prática está no terceiro e quarto capítulos. No capítulo III, “Da tradução automática ao 

atendimento multilingue de service desk”, buscou-se mostrar como a tradução automática pode 

contribuir de forma mais rápida e mais eficiente no atendimento multilingue de service desk com o 

cliente, mesmo que essa tradução automática tenha que passar por um processo de pós-edição, para 

que esse atendimento aconteça de forma gramaticalmente correta e eficaz. Assim, nesse capítulo, temos 

o conteúdo dos seguintes itens: i) processo de atendimento multilingue de service desk sem e com a 

tradução automática; ii) tradução automática e pós-edição no atendimento multilingue de service desk; 

iii) os resultados da pesquisa quantitativa sobre a utilização da tradução automática e pós-edição no 

atendimento multilingue de service desk, com a sua respetiva análise, que corrobora para entender como 

tradução automática e atendimento multilingue se relacionam.  

Ainda na parte prática, no quarto capítulo, “Tutoriais da Microsoft”, procurou-se mostrar como 

documentos já localizados da Microsoft podem funcionar como suporte para o operador informático 

multilingue de service desk no momento do atendimento com seu cliente, pontuando assim, de forma 

prática, a importância e a relação entre localização e atendimento multilingue de service desk. Esse 

capítulo está estruturado com os seguintes itens: i) relação dos tutoriais da Microsoft com o atendimento 

multilingue de service desk; ii) os resultados da pesquisa quantitativa sobre a utilização dos tutoriais da 

Microsoft durante o atendimento multilingue de service desk, avaliando como esses tutoriais podem ser 

úteis e se relacionar com o atendimento multilingue de service desk, deixando clara a relação desses 

tutoriais da Microsoft no momento do atendimento multilingue do operador informático de service desk 

com o seu cliente; iii) análise linguística dos tutoriais da Microsoft das aplicações Outlook, Excel, 

PowerPoint e Word, nos níveis terminológico, sintático, semântico-enunciativo e pragmático, em 

português do Portugal, português do Brasil e em inglês, relacionando mais uma vez teoria e prática. 

As pesquisas quantitativas foram realizadas no contexto empresarial, em que 50 agentes de 

service desk da empresa multinacional – onde a autora desta dissertação trabalhou – responderam a 

um questionário de múltipla escolha com 13 perguntas sobre: faixa etária; nível de escolaridade; língua 

materna; línguas estrangeiras; uso de ferramenta de tradução automática durante o atendimento de 

service desk e quais usam; necessidade de edição das traduções feitas pelas ferramentas de tradução 

automática por parte dos agentes; utilização dos textos de suporte da Microsoft durante o atendimento 

de service desk; utilidade e eficácia desses textos no atendimento; escolha da língua para o uso dos 
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textos de suporte da Microsoft; e, por último, se os agentes tinham ciência de que a Microsoft 

disponibilizava tutoriais e manuais de suporte para as suas aplicações em quase todos os idiomas. 

No questionário que serviu como base para a análise quantitativa, as perguntas de 1 a 4 são de 

cunho pessoal, analisando o perfil do agente de service desk; as perguntas de 5 a 9 são a respeito da 

relação com a tradução automática e o atendimento multilingue de service desk; as perguntas de 10 a 

13 são a respeito da relação entre os tutoriais da Microsoft e o atendimento multilingue de service desk.  

Ao analisar os resultados dessa pesquisa para confirmar a relevância da tradução automática e 

dos tutoriais da Microsoft no atendimento multilingue de service desk, conseguimos detectar quantos 

dos 50 agentes informáticos utilizam as ferramentas de tradução automática, em quais circunstâncias 

as usam e se realizam pós-edição dessas traduções.  

A partir das partes teórica e prática, da análise quantitativa com os agentes informáticos e da 

análise qualitativa dos tutoriais da Microsoft, a dissertação termina com o quinto capítulo, em que 

pudemos chegar à conclusão de como os conceitos abordados se relacionam com o operador informático 

multilingue de service desk, principalmente a tradução automática e os textos da Microsoft, além de 

expor os dados mais significativos da análise linguística de alguns tutoriais da Microsoft, que 

possibilitaram entender o perfil e o estilo dos textos em português de Portugal, português do Brasil e em 

inglês. Por fim, expressamos o que se espera deste trabalho a partir do relato de experiência e das 

análises quantitativa e qualitativa. 

Após a conclusão, apresentam-se as referências das fontes textuais que serviram de base para a 

análise linguística – os tutoriais da Microsoft. Em seguida, apresentam-se toda a bibliografia utilizada 

para fundamentar a parte teórica, os anexos, em que há o questionário para a pesquisa quantitativa, os 

resultados dessa pesquisa, que serviram como base para a análise quantitativa, e os textos selecionados 

dos tutoriais da Microsoft para os corpora paralelos, que auxiliaram a análise qualitativa. 

Portanto, diante da crescente globalização e da necessidade de atendimento multilingue eficaz, 

este trabalho busca analisar e comprovar como que os operadores informáticos desempenham um papel 

crucial na interseção entre tecnologia, tradução e comunicação. Ao explorar os desafios enfrentados por 

esses profissionais no ambiente dinâmico do service desk na área da tecnologia da informação, esta 

dissertação mergulha nas complexidades da globalização, localização, tradução automática e das 

interações multilingues. Nesse cenário em constante evolução, esta dissertação busca analisar a 

interseção da tradução automática e humana no âmbito da tecnologia da informação e do atendimento 

multilingue, destacando sua relevância em um mundo cada vez mais conectado, diversificado e digital. 
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 Os desafios do operador informático no atendimento multilingue 

de service desk 

O ramo de central de serviços, por meio de chats, chamadas telefónicas e de atendimento 

informático mediante acesso remoto em dispositivos eletrónicos tem experimentado um crescimento 

notável no contexto global altamente conectado por mídias digitais. Essa tendência reflete a necessidade 

crescente de empresas multinacionais que buscam serviços de empresas especializadas em service desk 

multilingue para atender seus utilizadores em países específicos e, frequentemente, para fornecer 

suporte em inglês em escala global.  

A autora desta dissertação traz consigo uma experiência pessoal valiosa, tendo trabalhado por dois 

anos e meio como operadora informática multilingue, fornecendo atendimento de service desk nos 

idiomas inglês, italiano e português, em uma empresa multinacional na área de tecnologia da informação 

(TI) – que, por motivos de segurança de dados e informações, será chamada neste trabalho de empresa 

A. Essa empresa, por sua vez, prestava serviço técnico de TI para outra empresa multinacional – que 

aqui será chamada de empresa B. Durante sua trajetória na empresa A, enfrentou desafios específicos 

para resolver problemas de nível técnico, com utilização de artigos de suporte disponíveis dentro do 

sistema da empresa A, artigos da Microsoft disponíveis na web, e até mesmo utilização de ferramentas 

de tradução automática para facilitar a tradução dos termos técnicos. Essa experiência profissional 

aconteceu ao mesmo tempo que cursava o mestrado em Tradução e Comunicação Multilingue na 

Universidade do Minho, o que proporcionou a oportunidade de aprofundar seus estudos nos conceitos 

que aplicava diariamente em seu ambiente de trabalho. 

Dessa forma, neste capítulo, direcionamos nosso foco para a parte teórica da dissertação, 

explorando conceitos fundamentais sobre globalização, localização, tradução, tradução automática, 

service desk, help desk e o operador informático multilingue. No primeiro tópico, falamos sobre a 

globalização e o modelo GILT. No segundo tópico, discorremos sobre a localização e uma breve análise 

sobre o processo de localização desenvolvido pela Microsoft, empresa que tem diversos textos de suporte 

disponíveis na web de forma localizada em vários idiomas. No terceiro tópico, discutimos sobre conceitos 

de tradução, tradução automática, incluindo traduções automática neuronal e estatística, e as diferenças 

entre Google Tradutor e DeepL, ferramentas que a autora desta dissertação mais utilizava durante o 

atendimento multilingue de service desk. No quarto tópico, apresentamos conceitos sobre service desk 

e suas diferenças com o help desk, a fim de delimitar nossa área de estudo; o operador informático 

multilingue de service desk; o modelo GILT e os desafios do atendimento multilingue de service desk, 
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correlacionando os conceitos anteriormente explorados de globalização, localização e tradução 

automática a essa área de estudo. 

Cada um desses conceitos desempenha um papel crucial na tradução e no atendimento 

multilingue de service desk, apresentando desafios complexos para o operador informático enquanto 

desempenha suas funções. Então, buscamos incorporar perspectivas de alguns autores em relação a 

esses temas a fim de compreender como esses conceitos podem ser aplicados de forma eficaz pelo 

operador informático multilingue, seja em interações por chamadas, chats ou acessos remotos aos 

sistemas de dispositivos de utilizadores que se comunicam em diferentes idiomas.  

Portanto, este capítulo se propõe a estabelecer uma base teórica, fornecendo o alicerce essencial 

para os dois capítulos subsequentes, que abordarão as aplicações práticas desses conceitos no contexto 

do atendimento multilingue de service desk. 

2.1 Globalização 

Desde meados da década de 1980, especialmente meados de 1990, o termo globalização tem 

sido muito utilizado. Isso se deve pelo constante crescimento e aprofundamento da integração 

económica, social, cultural e política em nível internacional. Na era digital, esse efeito global impactou 

diretamente na maneira como se disseminou o conhecimento e os idiomas. Preocupa-se ainda mais em 

aprender um novo idioma e expandir fronteiras falando-se no idioma do outro país com o qual se 

estabeleceu uma conexão. Nesse contexto global, o inglês se tornou cada vez mais o idioma universal, 

pela necessidade de comunicação em relações comerciais, por questões turísticas, ou pela simples 

comunicação entre pessoas de países diferentes. 

Dessa forma, com esse relacionamento estreito comercial entre países e a expansão de produtos 

e serviços em escala mundial, surgiu também o operador informático multilingue de service desk, que, 

na maioria das vezes, deve falar fluentemente, no mínimo, o inglês, além do seu idioma nativo. Por isso, 

nos próximos itens, veremos os conceitos de globalização e do modelo GILT, como pontos iniciais do 

processo para a existência da função do operador informático multilingue de service desk. 
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2.1.1 Conceitos de globalização 

Nesta subsecção, discorreremos sobre os conceitos de globalização a partir de teóricos que tratam 

desse tema. 

Segundo Held e McGrew (2003, p. 3), a globalização tem um aspecto inegavelmente material, na 

medida em que é possível identificar, por exemplo, fluxos de comércio, capital e pessoas em todo o 

mundo. Esses fluxos são facilitados por diferentes tipos de infraestrutura – física (como sistemas 

bancários ou de transporte), normativa (como regras comerciais) e simbólica (como o inglês como língua 

franca) – que estabelecem as condições prévias para formas regularizadas e relativamente duradouras 

de interconexão global. Eles ainda afirmam que o conceito de globalização denota muito mais do que 

uma extensão das relações e atividades sociais por regiões e fronteiras, sugerindo uma magnitude ou 

intensidade crescente dos fluxos globais, de modo que os Estados e as sociedades se tornam cada vez 

mais envolvidos em sistemas e redes mundiais de interação. 

Held e McGrew (2003, p. 3) continuam apontando que, como consequência desse fenómeno, 

ocorrências e desenvolvimentos distantes podem vir a ter sérios impactos domésticos, enquanto 

acontecimentos locais podem gerar repercussões globais significativas. Em outras palavras, a 

globalização representa uma mudança significativa no alcance espacial das relações e da organização 

social em direção à escala inter-regional ou intercontinental. Isso não significa que o global 

necessariamente substitua ou tenha precedência sobre as ordens locais, nacionais ou regionais da vida 

social. Em vez disso, a questão é que o local passa a ser incorporado em conjuntos mais amplos de 

relações inter-regionais e redes de poder. 

Em outros termos, as identidades e os interesses locais continuam a ser importantes, mas eles 

precisam ser compreendidos no contexto de uma rede global de relações. Outro ponto importante que 

podemos entender dessa definição de globalização é que se trata de um processo desigual. Seus efeitos 

são distribuídos de forma variável entre diferentes países, regiões e grupos sociais. Isso significa que a 

globalização pode gerar tanto oportunidades quanto desafios. 

Held et al. (1999) afirmam que a globalização é a crescente integração das economias, das 

sociedades e das culturas do mundo. Colander (2000, p. 2), conforme citado por Duarte (2014, p. 11), 

afirmou que a globalização é um termo cada vez mais utilizado por ter sido impulsionado pelas inovações 

tecnológicas. A Internet, em particular, tem desempenhado um papel fundamental na redução das 

barreiras ao comércio, ao transporte e à comunicação, levando a um aumento da integração económica 

e cultural entre países de todo o mundo. 
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Anthony Pym (2005), um grande pesquisador em estudos de tradução, ao dissertar sobre 

globalização, apresenta a seguinte definição da Localisation Industry Standards Association (LISA): 

 

Globalization addresses the business issues associated with taking a product global. In the 

globalization of high-tech products this involves integrating localization throughout a company, 

after proper internationalization and product design, as well as marketing, sales, and support in 

the world market. (Pym, 2005, p. 17) 

 

Ou seja, a globalização está relacionada com as questões empresariais associadas à globalização 

de um produto. Na globalização de produtos de alta tecnologia, isso significa integrar a localização em 

toda a empresa, depois da devida internacionalização e concepção do produto, por exemplo o marketing, 

as vendas e a assistência no mercado mundial. Isso significa que, nesse contexto, os produtos são 

frequentemente lançados globalmente e precisam ser adaptados às necessidades de diferentes 

mercados. Vale ressaltar que essa definição de Anthony Pym limita-se apenas à questão da 

internacionalização, localização e integração, sem considerar os aspectos sociais, culturais e políticos 

desse fenómeno. 

Esselink (2000, p. 4) apresenta a globalização como um termo usado por três perspectivas 

diferentes possíveis: primeiro, há o nível geopolítico superior que trata da globalização dos negócios como 

uma evolução económica; em segundo lugar, há a globalização de uma empresa que estabelece uma 

presença internacional com filiais ou escritórios de distribuição locais; em terceiro lugar, há o processo 

de criação de versões locais ou localizadas de websites, que ele chama de “globalização de websites”. 

Assim, ele conclui que a globalização de websites refere-se à capacitação de um site para lidar com 

visitantes que não falam inglês, ou seja, internacionalizar o software de retaguarda do site, projetar uma 

arquitetura multilingue e localizar o conteúdo estático ou dinâmico do site. 

Ao apresentarem uma definição de globalização que consta no glossário de internacionalização da 

empresa IBM, Caudieux e Esselink (2004) afirmam: 

 

The process of developing, manufacturing, and marketing software products that are intended 

for worldwide distribution. This term combines two aspects of the work: internationalization 

(enabling the product to be used without language or culture barriers) and localization (translating 

and enabling the product for a specific locale). (p. 2) 
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Com isso, segundo esses autores, entendemos que a globalização envolve o processo de 

desenvolver, manufaturar e comercializar produtos de software destinados à distribuição global, 

misturando dois aspectos do trabalho: a internacionalização (possibilitar o uso do produto sem barreiras 

culturais ou linguísticas) e localização (traduzir e tornar possível um produto para um local específico). 

Lako (2012, p. 202) complementa que a globalização surgiu como uma consequência natural da 

necessidade cada vez maior de as empresas se expandirem e ingressarem em novos mercados globais. 

Assim, o termo globalização foi inicialmente utilizado no âmbito económico, nos níveis de decisão de 

empresas poderosas que buscavam oferecer seus produtos e serviços em maior escala, a diversos 

clientes ao redor do globo. Só mais tarde, isso chamou a atenção dos pesquisadores dos estudos da 

tradução, quando uma maior demanda de oferecer produtos e serviços em vários idiomas se tornou uma 

necessidade de marketing. Por isso, veremos, na subsecção a seguir, sobre o modelo GILT, para 

entender melhor sobre essa evolução entre globalização, internacionalização, localização e a necessidade 

de tradução, com o consequente uso da tradução automática. 

2.1.2 Modelo GILT 

Dentro de uma empresa que foi globalizada, os produtos são internacionalizados para que possam 

ser rápida e simultaneamente localizados, fazendo a tradução parte desse processo de localização, 

surgindo assim a relação entre os conceitos de globalização, internacionalização, localização e tradução 

(o modelo GILT). 

Garcia e Gonçalves (2017) afirmam que o modelo GILT é o acrónimo constituído pelos termos 

globalização, internacionalização, localização e tradução, correspondendo a um conjunto de processos 

que funcionam de maneira integrada, iterativa e clínica, com o objetivo de criar, desenvolver e 

comercializar produtos destinados ao mercado global. Esses autores explicam que:  

 

A tradução faz parte do processo localização, este por sua vez, é indispensável à 

internacionalização, todos eles incluídos no processo de globalização. Como os termos que 

compõem o acrónimo são de extensão considerável, a sua formação foi abreviada pelos 

profissionais da área para facilitar a comunicação entre si. Na palavra globalization cuja 

abreviatura é G11N, o número onze corresponde ao número de letras entre a primeira e última 

letra. Também os restantes termos são conhecidos por abreviaturas formadas pelo mesmo 

processo, a palavra internationalization, a mais extensa, passou a ser designada por I18N, já a 
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palavra localization adquiriu a abreviatura L10N e a palavra translation foi abreviada a T9N. 

(W3C, 2005, conforme citado por Garcia e Gonçalves, 2017, p. 2, grifos dos autores). 

 

Nessa linha de entendimento, Garcia e Gonçalves (2017) explicam que os conceitos de 

globalização (G11N), internacionalização (I18N), localização (L10N) e tradução (T9N) estão interligados. 

G11N é o processo de tornar um produto ou serviço acessível a um público global, enquanto I18N é o 

processo de adaptar um produto ou serviço a diferentes idiomas. Já L10N é o processo de adaptar um 

produto ou serviço a uma cultura específica, e T9N é o processo de traduzir um produto ou serviço de 

um idioma para outro. 

Sendo assim, cada um desses conceitos é essencial para o sucesso da internacionalização de um 

produto ou serviço. G11N garante que o produto ou serviço seja acessível a um público global, I18N 

garante que ele seja compreensível em diferentes idiomas, L10N garante que ele seja relevante para 

uma cultura específica, e T9N garante que ele seja traduzido com precisão. Se um desses conceitos for 

negligenciado, o produto ou serviço pode ser malsucedido no mercado internacional. Por exemplo, um 

produto ou serviço que não é acessível a um público global não terá sucesso em um mercado global. 

Um produto ou serviço que não é compreensível em diferentes idiomas também não terá sucesso. Um 

produto ou serviço que não é relevante para uma cultura específica pode ser mal recebido pelos 

consumidores dessa cultura. E um produto ou serviço que não é traduzido com precisão pode causar 

confusão e frustração entre os consumidores. 

Nesse sentido, percebe-se que nenhum desses pontos pode se concretizar atuando de maneira 

independente, conforme demonstrada na Figura 1: 

 

Figura 1: Modelo GILT 

 
Fonte: Elaboração própria, 2023. 
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Held, McGrew, Goldblatt e Perraton, em sua obra Global Transformations: Politics, Economics and 

Culture, publicada em 1999, propuseram o modelo GILT para superar as limitações das definições 

tradicionais de globalização, que tendiam a enfatizar apenas o aspecto económico do fenómeno. Eles 

afirmam que modelo GILT divide a globalização nas seguintes dimensões: i) globalização económica, que 

refere-se à integração das economias nacionais em uma economia global; ii) globalização política, 

concernindo-se à interdependência entre os sistemas políticos nacionais; iii) globalização social, que diz 

respeito à interdependência entre as sociedades nacionais; iv) globalização cultural, que concerne à 

disseminação de ideias, valores e práticas culturais em todo o mundo. 

Keohane e Nye (2000, p. 13) afirmam que o conceito GILT “é útil para entender a complexidade 

e a multifacetada natureza da globalização. Ele ajuda a enfatizar que a globalização não é apenas um 

fenómeno económico, mas também político, social e cultural” (tradução nossa). Já Scholte (2000) 

aponta que: 

 

o conceito GILT é uma ferramenta útil para analisar o impacto da globalização em diferentes 

esferas da vida humana. Ele pode ser usado para entender, por exemplo, como a globalização 

está afetando as economias nacionais, os sistemas políticos, as sociedades e as culturas. (p. 25, 

tradução nossa) 

 

A globalização, portanto, trata dos aspectos comerciais relacionados ao lançamento de um 

produto, para que ele seja acessível em todo o mundo. No entanto, para globalizar um produto com 

eficiência, ele deve passar por um processo de internacionalização antes. Esse processo torna o produto 

utilizável sem barreiras linguísticas ou culturais e sem a necessidade de reformulação. A 

internacionalização ocorre no nível do design do programa e do desenvolvimento de documentos. 

Por exemplo, imagine o lançamento de um software em vários países do mundo. Quanto mais 

bem-sucedida for a sua internacionalização, mais fácil será a sua localização. Após a devida 

internacionalização, a localização adapta o produto aos aspectos linguísticos, culturais, técnicos e legais 

do país ou mercado específico em que ele será utilizado e vendido. Em outras palavras, a localização 

adapta o produto a diferentes localidades. 

Por fim, a tradução, que faz parte do processo de localização e é a fase final do modelo GILT, 

propondo-se a converter o significado do texto de partida para o texto de chegada de forma fiel, dando 

atenção especial aos aspectos culturais do público-alvo. Logo, é evidente que, para haver globalização, 

é necessária a tradução. 
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Como vimos, esse modelo foi desenvolvido com base em uma ampla pesquisa bibliográfica e 

empírica. Os autores analisaram uma variedade de fontes, incluindo dados económicos, políticos, sociais 

e culturais. Sendo bem recebido pela comunidade acadêmica, ele foi usado em uma variedade de 

pesquisas sobre globalização, incluindo estudos sobre economia, política, sociedade e cultura. 

Na subsecção seguinte, veremos o conceito de localização de maneira mais específica e um breve 

estudo de caso do processo de localização realizada pela empresa Microsoft, pelo fato de esse conceito 

e essa empresa estarem diretamente ligados a etapas do processo de serviços e tradução que a autora 

desta dissertação realizava como operadora informática multilingue de service desk. 

2.2 Localização 

A globalização é um fenómeno que impulsiona a internacionalização de produtos e serviços, o 

que, por sua vez, requer a localização destes para atender às necessidades de diferentes mercados. 

Nesse contexto, os estudos de tradução e o universo informático têm abordado diversos conceitos de 

localização. Logo, nesta subsecção, discorreremos sobre os conceitos de localização a partir de teóricos 

que tratam desse assunto e depois abordaremos um breve resumo de um estudo de caso sobre o 

processo de localização realizado pela empresa Microsoft nos anos 1990. 

2.2.1 Conceitos de localização 

Em seu livro A practical guide to localization, Esselink (2000, p. 1) afirma que, nas décadas finais 

do século XX, a localização deixou de ser um esforço adicional de alguns editores de software para se 

tornar um setor profissional multibilionário. Por isso, a localização, a globalização de websites, a 

engenharia de idiomas e a internacionalização de software tornaram-se questões importantes para as 

empresas que desejam comercializar e vender seus produtos em mercados internacionais. Em muitos 

casos, a localização provou ser o principal fator para a aceitação e o sucesso de produtos internacionais. 

Esselink (2000, p. 1) afirma ainda que a localização é a tradução e a adaptação de um software 

ou produto da web, o que inclui o próprio aplicativo de software e toda a documentação relacionada ao 

produto. Esse autor ainda explica que o termo localização é derivado da palavra locale, que 

tradicionalmente significa uma pequena área ou vizinhança. Atualmente, locale é usado principalmente 

em um contexto técnico, no qual representa uma combinação específica de idioma, região e codificação 
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de caracteres. Para ilustrar esse termo, o autor utiliza o exemplo de que o francês falado no Canadá é 

um locale diferente do francês falado na França. 

Esselink (2000, p. 1) complementa que, antes de a Internet e a World Wide Web transformarem 

o desenvolvimento e a localização de software, um projeto de localização típico englobava a tradução e 

a engenharia completas de um aplicativo de software, seus arquivos de ajuda on-line, um conjunto de 

manuais impressos e cartões de referência e registo incluídos na caixa do produto. Essa descrição ainda 

se aplica a muitos projetos atuais. Entretanto, devido às novas tecnologias da web, a localização agora 

também pode incluir a tradução e a adaptação de aplicativos e websites orientados por banco de dados. 

Pym (2005, p. 17) explica que a localização pode ser entendida como um modo geral de 

pensamento que informa a adaptação transcultural de textos nas áreas de software, documentação de 

produtos, tecnologia da web e alguns serviços de notícias internacionais. Ele acredita que é uma série 

de conceitos que estão constantemente fazendo seu caminho para os estudos de tradução, embora 

raramente apareçam na linguística convencional. 

Segundo LISA (1998), conforme citado por Pym (2005, p. 17), a localização “involves taking a 

product and making it linguistically and culturally appropriate to the target locale (country/region and 

language) where it will be used and sold”, ou seja, a localização envolve pegar um produto e torná-lo 

linguística e culturalmente apropriado ao local de destino (país/região e idioma) onde será utilizado e 

vendido. 

Esselink (2000, p. 3) acrescenta que alguns editores consideram a localização como parte 

integrante do processo de desenvolvimento de um produto. Em alguns casos, versões especiais de 

produtos de software específicas para cada país são chamadas de localizações. No entanto, em seu livro, 

Esselink (2000) explica que se referiu a todas as atividades relacionadas à localização que ocorrem 

durante o desenvolvimento do produto original como internacionalização. 

Ao analisar o ramo da localização mediante à tradução, Austermühl (2007) afirma que os alunos 

de tradução possuem um conjunto de competências (linguísticas, culturais, comunicativas e técnicas) 

que os posicionam bem na economia global do conhecimento de hoje, além de representar uma 

combinação ideal para as necessidades do novo idioma ou da indústria GILT. Além disso, ele 

complementa que os desenvolvimentos económicos e tecnológicos das últimas décadas transformaram 

a profissão ligeiramente romântica da tradução em uma indústria multibilionária – corroborando o 

mesmo pensamento de Esselink (2000), apontado no início desta subsecção –, sendo um setor que 

oferece novas e estimulantes oportunidades de carreira, tanto vertical quanto horizontalmente, em um 

mercado de trabalho mais fragmentado e diversificado. 
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Sendo assim, para o ramo de informática, a localização tem rompido diversas barreiras culturais 

e linguísticas, principalmente quando analisamos o universo da Microsoft, que já tem o sistema 

operacional Windows em diversos idiomas, incluindo suas aplicações (pacote Office 365 e outras), tema 

sobre o qual falaremos um pouco mais na subsecção a seguir.  

2.2.2 Uma breve análise sobre a localização desenvolvida pela Microsoft 

Para realizarmos uma análise sobre a localização desenvolvida pela Microsoft, utilizaremos como 

base um trecho introdutório de um extenso estudo de caso sobre a estratégia de globalização dessa 

empresa, chamado “What Price Globalization?”, escrito por David Brooks (2000). Brooks ingressou na 

Microsoft em 1990 como gerente de preços de transferência e, a partir disso, ocupou diversos cargos 

com foco internacional. Quando escreveu esse texto, ele era diretor sênior de estratégia de produtos 

internacionais, e sua missão era apoiar e coordenar a criação de versões internacionais de produtos da 

Microsoft.  

Quando analisamos o universo da Microsoft, que já tem o sistema operacional Windows em 

diversos idiomas, incluindo suas aplicações (pacote Office 365 e outras), vemos o quanto já avançou em 

localização e expandiu as suas diversas barreiras geográficas, culturais e linguísticas. Porém, nem 

sempre foi assim. 

Segundo Brooks (2000, p. 17), a Microsoft enfrentou um grande desafio em 1998, quando viu 

seu mercado expandir fora dos Estados Unidos da América (EUA), pois a maioria dos seus mercados 

eram de países não falantes de inglês e, a partir desse período, teria de arcar com a indústria de entrega 

de produtos localizados a esses mercados. Esse autor relata que Bill Gates chegou a pensar que a 

localização era caracterizada como “só um processo linguístico”, expressando frustração e querendo 

fugir dos altos custos. Pior ainda, a capacidade da Microsoft de fornecer produtos localizados estava 

sendo limitada: a empresa estava tendo problemas para fornecer o fôlego de produtos localizados que o 

mercado desejava e para atender às demandas dos clientes por lançamentos imediatos e simultâneos 

de produtos localizados. 

Brooks (2000, p. 17) conta que, quando a liderança da Microsoft começou a analisar a localização 

no início dos anos 1990, os principais desafios eram com atrasos, gargalos, custos e falta de métricas. 

A empresa priorizou os projetos de localização, mas a responsabilidade recaiu principalmente sobre as 

equipas da Irlanda e da Ásia. A terceirização era limitada, e o processo era considerado ineficiente, caro 

e incapaz de atender às demandas do mercado. 
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Brooks (2000, p. 17) narra que o então chefe do grupo de desenvolvimento de produtos de 

plataformas e aplicativos da Microsoft, Paul Maritz, lançou uma campanha para controlar esses 

problemas, convidando-o para conduzir essa iniciativa. Brooks tinha ingressado na organização de Maritz 

havia vários anos como diretor de operações comerciais e tinha experiência em consultoria de gestão e 

gestão de custos e, a partir disso, enfrentou uma curva de aprendizagem acentuada ao lidar com os 

problemas de localização da Microsoft. 

Após aceitar o desafio de Maritz, o primeiro passo de Brooks, ao lidar com essa situação, foi 

encontrar pessoas com conhecimento na comunidade de localização da empresa. Isto levou a uma 

“cúpula de localização” no verão de 1994, que reuniu profissionais seniores de localização de toda a 

empresa para dois dias de discussão. No início dessas reuniões, ficou claro para eles que a localização 

não se tratava realmente de tradução, mas sim uma extensão do desenvolvimento do produto. Durante 

muito tempo, mesmo depois de muitos encontros com profissionais competentes, o design centrado nos 

EUA do produto americano, as mudanças imprevisíveis no cronograma e os problemas logísticos que 

tiveram tornaram a localização um doloroso processo de reengenharia para a Microsoft (Brooks, 2000, 

p. 17). 

Em seu relato, Brooks (2000, pp. 17-18) narra que, após os encontros no verão de 1994, a cúpula 

fez uma reunião com Bill Gates para delinear um plano estratégico para atacar os custos de localização, 

concluindo que: a localização é um processo complexo que envolve muito mais do que tradução; os 

desafios incluem mudanças em áreas como logística, engenharia corretiva, testes, gerenciamento de 

projetos e alterações no cronograma de desenvolvimento do produto; o gerenciamento de custos de 

localização é uma área que precisa ser melhorada. Essas conclusões corroboram o que Esselink (2000, 

p. 1) entende de localização, ou seja, uma das etapas de tradução e engenharia completa de um 

aplicativo de software e adaptação do produto e toda a sua documentação, conforme explicitado na 

subsecção 2.2.1 deste trabalho. 

Sendo assim, Maritz concentrou-se nos aspectos de engenharia da localização e nas metas que 

estabeleceu para os grupos de desenvolvimento que refletiam sua avaliação de que o design centrado 

nos EUA era o cerne do problema. Portanto, ele desenvolveu uma diretriz para as equipas de 

desenvolvimento de produtos para melhorar o processo de localização da Microsoft com as seguintes 

mudanças: globalizar o produto dos EUA para que a reengenharia não fosse necessária durante a 

localização; adotar um conjunto comum de ferramentas e processos de localização; reduzir o nível de 

habilidades técnicas necessárias e manter uma única base de código em todas as versões localizadas 

de um único produto para garantir a compatibilidade entre os idiomas (Brooks, 2000, p. 18).  



16 

 

Posteriormente, a tarefa mais difícil foi romper a mentalidade da comunidade de desenvolvimento, 

que era centrada nos Estados Unidos da América (EUA). Com um mercado de software altamente 

competitivo e inovador nos EUA, os engenheiros de software e a maioria dos desenvolvedores da 

Microsoft consideravam essas tarefas como simplesmente uma distração dos desafios de criar produtos 

novos e atraentes. Outra tarefa complicada foi fazer os engenheiros e desenvolvedores de produtos 

mudar o pensamento ingênuo de que “localização se equivalia à tradução”. Em geral, eles não tinham 

consciência dos preconceitos e das limitações de engenharia inerentes ao produto norte-americano que 

estavam criando (Brooks, 2000, p. 18). 

Os desafios de localização variavam desde mudar a quantidade total de caracteres na base de 

dados, ajustar o tamanho de botões para o texto da língua de chegada quando essa localização era maior 

que o texto do botão em inglês, questionar se seriam mantidas as teclas de atalhos para que não ficassem 

distribuídos de forma arbitrária quando não combinassem com o idioma em questão, entre outros. 

Brooks (2000, p. 18) explica que reconhecer a classe desses problemas foi embaraçoso, mas resultou 

no desenvolvimento de ferramentas e procedimentos para eliminar o problema na fonte, ou seja, no 

código principal. Equipas especializadas de localização para alemão e japonês foram delegadas para 

descobrir esses problemas, e os desenvolvedores começaram a encontrar e eliminar os possíveis erros 

de localização que surgiam no processo de tradução automática dos elementos de interface do utilizador 

para uma linguagem sem sentido. Esses problemas descritos por Brooks, mais uma vez, validam o que 

Esselink (2000) e Pym (2005) afimam acontecer em um processo de localização. 

Para resolver esses problemas pontuais que surgiam ao internacionalizar os produtos, a Microsoft 

precisou estabelecer um planejamento de localização. Primeiramente, foi necessário entender que o 

principal objetivo da localização é atender às necessidades dos consumidores nos mercados 

internacionais e que as decisões sobre os produtos a serem localizados, a extensão da localização e o 

cronograma de entrega são orientados por considerações de mercado. Por isso, a equipa especializada 

passou a definir o mercado linguisticamente e não geograficamente. Por exemplo, o mercado espanhol 

é o agregado da Espanha, México, Argentina, etc. – um total de 22 países – não apenas a Espanha 

ibérica; o mercado alemão é similarmente um agregado da Alemanha, Áustria e parte da Suíça (Brooks, 

2000, p. 19). Esse fato confirma o que Esselink (2000) explicou sobre o termo locale e o que Pym (2005) 

explica sobre o processo de adaptação transcultural na localização, descrevendo como tornar um produto 

linguística e culturalmente apropriado ao local de destino (país/região e idioma) onde será utilizado e 

vendido, conforme apresentado na subsecção 2.2.1 desta dissertação. 
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Nesse processo, Brooks (2000, p. 19) relata que a receita de produtos localizados é o principal 

critério para atribuir mercados a categorias. Outros fatores, como a população, têm pouca influência 

sobre o mercado de software, mas o número de PCs vendidos é considerado. Por isso, eles acabaram 

usando quatro categorias principais (níveis) no processo de planejamento: i) nível 1 – os maiores 

mercados internacionais (japonês, alemão, francês) para os quais a maioria dos produtos está localizada; 

ii) nível 2 – mercados grandes o suficiente para justificar investimentos substanciais em localização 

(holandês, coreano, português do Brasil), mas uma ordem de grandeza menor que o nível 1; iii) nível 3 

– mercados pequenos mas em crescimento (português, árabe, húngaro) para os quais está localizado 

um subconjunto de produtos com amplo apelo; iv) nível 4 – mercados emergentes de potencial limitado 

(tailandês, romeno, vietnamita) para os quais apenas produtos essenciais como o Windows estão 

localizados. 

Para fins de planejamento, eles agruparam os produtos em categorias que correspondiam aos 

segmentos de mercado, como produtos desktop, sistemas de negócios e ferramentas de 

desenvolvimento. Com os níveis de mercado e as categorias de produtos organizados em uma grade, 

com base nos requisitos de cada nível e nas características do produto, foi decidido os graus ou níveis 

de localização: i) habilitado – em que os utilizadores podem redigir documentos em seu próprio idioma, 

mas a interface do utilizador e a documentação do software permanecem em inglês; ii) localizado – em 

que a interface do utilizador e a documentação são traduzidas, mas as ferramentas e o conteúdo 

específicos do idioma permanecem em inglês; iii) adaptado – as ferramentas linguísticas, o conteúdo e 

as funções do software são revisados ou recriados para o mercado-alvo (Brooks, 2000, p. 19). 

Essa subdivisão foi orientando e definindo os graus de prioridade e dados de custos de localização 

da Microsoft. Após muitos anos de investimento em equipa especializada, terceirização da maior parte 

do trabalho de tradução, iniciativas e esforços para resolver as questões que envolviam a localização de 

seus produtos e serviços, entendendo as demandas de cada público-alvo, país e idioma, a Microsoft 

conseguiu gerir essa problemática e, devido à complexidade de seus produtos, a quantidade de seus 

manuais continuam a crescer. 

Atualmente, a Microsoft possui manuais e tutoriais para todas as suas aplicações em idiomas de 

quase todo o mundo. Conforme Brooks (2000, p. 17) relatou, Bill Gates pensou que seriam altos custos, 

mas, com certeza, agora gera altíssima rentabilidade para ele. Por exemplo, se você entrar no site oficial 

da Microsoft em Português do Brasil1, clicar no botão “Pesquisar” e digitar a aplicação “Outlook”, 

encontrará uma lista numerosa de artigos, manuais e tutoriais de suporte.  

 
1 Recuperado em 14 de novembro de 2023, de https://www.microsoft.com/pt-br. 

https://www.microsoft.com/pt-br
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No campo do serviço informático, para o agente de help desk ou service desk, ter a possibilidade 

de obter o sistema operacional Windows localizado no idioma nativo do utilizador e ter os manuais da 

Microsoft localizados na maioria dos idiomas para dar a assistência apropriada ao cliente têm sido de 

imenso auxílio no momento do suporte com as respetivas aplicações. 

2.3 Tradução 

Neste capítulo, serão apresentados os conceitos de tradução e seus estudos, bem como os 

conceitos de tradução automática a partir da visão de pesquisadores da área. Também serão discutidas 

as diferenças entre tradução automática neuronal e estatística, e entre as ferramentas de tradução 

automática Google Tradutor e DeepL. 

2.3.1 Conceitos de tradução e estudos de tradução 

Ao longo da história e por conta de todo o fenómeno que a globalização ocasionou nas últimas 

décadas, o conceito de tradução passou por diversas transformações. Munday et al., em seu livro 

Introducing Translation Studies, na sua quinta edição (2022, p. 8), ao conceituarem a tradução, explicam 

que o termo inglês translation, atestado pela primeira vez por volta de 1340, deriva do francês antigo 

translation ou, mais diretamente, do latim translation, que vem do particípio do verbo transferre 

(“transportar”). Então, esses autores alegam que, no campo dos idiomas, a tradução hoje tem vários 

significados: i) o campo de assunto ou fenómeno geral (por exemplo, “estudei tradução na 

universidade”); ii) o produto, ou seja, o texto que foi traduzido (por exemplo, “eles publicaram a tradução 

em árabe do relatório”); iii) o processo de produção da tradução, também conhecido como tradução (o 

serviço de tradução).  

Nesse contexto, o processo de tradução entre dois idiomas escritos diferentes envolve a mudança 

de um texto escrito original (o texto de partida, ou TP) no idioma verbal original (a língua de partida, ou 

LP) para um texto escrito (o texto de chegada, ou TC) em um idioma verbal diferente (a língua de chegada, 

ou LC) (Munday et al., 2022, p. 8). 

Além disso, Munday et al. (2022, p. 10) declaram que a tradução é uma atividade humana 

essencial que tem sido praticada ao longo da história, que se intensificou ainda mais com comunicação 

inter-cultural e o comércio global. No entanto, o estudo da tradução como disciplina acadêmica só 

começou a ganhar força na segunda metade do século XX. O termo estudos de tradução foi cunhado 



19 

 

pelo acadêmico norte-americano James S. Holmes. Holmes definiu os estudos de tradução como uma 

disciplina interdisciplinar que estuda “o complexo de problemas agrupados em torno do fenómeno da 

tradução e das traduções” (Holmes 1988b/2004, p. 181, conforme citado por Munday et al, 2022, p. 

10). 

Outra obra recente sobre esse assunto é o livro Reflexive Translation Studies, de Silvia Kadiu 

(2019). Já no prefácio, essa autora fala que a teoria da tradução – como percebemos, descrevemos ou 

pensamos sobre a tradução – está inevitavelmente entrelaçada com a prática. Kadiu (2019, p. 1) ainda 

explica que o rápido desenvolvimento dos estudos da tradução como disciplina desde a década de 1990 

transformou-o em um período de crescimento na teoria da tradução e assistiu a uma proliferação de 

teorias que apelam a uma maior reflexividade na tradução, o que levanta questões de visibilidade, 

criatividade e ética.  

Anthony Pym, em seu livro Explorando as teorias da tradução (2017, p. 10), ao explicar o que 

seria uma teoria da tradução, questiona o uso dos termos texto-fonte/texto de partida e texto-alvo/texto 

de chegada, combinados com o refixo “trad-” presente no termo tradução, como se houvesse apenas 

dois lados envolvidos no processo, e se devesse elaborar uma cena espacial na qual as opções vão de 

um lado para o outro. Para contrapor essa ideia, ele menciona que existe o termo anuvad, em sânscrito 

e hindi, para referir-se à tradução escrita e que significa “repetição” ou “dizer depois”. Então, ele 

continua: 

 

Conforme esse termo alternativo, a diferença principal entre o texto de um lado e o texto do 

outro poderia se dar não no espaço, mas no tempo. A tradução seria, portanto, entendida como 

um processo de atualização e elaboração constantes, em vez de algum tipo de deslocamento 

físico através das culturas. 

Nossas denominações inter-relacionadas formam cenas, e essas cenas tornam-se teorias a 

respeito do que poderia ou deveria ser uma tradução. 

Isso não significa que todo o nosso processo de teorização interna seja constantemente 

transformado em objetos públicos. Quando os tradutores falam entre si, eles, na maioria das 

vezes, aceitam os termos em comum sem muita polêmica. Enganos evidentes são, em geral, 

esclarecidos com rapidez através da referência ao uso, ao conhecimento linguístico ou ao senso 

comum. (Pym, 2017, p. 10) 
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Nesse sentido, as divergências nas teorias da tradução apontam para a necessidade de uma maior 

integração entre teoria e prática, bem como de uma reflexão mais aprofundada sobre o papel do tradutor. 

Nesse contexto, os pesquisadores de estudos de tradução adotam métodos de tradução e abordagens 

teóricas distintas, cada um com sua própria lógica. Portanto, tradutores profissionais que estudam teorias 

e métodos de tradução podem pautar-se nos teóricos mais renomados e em formas de traduzir que vão 

se adequar e variar de acordo com cada situação e finalidade do texto a ser trabalhado. 

Dessa forma, apesar de haver divergências e convergências nos estudos de tradução, algo inegável 

é que, desde a invenção da escrita, a tradução tem desempenhado um papel importante na interação 

entre povos e culturas. Atualmente, ela funciona como um mediador cultural vital, como uma 

comunicação entre idiomas e culturas. Como já vimos, nas últimas décadas, a globalização têm 

desencadeado diversas mudanças no trabalho do tradutor (Darin, 2010, p. 1). 

Austermühl (1999, p. 1) compartilha dessa mesma visão, ao explicar que os acadêmicos e 

profissionais da área de tradução, muito mais do que colegas de outros campos de ciências humanas, 

trabalham em um contexto científico e sociocultural que é significativamente influenciado pelo 

crescimento exponencial da comunicação internacional. Esse autor ainda acrescenta que o aumento 

exponencial das informações disponíveis, o número crescente de encontros interculturais e a 

virtualização contínua da vida privada e empresarial deram início a mudanças drásticas e sustentáveis 

na disciplina de estudos de tradução. Corroborando o que já foi explicado aqui, ele complementa que a 

digitalização e a globalização dos fenómenos económicos, políticos, sociais e culturais estão gerando 

grandes expectativas em relação às competências de todos os acadêmicos, professores e profissionais 

de tradução. 

Esselink (2000, p. 4) afirma que a tradução é o processo de converter o texto escrito ou as palavras 

faladas para outro idioma, exigindo que o significado completo do material de origem seja traduzido com 

precisão para o idioma de destino, com atenção especial às nuances e ao estilo culturais. Nesse sentido, 

o papel do tradutor é crucial no mundo globalizado em que empresas e organizações desenvolvem 

influência internacional, operando e oferecendo seus produtos e serviços em escala mundial, o que 

requer uma multiplicidade de línguas. A partir disso, o tradutor torna-se essencial para a representação 

da empresa no processo de tradução, seja na escolha de interpretar um merchandising, um slogan, 

qualquer material de cunho de marketing, ou até mesmo produtos, serviços, materiais e manuais da 

empresa em outro país, como o caso da Microsoft.  

Alves (2006) traz uma ótima definição para esse fenómeno atual: 
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Traduzir hoje é, porventura, resolver o dilema entre o social, o técnico e o humano, uma exigente 

actividade profissional inserida no contexto da indústria das tecnologias da linguagem, num 

mercado altamente competitivo e selectivo, mas também movediço e dinâmico, 

sociologicamente marcado pela fluidez e pela ausência de barreiras e fronteiras [. . .] (p. 4) 

 

Nesse cenário, o avanço da tecnologia mudou muito a forma como se produz trabalhos de 

tradução ao longo dos anos, por conta de propagandas informatizadas em nível de website, redes sociais, 

aplicações, por causa da criação de tradução automática (machine translation), pelo uso de ferramenta 

para traduzir textos, as computer-aided translation, as ferramentas de tradução assistida por computador 

(conhecidas como CAT Tools), algumas até pautadas em memórias de tradução (translation memory), 

assunto que veremos na subsecção seguir. 

Sendo assim, abordaremos aqui o conceito de tradução automática mais aprofundado e como 

esta pode ser apenas um ponto de partida para uma intervenção humana, para, em seguida, falarmos 

mais especificamente como essa intervenção pode ser feita pelo operador informático multilingue de 

service desk. 

2.3.2 Conceitos de tradução automática 

Segundo Forcada (2010), a machine translation, em português tradução automática, é a tradução 

por meio de um computador que utiliza um software adequado, de um texto escrito no idioma de origem 

que produz outro texto no idioma de destino, que pode ser chamado de sua tradução bruta. Ainda de 

acordo com esse autor, essa definição parece implicar que a tradução resultante pode ser usada como 

um produto profissional, mas a tradução automática e a tradução profissional, mesmo que estritamente 

relacionadas no propósito, não são produtos intercambiáveis. 

De acordo com Bowker e Fisher (2010), a computer-aided translation (CAT), em português 

tradução assistida por computador, é o uso de software de computador para auxiliar um tradutor humano 

no processo de tradução. Eles mencionam que o termo se aplica à tradução, que continua sendo 

responsabilidade de uma pessoa, mas envolve um software que pode facilitar certos aspectos. Isso 

contrasta com a tradução automática, que se refere à tradução que é realizada principalmente por 

computador, mas que pode envolver alguma intervenção humana, como pré ou pós-edição. Esses 

autores ainda comentam que é útil conceber a CAT como parte de um contínuo de possibilidades de 

tradução, em que vários graus de tradução automática ou humana podem ser utilizados. 
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Sendo assim, a tradução automática pode ser utilizada com a intervenção humana antes ou depois 

da tradução, enquanto que, utilizando uma CAT tool, a tradução é executada por um profissional com o 

auxílio de uma variedade de ferramentas para o ajudar.  

A tradução automática possui uma série de desafios e limitações. Algumas traduções feitas por 

essa ferramenta podem ser débeis e tendem a ser muito diferentes das produzidas por um tradutor 

profissional. No entanto, isso não quer dizer que elas não sejam úteis em diversas áreas, significa apenas 

que exige a atenção do tradutor. É necessário ao tradutor ver em que tipos de texto uma tradução 

automática é capaz de fazer um bom trabalho.  

Nesse contexto, podem ocorrer algumas dificuldades na interpretação de um texto por uma 

tradução automática, como por exemplo, a ambiguidade. A resolução de problemas de ambiguidade é 

até aos dias de hoje o maior problema de uma tradução automática. Essas decisões vêm de processos 

e programas de computador que usam as suas memórias para processar a informação. Uma palavra 

pode aparecer diversas vezes com interpretações diferentes; a estrutura da frase pode ser representada 

de variadas formas. Além disso, o conteúdo não determina necessariamente a forma. Diferentes línguas 

utilizam diferentes estruturas de interpretações adaptados à sua realidade. A tradução feita palavra por 

palavra poderá então ser errada ou incompreensível. Outro problema que pode acontecer de forma 

recorrente e arbitrária é quando, por alguma falha de dados, a tradução automática repete trechos dentro 

do texto traduzido, ou até mesmo deixa de traduzir parte do texto, causando omissão de trechos, quando 

traduz automaticamente. Isso exige ainda mais a atenção do tradutor para comparar o texto original com 

o texto gerado pela tradução automática para detectar tais falhas e não prejudicar o sentido e a 

integridade do texto que quer traduzir.  

O maior obstáculo da tradução automática é linguístico, não computacional. A ineficiência desse 

processo sucede porque a tradução depende de conhecimentos semânticos, gramaticais, léxicos, de 

aspectos extralinguísticos e conhecimentos empíricos. Portanto, as máquinas ainda não conseguem 

reproduzir essas características tão intrinsicamente humanas (Hutchins & Sommers, 1992; Sales, 2011, 

conforme citado por Oliveira Matos et al., 2015). 

Por um lado, podemos detectar que a tradução automática pode ser capaz de exercer uma boa 

tradução quando trabalha com cartas comerciais, textos técnicos ou até mesmo económicos; por outro 

lado, não é capaz de o fazer com a mesma eficácia em textos poéticos, anúncios, ou aqueles que exijam 

uma intervenção mais literária. Por isso, o uso de tradução automática é válido quando pode ser lido por 

um humano para corrigir e editar erros e falhas que essa ferramenta possa gerar nos textos traduzidos. 
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Portanto, a tradução automática acabou por facilitar a tradução por parte das empresas que a 

queriam realizar de forma rápida e em grande escala para atender a uma vasta demanda gerada pelos 

efeitos da globalização. Contudo, a tradução automática não pode ser realizada com perfeita qualidade, 

já que traduz automaticamente, sem muita das vezes levar em consideração o contexto inserido, e pode 

apresentar problemas de ambiguidade, repetições, omissões, excesso de impessoalidade ou 

pessoalidade, até mesmo erros gramaticais. Essas questões podem ser discernidas apenas por um 

humano, pelo poder de interpretação, análise de contexto e tomada de decisão, que se atentará a manter 

a qualidade do texto de acordo com a sua finalidade. 

Apesar de tudo isso, o desenvolvimento da tradução automática abrange pontos positivos. Vemos 

muitas delas gratuitas disponíveis na internet, como Google Tradutor, Bing, DeepL, entre outros, que 

ajudam diversas pessoas e empresas ao redor do mundo a realizar variados projetos de tradução, ou 

que precisam se comunicar de forma rápida e não podem esperar pela intervenção de um tradutor.  

Para aprofundar sobre esse assunto, veremos, na subsecção seguinte, as diferenças entre tipos 

de tradução automática. 

 

2.3.2.1 Tradução automática neuronal e estatística 

A tradução automática neuronal, do inglês neural machine translation (NMT), é um método que 

se baseia no uso de redes neurais artificiais para aprender a traduzir textos de um idioma para outro (Wu 

et al., 2016). Nessa abordagem, é alimentada uma extensa quantidade de dados de treinamento, 

contendo pares de frases em diferentes idiomas, em uma rede neural. Essa rede neural é composta por 

camadas interconectadas de neurónios, que processam a entrada e geram uma saída correspondente 

(LeCun et al., 2015). 

Ao analisar o contexto da tradução automática, Cho et al. (2014) ponderam que a entrada 

corresponde à sentença a ser traduzida em um idioma, e a saída é a tradução resultante em outro 

idioma. A rede neural aprende a estabelecer uma relação entre esses dois conjuntos de informações, 

ajustando os pesos das conexões entre os neurónios em suas camadas para minimizar o erro entre as 

traduções geradas e as traduções esperadas nos dados de treinamento. 

Para a implementação da tradução automática neuronal, comumente é empregado um modelo 

conhecido como “codificador-decodificador”. Nesse modelo, o codificador processa a sentença de 

entrada, transformando-a em uma representação chamada de vetor latente. Em seguida, o decodificador 

utiliza esse vetor latente para produzir a tradução correspondente no idioma de destino (Wu et al., 2016). 
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Esse processo ocorre iterativamente, à medida que a rede neural ajusta seus parâmetros para melhor 

se adequar aos dados de treinamento (LeCun et al., 2015). 

Portanto, a tradução automática neuronal é uma técnica que utiliza redes neurais artificiais para 

aprender a traduzir sentenças de um idioma para outro, por meio do treinamento e da análise de grandes 

volumes de dados que contêm pares de sentenças em diferentes idiomas (Cho et al., 2014). 

O modelo de tradução automática estatística, do inglês statistical machine translation (SMT), foi 

uma abordagem predominante na tradução automática antes do surgimento da NMT. Nesse método, as 

traduções eram baseadas em modelos estatísticos que analisavam padrões de correspondência entre 

palavras e frases em diferentes idiomas, com base em um grande volume de dados de treinamento. 

Embora a NMT tenha em grande parte substituído os métodos estatísticos devido a melhorias na 

qualidade de tradução, ainda é possível encontrar sistemas que utilizam essa abordagem. Algumas 

opções incluem: 

i) Google Tradutor – serviço que permite a tradução de palavras, frases, textos ou páginas da internet, 

inicialmente baseado no tradutor Systran, que utilizava uma abordagem baseada em regras. Em 

2007, a empresa lançou seu próprio sistema de tradução, que utilizava uma abordagem estatística. 

Baseava-se em padrões estatisticamente significativos encontrados em documentos traduzidos por 

humanos, por exemplo, textos disponíveis na internet de fontes consideradas confiáveis, como textos 

oficiais de organizações como a Organização das Nações Unidas (ONU), documentos bilíngues de 

arquivos públicos, livros ou websites disponíveis na internet (Oliveira Matos et al., 2015). Começou 

a adotar a NMT por volta de 2016. A abordagem NMT trouxe melhorias significativas na qualidade 

das traduções em comparação com os métodos estatísticos anteriores, como os modelos de SMT. 

A mudança para a NMT permitiu que o Google Tradutor produzisse traduções mais naturais e 

contextuais, o que contribuiu para a melhoria geral da experiência de tradução (Wu et al., 2016); 

ii) Bing Tradutor – serviço de tradução on-line e gratuito fornecido pela Microsoft, inicialmente 

desenvolvido para atender necessidades internas da empresa, mas foi disponibilizado para o público 

geral em 2007. Em 2012, a Microsoft firmou uma parceria com o Yahoo! e o tradutor da Microsoft 

substituiu o Yahoo! Babel Fish, após uma parceria firmada entre as empresas Microsoft e Yahoo! 

Em 2012 (Oliveira Matos et al., 2015). Embora o Bing Tradutor também tenha implementado 

técnicas de NMT, ainda há uma presença de modelos estatísticos na plataforma; 

iii) Systran – ferramenta de tradução desenvolvida na França na década de 1960, é uma das mais 

antigas e bem estabelecidas do mercado. É usada por empresas, governos e indivíduos em todo o 

mundo. Essa ferramenta usa um processo de análise sintática para traduzir texto de uma língua 
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para outra, sendo baseada em um banco de dados de pares de palavras e frases que foram 

traduzidos por humanos. Tem sido objeto de muitos estudos acadêmicos. Alguns autores elogiam 

a Systran por sua precisão e velocidade, enquanto outros criticam sua qualidade e sua falta de 

flexibilidade. Os autores que fornecem uma visão geral da Systran e de seu papel no campo da 

tradução automática, discutindo sua precisão, velocidade, qualidade e flexibilidade, são: Callison-

Burch et al. (2007) e Simard (2019); 

iv) Yandex.Translate – uma ferramenta de tradução automática gratuita fornecida pela Yandex, uma 

empresa de tecnologia russa. Está disponível em vários idiomas, incluindo inglês, russo, espanhol, 

alemão, francês e chinês. A Yandex.Translate usa uma variedade de técnicas de MT, incluindo SMT, 

NMT e tradução automática híbrida. Ela também usa um banco de dados de pares de palavras e 

frases traduzidos por humanos para melhorar a precisão das traduções. Pode ser usada para 

traduzir texto, websites, documentos e até mesmo conversas em tempo real. Ela é uma ferramenta 

útil para quem precisa traduzir texto de um idioma para outro. Os autores que apresentam uma 

visão geral da Yandex.Translate, discutindo a arquitetura, os mecanismos, a precisão e o 

desempenho, são: Sumasjo e Mahanani (2020) e Gampieri (2023). 

Vale ressaltar que a maioria dos sistemas modernos de tradução automática tem migrado para a 

abordagem de tradução automática neuronal devido às melhorias significativas na qualidade das 

traduções que ela oferece (Araújo & Aguiar, 2023). Isso não apenas se aplica ao Google Tradutor, mas 

também a muitas outras plataformas de tradução.  

 

2.3.2.2 Diferenças entre Google Tradutor e DeepL2 

O Google Tradutor e o DeepL são dois dos sistemas mais populares de tradução automática 

disponíveis atualmente, e ambos usam a tecnologia de aprendizado de máquina para traduzir textos de 

um idioma para outro. No entanto, há algumas diferenças importantes entre esses dois sistemas: 

i) qualidade da tradução – em geral, muitos utilizadores relatam que a qualidade das traduções feitas 

pelo DeepL é mais precisa e natural do que as do Google Tradutor. Isso ocorre porque o DeepL usa 

uma arquitetura de rede neural mais avançada que permite uma melhor compreensão do contexto 

e do significado do texto original, tendo o seu foco na precisão da tradução, e não em uma 

abordagem mais abrangente e diluída como o Google; 

 
2 As informações fornecidas neste item sobre o Google Tradutor e o DeepL foram adaptadas por meio de análises comparativas dos websites 
Conveythis, DeepL e Linguise, cujos textos estão referenciados na lista de Bibliografia. 
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ii) pares de idiomas disponíveis – o Google Tradutor suporta uma ampla variedade de pares de 

idiomas, incluindo traduções entre idiomas não tão comuns, como o persa e o xhosa. O DeepL, por 

outro lado, ainda suporta um número menor de pares de idiomas, embora ofereça suporte para os 

principais idiomas europeus, além do japonês e do chinês; 

iii) velocidade – o Google Tradutor é geralmente mais rápido do que o DeepL ao traduzir textos curtos 

ou frases simples. No entanto, o DeepL pode ser mais rápido para textos mais longos e complexos, 

pois sua arquitetura de rede neural é mais eficiente em lidar com tarefas de tradução mais 

complexas; 

iv) preço – o Google Tradutor é gratuito para uso geral e não há limites no número de traduções que 

podem ser feitas. O DeepL, por outro lado, tem um modelo de negócios baseado em assinatura que 

oferece recursos adicionais, como traduções ilimitadas de documentos, bem como acesso a outros 

recursos avançados de processamento de linguagem natural. 

Em resumo, como senso comum entre os estudiosos de tradução, enquanto o Google Tradutor é 

mais abrangente em termos de idiomas suportados e é mais rápido para traduções simples, o DeepL é 

geralmente considerado superior em termos de qualidade de tradução, especialmente para textos mais 

complexos. Embora possam apresentar erros em suas traduções, na maioria das vezes, essas 

ferramentas de tradução automática revelam traduções bastante satisfatórias (Borges & Pimentel, 2020). 

2.4 Service desk 

Os conceitos até aqui abordados destacam que a globalização tem sido um dos principais fatores 

de crescimento do mercado de localização e tradução. Essa expansão económica, tecnológica e global 

das empresas tem aumentado a demanda por serviços de suporte técnico, localização e tradução de 

produtos, sistemas e serviços para diferentes países e regiões.  

Com o constante avanço tecnológico e digital, as organizações estão cada vez mais buscando 

formas de se aproximar dos seus clientes, sendo a tecnologia da informação (TI) uma grande aliada 

nesse processo, mas não a única. Nesse cenário, o service desk multilingue surge como uma solução 

para atender às necessidades de suporte técnico de empresas que operam em um mercado global. Esse 

serviço requer a disponibilidade de profissionais de línguas e agentes de suporte de TI fluentes em 

diferentes idiomas e culturas. Sendo assim, o mercado requer que as novas estratégias sejam bem 

planejadas para que tragam os resultados esperados.  
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É por isso que, neste tópico, veremos os conceitos relacionados ao ramo de service desk, as 

diferenças entre service desk e help desk, e como essa funções são orientadas e gerenciadas no universo 

de gerenciamento de serviços de TI, a fim de facilitar a compreensão da correlação dessa função com a 

localização e as ferramentas de tradução automática. 

2.4.1 Conceitos de service desk 

Antes de aprofundarmos sobre a função de service desk, precisamos mencionar a importância da 

Information Technology Infrastructure Library (ITIL) – em português, traduzido livremente para Biblioteca 

de Infraestrutura de Tecnologia da Informação. A ITIL funciona como uma orientação sobre as melhores 

práticas para gerenciamento do serviços de TI (ITIL® Foundation, 2019, p. 11), englobando a 

infraestrutura da área, a manutenção e a operação dos serviços de TI. Segundo Lyra (2020), a ITIL® é 

a orientação mais amplamente adotada no gerenciamento de serviços de TI – em inglês, Information 

Technology Service Management (ITSM) – no mundo, oferecendo suporte a organizações e indivíduos na 

obtenção de valor ideal dos serviços digitais e de TI, liderando a indústria de ITSM com programas de 

orientação, treinamento e certificação há mais de 30 anos, para profissionais que atuam nesse ramo e 

desejam consolidar a carreira nessa área.  

Desde a sua origem em 1989, a ITIL já possui quatro versões, tendo lançado sua quarta versão 

em 2019. Diversas instituições fornecem cursos preparatórios para que esses profissionais possam obter 

esse tipo de certificação. Segundo Lyra (2020), a primeira certificação que o profissional do 

gerenciamento de serviços pode fazer é a ITIL® 4 Foundation, apresentando o que há de mais moderno 

em gerenciamento de serviços, com uma linguagem comum e conceitos essenciais de como aperfeiçoar 

métodos de trabalho. As outras certificações se chamam respetivamente ITIL® 4 Managing Professional, 

ITIL® 4 Strategic Leader e ITIL® 4 Master3.  

Lyra (2020) também explica que a ITIL 4 atualiza a ITIL reformulando muitas das práticas 

estabelecidas de ITSM no contexto mais amplo da experiência do cliente, fluxos de valor e transformação 

digital, além de adotar novas maneiras de trabalhar. Sendo assim, a ITIL 4 fornece a orientação que as 

organizações precisam para enfrentar novos desafios de gerenciamento de serviços e utilizar o potencial 

da tecnologia moderna. Ele foi projetado para garantir um sistema flexível, coordenado e integrado para 

a governança e o gerenciamento eficazes de serviços dependentes da TI. 

 
3 Mais detalhes sobre as certificações da ITIL 4 podem ser encontrados em www.axelos.com/certifications. Recuperado em 8 de dezembro 
de 2023. 

http://www.axelos.com/certifications
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Nesse cenário, a ITIL orienta e avalia a função de service desk, possuindo conceitos e metas 

específicos para esse papel. De acordo com o glossário da ITIL® 4 Foundation (2019, p. 21), o termo 

service desk seria traduzido para o português como “central de serviço”, cuja definição seria: “o ponto 

de comunicação entre o provedor de serviço e todos os seus usuários”. Uma central de serviços típica 

gerencia incidentes e solicitações de serviço e também lida com a comunicação com os utilizadores. 

Logo, para a ITIL® 4 Foundation (2019), o service desk é um ponto de contato único para usuários que 

precisam de suporte para um sistema ou produto, sendo o responsável por fornecer suporte técnico, 

responder a perguntas e resolver problemas. 

Além da ITIL, existe a Help Desk Institute (HDI), uma associação mundial para profissionais de 

serviços e suporte que funciona também como um órgão de certificação para o setor. Fundada em 1989, 

a HDI promove o setor de atendimento ao cliente e suporte técnico, capacitando seus membros por meio 

do acesso a informações oportunas e valiosas sobre o setor, incluindo relatórios e publicações; 

incentivando a colaboração dos membros por meio de eventos e fóruns on-line; estabelecendo programas 

de certificação e treinamento do setor internacionalmente reconhecidos e baseados em padrões4. 

De uma maneira geral, conforme definido por diversas empresas5, a expressão service desk refere-

se a um conceito fundamental no âmbito da tecnologia da informação e comunicação (TIC), com uma 

possível tradução e entendimento de “central de serviços”, “balcão de serviços” ou “central de ajuda”. 

Nesse sentido, service desk seria uma central de serviços de atendimento integrado em tecnologia da 

informação, baseada nas melhores práticas exigidas pela ITIL e pela HDI, que presta assessoria para 

solucionar problemas, gestão e integração de recursos e ferramentas, para atendimento interno (staff) 

ou externo (clientes diretos e indiretos).  

Sendo assim, o service desk representa um ponto centralizado de contato entre utilizadores e uma 

organização, geralmente uma equipa especializada, que fornece suporte técnico, resolução de problemas 

e assistência relacionada a serviços de TIC. Por isso, o service desk desempenha um papel crucial na 

garantia do funcionamento eficaz dos sistemas de tecnologia, na manutenção da continuidade dos 

negócios e na satisfação dos usuários. 

O service desk não é apenas um ponto de contato para questões técnicas, mas também atua 

como uma interface entre os utilizadores finais e a equipa de tecnologia. Geralmente, conforme foi 

observado pela experiência dos operadores informáticos, esse setor é responsável por receber, registrar, 

 
4 Informação extraída, adaptada e recuperada em 7 de dezembro de 2023, de https://www.contactcenterworld.com/company/help-desk-
institute-hdi.aspx. 
5 Para obter diferentes perspectivas empresariais sobre os termos help desk  e service desk, pesquisou-se sobre definições de organizações 
conhecidas, como Atlassian, Zendesk, Cloud Business, Neo Assist, entre outras, cujos textos estão referenciados na lista de Bibliografia. 

https://www.contactcenterworld.com/company/help-desk-institute-hdi.aspx
https://www.contactcenterworld.com/company/help-desk-institute-hdi.aspx


29 

 

priorizar e gerenciar solicitações de suporte técnico, consultas e incidentes que os usuários possam 

enfrentar ao utilizar sistemas, software, hardware e outras soluções tecnológicas. Além disso, ele 

desempenha um papel vital na comunicação proativa de informações relevantes, como atualizações de 

sistema, interrupções planejadas ou problemas conhecidos, mantendo os utilizadores informados e 

minimizando potenciais impactos.  

Segundo Medeiros e Soares (2010, p. 5), a fim de evitar que o cliente se comunique ou recorra a 

vários atendentes e departamentos, gerando desgaste, o service desk funciona como esse ponto central 

de comunicação entre os diversos setores existentes e o utilizador, atendendo aos objetivos comerciais 

da corporação e melhorando a satisfação desse cliente. Por isso, o service desk tem a obrigação de 

manter os utilizadores informados a respeitos dos serviços, eventos, ações e oportunidades passíveis de 

impactar a capacidade de execução de suas atividades diárias. 

Segundo esses autores, o service desk é o único ponto de contato entre os prestadores de serviços 

e usuários no dia a dia, sendo um ponto focal para fazer pedidos de serviços e comunicar incidentes. 

Para eles, o service desk tem a obrigação de manter os usuários informados dos serviços, eventos, ações 

e oportunidades passíveis de impactar a capacidade de execução de suas atividades diárias. 

Ainda de acordo com Medeiros e Soares (2010, p. 5), o service desk é a interface amigável do 

utilizador com os benefícios que a TI traz aos negócios. Ele é responsável pela primeira impressão que 

a área de Tl dará aos seus utilizadores quando houver necessidade de interação. Logo, o service desk 

atua estrategicamente, como uma função para identificar e diminuir o custo de infraestrutura; apoia a 

integração e a gestão de mudanças em toda a empresa; reduz os custos pela utilização eficiente dos 

recursos e tecnologias; auxilia a obter a satisfação do cliente e a ampliação das oportunidades de negócio. 

A abordagem do service desk pode variar de acordo com as necessidades e o tamanho da 

organização. Isso pode incluir canais de comunicação como telefone, e-mail, chat ao vivo e sistemas de 

gerenciamento de incidentes. A equipa do service desk é composta por profissionais técnicos treinados, 

que possuem conhecimento especializado em uma variedade de tecnologias e sistemas. 

Em um ambiente cada vez mais globalizado e digitalizado, o service desk evoluiu para se tornar 

um núcleo de suporte abrangente, incluindo não apenas questões técnicas, mas também suporte a 

aplicativos, treinamento e consultoria. A implementação eficaz de um service desk pode melhorar a 

produtividade dos utilizadores, minimizar o tempo de inatividade e otimizar o uso dos recursos de 

tecnologia em uma organização. 

Portanto, o service desk é um componente crítico da infraestrutura de tecnologia da informação, 

fornecendo um ponto central de contato, suporte e solução de problemas para garantir a operação eficaz 
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e eficiente dos sistemas de uma organização. Antes de abordarmos como essas funções ocorrem na 

prática com o operador informático multilingue de service desk, veremos as diferenças entre help desk 

e service desk. 

 

2.4.1.1 Diferenças entre help desk e service desk 

No contexto de central de atendimento, ou central de serviços, é comum que operadores 

informáticos de service desk necessitem atender demandas de help desk, razão pela qual consideramos 

importante a diferenciação entre essas atividades nesse âmbito de atuação profissional. 

De acordo com Cohen (2008, p. 20), a implementação de um help desk é uma prática antiga que 

vem evoluindo ao longo do tempo. Inicialmente, as empresas colocavam um funcionário à disposição 

dos clientes para atender suas dúvidas por telefone. Com o aumento da demanda, foi necessário criar 

uma equipa de atendimento que não apenas recebesse as ligações, mas também solucionasse os 

problemas dos clientes. Logo, a criação de um setor de help desk permitiu solucionar os problemas dos 

clientes de forma imediata e personalizada, sem a necessidade de deslocamento de funcionários. Isso 

aumenta o valor da empresa aos olhos dos clientes, melhorando os índices de satisfação desses 

utilizadores e reduzindo os custos de locomoção. 

De acordo com Magalhães e Pinheiro (2007, p. 110), para alcançar os objetivos traçados pelos 

clientes e pela estratégia de negócio da organização em relação aos serviços de TI, muitas organizações 

têm implementado um ponto único de contato para a recepção das chamadas dos utilizadores e clientes 

relacionados aos serviços de TI e ao tratamento de eventos a eles relacionados: central de suporte (help 

desk), centro de contato (contact center) e central de serviços (service desk). Aqui vamos nos atentar 

apenas à diferenciação que esses autores fazem de help desk e service desk. 

Magalhães e Pinheiro (2007, p. 111) ainda informam que a ITIL, após a sua primeira revisão, 

evoluiu a abordagem de central de suporte (help desk) para central de serviços (service desk). Segundo 

esses autores, o propósito de um help desk é gerenciar, coordenar e resolver incidentes o mais 

rapidamente possível, assegurando que nenhuma requisição de ajuda será perdida, esquecida ou 

ignorada. Nessa função, o inter-relacionamento com o processo de gerenciamento de configuração e 

ferramentas de gerenciamento de conhecimento são normalmente utilizados para o desenvolvimento 

dos trabalhos de suporte às diversas tecnologias existentes na infraestrutura de TI.  

Por outro lado, esses autores explicam que a central de serviços (service desk) estende a gama 

de serviços e oferece uma abordagem ao mesmo tempo global, por ser a única porta de entrada, focada, 

pela especialização nos diferentes tipos de atendimento, permitindo que os processos de negócio sejam 
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integrados aos processos que compõem o gerenciamento dos serviços de TI. Logo, o service desk não 

trata apenas de atender aos incidentes, problemas e consultas, mas também de prover uma interface 

para outras atividades relacionadas com as demais necessidades dos utilizadores e clientes dos serviços 

de TI, como requisições de mudança, contratos de manutenção, licenciamento de produtos de software, 

solicitações de serviços, reclamações sobre divergências nas faturas de serviços, cronograma de 

manutenções preventivas e mudanças a serem realizadas na infraestrutura de TI, orientação em caso 

de desastres, entre outros. 

De uma maneira geral, podemos dizer que a expressão de língua inglesa formada pelas palavras 

help (ajuda) e desk (mesa secretária) significa “balcão de ajuda”. Sendo assim, durante muito tempo, o 

help desk funcionou como o primeiro ponto de contato para clientes e funcionários de uma empresa. 

Por meio da experiência da autora e dos operadores informáticos da empresa A, pôde-se avaliar que, 

quando os funcionários da empresa B precisavam de respostas, era ao help desk que eles recorriam. 

Quando esses clientes precisavam de alguém para solucionar problemas de uma impressora, atualizar 

a segurança de um computador portátil ou dar-lhes acesso a um novo sistema, o help desk os resgatava. 

Quando os clientes não conseguiam acessar seus sistemas, precisando de ajuda com a configuração de 

um dispositivo ou encontravam um erro sem sentido em alguma aplicação, era o help desk que 

normalmente recebia a ligação. 

Como vimos, o service desk também fornece suporte técnico aos utilizadores, mas sua abordagem 

é mais abrangente e integrada. Além de lidar com problemas, ele também gerencia solicitações de 

serviço, informações gerais e oferece suporte proativo para melhorar a experiência do usuário. 

Geralmente, está mais alinhado com o gerenciamento de serviços de TI e pode ter uma visão mais ampla 

de processos e fluxos de trabalho. Na prática com a empresa A, o service desk envolvia, na maioria das 

vezes, acessar o dispositivo do utilizador para resolução de algum incidente no sistema operacional ou 

em determinada aplicação ou ferramenta. 

Medeiros e Soares (2010, p. 5) explicam que, a partir do século XX, ocorreu a modificação do 

conceito de help desk para service desk. Para muitos clientes, o service desk é provavelmente a função 

mais importante em uma organização, com um escopo de serviço mais abrangente que o do help desk 

tradicional. Considerado um novo conceito de prestação de serviço de suporte, o service desk segue as 

tendências inovadoras e as melhores práticas do mercado. Os processos e serviços são reprojetados de 

forma a assegurar qualidade e a satisfação do cliente, atendendo às necessidades de cada empresa e 

acompanhando metodologias de gestão de serviços de TI, como ITIL e HDI, conforme explicado 

anteriormente. 
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De acordo com Medeiros e Soares (2010, p. 6), a diferença básica entre as nomenclaturas service 

desk e help desk está no nível de maturidade da área de TI da organização. Eles mencionam que, em 

empresas com uma infraestrutura de TI mais robusta, é comum encontrar um help desk responsável 

por fornecer suporte técnico básico, como o atendimento a problemas de hardware e a resolução de 

dúvidas simples. Já o service desk é um modelo mais abrangente, que oferece um escopo de serviços 

mais amplo, incluindo a resolução de problemas complexos e a gestão de incidentes e solicitações de 

serviço. O Quadro 1 mostra as principais diferenças entre os conceitos de help desk e service desk 

segundo a visão desses autores: 

 

Quadro 1: Diferenças entre help desk e service desk 

Diferenças Help desk Service desk 

Atuação Reativo Proativo 

Ponto de contato Descentralizado Centralizado 

Perfil do atendente Técnico Relacionamento 

Interação com o usuário A distância Envolvimento 

Vínculo com o negócio Periférico-Foco TI Conhecimento do Negócio 

Importância estratégica Pequena Grande 

Fonte: Medeiros & Soares, 2010, p. 6. 

 

Portanto, a distinção entre help desk e service desk pode variar em diferentes organizações, uma 

vez que os termos são frequentemente usados de maneira intercambiável. No entanto, é possível 

identificar uma distinção entre os dois conceitos a partir da análise de seus objetivos e escopo. Por 

exemplo, no contexto da empresa A, os operadores informáticos multilingues de service desk realizavam 

serviços de help desk, que se concentravam na resolução de problemas simples e na orientação dos 

utilizadores pelo fato de determinado incidente estar fora do escopo da empresa A ou B. Esses incidentes 

eram resolvidos rapidamente, com a abertura de um ticket descritivo que era alterado para o status 

resolvido logo em seguida. Nesse cenário, as ocorrências de help desk podem ser consideradas uma 

forma de service desk básico, que se concentra na resolução de problemas de primeira linha. No entanto, 

o conceito de service desk pode ser mais amplo, incluindo também a resolução de problemas complexos 

e o suporte a aplicações e sistemas específicos. 
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2.4.2 O operador informático multilingue de service desk 

O operador informático é a figura crucial no atendimento multilingue de service desk. Segundo 

Magalhães e Pinheiro (2007, p. 610), esse profissional também pode ser chamado de agente de 

atendimento, atendente ou representante. Esses autores pontuam que esse agente é o responsável pelo 

atendimento de chamadas que chegam a um call center ou centro de suporte pela realização de 

chamadas externas como em campanhas de telemarketing. Eles explicam que, em telecomunicações, o 

termo mais utilizado é atendente; e em call centers profissionais, usa-se agente. Aqui neste trabalho, 

além de operador informático, ele poderá ser chamado de agente de service desk. 

De uma maneira geral, o operador informático é um profissional da área de informática e 

computação, que efetua a instalação e a configuração de softwares nos computadores, dispositivos 

eletrónicos diversos, redes locais, internet e outras aplicações de utilizadores e empresas que 

contrataram o seu serviço. Ele também pode realizar a manutenção de computadores de acordo com as 

especificações técnicas, os instrumentos e as ferramentas adequadas, respeitando as normas de 

segurança da empresa para a qual trabalha. 

Como vimos no início da subsecção 2.4, o service desk funciona para centralizar e unir 

necessidades de uma empresa em um único lugar, gerindo todo o suporte técnico e operacional aos 

utilizadores de um sistema e registrando todas as interações como forma de controle e monitoramento 

por parte da organização. Dessa forma, um service desk é parte crucial da estrutura da TI e pode 

funcionar das seguintes formas: local (quando os utilizadores e o service desk compartilham o mesmo 

espaço físico); centralizado (quando está fisicamente localizado em um ponto e os utilizadores podem 

enviar seus pedidos de diversos locais); e virtual (não possui localização fixa, mas vários pontos de 

suporte e utilizadores em diferentes locais). 

A ITIL® 4 Foundation (2019, p. 3) define call, traduzido em português para chamada, como a 

“interação (por exemplo, uma chamada telefônica) com a central de serviço. Uma chamada pode resultar 

no registo de um incidente ou de uma requisição de serviço”. Dessa forma, as chamadas geralmente 

acontecem quando ocorre o que a ITIL® 4 Foundation (2019, p. 10) nomeia como incident, traduzido 

para português como “incidente”: “interrupção não planejada ou redução na qualidade de um serviço”. 

Outro motivo de abertura de chamada é a service request, em português traduzida para “requisição de 

serviço”, cuja definição da ITIL® 4 Foundation (2019, p. 22) é “solicitação de um usuário, ou seu 

representante autorizado, que inicia uma ação de serviço acordada como parte regular da entrega de 

serviço”. Logo, os utilizadores entram em contato com o service desk quando ocorrem esses incidentes 

em dispositivos eletrónicos, aplicações, ou sistemas, que podem acabar prejudicando seu desempenho 



34 

 

no trabalho, ou impactar significativamente os processos normais da empresa; ou quando precisam 

solicitar algum produto novo, a licença de alguma aplicação, ou a prestação de um serviço específico. 

Com os agentes de service desk da empresa A, essas chamadas eram registradas em tíquetes (tickets), 

com toda a descrição do problema relatado pelo cliente e todo o procedimento técnico realizado para a 

sua resolução.6 

Desse modo, o operador informático multilingue de service desk pode realizar atendimento na sua 

língua materna e em até duas ou mais línguas estrangeiras. Ou seja, quando ele é contratado por uma 

empresa para prestar atendimento em idiomas específicos, ele estará apto para atender utilizadores que 

falem essas mesmas línguas. Além disso, ele registra, no sistema com a língua oficial da empresa 

(quando se trata de uma empresa multinacional, é geralmente em inglês), as interações dos incidentes 

e das requisições de serviço (solicitações) que os utilizadores fazem por meio de chamadas telefónicas, 

e-mails e chats. Esses registos são chamados por muitas empresas de tickets, ou até mesmo número 

de protocolo, chamada ou incidente. Portanto, o atendimento multilingue de service desk acontece 

quando o operador informático fala e escreve mais de uma língua no momento do atendimento, ou 

simplesmente quando, ao realizar suas funções, intercala interações do sistema, chamadas telefónicas, 

e-mails, chats comunicando-se em mais de um idioma. 

No caso da autora desta dissertação, ela é brasileira de língua materna português do Brasil, tendo 

atuado como operadora informática em uma determinada empresa multinacional com filial em Portugal, 

a empresa A, cuja língua oficial é o inglês – isto é, mesmo funcionando em Portugal, a comunicação 

oficial interna da empresa e o registo das interações dos incidentes e das solicitações no sistema ocorrem 

em inglês. Durante a sua função, ela realizou atendimento de service desk aos utilizadores da empresa 

B (a empresa para a qual a empresa A prestava serviço) em inglês, para falantes do Reino Unido e outros 

países da África e do Oriente Médio; italiano, para falantes da Itália; e às vezes em Português para 

falantes de Portugal e outros países da América Latina. Seu caso é um exemplo claro de atendimento 

multilingue de service desk, área de estudo específico deste trabalho. 

Veremos como funciona o processo de atendimento multilingue de service desk na prática com e 

sem tradução automática no capítulo III desta dissertação. Na subsecção seguinte, vamos analisar como 

esse atendimento se relaciona com conceitos de globalização, localização e tradução automática. 

 
6 Esse assunto será mais aprofundado na parte prática, no capítulo III desta dissertação. 
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2.4.3 O modelo GILT e os desafios do atendimento multilingue de service desk 

Conforme abordado nos tópicos anteriores, o modelo GILT ocasiou muitas mudanças no mundo 

empresarial impactando também as tecnologias e a maneira como as organizações apresentam e 

vendem com seus produtos e serviços no mercado global. Por isso, nesse tópico, vamos analisar como 

esse fenómeno impactou e quais desafios apresentam no contexto de atendimento multilingue de service 

desk. 

 
2.4.3.1 Globalização e o atendimento multilingue de service desk 

Conforme já vimos, a globalização, como fenómeno social, económico e cultural, tem redefinido 

profundamente a maneira como as organizações operam e interagem em escala mundial. No final do 

século XX, esse movimento foi impulsionado pelo domínio da língua inglesa e pelo alcance do 

imperialismo estadunidense, transformando e consolidando o nosso mundo em uma rede global 

interconectada. O inglês, ao mesmo tempo que uniu nações, também estimulou a importância de 

aprender o idioma para se inserir no contexto globalizado e no mercado de trabalho, tornando-se 

praticamente um pré-requisito básico. No entanto, essa interconexão global não ocorre exclusivamente 

em inglês. À medida que empresas e instituições expandem suas operações para além das fronteiras 

nacionais, vivenciando a colaboração e a interdependência entre empresas e indivíduos, enfrentam 

desafios complexos relacionados à comunicação e à prestação de serviços em diferentes idiomas e 

culturas. Apesar de o inglês ser amplamente utilizado, é importante lembrar que muitas pessoas ao redor 

do mundo ainda não o dominam, o que gera uma demanda crescente por serviços de suporte técnico 

que superem barreiras linguísticas. Essa demanda tem gerado uma crescente necessidade de localização 

de serviços e produtos, a fim de fornecer soluções eficazes para atender a clientes de diversas 

nacionalidades. Assim, o atendimento multilingue de service desk se torna uma peça fundamental nesse 

cenário, permitindo que empresas multinacionais ofereçam suporte eficiente e personalizado, 

independentemente do idioma em que seus clientes preferem se comunicar. 

Além disso, a tecnologia e a comunicação instantânea têm permitido que problemas e consultas 

técnicas sejam tratados virtualmente em tempo real, independentemente da localização geográfica. Isso 

significa que as equipas de atendimento multilingue de service desk não só devem ser proficientes em 

diversos idiomas, mas também capazes de compreender as nuances culturais que podem influenciar as 

interações com os clientes. A capacidade de fornecer suporte em diversos idiomas não é apenas um 
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diferencial competitivo, mas também uma demonstração tangível do compromisso de uma organização 

com a satisfação e o atendimento de qualidade aos seus clientes globais. 

Empresas que buscam expandir seus negócios de maneira internacional frequentemente têm 

funcionários distribuídos por todo o mundo. Para atender a essa diversidade linguística, muitas delas 

possuem equipas especializadas com service desk multilingue ou optam por contratar outras empresas 

que lhes forneçam esse serviço. Algumas organizações mantêm centrais de atendimento em inglês e em 

outros idiomas, garantindo que seus utilizadores sejam atendidos em sua língua materna. Nesse 

contexto, o papel do operador informático multilingue se torna essencial, não apenas para superar as 

barreiras linguísticas, mas também para solucionar problemas técnicos de utilizadores que estão 

dispersos pelo mundo. Portanto, o atendimento multilingue de service desk surge como uma resposta 

prática à necessidade de atender a uma base de clientes diversificada e globalizada. 

Além disso, por conta da globalização, uma central multilingue de service desk precisa considerar 

várias questões cruciais para sua eficácia e excelência na execução do atendimento. Nesse contexto, 

abordaremos sua essência e os desafios cotidianos enfrentados pelo operador informático nesse tipo de 

serviço. 

Algumas centrais de atendimento multilingue de service desk podem recorrer ao Google Tradutor, 

DeepL, ou a outras ferramentas on-line para traduzir um tíquete e oferecer suporte. Outras podem 

compor equipas com agentes bilingues para atuarem como intermediários, enquanto algumas 

organizações simplesmente se desculpam pela falta de capacidade linguística e prosseguem o 

atendimento em inglês. Por conta disso, em uma central de atendimento multilingue de service desk, 

podem ocorrer inúmeros mal-entendidos gerando desinformação quando existe a barreira do idioma. 

Para evitar que isso aconteça, de acordo com a empresa Cloud Business7 (que oferece atendimento de 

service desk em suporte de TI), é importante que uma empresa avalie: 

i) quais idiomas seus utilizadores falam e qual o volume de tíquetes que eles geram – identificar os 

idiomas que se beneficarão do suporte multilingue para que seja estabelecida a central de serviços 

multilingue com os idiomas corretos; 

ii) quão fácil para os clientes é relatar um problema e com que tipo de incidentes eles precisam de 

suporte; se os utilizadores em outros mercados sabem como obter suporte e essas informações 

estão localizadas para garantir uma comunicação clara – bancos de conhecimento localizados 

podem ser suficientes se os utilizadores geralmente relatam problemas que eles mesmos podem 

resolver; 

 
7 Informações extraídas e adaptadas em 5 de janeiro de 2021, de https://cloudbusiness.com/multilingual-it-support-outsourcing/. 

https://cloudbusiness.com/multilingual-it-support-outsourcing/


37 

 

iii) quais são os canais de comunicação preferidos e quais estão disponíveis – pode ser preferível abrir 

um tíquete on-line a telefonar para uma central de atendimento que fale inglês. Por isso, é 

interessante descobrir o que os usuários esperam do suporte técnico, pois culturas diferentes às 

vezes esperam canais de comunicação diferentes; 

iv) se os tíquetes são repassados para a equipa de nível mais experiente  antes que alguém possa 

respondê-los – isso afeta os tempos de resposta e resolução e consome o tempo da equipa da 

central de serviços, que tenta encontrar uma maneira de se comunicar com o utilizador; 

iv) como os tempos de resposta e a resolução se comparam às operações em cada país atendido – 

comparar o desempenho com os tempos de resposta e a resolução dos utilizadores, e medir os 

principais indicadores de desempenho (em inglês, chamados de knowledge management practice 

– KPIs) de cada idioma permite compreender como as métricas de qualidade variam e identificar 

quais idiomas devem ser priorizados; 

v) o que dizem os utilizadores globais – analisar os níveis de satisfação, as reclamações e o feedback 

dos utilizadores ajuda a entender melhor o desempenho da central de serviços nos mercados 

estrangeiros; 

vi) qual é a estratégia global da organização – o suporte técnico precisa ser planejado de acordo com 

a expansão da organização para novos mercados ou de seu crescimento nos mercados existentes. 

Por isso, é necessário se certificar de que os idiomas façam parte dessa estratégia. 

Em resumo, a relação entre a globalização e o atendimento multilingue de service desk está 

intrinsecamente ligada à necessidade de se adaptar às complexidades da diversidade linguística e 

cultural que a globalização traz. A habilidade de fornecer atendimento técnico eficaz e relevante, 

independentemente do idioma, torna-se um componente vital da estratégia global das organizações, 

auxiliando-as a construir relacionamentos positivos e duradouros com clientes de todo o mundo. 

 
2.4.3.2 Localização e o atendimento multilingue de service desk 

 

Já vimos como o service desk multilingue é fundamental em um mundo globalizado, onde as 

empresas atendem a uma base de clientes diversificada em termos de idiomas e culturas. No entanto, 

a eficácia do atendimento multilingue não se limita apenas à habilidade dos agentes de service desk em 

lidar com produtos, sistemas de dispositivos e tutoriais que já estejam localizados e saber como 

administrá-los. Na verdade, é essencial que as empresas também localizem seus serviços para garantir 
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uma experiência de atendimento fluida e eficaz, já que muita das vezes os operadores precisam saber 

localizar os serviços em seu idioma nativo ao mesmo tempo que em inglês, ou em seu idioma nativo e 

simultaneamente em outro idioma. 

Uma prática que pode significativamente facilitar o trabalho dos agentes multilingues de service 

desk é a localização dos serviços oferecidos pelas empresas. Por exemplo, quando uma empresa precisa 

enviar mensagens padronizadas para seus usuários em diversos países, é de extrema importância que 

essas mensagens estejam disponíveis nos idiomas de cada país. Isso permite que os agentes 

simplesmente escolham a mensagem no idioma apropriado e a enviem para o cliente de destino, sem a 

necessidade de tradução manual. Da mesma forma, quando uma empresa fornece guias técnicos para 

solucionar problemas específicos em diferentes regiões do mundo, a localização desses guias é 

fundamental. Isso colabora para que os agentes multilingues de service desk trabalhem com maior 

eficiência, alcançando os objetivos de comunicação da empresa e garantindo a satisfação do cliente, 

independentemente de sua localização geográfica. 

Essa abordagem não apenas otimiza o trabalho dos agentes, mas também contribui para a 

satisfação geral dos clientes e fortalece a imagem da empresa como uma organização que valoriza e 

respeita as diversas culturas e idiomas de seus clientes. Além disso, a localização de serviços é um fator-

chave para o sucesso global de uma empresa, ajudando-a a estabelecer e manter relacionamentos 

sólidos em mercados internacionais. 

Nessa expansão de mercado de trabalho na área de localização e tradução, podemos dizer que a 

área de service desk ampliou ainda mais seu ramo de atuação, com especificações cada vez mais 

fragmentadas, exigindo profissionais mais capacitados em ramo de informática e linguística: o operador 

informático multilingue. Este precisa ter noção de informática, sem necessariamente ter conhecimento 

aprofundado sobre localização, mas se for um profissional de idiomas, torna o seu trabalho com mais 

qualidade. 
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2.4.3.3 Tradução automática e o atendimento multilingue de service desk 

 

No campo do operador informático multilingue, a utilização da tradução automática pode ser muito 

válida. Isso pode acontecer quando este se vê numa chamada telefónica e não sabe um termo técnico 

no idioma do atendimento, ou até mesmo quando está fazendo atendimento via chat e precisa escrever 

de uma maneira mais formal. 

A utilização da pesquisa do Google, das ferramentas de tradução automática e dos dicionários on-

line disponibilizados de maneira gratuita via web facilita esse processo de comunicação, caso o agente 

esteja utilizando o computador no momento do atendimento e tenha dúvidas sobre o idioma em que está 

atendendo. É absolutamente normal, ao lidar com mais de uma língua no ambiente de trabalho, 

confundir-se entre uma língua e outra. Por isso, deve-se estar muito atento e concentrado para não trocar 

as línguas no momento do atendimento. Logo, utilizar uma ferramenta de tradução automática durante 

o serviço pode orientar e ajudar o operador informático multilingue de service desk a manter-se focado 

naquilo que pretende falar. 

De acordo com Goffe (2005), a tradução automática é particularmente adequada para os 

requisitos de help desk, onde: 

i) a produção precisa ser inteligível, e não geralmente de qualidade “publicável”; 

ii) a área temática é geralmente bastante restrita (por exemplo, uma gama de produtos de software), 

e dicionários personalizados fornecidos com um software de tradução automática podem ser 

adaptados ao domínio específico; 

iii) o material existente pode ser reutilizado; bancos de dados preenchidos com documentos bilingues, 

software localizado, FAQs existentes, etc., que são utilizados pela memória de tradução; 

iv) da mesma forma, cada “nova” solução é potencialmente reutilizável; ela pode ser adicionada a um 

FAQ já existente, ou para uma base de conhecimento multilingue, permitindo que os usuários façam 

algumas consultas sem ligar para o help desk. 

 

Nesse sentido, a existência de uma base de conhecimento multilingue que possa ser alimentada 

regularmente com artigos e manuais traduzidos e localizados nos idiomas dos agentes é um recurso 

valioso para os operadores de service desk que atuam em um mercado global. Essa base de 

conhecimento em uma empresa pode fornecer aos operadores um acesso rápido e fácil às informações 

necessárias para resolver problemas técnicos, o que pode reduzir o tempo de resolução e melhorar a 

satisfação do cliente. 
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Além do atendimento técnico em outro idioma, a tradução é uma necessidade importante para 

empresas que operam em um mercado global. A tradução de documentos, websites e outros materiais 

é fundamental para comunicar-se com clientes e parceiros em todo o mundo. 

Em vista disso, neste tópico, podemos concluir que a globalização, a localização e a tradução 

automática são fatores que contribuem para o crescimento da demanda por operadores informáticos 

multilingues de service desk. Esses fatores exigem que as empresas forneçam suporte técnico e 

comunicação em diversos idiomas, o que torna os operadores multilingues essenciais para o sucesso 

dessas empresas internacionais. 
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 Da tradução automática ao atendimento multilingue de service 

desk 

Neste capítulo, analisaremos a atuação do operador informático durante o atendimento multilingue 

de service desk, ou seja, quando precisa utilizar ferramentas de tradução automática e se comunicar 

com os clientes em outros idiomas além de sua língua materna. Por isso, veremos também como 

funciona o atendimento multilingue de service desk com e sem tradução automática.  

Além disso, para analisar a parte prática, uma pesquisa quantitativa foi realizada com 50 agentes 

da empresa A8, num universo de cerca de 100 funcionários. O objetivo da pesquisa foi investigar como 

os agentes lidam com a tradução automática e os tutoriais da Microsoft no atendimento multilingue de 

service desk, já que estes são recursos úteis e encontram-se localizados em diversos idiomas e servem 

de suporte tanto para os atendentes quanto para os utilizadores. Com isso, analisaram-se a utilidade e 

a frequência do uso da tradução automática no atendimento multilingue de service desk, se há ou não 

pós-edição nos textos gerados pela tradução automática durante esse atendimento, assim como a 

utilidade e a frequência do uso dos tutoriais da Microsoft nesses serviços. 

Como vimos no capítulo II, o operador informático multilingue de service desk pode realizar 

atendimento na sua língua materna e até duas ou mais línguas estrangeiras. Além disso, ele registra, no 

sistema com a língua oficial da empresa, as interações dos incidentes e das requisições de serviço que 

os utilizadores fazem por meio de chamadas telefónicas, e-mails e chats. Esses registos podem ser 

chamados por muitas empresas de tickets, número de protocolo, chamada ou incidente. Vimos que o 

atendimento multilingue de service desk acontece quando o operador informático fala e escreve mais de 

uma língua no momento do atendimento, ou simplesmente intercala interações do sistema, chamadas 

telefónicas, e-mails, chats em mais de um idioma enquanto desempenha suas funções. 

Como brasileira de língua materna português do Brasil, enquanto atuava como operadora 

informática na empresa A, a autora desta dissertação utilizava a língua oficial inglês para a comunicação 

oficial interna da empresa e o registo das interações dos incidentes e das requisições de serviço no 

sistema. Durante a sua função, ela realizou atendimento de service desk aos utilizadores da empresa B 

(a empresa para a qual a empresa A prestava serviço) em inglês, para falantes do Reino Unido e outros 

países da África e do Oriente Médio; italiano, para falantes de Itália; e às vezes em português para falantes 

de Portugal e outros países da América Latina. Durante o atendimento via chamadas telefónicas, e-mails 

 
8 Conforme informado na Introdução e no segundo capítulo, por motivos de segurança de dados e informações, optou-se por chamar a 
empresa multinacional de tecnologia da informação de empresa A, e a empresa para a qual esta prestava serviço de empresa B, uma 
empresa multinacional especializada em produtos e serviços eletrónicos. 
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e chats para utilizadores da empresa B, ela usava com muita frequência ferramentas de tradução 

automática, como o Google Tradutor e DeepL, como ponte para tirar dúvidas de vocabulário e obter uma 

interação mais eficaz, clara e rápida. Além disso, ela também utilizou os tutoriais da Microsoft em 

português, inglês e italiano para suporte e resolução de problemas que os utilizadores da empresa B 

tinham em seus computadores ou em suas respetivas aplicações. 

Veremos, na subsecção seguinte, como acontece o processo de atendimento multilingue de 

service desk com e sem a tradução automática na prática. 

3.1 Processo de atendimento multilingue de service desk 

Para analisar a utilização da tradução automática no atendimento multilingue de service desk, é 

necessário descrever o processo, ou seja, o passo a passo de como esse atendimento funciona na 

prática. Antes de iniciar suas atividades na empresa A, a autora desta dissertação deveria logar no 

sistema dessa empresa. Dentro desse sistema, havia um servidor que a levava para logar numa máquina 

virtual da empresa para a qual ela prestava serviço (a empresa B). Dentro dessa máquina virtual, ela 

poderia logar em outros sistemas (cada um para uma aplicação diferente e com uma finalidade diferente) 

e ver os dados dos clientes, abrir ferramentas de chat e de acesso remoto aos computadores dos clientes. 

Sendo assim, fazia-se necessário a utilização de dois ecrãs para tornar possível esse tipo de trabalho: 

um onde se veria o sistema da empresa A, e outro onde se veriam todos os sistemas da empresa B.  

Além disso, no sistema da empresa A, havia uma aplicação específica para receber as chamadas 

telefónicas, que detectava os seguintes dados: de qual país era a chamada; em qual idioma o utilizador 

gostaria de falar; nome e sobrenome do utilizador; o código identificador desse utilizador na empresa 

onde trabalhava (a empresa B); telefone e e-mail do utilizador. Todos esses dados eram necessários para 

a criação do ticket da chamada, que deveria ser logado com esses dados e toda a descrição do incidente 

em inglês no sistema da empresa A durante a chamada. 

Os dados necessários e mais genéricos de um ticket criado eram: local do utilizador (país e cidade); 

sistema afetado; descrição do incidente; exata mensagem de erro (se houvesse); quando o incidente se 

iniciou; primeiro contato sobre o incidente (sim ou não); número de utilizadores afetados; qual impacto 

empresarial esse incidente ocasionava (individual ou coletivo); como o agente de service desk atuou para 

resolver o incidente; se o utilizador pode ser contactado em inglês (sim ou não); nome do dispositivo 

(computador ou celular); marca do dispositivo (computador ou celular); número de série do dispositivo 
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(computador ou celular); número de telefone de contato confirmado; e-mail confirmado; melhor horário 

de disponibilidade para contato.  

Os tickets relacionados a incidentes entendidos como prioridade alta (os que impactavam 

diretamente muitos utilizadores ao mesmo tempo, afetando produção, expedição, faturamento e áreas 

de atendimento aos clientes) eram preenchidos com mais detalhes, por exemplo: quantos utilizadores 

afetados, cidade, escritório, endereço, servidor. Além disso, nesse caso de chamada de prioridade alta, 

o agente de service desk deveria obrigatoriamente entrar em contato com uma equipa de nível mais 

experiente (de nível 2) e, se o computador do utilizador tivesse rede, deveria também realizar um acesso 

remoto no computador do utilizador para tentar coletar mais dados possíveis. Uma vez feito esse 

procedimento da forma correta e orientada pela equipa experiente, o agente deveria encaminhar o ticket 

para um setor responsável de nível superior, para que o incidente fosse resolvido o mais depressa 

possível. Isso acontecia, pois o nosso próprio cliente (da empresa B) também poderia lidar com sistemas 

para falar diretamente com os seus clientes e dar conta de suas demandas. 

Depois de criados, os tickets ficavam abertos até o dia em que o problema descrito ficasse 

resolvido. Os tickets criados a fim de resolver um problema em dispositivos, aplicações ou sistemas, aos 

quais o cliente já tinha acesso e os utilizava diariamente, eram chamados de incidentes. Caso o incidente 

do utilizador não se resolvesse durante a chamada, o ticket permaneceria aberto até que a resolução 

acontecesse posteriormente.  

Outro ponto muito importante era que, como as chamadas vinham de vários países diferentes, os 

agentes poderiam receber chamadas de tickets já existentes. Logo, o agente que criou o ticket, deveria 

descrever com clareza tanto a descrição do incidente quanto o que já tinha sido realizado como tentativa 

de sua resolução, para que a ação seguinte feita que, muito provavelmente seria feita por outro agente, 

fosse tomada baseando-se na anterior descrita no primeiro ticket. Esse outro agente deveria prestar a 

assistência e atualizar esse mesmo ticket para dar continuidade à resolução do incidente; caso o 

incidente também não fosse resolvido por esse outro agente, o ticket era apenas atualizado com as 

informações da assistência prestada e continuava em aberto. Por exemplo, uma tentativa de resolução 

do incidente num computador de um utilizador não deveria ser repetida, a menos que fosse realmente 

necessária, pois o utilizador, com certeza, iria informar que isso já tinha sido feito. Em caso de não 

conseguir encontrar nenhum manual ou nenhuma forma de resolver o incidente do utilizador, o agente 

de service desk poderia entrar em contato com equipas experts, que lhe davam assistência, tanto por 

meio de chat, durante as chamadas, quanto por e-mail, para os tickets que tinham incidentes mais 

complexos sob investigação. 
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Outro tipo de ticket que existia era relacionado a pedidos específicos, que chamamos de 

requisições de serviços, por exemplo: pedido de licenças de aplicações às quais o utilizador nunca teve 

acesso e só se tem acesso por meio de compra de licenças, pedido de novos dispositivos (computadores, 

telefones fixos, ou celulares empresariais). Nesses casos, o supervisor direto do utilizador, o setor 

financeiro e os diretores da empresa B deveriam aprovar esses tickets, e, só depois da aprovação deles, 

é que se dava prosseguimento a essas requisições. 

Sendo assim, podemos dizer que, além de ter muitas habilidades de comunicação oral para com 

o utilizador durante a chamada telefónica, o agente de service desk deve: ter agilidade, paciência e 

atenção para detectar o problema, fazendo as perguntas certas ao utilizador (principalmente para saber 

se o caso se tratava de um incidente já em andamento ou de um novo incidente, ou da abertura de uma 

nova requisição ou de uma requisição já em aberto); pesquisar no banco de dados da empresa A como 

resolver o problema; e criar o ticket no sistema da empresa A durante a chamada, se possível. Esses 

tickets eram migrados automaticamente para outro sistema da empresa B, onde os utilizadores poderiam 

acompanhá-los com detalhes por meio de um portal e se comunicar com os agentes dentro do próprio 

ticket. 

Com o tempo e a experiência, cada agente aprendia que a pesquisa na base de conhecimento da 

empresa A deveria ser feita por palavras-chave, para que assim possam-se encontrar os manuais e as 

orientações para a resolução de problemas técnicos. Além disso, a empresa A dispunha de muitos 

treinamentos, e agentes mais experientes sempre auxiliavam os agentes menos experientes a 

encontrarem as melhores formas de aprender a resolver os incidentes dos utilizadores. Para a busca de 

requisições da empresa B, havia um sistema onde podíamos pesquisar os seus formulários, e quando 

ficava muito confuso para o utilizador, fazíamos o acesso remoto ao computador deste para orientá-lo a 

preencher os formulários de novas requisições da maneira correta, evitando-se que os utilizadores 

criassem os tickets errados, ou novos sem necessidade, ou que tornasse o processo mais demorado. 

Todo ticket criado gerava um código identificador. Caso um utilizador ligasse com um incidente ou 

requisição já em aberto, o agente deveria lhe pedir esse código identificador no início das chamadas para 

a pesquisa no sistema de tickets e o acompanhamento destes. 

Durante o processo de instruir-se e examinar os detalhes e as técnicas de como responder proativa 

e eficazmente a essas demandas, a autora desta dissertação encontrou na aplicação OneNote uma base 

de auxílio, onde anotava todas as informações novas que aprendia, com abas separadas por aplicações 

e resoluções de problemas diferentes, o que tornou o seu processo de aprendizagem mais organizado e 

fácil de se assimilar. Além disso, no momento das chamadas, ela mantinha uma aba dessa aplicação 
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em aberto para anotar os dados dos utilizadores e a descrição dos incidentes e das requisições, para 

que não ficasse perdida, facilitando assim a criação e o acompanhamento dos tickets. 

Para a parte de atendimento inicial da chamada, era necessária uma saudação, que poderia ser 

feita nos idiomas do utilizador: 

 

Service Desk da empresa B, bom dia/boa tarde/boa noite. Meu nome é [xxx]9. Como posso 

ajudá-lo(a)? 

 

Para dar continuidade à resolução dos tickets em aberto, deveria-se fazer contato com o utilizador 

em três tentativas por três meios de comunicação: chat, telefone e e-mail. Cada tentativa envolvia esses 

três meios de contato e era chamada de strike. Sendo assim, caso o utilizador encontra-se indisponível, 

realizavam-se até três strikes. Se o utilizador não respondesse o agente de service desk por nenhum 

desses meios depois de 24h do terceiro strike, o ticket era fechado sem a resolução solicitada pelo 

cliente. Contudo, se o cliente visse algumas das tentativas de chamadas, chats ou e-mails e fizesse 

contato com o service desk em até cinco dias após o fechamento do ticket, este poderia ser reaberto 

para dar prosseguimento à sua resolução. No caso de o cliente não entrar em contato após os cinco dias 

desse fechamento, o sistema impossibilitava automaticamente o ticket de ser reaberto, ficando em um 

estado de total bloqueio e não atualização. Sendo assim, caso o cliente ligasse para a resolução de um 

ticket fechado há muito tempo com um problema não resolvido, um novo ticket deveria ser aberto, pois 

esse cliente perdeu todas as oportunidades de tentativas de resolução nos strikes, quando foi contatado 

pelos agentes de service desk, mas não estava disponível nem fez retorno de contato. 

As mensagens-modelo para o contato via chat eram mais ou menos assim traduzidas em diversos 

idiomas: 

 

Olá, [nome do cliente]. 

Sou Milena, do Service Desk da Empresa B. 

Entro em contato para confirmar se o problema [xxx]10 persiste. 

Peço que responda-me aqui neste chat, ou ao e-mail enviado por nós, ou ligue diretamente para 

a nossa central de atendimento, a fim de que seu problema seja resolvido. 

Agradecemos antecipadamente. 

 
9 Aqui nesta fala, onde há [xxx], o agente falava o seu próprio nome. 
10 Os itens entre colchetes [ ] e/ou especificados com [xxx] referem-se ao que se variava dentro do texto de acordo com cada incidente e 
cliente. 
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Com os melhores cumprimentos, 

Service Desk da Empresa B 

 

As mensagens-modelo para o contacto via e-mail do primeiro strike eram mais ou menos assim 

traduzidas em diversos idiomas: 

 

Caro/a Sr./Sra. [xxx], 

  

Por favor, verifique que tentamos contatá-lo via chat e número de telefone [xxx] sem sucesso. 

  

Em relação ao Incidente com a Referência [xxx] – [Nome do incidente] e de forma a podermos 

prosseguir com a resolução, necessitamos das seguintes informações:  

  

[Pergunta sobre o problema] 

  

Pedimos-lhe cordialmente que reveja as informações solicitadas, respondendo a este e-mail, 

contactando-nos através da opção de chat da aplicação xxx [aplicação instalada em seu 

computador para o acesso remoto do suporte técnico] ou de uma chamada ao número da nossa 

central de atendimento: [xxx]. 

  

Por favor, note que este incidente será agora suspenso por 24 horas úteis, pendente da sua 

resposta. 

  

Agradecemos antecipadamente. 

  

Com os melhores cumprimentos, 

Service Desk da Empresa B 

 

Desse modo, sempre após o primeiro strike, o agente aguardava completar 24 horas até o cliente 

entrar em contato. Caso esse contato não acontecesse, o operador realizava o segundo strike, e assim 

sucessivamente. Logo, os strikes eram identificados nos chats e nos e-mails, para que o cliente estivesse 

ciente de que o service desk estava tentando fazer contato e aguardava um retorno de sua parte (por 

exemplo, “esta é a primeira/segunda/terceira tentativa de contato”). 
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As mensagens-modelo para o contato via e-mail do segundo strike eram iguais à do primeiro, com 

exceção do final, traduzidas em diversos idiomas: 

 

Por favor, note que esta é a nossa segunda tentativa de contato relativamente a este assunto. 

Este Incidente será agora suspenso por 24 horas úteis, pendente da sua resposta. 

 

Agradecemos antecipadamente. 

  

Com os melhores cumprimentos, 

Service Desk da Empresa B 

 

Já as mensagens do terceiro strike tinha que conter um final informando sobre o fechamento do 

ticket sem a devida resolução do incidente: 

 

Note que esta é a nossa terceira e última tentativa de contacto sobre este assunto. 

 

Observe que, se não recebermos nenhuma resposta sua em 24 horas, seu ticket será definido 

com o status Resolvido. 

 

Após isto, caso nenhuma resposta seja recebida, o Incidente será encerrado automaticamente 

em 5 dias úteis. 

 

Agradecemos antecipadamente. 

 

Com os melhores cumprimentos, 

Service Desk da Empresa B 

 

Pode-se observar que o texto das mensagens-modelo enviadas tanto via chat quanto via e-mail é 

sempre com a linguagem formal. O cliente é sempre tratado com respeito e formalidade, mantendo 

assim uma linguagem educada e polida. 
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3.1.1 Sem a tradução automática 

De acordo com a explicação prática anterior do processo de atendimento multilingue de service 

desk, podemos montar um esquema desse processo sem a tradução automática.  

Com base em um incidente resolvido com o acesso remoto ao computador do utilizador durante 

a chamada, pode-se chegar ao seguinte passo a passo de atendimento, representado no Quadro 2: 

 
Quadro 2: Atendimento multilingue de service desk sem a tradução automática, por meio de acesso remoto 

Etapas de 
atendimento 

Passo a passo do atendimento 

Atendimento 
inicial 

1. O operador informático recebe uma chamada, e-mail ou chat do cliente. 
2. O operador faz perguntas ao cliente para identificar o problema. 

Operação 
informática 

3. O operador pesquisa, no sistema da empresa A, algum manual ou tutorial 
em inglês para resolver o problema. 

4. O operador encontra o manual em inglês no sistema para resolver o 
problema. 

5. O operador faz acesso remoto no computador do utilizador para resolução 
do problema. 

6. O operador segue o passo a passo do manual no computador do cliente. 
7. O operador resolve o problema do cliente. 

Atendimento final 

8. O operador cria o ticket e descreve nele o problema do cliente. 
9. O operador salva o ticket com o status de resolvido com a autorização do 

cliente. 
10. O operador faz a saudação final ao cliente e encerra a chamada. 

Fonte: Elaboração própria, 2022. 

 

Além disso, pode-se ter por base um incidente resolvido sem acesso remoto ao computador do 

utilizador durante a chamada. Esse caso poderia acontecer quando o problema do cliente era ter o 

computador sem acesso à internet, ou quando ele ligava com problemas no celular, sem a possibilidade 

de um acesso remoto. Vejamos o passo a passo de atendimento desse tipo de incidente no Quadro 3: 

 

Quadro 3: Atendimento multilingue de service desk sem a tradução automática e sem acesso remoto 

Etapas de 
atendimento 

Passo a passo do atendimento 

Atendimento 
inicial 

1. O operador informático recebe uma chamada, e-mail ou chat do cliente. 
2. O operador faz perguntas ao cliente para identificar o problema. 

Operação 
informática 

3. O operador pesquisa, no sistema da empresa A ou na internet, algum manual 
ou tutorial para resolver o problema. 

4. O operador encontra o manual em inglês ou tutorial na língua materna do 
utilizador para resolver o problema. 

5. O operador compartilha o manual com o cliente para ele segui-lo. 



49 

 

6. O operador guia o cliente com o manual até que ele consiga seguir o passo 
a passo e confirme que o problema foi resolvido. 

Atendimento final 

7. O operador cria o ticket e descreve nele o problema do cliente. 
8. O operador salva o ticket com o status de resolvido com a autorização do 

cliente. 
9. O operador faz a saudação final ao cliente e encerra a chamada. 

Fonte: Elaboração própria, 2022. 

3.1.2 Com a tradução automática 

De acordo com a explicação prática anterior do processo de atendimento multilingue de service 

desk, podemos montar também o esquema de processo com a tradução automática. 

Baseando-se em um incidente resolvido com o acesso remoto ao computador do cliente durante 

a chamada, pode-se chegar ao seguinte passo a passo de atendimento, representado no Quadro 4:  

 
Quadro 4: Atendimento multilingue de service desk com a tradução automática, por meio de acesso remoto 

Etapas de 
atendimento 

Passo a passo do atendimento 

Atendimento inicial 

1. O operador informático recebe uma chamada, e-mail ou chat do cliente. 
2. O operador utiliza uma ferramenta de tradução automática para conversar 

com o utilizador. 
3. O operador faz perguntas ao cliente para identificar o problema. 

Operação 
informática 

4. O operador faz acesso remoto no computador do utilizador para entender e 
resolver o problema. 

5. O operador pesquisa, no sistema da empresa A ou na internet, algum 
manual em inglês ou tutorial no idioma do utilizador para resolver o 
problema. 

6. O operador encontra o manual no sistema ou na internet em inglês ou em 
outro idioma para resolver o problema. 

7. O operador utiliza uma ferramenta de tradução automática para traduzir 
termos do inglês para a língua materna do utilizador. 

8. O operador segue o passo a passo do manual no computador do cliente. 
9. O operador resolve o problema do cliente. 

Atendimento final 

10. O operador utiliza uma ferramenta de tradução para descrever o problema 
no ticket da sua língua materna ou da língua do utilizador para o inglês. 

11. O operador cria o ticket e descreve nele o problema do cliente em inglês. 
12. O operador salva o ticket com o status de resolvido com a autorização do 

cliente. 
13. O operador faz a saudação final na língua materna do cliente e encerra a 

chamada. 
Fonte: Elaboração própria, 2022. 

 

Além disso, pode-se ter um incidente resolvido sem acesso remoto durante a chamada. Esse caso 

poderia acontecer quando o problema do cliente era ter o computador sem acesso à internet, ou quando 
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ele ligava com problemas no telemóvel, sem a possibilidade de um acesso remoto. Logo, pode-se chegar 

ao seguinte passo a passo de atendimento, representado no Quadro 5: 

 

Quadro 5: Atendimento multilingue de service desk com a tradução automática, sem acesso remoto 

Etapas de 
atendimento 

Passo a passo do atendimento 

Atendimento inicial 

1. O operador informático recebe uma chamada, e-mail ou chat do cliente. 
2. O operador utiliza uma ferramenta de tradução automática para conversar 

com o utilizador. 
3. O operador faz perguntas ao cliente para identificar o problema. 

Operação 
informática 

4. O operador pesquisa na internet algum tutorial na língua materna do 
utilizador para resolver o problema. 

5. O operador encontra o manual ou tutorial na língua materna do utilizador 
para resolver o problema. 

6. O operador compartilha via chat ou e-mail o manual com o cliente para ele 
segui-lo. 

7. O operador guia o cliente com o manual até que ele consiga seguir o passo 
a passo e confirme que o problema foi resolvido. 

Atendimento final 

8. O operador cria o ticket e descreve nele o problema do cliente. 
9. O operador salva o ticket com o status de resolvido com a autorização do 

cliente. 
10. O operador faz a saudação final ao cliente e encerra a chamada. 

Fonte: Elaboração própria, 2022. 

 

Sendo assim, a utilização da ferramenta de tradução automática pode alongar o passo a passodo 

atendimento multilingue, mas isso pode variar de acordo com a agilidade de cada operador. A autora 

desta dissertação utilizava sempre as ferramentas de tradução Google Tradutor e DeepL, mantendo 

separadores no navegador abertos com essas ferramentas sempre disponíveis. Essa estratégia facilitava 

a comunicação com os utilizadores, pois algumas ações do atendimento multilingue e da operação 

informática podem ser realizadas simultaneamente. Por exemplo, o agente pode pesquisar e ler a 

tradução dos problemas em um ecrã enquanto realiza o acesso remoto ao computador do utilizador em 

outro ecrã. 

Portanto, com a prática, a utilização das ferramentas de tradução automática de forma simultânea 

com os outros sistemas de atendimento de service desk pode se tornar mais dinâmica e eficaz, e o 

atendimento do operador cada vez mais ágil. 
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3.2 Tradução automática e pós-edição no atendimento multilingue de service 

desk 

Conforme abordado no capítulo II, as ferramentas de tradução automática são sistemas 

computacionais que traduzem o texto de um idioma para o outro de forma totalmente mecânica. Por 

isso, nem sempre elas serão capazes de produzir traduções precisas, pois podem não levar em conta 

aspetos como a gramática, o contexto e as particularidades do idioma, como formalidade, o que somente 

um humano pode realizar. As ferramentas de tradução podem usar: sistemas automáticos estatísticos, 

que baseiam-se em grandes corpora de texto traduzido para aprender as correspondências entre palavras 

e expressões em diferentes idiomas; ou sistemas por redes neurais, que são treinadas em grandes 

quantidades de dados de texto e código para aprender a gerar traduções mais precisas e naturais. 

Durante o atendimento multilingue de service desk, em caso de uso da ferramenta de tradução 

automática para auxílio na interação escrita via e-mail ou chat, momento em que a linguagem precisa 

ser mais formal com o cliente, o operador informático multilingue pode identificar erros no texto traduzido 

e realizar a pós-edição no texto quando encontrar problemas gramaticais, de contexto ou até mesmo de 

vocabulário. Ou seja, caso o operador informático tenha tempo hábil suficiente durante o atendimento, 

ele fará correções que sejam apropriadas para a comunicação com o utilizador, prezando assim por uma 

qualidade melhor do texto e passando credibilidade em seu atendimento. 

Como já foi mencionado anteriormente, a autora desta dissertação utilizava com bastante 

frequência o Google Tradutor como suporte de tradução automática. Sendo assim, serão mostrados a 

seguir exemplos da utilização dessa ferramenta de tradução automática com pós-edição no atendimento 

multilingue de service desk. 

Como o sistema da empresa A era totalmente em inglês, havia algumas mensagens padronizadas 

que não estavam traduzidas em todos os contextos para outros idiomas, sendo o operador informático 

responsável por fazer a tradução e as edições necessárias para que a descrição do incidente fosse feita 

de maneira correta no idioma nativo do utilizador. 

Para tornar esta parte mais prática e realista, analisaremos como um operador informático utiliza 

alguma ferramenta de tradução automática e ainda realiza edições. Para isso, tomaremos como base 

alguns exemplos de e-mails padronizados com mensagens para strike 1 nos seguintes pares de tradução 

pelo Google Tradutor: de inglês para italiano e de inglês para português europeu. 

Neste primeiro momento, faremos a análise da tradução feita pelo Google Tradutor de um e-mail 

do inglês para o italiano. 

 



52 

 

Figura 2: Exemplo de tradução pelo Google Tradutor de um e-mail do inglês para o italiano 

 
Fonte: Google Tradutor, 2022. 

 

Com essa tradução automática, podemos ver que o Google Tradutor utilizou de linguagem informal 

tanto nas construções verbais quanto nas pronominais no italiano, ou seja, manteve todas as 

concordâncias com o pronome tu, pronome informal, que se difere do Lei, pronome formal no italiano 

que era utilizado para a comunicação escrita nos e-mails de strikes aos utilizadores. 

Sendo assim, o operador informático que se utilizava dessa tradução automática precisava realizar 

a pós-edição, alterando todas as ocorrências pronominais e verbais de tu para Lei. Além disso, 

dependendo do gênero do remetente, deveria-se trocar Caro (masculino) por Cara (feminino). Em caso 

de não gerar equívoco ou transtornos com o utilizador, preferia-se usar Gentile (uma expressão comum 

dos dois gêneros) no lugar de Caro ou Cara. 

No Quadro 6, veremos, sinalizadas de amarelo, quais as partes dessa mensagem traduzida do 

inglês para o italiano precisam de correções e as partes da pós-edição: 
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Quadro 6: E-mail traduzido pelo Google Tradutor de inglês para o italiano e pós-edição em italiano 

Texto traduzido do inglês para o italiano 

pelo Google Tradutor11 
Texto de pós-edição12 

Caro [xxx], 

 

Tieni presente che abbiamo provato a contattarti 

tramite Microsoft Teams e il numero di telefono 

[xxx] senza successo. 

 

Per quanto riguarda il riferimento all'incidente 

[xxx], dobbiamo sapere quando sei disponibile in 

modo da poter accedere al tuo PC e fornire una 

nuova risoluzione dei problemi. 

 

Ti chiediamo gentilmente di comunicarci un 

numero e un orario migliori per chiamarti, 

rispondendo a questa e-mail, utilizzando la nostra 

chat o chiamando il nostro numero di telefono 

[xxx]. 

 

Tieni presente che l'incidente sarà sospeso per 24 

ore lavorative in attesa del tuo feedback. 

 

Grazie in anticipo. 

 

Distinti saluti, 

Servizio reception 

Gentile [xxx], 

 

Tenga presente che abbiamo provato a 

contattarla tramite Microsoft Teams e il numero 

di telefono [xxx] ma senza successo. 

 

Per quanto riguarda il ticket di riferimento 

all'incidente [xxx], vorremmo sapere quando è 

disponibile in modo da poter accedere al suo PC e 

fornire una nuova risoluzione del problema. 

 

Le chiediamo gentilmente di comunicarci un 

numero e un orario migliori per chiamarla, 

rispondendo a questa e-mail, utilizzando la nostra 

chat o chiamando il nostro numero di telefono 

[xxx]. 

 

Tenga presente che l'incidente sarà ora sospeso 

per 24 ore lavorative in attesa della sua risposta. 

 

Grazie in anticipo. 

 

Distinti saluti, 

Service Desk 

Fonte: Elaboração própria, 2022. 

 

Como pode-se ver, a tradução automática do Google Tradutor manteve toda a estrutura textual 

coerente, havendo apenas necessidade de alterar as construções verbais e pronominais no italiano e 

alguns elementos conectivos, que analisaremos agora: 

i) no vocativo, troca de Caro por Gentile para evitar problemas com gêneros; 

ii) no primeiro parágrafo, a troca de Tieni por Tenga e ti por la para se dirigir ao pronome formal Lei, 

e a inclusão de ma como conectivo para trazer mais coesão ao texto;  

 
11 Fonte: Google Tradutor, 2022. 
12 Fonte: Pós-edição feita pela autora, 2022. 
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iii) no segundo parágrafo, houve: a inclusão de il ticket, para contextualizar melhor a respeito do ticket; 

a troca de dobbiamo do verbo dovere (dever) no modo presente indicativo por vorremmo do verbo 

volere (querer) no modo condizionale (condicional), para trazer uma forma verbal mais polida; a 

mudança de sei por è e de tuo por suo para se referir ao pronome formal Lei, e a troca de dei 

problemi por del problema para mudar a forma de plural para singular, para se referir ao problema 

do ticket; 

iv) no terceiro parágrafo, a troca de Ti por Le e de ti por la para se referir ao pronome formal Lei; 

v) no quarto parágrafo, a troca de Tieni por Tenga para se dirigir ao pronome formal Lei e de del tuo 

feedback por della sua risposta, evitando o estrangeirismo; 

vi) na saudação final e assinatura, troca-se Servizio reception pela expressão Service desk, pois era 

como os utilizadores conheciam o setor que lhes prestava atendimento. 

Agora, faremos a análise da tradução de um e-mail traduzido do inglês para o português a partir 

da Figura 3 e do Quadro 7: 

 

Figura 3: Exemplo de tradução pelo Google Tradutor de um e-mail do inglês para o português 

 

Fonte: Google Tradutor, 2022. 

 

Veremos, no Quadro 7, sinalizadas de amarelo quais partes desta mensagem traduzida do inglês 

para o português precisam de correções e as partes da pós-edição: 
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Quadro 7: E-mail traduzido pelo Google Tradutor de inglês para o português e pós-edição em português 

Texto traduzido do inglês para o português pelo 

Google Tradutor13 
Texto de pós-edição14 

Caro [xxx], 

  

Observe que tentamos entrar em contato com 

você via Microsoft Teams e número de telefone 

[xxx] sem sucesso. 

  

Em relação à referência do Incidente [xxx], 

precisamos saber quando você está disponível 

para que possamos acessar seu PC e fornecer 

novas soluções de problemas. 

 

Pedimos a gentileza de nos informar um número 

e horário melhores para ligar para você, 

respondendo a este e-mail, usando nosso 

aplicativo de chat, ou ligando para o nosso 

telefone [xxx]. 

 

Observe que o incidente agora será suspenso por 

24 horas úteis, dependendo do seu feedback. 

 

Agradeço antecipadamente. 

 

Com os melhores votos, 

Balcão de atendimento 

Caro Sr. / Cara Sra. [xxx], 

  

Observe que tentamos entrar em contacto com 

você via Microsoft Teams e número de telefone 

[xxx] sem sucesso. 

  

Em relação ao ticket do Incidente com a 

Referência [xxx], precisamos saber quando você 

está disponível para que possamos acessar seu PC 

e fornecer uma nova resolução para o problema. 

 

Pedimos a gentileza de nos informar um número 

de telefone e horário melhores para ligar para 

você, respondendo a este e-mail, usando nosso 

aplicativo de chat, ou ligando para o nosso 

telefone [xxx]. 

 

Por favor, note que este incidente estará agora 

suspenso por 24 horas úteis, pendente da sua 

resposta. 

 

Agradecemos antecipadamente. 

 

Com os melhores cumprimentos, 

Service Desk 

Fonte: Elaboração própria, 2022. 

 

Como pode-se ver, a tradução automática gerada pelo Google Tradutor manteve toda a estrutura 

textual coerente, sendo necessárias apenas algumas correções para esclarecer o contexto à mensagem 

do e-mail em relação ao problema do ticket, à pessoalidade e formalidade necessária. Essas correções 

foram: 

i) o vocativo precisou ser adaptado ao gênero do nome do utilizador, com “Caro Sr.” ou “Cara Sra.”; 

 
13 Fonte: Google Tradutor, 2022. 
14 Fonte: Pós-edição feita pela autora, 2022. 
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ii) no primeiro parágrafo, a palavra “contato” (português do Brasil) precisou ser alterada para 

“contacto” (português europeu), mudança necessária para efeitos de localização; 

iii) no segundo parágrafo, houve mudança de “à referência do Incidente” por “ao ticket do Incidente 

com a Referência” para trazer mais clareza ao contexto do ticket; e a troca de “novas soluções de 

problemas” por “uma nova resolução para o problema”, pois geralmente criava-se um ticket para 

cada problema; 

iv) no terceiro parágrafo, após “número”, houve a inclusão de “de telefone” para contextualizar melhor 

sobre a tentativa de contato e em caso de o número de telefone do utilizador estiver errado; 

v) no quarto parágrafo, houve a mudança de “dependendo do seu feedback” por “pendente da sua 

resposta”, evitando assim o estrangeirismo; 

vi) na saudação final, trocou-se “Agradeço” por “Agradecemos”, por se refererir ao setor inteiro e não 

a apenas uma pessoa; “votos” por “cumprimentos”, pois “Com os melhores cumprimentos” é uma 

frase de cordialidade conhecida em Portugal; e “Balcão de atendimento” por “Service Desk”, pois 

era como os utilizadores conheciam o setor que lhes prestava atendimento. 

Para além disso, vale ressaltar que alguns utilizadores mantinham vários tickets abertos acerca 

de problemas diferentes, logo, dependendo da situação, poderíamos especificar o nome do problema ao 

lado da referência do ticket, ou ao lado da frase “e fornecer uma nova resolução para o problema”, a fim 

de tornar o e-mail o mais específico possível e evitando de o utilizador ignorar o e-mail ou não saber do 

que se tratava. 

 

3.3 Pesquisa quantitativa sobre a tradução automática no atendimento 

multilingue de service desk 

Durante a elaboração desta dissertação, a autora ainda estava trabalhando como agente de service 

desk na empresa A, o que a possibilitou que fizesse uma pesquisa quantitativa com seus colegas de 

trabalho. Num universo de cerca de 100 agentes de service desk, 50 colegas responderam ao 

questionário (Anexos I, II e III), dando uma noção de análise bem geral e específica em alguns casos de 

como o uso da tradução automática contibuía no atendimento multilingue de service desk. 

Sendo assim, será feita aqui a análise das perguntas do questionário no que diz respeito à tradução 

automática e o atendimento multilingue de service desk, com seus respetivos gráficos e suas 

porcentagens referente às respostas dadas pelos participantes.  
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A primeira pergunta do questionário, “Qual é a sua faixa etária?”, está representada no Gráfico 1: 

 
Gráfico 1: Faixa etária 

 
Fonte: Google Forms, 2021. 

 

Para a pergunta 1, os resultados mostram que 40% (20 agentes) estavam entre os 26 e 32 anos, 

28% (14 agentes) tinham entre 33 e 40 anos, 18% (9 agentes) contemplavam a faixa etária de 41 a 50 

anos, e 14% (7 agentes) tinham entre 18 e 25 anos. Os dados dessa pergunta apontaram que não havia 

ninguém com menos de 18 anos de idade, nem acima de 50 anos. Sendo assim, do grupo de agentes 

que respondeu o questionário, a maioria faz parte de um público jovem adulto. 

A segunda pergunta do questionário, “Qual é o seu nível de escolaridade?”, está representada no 

Gráfico 2: 

 

Gráfico 2: Nível de escolaridade 

 
Fonte: Google Forms, 2021. 
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Para a pergunta 2 do questionário, pode-se destacar que 26% (13 agentes) estão com a Graduação 

concluída; 24% (12 agentes) estão com a Pós-graduação ou o Mestrado concluídos; 22% (11 agentes) 

possuem o Ensino Médio completo; 14% (7 agentes) o Ensino Superior incompleto, ou com a Graduação 

em andamento; 10% (5 agentes) estão com a Pós-graduação ou Mestrado em andamento; e 4% (2 

agentes) possuem o Doutoramento incompleto ou em andamento. Logo, o grupo constitui-se de pessoas 

com estudo no mínimo até o Ensino Médio. Isso facilita e possibilita o desenvolvimento da função de 

agente de service desk, já que inclui atividades de muita leitura e conhecimento de informática que varia 

de básico a avançado.  

A terceira pergunta do questionário foi “Qual é a sua língua materna?”, demostrada no Gráfico 3: 

 

Gráfico 3: Língua materna 

 
Fonte: Google Forms, 2021. 

 

De acordo com essa pergunta, 46% (23 agentes) possuem como língua materna o português de 

Portugal, 28% (14 agentes) o português do Brasil, 4% (2 agentes) o espanhol, 4% (2 agentes) o italiano, 

4% (2 agentes) o francês, 4% (2 agentes) a língua polaca, 2% (1 agente) o holandês, 2% (1 agente) o 

turco, 2% (1 agente) a língua sérvia, 2% (1 agente) a língua húngara, e 2% (1 agente) o russo. Nenhum 

dos participantes tem como inglês (americano ou britânico) a língua materna. Esses dados apontam 

como a equipa de service desk era bem diversificada quanto a nacionalidades, justificando a utilização 

do inglês como língua oficial da empresa A para comunicação por e-mail, de reuniões, treinamentos, 

manuais, entre outros. Além disso, constata-se que a empresa A conseguia disponibilizar atendimento 



59 

 

em muitos idiomas por possuir funcionários como agentes de service desk provenientes de vários países 

dando assistência em suas respetivas línguas maternas. 

A quarta pergunta do questionário foi “Quantas línguas estrangeiras fala (além de sua língua 

materna)?”, representada no Gráfico 4: 

 

Gráfico 4: Línguas estrangeiras 

 
Fonte: Google Forms, 2021. 

 

Segundo os resultados dessa questão, pode-se ver que 48% dos agentes falam duas línguas 

estrangeiras, 26% falam três línguas estrangeiras, 16% falam apenas uma língua estrangeira, e 10% falam 

quatro ou mais línguas além de sua língua materna. Esses dados também corroboram o fato de a 

empresa A disponibilizar atendimento em muitos idiomas, pois, além de os seus agentes de service desk 

darem assistência em suas respetivas línguas maternas, eles também poderiam prestar o mesmo serviço 

para empresas em países que falassem as línguas estrangeiras que esses funcionários falam. 

A quinta pergunta do questionário está representada no Gráfico 5: 

 
Gráfico 5: Utilização de ferramenta de tradução automática no atendimento de service desk 

 
Fonte: Google Forms, 2021. 
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Para a pergunta 5, “No atendimento de service desk (por chamada telefónica, e-mail ou chat) 

utiliza alguma ferramenta de tradução automática?”, 40% dos agentes responderam “Sim, utilizo com 

pouca frequência, só em casos de dúvidas”, 28% afirmaram que “Sim, utilizo às vezes”, 24% 

responderam “Sim, utilizo com muita frequência”, e 8% confirmou que “Não utilizo ferramenta de 

tradução automática no atendimento de service desk”. Desses dados, constata-se que 92% (46 agentes) 

utilizam alguma ferramenta de tradução automática em determinado momento do atendimento 

multilingue de service desk. Esse fato corrobora a ideia de que a ferramenta de tradução automática tem 

auxiliado os agentes de service desk no momento do atendimento multilingue.  

A sexta pergunta do questionário foi “Se respondeu ‘Sim’ à pergunta 5, em quais casos utiliza 

mais as ferramentas de tradução automática durante o atendimento de service desk?” e está 

representada no Gráfico 6: 

 

Gráfico 6: Casos de utilização das ferramentas de tradução no atendimento de service desk 

 

Fonte: Google Forms, 2021. 

 

A partir dessa pergunta, os agentes pontuaram um maior uso das ferramentas de tradução no 

atendimento via e-mail, com 58%, seguido do atendimento via chat, com 42%, e do atendimento via 

chamadas telefónicas, com 22%. Quatro pessoas (8%) afirmaram que não utilizam ferramenta de 

tradução automática no atendimento de service desk. 

A sétima pergunta do questionário, “Se respondeu ‘Sim’ à pergunta 5, qual ferramenta de tradução 

automática utiliza?”, está demonstrada no Gráfico 7: 
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Gráfico 7: Utilização de quais ferramentas de tradução automática no atendimento de service desk 

 
Fonte: Google Forms, 2021. 

 

Na sétima questão, 42 agentes (84%) responderam que usam o Google Tradutor, cinco deles (10%) 

utilizam o DeepL, dois (4%) usam o Microsoft Bing, um agente (2%) usa o My Memory, um agente (2%) 

utiliza Thesaurus para sinónimos, e um (2%) usa Reverso. Acredita-se que o uso majoritário do Google 

Tradutor se dá pela popularidade que essa ferramenta acaba tendo em relação às outras. 

A oitava pergunta do questionário, “Considera que a utilização de ferramentas de tradução 

automática seja útil durante o atendimento de service desk (por chamada telefónica, e-mail ou chat)?”, 

está demonstrada no Gráfico 8: 

 
Gráfico 8: Utilidade das ferramentas de tradução automática no atendimento de service desk 

 

Fonte: Google Forms, 2021. 

 

Com relação a essa questão, 48% dos agentes consideraram que as ferramentas de tradução 

automática são muito úteis durante o atendimento, 42% consideraram que as ferramentas são úteis, e 
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10% afirmaram que são pouco útil. Nenhum agente considerou que as ferramentas de tradução 

automática não sejam úteis no atendimento de service desk. 

A nona pergunta do questionário foi “Realiza alguma correção dos textos traduzidos pelas 

ferramentas de tradução automática em caso de encontrar erros gramaticais ou de formalidade?” e está 

demonstrada no Gráfico 9: 

 

Gráfico 9: Realização de correção dos textos traduzidos pelas ferramentas de tradução automática 

 

Fonte: Google Forms, 2021. 

 

A partir da pergunta 9, percebemos que 62% dos agentes responderam que sempre fazem 

correções nos textos traduzidos pelas ferramentas de tradução automática, pois preocupam-se com a 

formalidade do texto em atendimento por chamada telefónica, e-mail ou chat; 26% fazem correções às 

vezes, quando têm tempo; 4% não fazem correções, pois não se preocupam com a formalidade do texto; 

4% não fazem correções, pois têm pouco conhecimento de gramática; 2% não fazem correções, pois não 

usam ferramentas de tradução automática.  

Portanto, essas porcentagens apontam que a tradução automática, durante o atendimento 

multilingue, geralmente carece de pós-edição para correção e adequação à formalidade dos textos. Esses 

dados corroboram a premissa da autora desta dissertação, que, na maioria das vezes, também realizava 

pós-edição para correção nos textos gerados pelas ferramentas de tradução automática que utilizava 

durante o atendimento multingue de service desk: Google Tradutor e DeepL. 
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 Tutoriais da Microsoft 

Este capítulo tem como objetivo investigar a relação entre os tutoriais da Microsoft e o atendimento 

multilingue de service desk. Para isso, foram realizadas duas análises: uma análise quantitativa e uma 

análise qualitativa.  

A análise quantitativa foi realizada por meio de um questionário (Anexos I, II e III) com operadores 

de service desk sobre a utilização e a eficácia dos tutoriais da Microsoft.  

A análise qualitativa foi realizada por meio da extração de dados linguísitcos de corpora paralelos 

de alguns tutoriais da Microsoft. Os corpora paralelos foram compostos por versões dos tutoriais em 

português de Portugal (Anexo IV), português do Brasil (Anexo V) e Inglês (Anexo VI). A análise dos corpora 

paralelos visou a identificar semelhanças e diferenças entre essas versões. 

As análises desenvolvidas neste capítulo são relevantes por alguns motivos. Em primeiro lugar, 

elas contribuem para o entendimento da relação entre os tutoriais da Microsoft e o atendimento 

multilingue de service desk. Em segundo lugar, fornecem dados sobre a utilidade e a eficácia dos tutoriais 

da Microsoft em diferentes idiomas nesse atendimento entre os operadores informáticos. Em terceiro 

lugar, podem contribuir para o desenvolvimento de novas ferramentas e metodologias de tradução e 

localização para textos técnicos para o atendimento multilingue de service desk. 

Vejamos, na próxima subsecção, a descrição da parte prática de como um operador informático 

multilingue utiliza os tutoriais da Microsoft na empresa A tratando de problemas técnicos dos utilizadores 

na empresa B.  

4.1 Relação dos tutoriais da Microsoft com o atendimento multilingue de 

service desk 

A parte prática da relação entre os tutoriais da Microsoft e o atendimento multilingue de service 

desk envolve a utilização desses materiais por operadores do ramo informático para resolver problemas 

técnicos de usuários de tecnologia da informação de diferentes países e culturas. 

A utilização de tutoriais da Microsoft por operadores de service desk é uma prática comum em 

empresas de diferentes portes e setores. Esses materiais são disponibilizados gratuitamente pela 

Microsoft e fornecem informações detalhadas sobre o uso de seus produtos e serviços. 

Os tutoriais da Microsoft são utilizados por operadores de service desk para uma variedade de 

finalidades, incluindo: 
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i) aprendizado de novos produtos e serviços da Microsoft, por serem ótima fonte de informações para 

operadores de service desk que desejam aprender a usar novos produtos e serviços; 

ii) resolução de problemas técnicos, pois podem ser utilizados para resolver incidentes comuns 

enfrentados por usuários de tecnologia da informação; 

iii) fornecimento de suporte técnico aos usuários, podendo ser utilizados por operadores de service 

desk para fornecer suporte técnico aos utilizadores de tecnologia da informação. 

Por isso, veremos como os operadores informáticos da empresa A lidavam com os problemas 

técnicos das aplicações da Microsoft prestando atendimento de suporte aos utilizadores da empresa B. 

Como vimos no capítulo anterior, para ocorrer o atendimento de service desk, o operador 

informático multilingue da empresa A pode receber uma chamada de incidente e/ou requisição de 

serviços por telefonema, e-mail ou chat.  

Nesse contato com o cliente, primeiramente, o operador faz perguntas para identificar de qual 

problema se trata e em qual aplicação. Quando identifica que o incidente seja a respeito de uma 

aplicação da Microsoft, pode pesquisar no sistema da empresa A, no Google ou no site da Microsoft com 

palavras-chave do incidente e da aplicação em questão para encontrar o artigo correto relacionado ao 

problema se não dominar muito bem a forma como solucioná-lo.  

Caso o incidente fosse em uma aplicação do pacote Microsoft Office que estava instalada no 

computador do utilizador, o agente fazia o acesso remoto em seu PC, seguindo a orientação do tutorial 

encontrado no site da Microsoft para a resolução do problema. Se o incidente fosse muito complexo e o 

problema não poderia ser resolvido diretamente pelo agente durante a chamada telefónica, uma equipa 

interna mais experiente (de nível 2), que tratava apenas de problemas das aplicações da Microsoft, era 

acionada. Isso acontecia porque, em alguns casos, o incidente era causado por um erro muito específico 

e, dependendo do nível de dificuldade da resolução, havia a necessidade de reinstalar determinada 

aplicação.  

Em algumas situações, essa equipa orientava o agente, que conseguia resolver o incidente e o 

ticket. Em outras, durante a chamada, o ticket era direcionado à equipa de nível 2, e logo depois a 

chamada era transferida a um agente dessa equipa para a instalação de determinada aplicação ou para 

a resolução de um incidente mais complexo. Quando o incidente ainda assim não conseguia ser 

resolvido, o ticket era encaminhado a essa equipa de nível 2, que passava a fazer o contato direto com 

o cliente até que o problema fosse resolvido e o ticket fechado. 

Caso o incidente fosse em uma aplicação do pacote Microsoft Office que estava instalada no 

telemóvel do utilizador, o operador orientava esse cliente seguindo o passo a passo do tutorial encontrado 
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no site da Microsoft para a resolução do problema. Se o utilizador tivesse dificuldade de resolver o 

problema na aplicação do seu telemóveldurante a chamada telefónica com o agente, este enviava-lhe o 

link do tutorial por chat. Após 24 horas, o agente deveria contatar esse utilizador para saber se este 

conseguiu concluir as ações do tutorial e resolver o problema. Caso contrário, o operador ficava 

responsável pelo ticket até que o utilizador seguisse o tutorial da Microsoft a fim de resolver o problema 

em seu telemóvel. Caso o incidente não fosse resolvido dessa forma, o ticket era encaminhado 

diretamente a uma equipa de nível 2. 

Para avaliar a utilidade dos tutoriais da Microsoft no momento do atendimento multilingue de 

service desk, foi realizada uma pesquisa quantitativa, num total de 100 funcionários da empresa A, com 

50 operadores informáticos. Os resultados dessa pesquisa serão apresentados na subsecção a seguir.  

4.2 Pesquisa quantitativa sobre a utilidade dos tutoriais da Microsoft no 

atendimento multilingue de service desk 

Durante a elaboração desta dissertação, a autora ainda estava trabalhando como agente de service 

desk na empresa A, o que a possibilitou que fizesse uma pesquisa quantitativa com seus colegas de 

trabalho. Como explicado anteriormente, num universo de cerca de 100 agentes de service desk, 50 

colegas responderam ao questionário (Anexos I, II e III), dando uma noção de análise bem geral e 

específica em alguns casos de como o uso dos textos de suporte da Microsoft contibuía no atendimento 

multilingue de service desk. 

Nesse sentido, nesta subsecção, será feita a análise das perguntas finais do questionário, de 10 

a 13, no que se refere à utilização dos textos da Microsoft e o atendimento multilingue de service desk, 

com seus respetivos gráficos e suas porcentagens referentes às respostas dadas pelos participantes. 

A décima pergunta do questionário, “Utiliza os textos de suporte do site da Microsoft para prestar 

suporte aos utilizadores?”, está demonstrada no Gráfico 10: 
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Gráfico 10: Utilização dos textos de suporte da Microsoft no atendimento de service desk 

 
Fonte: Google Forms, 2021. 

 

Com relação à pergunta 10, 18% (9 agentes) responderam que utilizam os textos de suporte do 

site da Microsoft às vezes, 16% (8 agentes) utilizam com pouca frequência, só em casos de dúvidas, 12% 

(6 agentes) utilizam com muita frequência. Esses agentes que responderam positivamente ao uso dos 

artigos de suporte da Microsoft totalizam 46% (23 agentes) do total dos operadores informáticos que 

responderam ao questionário. Em contrapartida, 54% (27 agentes) negaram utilizar tais textos como 

auxílio no atendimento multilingue.  

Esses dados revelam uma porcentagem inferior à metade dos agentes que responderam ao 

questionário com relação ao uso dos tutoriais da Microsoft, o que levou a autora desta dissertação a 

formular algumas hipóteses. A primeira hipótese para a maioria dos agentes não utilizarem os textos da 

Microsoft é a existência de textos semelhantes na base de conhecimento no sistema da empresa A, que 

já contemplam, de maneira abrangente, resoluções para incidentes comuns e recorrentes nas aplicações 

da Microsoft. Outra hipótese seria a existência de uma equipa mais experiente (nível 2) na empresa A 

para tirar dúvidas sobre as aplicações da Microsoft e para a qual os agentes poderiam direcionar tickets 

com incidentes mais graves. 

A pergunta 11 do questionário foi “Se respondeu “Sim” à pergunta 10, considera os textos de 

suporte do site da Microsoft úteis durante o atendimento de service desk?” e está representada no  

Gráfico 11: 
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Gráfico 11: Utilidade dos textos de suporte do site da Microsoft durante o atendimento de service desk 

 
Fonte: Google Forms, 2021. 

 

A partir dessa pergunta, 26% (13 agentes) responderam que consideram os textos de suporte do 

site da Microsoft úteis, 24% (12 agentes) consideram muito úteis, 4% (2 agentes) acreditam ser pouco 

úteis, totalizando uma resposta positiva quanto à utilidade desses tutoriais em 54% dos agentes. Por 

outro lado, 8% (4 agentes) responderam que não consideram tais textos úteis. Além disso, 38% (19 

agentes) disseram que não utilizam os textos de suporte da Microsoft.  

Essa diferença de resposta da pergunta 10 para a 11 com relação à quantidade dos agentes que 

não utilizam os textos de suporte da Microsoft pode ter ocorrido pelo fato de alguns operadores 

considerarem que os textos sejam úteis, mesmo que não os utilizassem. Outra hipótese também poderia 

ser que, pelo fato de o questionário ter sido em língua portuguesa, que não era a língua materna de 

alguns dos agentes participantes, estes podem não ter entendido corretamente que a pergunta 11 foi 

apenas para as pessoas que responderam “sim” na 10. Logo, quem respondeu “Não utilizo os textos de 

suporte da Microsoft” na pergunta 10 também deveria ter respondido com a mesma opção na pergunta 

11, mas nem todos assim o fizeram.  

A pergunta 12 do questionário, “Se utiliza os textos da Microsoft como suporte no atendimento de 

service desk, em qual idioma costuma realizar a pesquisa primeiro?”, está representada no Gráfico 12: 

 



68 

 

Gráfico 12: Idioma utilizado nos textos de suporte da Microsoft no atendimento de service desk 

 

Fonte: Google Forms, 2021. 

 

Com relação a essa pergunta 12, 28% (14 agentes) afirmaram que pesquisam sempre os textos 

da Microsoft em inglês; 20% (10 agentes) dos agentes responderam que primeiro pesquisam os textos 

da Microsoft na sua língua materna, depois procuram os textos equivalentes na língua de atendimento; 

6% (3 agentes) os pesquisam sempre na língua de atendimento. Nessa pergunta, a partir desses dados, 

conseguimos chegar à conclusão de que 54% responderam positivamente ao uso dos textos da Microsoft 

quando decidem em que língua pesquisá-los para a resolução de um incidente. Por outro lado, dessa 

vez, 46% (23 agentes) negaram utilizar os textos da Microsoft como suporte no atendimento de service 

desk, dando um resultado diferente da pergunta 10 e 11 para a mesma opção, talvez pelos mesmos 

motivos explicados a respeito da pergunta anterior.  

A pergunta 13 do questionário foi “Você sabia que a Microsoft disponibiliza em seu site textos e 

manuais de suporte para as suas aplicações em quase todos os idiomas?”, sendo representada no 

Gráfico 13: 
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Gráfico 13: Ciência sobre a disponibilidade dos textos da Microsoft em quase todos os idiomas 

 
Fonte: Google Forms, 2021. 

 

A essa pergunta, 46% responderam que sim, sabiam que a Microsoft disponibiliza em seu site 

textos e manuais de suporte para as suas aplicações em quase todos os idiomas, 42% negaram saber, 

12% afirmaram que talvez saberiam. 

Ao somarmos os 42% que responderam sim e os 12% que responderam talvez, totalizam-se 54% 

de agentes que possivelmente utilizam ou sabiam utilizar os textos da Microsoft. Essa porcentagem de 

54% coincide com a porcentagem de agentes que consideram os textos da Microsoft úteis no atendimento 

multilingue de service desk e que pesquisam esses textos em determinada língua durante o suporte 

técnico. A partir da compatibilidade dessas porcentagens em três perguntas diferentes, podemos chegar 

a uma possível conclusão (hipotética) de que mais da metade dos agentes que responderam ao 

questionário utilizam os textos tutorias da Microsoft durante o atendimento multilingue de service desk.  

Por isso, podemos afirmar que, com as respostas das perguntas 11, 12 e 13, é provável que 

alguns dos 54% dos agentes que responderam “Não utilizo os textos de suporte da Microsoft” na pergunta 

10 o fizeram de maneira equivocada. 

Por tudo isso, mesmo que a maioria dos operadores informáticos não tenha respondido 

positivamente quanto à utilização dos textos de suporte da Microsoft no atendimento multilingue de 

service desk, uma parte um pouco maior (54%) considera os textos úteis e os pesquisa em determinado 

idioma para esse serviço.  

Esses dados, mesmo que inferiores à porcentagem do uso da tradução automática no atendimento 

multilingue de service desk, corroboram a ideia da autora desta dissertação de que os textos da Microsoft 

demonstraram-se úteis no atendimento multilingue de service desk, ainda que de uma forma não 

predominante, para a resolução de problemas técnicos de suas aplicações. Como a maioria dos 
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problemas aconteciam com aplicações como Outlook, Excel, Powerpoint e Word, muitos agentes 

possivelmente sabiam encontrar os artigos de resolução na base de conhecimento no sistema da 

empresa A. 

4.3 Análise linguística dos tutoriais da Microsoft 

Nesta subsecção, apresentamos a continuação da parte prática desta dissertação, com as etapas 

referentes à construção de um corpus e à extração de informações linguísticas a partir dele. As figuras, 

as tabelas, os gráficos e os quadros apresentados auxiliam na interpretação e na análise dos dados. 

O conteúdo aqui apresentado surgiu no terceiro semestre do Mestrado em Tradução e 

Comunicação Multilingue durante a disciplina de Seminário de Dissertação e Profissionalização, 

ministrada pela professora doutora Silvia Lima Gonçalves Araújo. O objetivo dessa disciplina era preparar 

os estudantes para a elaboração do relatório de estágio ou da dissertação no final do curso. Para isso, 

uma das atividades propostas foi construir um corpus paralelo para sua utilização em ferramentas de 

extração e análise de dados linguísticos. 

Como a autora desta dissertação ainda trabalhava como operadora informática multilingue de 

service desk durante o terceiro semestre do Mestrado, ela decidiu utilizar os textos da Microsoft para a 

sua análise. Essa escolha lhe permitiu aliar teoria e prática ao utilizar o conhecimento adquirido na 

disciplina para analisar linguisticamente textos de sua realidade de trabalho. Logo, essa análise de caráter 

qualitativo enriquece a sua experiência acadêmica e o desenvolvimento da sua pesquisa para o desfecho 

desta dissertação. 

4.3.1 Construção do corpus paralelo 

O corpus linguístico pode ser definido como uma coletânea de textos naturais, selecionados e 

organizados para caracterizar um estado ou variedade de linguagem (Sinclair, 1991, p. 171, conforme 

citado por Sardinha, 2000) de forma sistemática e a partir de critérios para uso em pesquisas. 

Levando-se em consideração o tema desta dissertação e a sua área de especialidade, escolheram-

se textos já localizados da Microsoft, para suporte à funcionalidade de suas aplicações e textos de 

orientações para correção de erros técnicos. 
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Sendo assim, selecionamos textos que já tinham suas versões em português de Portugal, 

português do Brasil e inglês, de modo a comparar e analisar as suas características e de que maneira 

elas diferem. 

Inicialmente, foram criados ficheiros .txt com os textos das aplicações Outlook, Excel, PowerPoint 

e Word, em português de Portugal, português do Brasil e Inglês, com o objetivo de analisar o vocabulário 

e a linguagem de cada aplicação. Nesse processo de copiar os textos para o .txt, foi feita a limpeza de 

itens como figuras, notas de cabeçalho e de rodapé, de referências bibliográficas e links.  

Posteriormente, foi criado um ficheiro .txt para os textos separados por cada versão em português 

de Portugal, português do Brasil e inglês. Nesses ficheiros, foram inseridos os 8 textos referentes a todas 

as aplicações em seus respetivos idiomas, com o objetivo de analisar o vocabulário e a linguagem de 

cada idioma. A Figura 4 ilustra a organização desses ficheiros: 

 

Figura 4: Pastas dos textos utilizados em português de Portugal, português do Brasil e inglês 

Pasta de textos em português 
de Portugal 

Pasta de textos em português 
do Brasil 

Pasta de textos em Inglês 

   
Fonte: Elaboração própria, 2021. 

 

Os ficheiros .txt que contém todos os textos em cada versão (“Textos_PT-PT”, “Textos_PT-BR” e 

“Texts_EN”) foram inseridos nas aplicações Word Counter, Voyant Tools e Sketch Engine para análise 

linguística e recolha de dados. 

 

4.3.1.1 Apresentação da área de especialidade 
 

A área de especialidade dos textos é a assistência técnica informática de aplicações da Microsoft. 

A escolha dos textos se deu pelo fato de a autora desta dissertação ter trabalhado com esse tipo de 

assistência como agente multilingue de service desk na empresa A nos idiomas inglês, italiano e 

português, ao solucionar, na maior parte do tempo, problemas de aplicações da Microsoft. A escolha 

também se deu pelo fato de a Microsoft já possuir os textos de suporte a suas aplicações e correção de 

erros publicados em seu site de forma localizada em diversos idiomas, sendo de muita relevância aos 

trabalhadores da área de suporte técnico multilingue.  
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Foram escolhidos um texto de suporte (guia de funcionalidade de uma aplicação) e um texto de 

documentação (artigo de correção de erro) para as seguintes aplicações do pacote Office 365 da 

Microsoft: Outlook, Excel, PowerPoint e Word. O texto de suporte é mais simples, com frases mais diretas. 

O texto de documentação é mais longo, com diversas situações e hipóteses, permitindo uma linguagem 

e uma sintaxe mais complexa.  

O motivo para a escolha de tais textos foi poder perceber e analisar a linguagem e o vocabulário 

da Microsoft desde a sua estrutura mais simples até a mais complexa no ramo de localização. Cada texto 

foi selecionado em sua versão em português de Portugal, português do Brasil e inglês. 

 

4.3.1.2 Títulos e fontes dos textos selecionados15 

 

Para a aplicação Outlook, foram escolhidos os seguintes textos de suporte nas versões em 

português de Portugal e do Brasil, e inglês: 

i) português de Portugal: Como configurar regras (Anexo IV); 

ii) português do Brasil: Como configurar as regras (Anexo V); 

iii) inglês: How to setup rules (Anexo VI). 

Além disso, para essa aplicação, foram escolhidos os seguintes textos de correção de erro e 

documentação nas versões em português de Portugal e do Brasil, e inglês: 

i) português de Portugal: Outlook não responde a erro ou Outlook congela quando abre um ficheiro 

ou envia correio (Anexo IV); 

ii) português do Brasil: O Outlook não está respondendo o erro ou o Outlook congela ao abrir um 

arquivo ou enviar emails (Anexo V); 

iii) inglês: Outlook not responding error or Outlook freezes when you open a file or send mail (Anexo VI). 

A respeito da aplicação Excel, foram escolhidos os seguintes textos de suporte nas versões em 

português de Portugal e do Brasil, e inglês: 

i) português de Portugal: Analisar e formatar no Excel (Anexo IV); 

ii) português do Brasil: Analisar e formatar no Excel (Anexo V); 

iii) inglês: Analyze and format in Excel (Anexo VI). 

Ainda para essa aplicação, foram escolhidos também os seguintes textos de correção de erro e 

documentação nas versões nos mesmos idiomas: 

 
15 As referências das fontes dos textos selecionados estão ao final do trabalho, na secção VI. Fontes, após a Conclusão. 
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i) português de Portugal: Uso da memória na edição de 32 bits do Excel 2013 e 2016 (Anexo IV); 

ii) português do Brasil: Uso de memória na edição de 32 bits do Excel 2013 e 2016 (Anexo V); 

iii) inglês: Memory usage in the 32-bit edition of Excel 2013 and 2016 (Anexo VI). 

Com relação à aplicação PowerPoint, foram escolhidos os seguintes textos de suporte nas versões 

em português de Portugal e do Brasil, e inglês: 

i) português de Portugal: Criar uma apresentação no PowerPoint (Anexo IV); 

ii) português do Brasil: Criar uma apresentação no PowerPoint (Anexo V); 

iii) inglês: Create a presentation in PowerPoint (Anexo VI). 

Ademais, para essa aplicação, foram escolhidos os seguintes textos de correção de erro e 

documentação nas versões nos mesmos idiomas: 

i) português de Portugal: Como resolver problemas com uma apresentação danificada no Powerpoint 

(Anexo IV); 

ii) português do Brasil: Como solucionar problemas de uma apresentação danificada no PowerPoint 

(Anexo V); 

iii) inglês: How to troubleshoot a damaged presentation in PowerPoint (Anexo VI). 

Para a aplicação Word, foram escolhidos os seguintes textos de suporte nas versões em português 

de Portugal e do Brasil, e inglês: 

i) português de Portugal: Registar alterações no Word (Anexo IV); 

ii) português do Brasil: Controlar alterações no Word (Anexo V); 

iii) inglês: Track changes in Word (Anexo VI). 

Além disso, foram escolhidos os seguintes textos de correção de erro e documentação nas versões 

nos mesmos idiomas: 

i) português de Portugal: Como resolver problemas relacionados com documentos danificados no 

Word (Anexo IV); 

ii) português do Brasil: Como solucionar problemas de documentos danificados no Word (Anexo V); 

iii) inglês: How to troubleshoot damaged documents in Word (ver Anexo VI). 
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4.3.1.3 Tamanho do corpus 

 

4.3.1.3.1 Textos em português de Portugal 

 

A partir do recurso “Corpus info” do Sketch Engine, podemos verificar que os textos de português 

de Portugal contêm no total 13.432 palavras e 715 frases conforme a Figura 5: 

 

Figura 5: Informação do tamanho do corpus em português de Portugal por Sketch Engine 

 

Fonte: Sketch Engine, 2021. 

 

Conforme a Figura 6, o Word Counter detectou outra contagem para o mesmo texto: 

 

Figura 6: Informação do corpus em português de Portugal por Word Counter 

 

Fonte: Word Counter, 2021. 

 

A análise do corpus em português de Portugal feita pelo Word Counter revelou que, das 11.553 

palavras totais do texto, 2.009 são palavras únicas, ou seja, este é o número de vezes que estas palavras 

aparecem durante o texto sem contar as vezes que são repetidas. Para além disso, o corpus tem ao todo 

72.643 caracteres, 704 frases e 833 parágrafos. Devido ao seu tamanho, os textos das quatro aplicações 

apresentam tempo de leitura de um pouco mais de 42 minutos. Apesar de dizer que os textos são para 

leitores de nível académico, eles podem ser lidos por utilizadores das aplicações, que podem ter 

conhecimento básico, intermédio ou avançado em seu uso. 
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Além disso, o Word Counter gerou uma espécie de densidade de palavras e expressões, conforme 

suas frequências, que está representada na Figura 7: 

 

Figura 7: Densidade de palavras e expressões em português de Portugal por Word Counter 

 
Fonte: Word Counter, 2021. 

 

4.3.1.3.2 Textos em português do Brasil 

 

Utilizando-se do recurso “Corpus info” do Sketch Engine, verificamos que os textos em português 

do Brasil possuem 12.951 palavras totais e 715 frases, como podemos ver na Figura 8: 

 

Figura 8: Informação do tamanho do corpus em português do Brasil por Sketch Engine 

 
Fonte: Sketch Engine, 2021. 

 

Conforme a Figura 9, a contagem do Word Counter para o mesmo texto foi: 
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Figura 9: Informação do corpus em português do Brasil por Word Counter 

 
Fonte: Word Counter, 2021. 

 

A análise do corpus em português do Brasil feita pelo Word Counter revelou que, das 11.392 

palavras totais do texto, 1.912 são palavras únicas, ou seja, este é o número de vezes que estas palavras 

aparecem durante o texto sem contar as vezes que são repetidas. Para além disso, o corpus tem ao todo 

70.434 caracteres, 704 frases e 833 parágrafos. Devido ao seu tamanho, os textos das quatro aplicações 

apresentam tempo de leitura de um pouco mais de 41 minutos. Apesar de dizer que os textos são para 

leitores de nível académico, eles podem ser lidos por utilizadores das aplicações, que podem ter 

conhecimento básico, intermédio ou avançado em seu uso. 

Ademais, podemos reparar que os textos de português do Brasil têm menos palavras que o 

português de Portugal para explicar a mesma coisa, o que pode nos levar à hipótese de que o português 

brasileiro pode ser mais direto e sucinto na linguagem técnica. 

Além disso, o Word Counter gerou uma espécie de densidade de palavras e expressões, conforme 

suas frequências, que está representada na Figura 10: 

 

Figura 10: Densidade de palavras e expressões em português do Brasil por Word Counter 

 
Fonte: Word Counter, 2021. 
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4.3.1.3.3 Textos em inglês 

 

Os textos em inglês, analisados pelo recurso “Corpus info” do Sketch Engine, apresentaram um 

total de 12.583 palavras e 718 frases, como podemos ver na Figura 11: 

 

Figura 11: Informação do tamanho do corpus em inglês por Sketch Engine 

 

Fonte: Sketch Engine, 2021. 

Conforme a Figura 12, a contagem do Word Counter para o mesmo texto foi: 

 
Figura 12: Informação do corpus em inglês por Word Counter 

 
Fonte: Word Counter, 2021. 

 

A análise do corpus em inglês feita pelo Word Counter revelou que, das 10.724 palavras totais do 

texto, 1.680 são palavras únicas, ou seja, este é o número de vezes que estas palavras aparecem durante 

o texto sem contar as vezes que são repetidas. Para além disso, o corpus tem ao todo 62.914, 709 

frases e 835 parágrafos. Devido ao seu tamanho, os textos das quatro aplicações apresentam 39 minutos 

de tempo de leitura. Os textos caracterizam-se para leitores de nível estudantil, mas eles também podem 

ser lidos por utilizadores das aplicações, que podem ter conhecimento básico, intermédio ou avançado 

em seu uso. 

Ademais, podemos reparar que os textos em inglês têm menos palavras do que os textos em 

português de Portugal e português do Brasil para explicar a mesma coisa. Enquanto há uma diferença 

menor entre português de Portugal e português do Brasil, em nível de palavras e tamanho do texto, que 

podem ter terminologia e uma sintaxe mais parecida, o texto em inglês é ainda mais enxuto, o que pode 

significar ter terminologia e sintaxe mais direta e sucinta na linguagem técnica. 
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4.3.2 Análise linguística do corpus paralelo 

Neste tópico, faremos a análise linguística do corpus paralelo em quatro níveis: terminológico, 

sintático, semântico-enunciativo e pragmático, estudados por Afonso e Araújo (2019). Eles estão 

interconectados e trabalham juntos para construir o significado completo de uma mensagem em uma 

língua. A gramática e a linguística abordam esses níveis de maneira aprofundada para entender como 

as línguas funcionam e como a comunicação ocorre. Antes de entrar na análise prática, vejamos 

resumidamente do que se trata cada um. 

O nível terminológico é o nível mais baixo da linguagem e lida com as unidades básicas de 

significado em uma língua, ou seja, os termos e palavras individuais. É aqui que se encontram os 

elementos linguísticos mais elementares que compõem as frases. O nível terminológico ajuda na 

avaliação de quais palavras poderiam ser mais pesquisadas na tradução automática e quais palavras-

chave poderiam ser mais usadas para busca de artigos tutoriais da Microsoft, no atendimento multilingue 

de service desk em uma chamada, chat e e-mail.  

O nível sintático se concentra na organização e estrutura das palavras em uma frase ou sentença. 

Ele lida com as regras gramaticais que determinam como as palavras são combinadas para formar frases 

significativas. Essas regras incluem a ordem das palavras, acordos de gênero e número, conjugação 

verbal, uso de conectivos, elementos de coesão. No nível sintático, podemos avaliar a necessidade de 

uma possível pós-edição da tradução automática, principalmente relacionado ao uso de conectivos de 

forma coesa e coerente.  

O nível semântico-enunciativo envolve o significado das frases e como as mensagens são 

construídas e interpretadas. Isso não se limita apenas a definir o significado das palavras, mas também 

a entender como o contexto, a intenção do falante (enunciador) e as estruturas linguísticas contribuem 

para a interpretação. Aqui, considera-se a verdade e a assertividade de uma declaração. A análise desse 

nível possibilitou verificar estratégias de construção de significado que visam a facilitar a compreensão 

do conteúdo técnico. 

O nível pragmático se concentra nas relações entre o discurso e o contexto em que ocorre. Lida 

com a interpretação do significado em situações reais, levando em consideração elementos como o papel 

do falante (enunciador), do ouvinte (destinatário), da situação, dos objetivos da comunicação, das normas 

sociais e culturais, etc. Envolve a análise de como as intenções do falante são expressas e entendidas. 

No nível pragmático, analisamos quando havia o uso de pronomes inapropriados para fins de 

formalidade, exigindo uma pós-edição para acertos nesse quesito.  
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Foram utilizadas as ferramentas on-line Voyant Tools e Sketch Engine. A partir da inserção dos 

ficheiros .txt dos textos em cada versão nessas ferramentas, foi possível analisar os corpora nesses 

níveis, para ter uma noção mais aprofundada da linguagem dos textos, como veremos na subsecção a 

seguir. 

 

4.3.2.1 Nível terminológico 

 

Para a análise no nível terminológico dos corpora paralelos, foram utilizadas as ferramentas on-

line: Voyant Tools, para a recolha da nuvem de palavras, quantidade de palavras, análise de palavras 

mais frequentes; e Sketch Engine, para a análise de palavras individuais e multipalavras, e recolha de 

dados para as classes gramaticais. 

 

4.3.2.1.1 Textos em Português de Portugal 

 

Para a análise linguística em nível terminológico do corpus em português de Portugal, utilizou-se 

o recurso de “Keywords” da ferramenta on-line Sketch Engine para indicar as palavras individuais e 

multipalavras mais frequentes ao longo dos textos.  

Para o resultado de palavras individuais, temos a Figura 13: 

 

Figura 13: Palavras individuais no corpus em português de Portugal por Sketch Engine 

 
Fonte: Sketch Engine, 2021. 

 

Como é possível verificar, a maior parte das palavras individuais estão diretamente relacionadas 

com o tema informático dos programas do pacote Office. Como exemplo, temos “PowerPoint”, 
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“Outlook”, “Excel” e “Word”. Ao mesmo tempo, também há termos que explicitam que esses programas 

são localizados, por exemplo, “dispositivo”, “separador”, “ficheiro” e “hiperligação”. A palavra mais 

destacada é “dispositivo”, referindo-se ao equipamento informático onde se encontram os programas. 

Para as multipalavras, temos o resultado representado na Figura 14: 

 

Figura 14: Multipalavras no corpus em português de Portugal por Sketch Engine 

 

Fonte: Sketch Engine, 2021. 

 

Quanto às multipalavras, vemos também que estão em sua maioria relacionadas com o contexto 

informático, com apenas algumas exceções como “comportamento estranho” e “comportamento 

inesperado”, que provavelmente estão ali para demonstrar algum desempenho diferente das aplicações 

em questão.  

Para além disso, foi utilizada a ferramenta on-line Voyant Tools para a criação de nuvem de 

palavras e frequências de palavras. Na Figura 15, vemos a nuvem de palavras do corpus em português 

de Portugal: 
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Figura 15: Nuvem de palavras do corpus em português de Portugal por Voyant Tools 

 
Fonte: Voyant Tools, 2021. 

 

Já, na Figura 16, vemos os resultados gerados por Voyant Tools dos termos mais frequentes no 

corpus em português de Portugal: 

 

Figura 16: Termos mais frequentes do corpus em português de Portugal por Voyant Tools 

 
Fonte: Voyant Tools, 2021. 

 

Como resultado, temos uma lista das 15 palavras mais frequentes do corpus em português de 

Portugal, em que as três palavras mais frequentes são: “selecione” com 335 ocorrências, “seguida” 

com 173 ocorrências, e “documento” com 157. Além disso, nesta lista, também vemos as aplicações 

“Outlook”, “Word”, “Office” e “PowerPoint”, os termos “documento” e “ficheiro” localizados nas 

aplicações. 
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Além de recolher dados sobre a frequência das palavras no Sketch Engine, foi feita uma análise 

sobre a frequência das classes gramaticais nos textos em português de Portugal. Por meio do recurso 

“Wordlist”, geraram-se ficheiros Excel para cada classe gramatical, a partir dos quais criamos o  

Gráfico 14: 

 

Gráfico 14: Frequência das classes gramaticais no corpus em português de Portugal 

 

Fonte: Elaboração própria, 2021. 
 

Como podemos ver, como a classe gramatical mais frequente nos textos em português de Portugal 

Brasil, temos os substantivos, com 3.788 ocorrências; em segundo lugar, estão os verbos, com 2.432; 

depois, em terceiro, as preposições, com 2.094; em quarto lugar, as conjunções, com 589; em quinto, 

os adjetivos, com 488; depois, os advérbios, com 282; em seguida, os pronomes, com 230; e, por 

último, os numerais, com 6. 

 

4.3.2.1.2 Textos em português do Brasil 

 

Utilizando-se o recurso de “Keywords” da ferramenta on-line Sketch Engine para a análise 

linguística em nível terminológico do corpus em português do Brasil, obtivemos as palavras individuais e 

multipalavras mais frequentes ao longo dos textos.  

Para o resultado de palavras individuais, temos a Figura 17: 
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Figura 17: Palavras individuais no corpus em português do Brasil por Sketch Engine 

 

Fonte: Sketch Engine, 2021. 

 

Como podemos verificar, a maior parte das palavras individuais estão diretamente relacionadas 

com o tema informático dos programas do pacote Office. Como exemplo, temos “PowerPoint”, 

“Outlook”, “Word” e “Excel”. Diferentemente do português de Portugal, os textos em português brasileiro 

apresentaram poucos poucas palavras únicas de localização das aplicações e mais termos genéricos do 

ramo informático, como “opções”, “vínculos” “autoarquivar” e “rascunho”. A palavra mais destacada é 

“powerpoint”, referindo-se à aplicação do pacote Office da Microsoft. 

Para as multipalavras, temos o resultado representado na Figura 18: 

 

Figura 18: Multipalavras no corpus em português do Brasil por Sketch Engine 

 

Fonte: Sketch Engine, 2021. 
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Quanto às multipalavras, vemos também que estão em sua maioria relacionadas com o contexto 

informático, e assim como em português europeu, nos textos em português brasileiro aparecem as 

expressões “comportamento estranho” e “comportamento inesperado”, que provavelmente estão ali 

para demonstrar algum desempenho diferente das aplicações em questão.  

Em adição, foi utilizada a ferramenta on-line Voyant Tools para a criação de nuvem de palavras e 

frequências de palavras. Na Figura 19, vemos a nuvem de palavras do corpus em português do Brasil: 

 

Figura 19: Nuvem de palavras do corpus em português do Brasil por Voyant Tools 

 
Fonte: Voyant Tools, 2021. 

 

Pudemos recolher também os resultados gerados por Voyant Tools dos termos mais frequentes 

no corpus em português do Brasil, conforme representado na Figura 20: 

 

Figura 20: Termos mais frequentes do corpus em português do Brasil por Voyant Tools 

 

Fonte: Voyant Tools, 2021. 
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Como resultado, temos uma lista das 15 palavras mais frequentes do corpus em português do 

Brasil, onde as três palavras mais frequentes são: “selecione” com 245 ocorrências, “documento” com 

157 ocorrências, e “clique” com 126. Além disso, nesta lista, também vemos as aplicações “Outlook”, 

“Office”, “PowerPoint” e “Word” como mais frequentes, e as palavras “arquivo” e “abrir”, que são 

termos localizados nas aplicações. 

Além disso, foi feita uma análise sobre a frequência das classes gramaticais nos textos em 

português do Brasil no Sketch Engine. Por meio do recurso “Wordlist”, geraram-se ficheiros Excel para 

cada classe gramatical, a partir dos quais criamos o Gráfico 15: 

 

Gráfico 15: Frequência das classes gramaticais no corpus em português do Brasil 

 

Fonte: Elaboração própria, 2021. 

 

Como podemos ver, a classe gramatical mais frequente nos textos em português do Brasil é os 

substantivos, com 3.708 ocorrências; em segundo lugar, estão os verbos, com 2.344; depois, em 

terceiro, as preposições, com 1.953; em quarto lugar, as conjunções, com 608; em quinto, os adjetivos, 

com 464; depois, os advérbios, com 330; em seguida, os pronomes, com 319. Estranhamente os 

numerais apresentaram 262, uma quantidade muito diferente do português de Portugal. 

 

4.3.2.1.3 Português europeu x Português brasileiro 

 

A análise dos corpora do português de Portugal e do português do Brasil revelou que existem 

diferenças terminológicas entre essas variantes linguísticas. O Quadro 8 apresenta uma lista de alguns 

exemplos dessas diferenças: 
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Quadro 8: Diferenças de terminologia entre o corpus em português de Portugal e o corpus em português do 

Brasil 

Português de Portugal Português do Brasil 

ficheiro arquivo 

guardar salvar 

utilizar usar 

rato mouse 

selecione clique 

seguinte avançar 

causa motivo 

add-in suplemento 

passo etapa 

certifique-se verifique 

questão problema 

limpe desmarque 

Painel de Controlo Painel de Controle 

utilizador usuário 

executar realizar 

Nota Observação 

definições configurações 

folha de Excel planilha de Excel 

desative desabilite 

Criar uma apresentação Crie uma apresentação 

separador guia 

registar controlar 

rever revisar 

eliminar excluir 

estrutura design 

esquema layout 

Fonte: Elaboração própria, 2021. 

 

4.3.2.1.4 Textos em inglês 

 

Para a análise linguística em nível terminológico do corpus em inglês, utilizou-se o recurso de 

“Keywords” da ferramenta on-line Sketch Engine para indicar as palavras individuais e multipalavras 

mais frequentes ao longo dos textos.  

Para o resultado de palavras individuais, temos a Figura 21: 
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Figura 21: Palavras individuais no corpus em inglês por Sketch Engine 

 
Fonte: Sketch Engine, 2021. 

 

Como podemos ver, a maior parte das palavras individuais estão diretamente relacionadas com o 

tema informático dos programas do pacote Office. Como exemplo, temos PowerPoint, Outlook, Excel e 

Word. Diferentemente das duas versões de português, os textos em inglês apresentaram Save e Inbox 

como palavras localizadas das aplicações. A palavra mais destacada é damaged, referindo-se a alguma 

erro ou danificação de ficheiros. 

Para as multipalavras, temos o resultado representado pela Figura 22: 

 

Figura 22: Multipalavras no corpus em inglês por Sketch Engine 

 
Fonte: Sketch Engine, 2021. 
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Quanto às multipalavras, vemos também que estão em sua maioria relacionadas com o contexto 

informático. As expressões mais usadas são: damaged presentation, damaged document and new 

presentation. Assim como nas versões em português, o inglês apresentou os seus correspondentes 

strange behavior e unexpected behavior, para apontar algum desempenho diferente do normal das 

aplicações em questão. 

Além disso, foi utilizada a ferramenta on-line Voyant Tools para a criação de nuvem de palavras e 

frequências de palavras. Na Figura 23, vemos a nuvem de palavras do corpus em inglês: 

 

Figura 23: Nuvem de palavras do corpus em inglês por Voyant Tools 

 

Fonte: Voyant Tools, 2021. 

Na Figura 24, vemos os resultados gerados por Voyant Tools dos termos mais frequentes no 

corpus em inglês: 

 

Figura 24: Termos mais frequentes do corpus em inglês por Voyant Tools 

 
Fonte: Voyant Tools, 2021. 
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Como resultado, temos uma lista das 15 palavras mais frequentes do corpus em inglês, onde as 

três palavras mais frequentes são: select com 438 ocorrências, document com 156 ocorrências, e file 

com 121. A palavra select e seus correspondentes “selecione” aparecem como a mais frequente nas 

três versões, porém em inglês como uma ocorrência ainda maior. 

Além disso, nesta lista, também vemos as aplicações Outlook, PowerPoint, Office e Word como 

mais frequentes, e os termos open e new, que são termos localizados nas aplicações. 

Adicionalmente, foi feita uma análise sobre a frequência das classes gramaticais nos textos em 

inglês no Sketch Engine. Por meio do recurso “Wordlist”, geraram-se ficheiros Excel para cada classe 

gramatical, a partir dos quais criamos o Gráfico 16: 

 

Gráfico 16: Frequência das classes gramaticais no corpus em inglês 

 

Fonte: Elaboração própria, 2021. 

 

Como podemos ver, a classe gramatical mais frequente nos textos em inglês é os substantivos, 

com 3.676 ocorrências; em segundo lugar, estão os verbos, com 1.949; depois, em terceiro, as 

preposições, com 1.162; em quarto lugar, os adjetivos, com 727; em quinto, as conjunções, com 436; 

depois, os advérbios, com 393; em seguida, os pronomes, com 341. O Sketch Engine não detectou 

numerais nos textos em inglês. 

Portanto, podemos concluir que, nas três versões, a terminologia caracterizou os textos de contexto 

mais técnico, com vocabulário do ramo informático, expressões e termos localizados das aplicações em 

questão. 
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4.3.2.2 Nível sintático 

 

Para a realização da análise linguística em nível sintático, usou-se novamente o Sketch Engine, 

desta vez utilizando o recurso “Concordance” e a opção “CQL”, para retirar dados das conjunções dos 

corpora. Após a recolha dos dados, obtivemos a análise detalhada a seguir. 

 

4.3.2.2.1 Textos em português de Portugal 

 

No corpus em português de Portugal, verificamos que 440 conjunções são coordenativas e 149 

são subordinativas. Essas informações estão representadas no Gráfico 17, com 75% de conjunções 

coordenativas e 25% de subordinativas. 

 

Gráfico 17: Frequência das conjunções no corpus em português de Portugal 

 

Fonte: Elaboração própria, 2021. 

 

Entre as conjunções coordenativas no português de Portugal, temos “e”, “ou”, “porque”, “quer” 

e “mas”, enquanto as subordinativas são: “se”, “como”, “que”, “caso”, “consoante” e “embora”. 

 

4.3.2.2.2 Textos em português do Brasil 

 

No corpus em português do Brasil, verificamos 442 conjunções coordenativas e 166 conjunções 

subordinativas. Essas informações estão representadas no Gráfico 18, com um total de 73% de 

conjunções coordenativas e 27% de subordinativas. 
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Gráfico 18: Frequência das conjunções no corpus em português do Brasil 

 
Fonte: Elaboração própria, 2021. 

 

Entre as conjunções coordenativas no português do Brasil, temos “e”, “ou”, “porque”, “exceto”, 

“nem”, “portanto” e “mas”, já as subordinadas são: “se”, “como”, “que”, “caso” e “embora”. 

 

4.3.2.2.3 Textos em inglês 

 

No corpus em inglês, o Sketch Engine detectou 436 conjunções coordenativas e nenhuma 

subordinativa. Essas informações estão representadas no Gráfico 19, demostrando que as conjunções 

coordenativas representam 100% do total e as conjunções subordinativas, 0%. 

 

Gráfico 19: Frequência das conjunções no corpus em inglês 

 
Fonte: Elaboração própria, 2021. 

 

Entre as conjunções coordenativas no inglês, temos and, or e but. 
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Portanto, a análise dos corpora paralelos em português de Portugal, português do Brasil e inglês 

revelou que o inglês apresenta uma estrutura sintática mais simples do que as variantes linguísticas 

portuguesas, e essa diferença pode ser observada na frequência das conjunções. No corpus em inglês, 

há apenas conjunções coordenativas, representando 100% do total. Já no corpus em português de 

Portugal, as conjunções coordenativas representam 75% do total; as conjunções subordinativas 

representam 25%. No corpus em português do Brasil, as conjunções coordenativas compõem 73%, 

enquanto as subordinativas, 27%. 

 

4.3.2.3 Nível semântico-enunciativo 

 

Para a realização da análise linguística em nível semântico-enunciativo, usou-se a ferramenta on-

line Sketch Engine, mais uma vez utilizando o recurso “Concordance” para combinar fórmulas que 

analisam os verbos modais e outros mais frequentes. O objetivo era identificar quais tipos de palavras 

estão combinadas a estes verbos, para entender como o enunciado do texto se comporta. 

Os verbos modais são assim chamados porque expressam uma modalidade, ou seja, uma atitude 

do falante em relação à situação descrita pelo verbo principal. Eles expressam uma variedade de 

significados, como possibilidade, necessidade, obrigação, permissão e tentativa. São sempre seguidos 

de um verbo principal que expressa a ação ou o estado principal da oração. O verbo modal pode ser 

flexionado na mesma pessoa, número e tempo do verbo principal, ou pode ser flexionado de forma 

diferente, dependendo do significado que se deseja expressar. O significado dos verbos modais pode ser 

influenciado pelo contexto em que eles são usados. Por exemplo, o verbo “poder” pode expressar 

possibilidade, necessidade ou permissão, dependendo do contexto. 

Como verbos modais, analisaremos os seguintes:  

i) verbos que indicam possibilidade: “poder”; 

ii) verbos que indicam obrigatoriedade: “dever”, “ter”, “precisar” e “haver”; 

iii) verbos que indicam vontade: “querer” e “desejar”; 

iv) verbos que indicam intenção: “tentar”; 

v) verbos auxiliares modais que indicam finalização: “conseguir”. 

Além disso, analisaremos os verbos “ser” e “estar” como auxiliares e suas ocorrências 

combinados com outros verbos (seja no gerúndio, seja no particípio), ou quando significam o estado de 

um incidente ou de muitas aplicações, a descrição ou a identidade de determinado produto, ou até 

mesmo algo estático ou que está a acontecer em um determinado momento. 
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4.3.2.3.1 Textos em português de Portugal 

 

No corpus do português de Portugal, para análise do verbo “poder”, que indica possibilidade, o 

Sketch Engine detectou 91 ocorrências, de acordo com a Figura 25: 

 

Figura 25: Ocorrências do verbo poder no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 
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Já a análise do verbo “poder” diretamente combinado com outros verbos detectou 83 ocorrências, 

representadas na Figura 26: 

 

Figura 26: Ocorrências do verbo poder + outro verbo no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Para análise dos verbos que indicam obrigatoriedade, vimos como se comportam os verbos: dever, 

ter e haver. O Sketch Engine não detectou ocorrências do verbo “precisar” nos textos de português de 

Portugal. 

Para a análise do verbo “dever”, o Sketch Engine detectou cinco ocorrências: 

 

Figura 27: Ocorrências do verbo dever no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Nessas passagens do verbo “dever”, vemos que eles se relacionam diretamente com verbos, não 

havendo outras palavras de outra classe gramatical entre o verbo “dever” e os seguintes, que são: “ter”, 

“importar”, “ser”, “escrever” e “verificar”. 
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O Sketch Engine detectou 36 ocorrências do verbo “ter”, conforme representadas na Figura 28: 

 

Figura 28: Ocorrências do verbo ter no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo “ter” combinado com a preposição “de”, o Sketch Engine gerou as 

ocorrências representadas na Figura 29: 

 

Figura 29: Ocorrências do verbo ter + preposição de no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo “ter” combinado com a conjunção “que”, o Sketch Engine detectou apenas 

uma ocorrência, representada na Figura 30: 
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Figura 30: Ocorrência do verbo ter + conjunção que no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo “haver”, o Sketch Engine detectou quatro ocorrências, conforme a  

Figura 31: 

 

Figura 31: Ocorrências do verbo haver no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Analisando essas ocorrências, podemos verificar que há duas ocorrências de 

possibilidade/hipótese quando o verbo “haver” é conjugado como “houver” no futuro do conjuntivo. 

Para a análise do verbo “querer”, o Sketch Engine detectou quatro ocorrências, de acordo com a  

Figura 32: 

 

Figura 32: Ocorrências do verbo querer no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Nessas ocorrências, vemos que cada verbo “querer” conjugado comporta-se de uma maneira 

específica. Na primeira, temos “onde quer que esteja”, em que o verbo “quer” faz parte da expressão 

“onde quer que”. Na segunda, temos “Coloque o cursor onde quiser”, no conjuntivo futuro, que indica 

uma situação hipotética volitiva. Na terceira, temos “Se quiser copiar mais”, no conjuntivo futuro, 

indicando uma condição. Na quarta, ocorre “Normalmente, um editor ou revisor quer”, no indicativo 

presente apontando constância ou situações normais, como caracteriza o advérbio “normalmente”. 

Para a análise do verbo “desejar”, o Sketch Engine detectou duas ocorrências, representadas na 

Figura 33: 
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Figura 33: Ocorrências do verbo desejar no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo “tentar”, com sentido de intenção, o Sketch Engine detectou 37 

ocorrências, conforme a Figura 34: 

 

Figura 34: Ocorrências do verbo tentar no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Nessas ocorrências, o verbo “tentar” se apresenta muitas vezes conjugado no imperativo “tente” 

(ao se dirigir ao pronome “você”) e “tenta” (ao se dirigir ao pronome “tu”), demonstrando orientações 

ao leitor para realizar tentativas de funcionalidades para correções de erros nas aplicações em questão. 

Sendo assim, vemos que o texto em português de Portugal ora se comporta de maneira formal, ora 

informal ao se dirigir ao utilizador. 

Para a análise do verbo “conseguir”, com sentido de intenção, o Sketch Engine detectou quatro 

ocorrências, conforme podemos ver na Figura 35: 
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Figura 35: Ocorrências do verbo conseguir no corpus em português de Portugal 

 

Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo “ser”, o Sketch Engine detectou 92 ocorrências, conforme podemos ver 

uma parte na Figura 36: 

 

Figura 36: Ocorrências do verbo ser no corpus em português de Portugal 

 

Fonte: Sketch Engine, 2021. 
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Para a análise do verbo “ser” seguido de outro verbo, o Sketch Engine detectou 56 ocorrências, 

conforme podemos ver uma parte na Figura 37: 

 

Figura 37: Ocorrências do verbo ser + outro verbo no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Vemos nessas ocorrências que a maioria acontece com um verbo “ser” seguido de um outro verbo 

no particípio, geralmente para descrever o estado de alguma aplicação, que se comporta como um 

predicativo do sujeito, por exemplo: “A sua pasta AppData é redirecionada para uma localização de rede”, 

“Estes passos são fornecidos numa ordem específica”. Essas frases também são exemplos e 

demonstram a utilização da voz passiva, porém sem ter expresso o agente da passiva. 

Para a análise do verbo “estar”, o Sketch detectou 73 ocorrências, conforme podemos ver uma 

parte na Figura 38: 
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Figura 38: Ocorrências do verbo estar no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo “estar” seguido de outro verbo, o Sketch detectou 30 ocorrências, 

conforme podemos ver uma parte na Figura 39: 

 

Figura 39: Ocorrências do verbo estar + outro verbo no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 
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Vemos nessas ocorrências que a maioria acontece com um verbo “estar” seguido de um outro 

verbo no particípio, geralmente para descrever algum estado de alguma aplicação, comportando-se como 

um predicativo do sujeito, por exemplo: “o Windows update não está configurado”, “as últimas 

atualizações do Outlook estão instaladas”. 

Além disso, para analisar as ocorrências de ações em continuidade, tivemos de pesquisar as 

ocorrências do verbo “estar” + uma palavra + outro verbo, pois, diferentemente do português do Brasil 

que usa o verbo “estar” + outro verbo no gerúndio, o português de Portugal utiliza o verbo “estar” + 

preposição “a” + outro verbo no infinitivo. Um exemplo está na primeira frase da Figura 40: “O Outlook 

está a ser usado por outro processo”. Essa análise detectou 28 ocorrências de frases com essa 

construção: 

 
Figura 40: Ocorrências do verbo estar + preposição a + outro verbo no infinitivo no corpus em português de 

Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Baseado nos dados expostos a respeito dos verbos modais no corpus em português de Portugal, 

conseguimos compelir os seguintes dados, representados na Tabela 1: 

  



102 

 

Tabela 1: Análise dos verbos modais e auxiliares no corpus em português de Portugal 

Verbos Ocorrências 

poder 91 

dever 5 

ter 36 

haver 4 

querer 4 

desejar 2 

tentar 37 

conseguir 13 

ser 92 

estar 73 

Fonte: Elaboração própria, 2021. 

 

Com esses dados, conseguimos elaborar o Gráfico 20: 

 

Gráfico 20: Análise dos verbos modais e auxiliares no corpus em português de Portugal 

 
Fonte: Elaboração própria, 2021. 

 

Para finalizar a análise dos verbos, dos 271 verbos diferentes, verificamos os 20 mais frequentes 

no corpus em português de Portugal, conforme a Figura 41: 
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Figura 41: Os 20 verbos mais frequentes no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Por meio da análise dos verbos modais e auxiliares no corpus em português de Portugal, pela 

Tabela 1 e pelo Gráfico 20, verificamos que os mais frequentes são “ser”, “poder” e “estar”. Com base 

na análise geral dos verbos selecionados no corpus em português de Portugal, é possível inferir que os 

textos tutoriais da Microsoft são técnicos e injuntivos, com orientações e recomendações para que o 

utilizador siga instruções e consiga resolver seu problema de origem eletrónica.16 A partir da Figura 41, 

verificamos uma alta frequência dos verbos “selecionar”, “ser” e “poder”.  

A alta frequência do verbo “ser” pode ser interpretada como uma forma de descrever o estado de 

um incidente ou de muitas aplicações (“O seu perfil de utilizador foi corrompido”), a descrição ou a 

identidade de determinado produto (“As suas caixas de correio são muito grandes”), ou até mesmo algo 

estático (“A mensagem é agora apresentada nessa pasta”) ou que está a acontecer em um determinado 

momento (“O Outlook está a ser usado por outro processo”). Além disso, em algumas vezes, o verbo 

“ser” aparece em estrutura de oração passiva sem apresentar o agente da passiva (“Estes passos são 

fornecidos numa ordem específica baseada na comunhão e complexidade”); em outras, não ocupa a 

posição de verbo auxiliar, mas de principal (“O desempenho pode ser diminuído se utilizar a 

funcionalidade Outlook AutoArchive”); ou descreve o resultado esperado de uma ação (“O documento 

será aberto no Bloco de Notas com código extra e texto em torno do conteúdo”). 

 
16 A definição de texto injuntivo foi adaptada dos websites Ciberdúvidas da Língua Portuguesa e Brasil Escola, estando referenciados na lista 
de Bibliografia. 
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Já a alta frequência do verbo “poder” indica a apresentação de possíveis cenários de problema 

técnico versus sua resolução (“Isto pode ser porque o Windows Update não está configurado no seu 

computador para descarregar e instalar automaticamente atualizações recomendadas”), podendo 

também designar a possibilidade ou a recorrência de um incidente (“Esta questão pode ocorrer por uma 

ou mais das razões nesta secção”), permissão (“Pode utilizar o Process Explorer para verificar se está a 

aproximar-se do limite de 2 GB no Excel.”) ou capacidade (“Os add-ins COM podem utilizar a memória 

em detrimento da limitação de 2 GB”). Concluimos então que, nos textos da Microsoft, o verbo “poder” 

pode ser usado para descrever as causas possíveis de um problema técnico, ou para descrever os 

requisitos necessários para resolver um problema. 

O verbo “estar” pode expressar alguns significados, como localização (“Localizar a pasta 

C:\Utilizadores\Old_Username, na qual C é a unidade em que o Windows está instalado”), estado (“Esse 

comportamento pode ocorrer, porque a apresentação está danificada”), ou situação hipotética com uma 

futura orientação de possíveis resoluções (“Se estiver a usar um rato, aponte para o canto superior direito 

do ecrã”). 

O uso do verbo “selecionar” em suas diversas variantes, como “selecione”, indica que o texto tem 

como objetivo orientar o leitor a realizar uma ação específica, por exemplo: “No Painel de Controlo, 

selecione Aparência e Personalização e, em seguida, selecione Opções de Pasta”. O uso de alguns verbos 

no imperativo demonstra o caráter de texto técnico e injuntivo, reforçando essa orientação e tornando o 

texto mais direto e objetivo. 

Essas interpretações são apoiadas pelo fato de que os textos tutoriais da Microsoft costumam 

abordar problemas técnicos que podem ter diversas causas. Portanto, a análise dos verbos selecionados 

em português de Portugal sugere que os textos tutoriais da Microsoft são textos técnicos e injuntivos que 

visam orientar o leitor a resolver problemas de origem tecnológica e/ou eletrónica. 

 

4.3.2.3.2 Textos em português do Brasil 

 

No corpus do português do Brasil, para análise do verbo “poder”, que indica possibilidade, o 

Sketch Engine detectou 83 ocorrências, representadas na Figura 42: 
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Figura 42: Ocorrências do verbo poder no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Já a análise do verbo “poder” diretamente combinado com outros verbos detectou 76 ocorrências, 

representadas na Figura 43: 

 

Figura 43: Ocorrências do verbo poder + outro verbo no corpus do português do Brasil 

 

Fonte: Sketch Engine, 2021. 
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Para a análise do verbo “dever”, o Sketch Engine detectou sete ocorrências, representadas na 

Figura 44: 

 
Figura 44: Ocorrências do verbo dever no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Já a análise do verbo “dever” diretamente combinado com outros verbos detectou seis 

ocorrências, conforme a Figura 45: 

 

Figura 45: Ocorrências do verbo dever + outro verbo no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Como podemos ver pela Figura 45, o verbo “dever” com sentido de obrigatoriedade tem frequência 

de seis ocorrências, combinado com outros verbos: aguardar, ter, importar, ser, digitar e verificar. 

Para a análise do verbo “ter”, o Sketch Engine detectou 25 ocorrências, representadas na  

Figura 46: 
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Figura 46: Ocorrências do verbo ter no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo “ter” combinado com a conjunção “que”, o Sketch Engine gerou as duas 

ocorrências, representadas na Figura 47: 

 

Figura 47: Ocorrências do verbo ter + conjunção que no corpus do português do Brasil 

 

Fonte: Sketch Engine, 2021. 

 

Podemos reparar que, em ambas as ocorrências, a expressão “ter que” é antecedida do verbo 

“pode”, formando as expressões “você pode ter que abrir”, “você pode ter que alterar”. 

Diferentemente do corpus em português de Portugal, o corpus em português do Brasil não 

apresentou ocorrências do verbo “ter” seguido da preposição “de”.  

Para a análise do verbo “precisar”, o Sketch Engine detectou três ocorrências, representadas na 

Figura 48: 
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Figura 48: Ocorrências do verbo precisar no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Nessas ocorrências, podemos ver que duas são em sentido de obrigatoriedade, mas a outra de 

possibilidade devido ao uso do advérbio “talvez”: “Talvez você precise”. 

Para a análise do verbo “haver”, o Sketch Engine detectou sete ocorrências, como podemos ver 

na Figura 49: 

 

Figura 49: Ocorrências do verbo haver no corpus do português do Brasil 

 

Fonte: Sketch Engine, 2021. 

 

Analisando essas ocorrências, podemos verificar que há três de possibilidade/hipótese quando o 

verbo “haver” é conjugado como “houver” no futuro do conjuntivo. 

Para a análise do verbo “querer”, o Sketch Engine detectou quatro ocorrências, como demonstra 

a Figura 50: 

 

Figura 50: Ocorrências do verbo querer no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Nessas ocorrências, vemos que cada verbo “querer” conjugado comporta-se de uma maneira 

específica. Na primeira temos “onde quer que elas estejam”, em que o verbo “quer” faz parte da 

expressão “onde quer que”, que pede o conjuntivo presente para o verbo de seu sujeto a seguir: “elas 

estejam”. Na segunda temos “Selecione um slide que você queira”, no conjuntivo presente, que indica 
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uma situação hipotética. Na terceira, temos “Se você quiser”, no conjuntivo futuro, indicando uma 

condição. Na quarta, ocorre “Um editor ou revisor geralmente quer”, no indicativo presente apontando 

constância ou situações frequentes, como caracteriza advérbio “geralmente”. 

Para a análise do verbo “desejar”, o Sketch Engine detectou 20 ocorrências, representadas na 

Figura 51: 

 

Figura 51: Ocorrências do verbo desejar no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Nessas ocorrências, vemos um comportamento padrão do verbo “desejar”, em que acontece 

várias vezes a conjugação “você deseja”, e o particípio passado “desejado” variado em gênero e número, 

concordando-se com palavras como “opções”, “gráfico”, “opção”, “tipo”, “imagem” e “item”. 

Para a análise do verbo “tentar”, com sentido de intenção, o Sketch Engine detectou 38 

ocorrências, demonstradas na Figura 52: 
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Figura 52: Ocorrências do verbo tentar no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Nessas ocorrências, o verbo “tentar” se apresenta muitas vezes conjugado no imperativo “tente”, 

demonstrando orientações para o leitor realizar tentativas de funcionalidades para correções de erros 

nas aplicações em questão. 

Para a análise do verbo “conseguir”, com sentido de intenção, o Sketch Engine detectou quatro 

ocorrências, conforme podemos ver na Figura 53: 

 
Figura 53: Ocorrências do verbo conseguir no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Nessas ocorrências, aparecem duas vezes “Se você não conseguir”, ligada a uma situação 

hipotética de tentativa, demonstrando orientações ao leitor. Já nas outras ocorrências de “consegue”, 

uma aponta para o programa PowerPoint (“O PowerPoint não consegue abrir o tipo de arquivo 

representado”), a outra aponta para o leitor (“selecione o documento que você não consegue abrir”). 
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Para a análise do verbo “ser”, o Sketch detectou 107 ocorrências, conforme podemos ver uma 

parte na Figura 54: 

 

Figura 54: Ocorrências do verbo ser no corpus em português do Brasil 

 
Fonte: Sketch Engine, 2021. 
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Para a análise do verbo “ser” seguido de outro verbo, o Sketch detectou 65 ocorrências, conforme 

podemos ver uma parte na Figura 55: 

 
Figura 55: Ocorrências do verbo ser + outro verbo no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Vemos nessas ocorrências que a maioria acontece com um verbo “ser” seguido de um outro verbo 

no particípio, geralmente para descrever algum estado de alguma aplicação, que se comporta como um 

predicativo do sujeito, por exemplo: “A mensagem será exibida nesta pasta”, “Essas etapas são 

fornecidas em uma ordem específica”. Essas frases também são exemplos e demonstram a utilização 

da voz passiva. 
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Para a análise do verbo “estar”, o Sketch detectou 79 ocorrências, conforme podemos ver uma 

parte na Figura 56: 

 

Figura 56: Ocorrências do verbo estar no corpus em português do Brasil 

 

Fonte: Sketch Engine, 2021. 
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Para a análise do verbo “estar” seguido de outro verbo, o Sketch detectou 65 ocorrências, 

conforme podemos ver uma parte na Figura 57: 

 

Figura 57: Ocorrências do verbo estar + outro verbo no corpus do português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Vemos nessas ocorrências que a maioria acontece com um verbo “estar” seguido de um outro 

verbo no gerúndio, geralmente para descrever algum comportamento da aplicação em questão ou do 

sistema operativo Windows que está acontecendo, por exemplo: “O Outlook está carregando conteúdo 

externo”, “Um suplemento [...] está interferindo no Outlook”, “Se você estiver executando o Windows 

10”. As outras ocorrências apresentam o verbo “estar” seguido de um verbo no particípio para 

determinar algum estado de alguma aplicação, por exemplo “quando o Outlook estiver ativado”, “Seu 

software antivirus instalado está desatualizado”, “o Windows Update não está configurado”. 

Além disso, para analisar as ocorrências de ações em continuidade, analisamos ocorrências em 

que o verbo “estar” pudesse ser seguido de outra palavra + outro verbo, para verificar se apresentaria a 

mesma construção que no português de Portugal (estar + a + outro verbo), mas o resultado foi bem 

diferente, conforme podemos ver na Figura 58: 
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Figura 58: Ocorrências do verbo estar + outro verbo + outro verbo no corpus em português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Nesses dados, podemos ver que o português do Brasil não utiliza o verbo “estar” + preposição 

“a” + outro verbo para explicar uma ação em continuidade, mas sim o verbo “estar” + outro verbo no 

gerúndio. 

Baseado nos dados expostos a respeito dos verbos modais no corpus em português do Brasil, 

conseguimos compelir os dados representados na Tabela 2: 

 

Tabela 2: Análise dos verbos modais e auxiliares no corpus em português do Brasil 

Verbos Ocorrências 

poder 83 

dever 7 

ter 25 

precisar 3 

haver 7 

querer 4 

desejar 20 

tentar 38 

conseguir 4 

ser  107 

estar 79 

Fonte: Elaboração própria, 2021. 
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Com esses dados, conseguimos elaborar o Gráfico 21: 

 
Gráfico 21: Análise dos verbos modais e auxiliares no corpus em português do Brasil 

 

Fonte: Elaboração própria, 2021. 

 

Como podemos ver, entre os verbos auxiliares, o verbo “ser” foi o mais frequente com 107 

ocorrências. Entre os verbos modais, o verbo “poder” foi o mais frequente, com 83 ocorrêcias. 

Para finalizar a análise sobre os verbos, dos 257 verbos diferentes, verificamos os 20 mais 

frequentes no corpus em português do Brasil, conforme a Figura 59: 

 

Figura 59: Os 20 verbos mais frequentes no corpus em português do Brasil 

 

Fonte: Sketch Engine, 2021. 
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Por meio da análise dos verbos modais e auxiliares no corpus em Português do Brasil, pela Tabela 

2 e pelo Gráfico 21, verificamos que os mais frequentes são “ser”, “poder” e “estar”. Com base na 

análise geral dos verbos selecionados no corpus em português do Brasil, é possível perceber que os 

textos tutoriais da Microsoft são técnicos e injuntivos, com orientações e recomendações para que o 

utilizador siga instruções e consiga resolver seu problema de origem eletrónica.17 A partir da Figura 59, 

notamos que os verbos mais frequentes foram “selecionar” com 258 ocorrências, “ser” com 107 e 

“danificar” com 93. 

A alta frequência do verbo “ser” pode ser interpretada como uma forma de descrever o estado de 

um incidente ou de muitas aplicações (“Seu perfil de usuário foi corrompido”), ou a descrição, identidade 

de determinado produto (“Suas caixas de correio são muito grandes”), ou até mesmo algo que está a 

acontecer em um determinado momento (“O Office 365 ProPlus está sendo renomeado como Microsoft 

365 Apps para empresas”). Além disso, em algumas ocasiões, o verbo “ser” aparece em estrutura de 

oração passiva sem apresentar o agente da passiva (“Essas etapas são fornecidas em uma ordem 

específica com base em semelhanças e complexidades”); em outras, não ocupa a posição de verbo 

auxiliar, mas de principal (“Um documento do Word pode ser corrompido por várias razões”); ou descreve 

o resultado esperado de uma ação (“A informação do documento danificado será exibida se houver dados 

ou textos recuperáveis”).  

Já a alta frequência do verbo “poder” indica a apresentação de possíveis cenários de problema 

técnico versus sua resolução (“esse comportamento pode ser causado por outros fatores além do 

documento danificado”), assinalando também possibilidade (“Esse comportamento pode ocorrer porque 

a apresentação está danificada”), permissão (“Você pode desabilitar toda a integração do Outlook no 

software antivírus”) ou capacidade (“os suplementos de COM podem usar a memória à custa da 

limitação de 2 GB”). Nos textos da Microsoft, o verbo “poder” pode ser usado para descrever as causas 

possíveis de um problema técnico, ou para descrever os requisitos necessários para resolver um 

problema.  

Nos tutoriais da Microsoft selecionados em português do Brasil, verificamos que o verbo “estar” 

pode ser usado para expressar uma ação em continuidade (“O Outlook está carregando conteúdo 

externo”), estado (“Seu software antivírus instalado está desatualizado”), ou situação hipotética para 

descrever uma solução ou as etapas necessárias para resolver um problema (“Se você estiver usando 

um mouse, aponte para o canto superior direito da tela”). 

 
17 A definição de texto injuntivo foi adaptada dos websites Ciberdúvidas da Língua Portuguesa e Brasil Escola, referenciados na lista de 
Bibliografia. 
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O uso do verbo “selecionar” em suas diversas variantes, como “selecione”, indica que o texto tem 

como objetivo orientar o leitor a realizar uma ação específica, por exemplo: “No painel de controle, 

selecione programas, selecione contas de usuário e, em seguida, selecione email para abrir itens de 

email”. O uso de alguns verbos no imperativo demonstra o caráter de texto técnico e injuntivo, reforçando 

essa orientação e tornando o texto mais direto e objetivo. 

Ademais, verificamos o alto uso do verbo “danificar” e suas variações “danificado(a)” no corpus 

em português do Brasil. Ele é frequentemente usado para alertar os utilizadores sobre os riscos de danos 

a seus sistemas ou aplicativos e sobre a importância de seguir as instruções do tutorial para evitar danos 

ao computador, por exemplo, “Não copie as quebras de seção, já que isso pode danificar o novo 

documento”. O verbo “danificar” no particípio também pode ser usado para descrever os resultados de 

danos a um sistema ou aplicativo (“Em alguns casos, um slide danificado pode causar um problema 

durante toda a apresentação”). Em outras situações, ele pode ser usado para expressar a possibilidade 

de danos a um sistema ou aplicativo (“Se você notar um comportamento inesperado na nova 

apresentação depois de copiar um slide para a apresentação, esse slide provavelmente será danificado”). 

Portanto, o significado do verbo “danificar” e de suas variações nos tutoriais da Microsoft pode alternar 

dependendo do contexto específico em que ele é usado. 

Essas interpretações são apoiadas pelo fato de que os textos tutoriais da Microsoft costumam 

abordar problemas técnicos que podem ter diversas causas. Portanto, a análise dos verbos selecionados 

em português do Brasil sugere que os textos tutoriais da Microsoft são textos técnicos e injuntivos que 

visam orientar o leitor a resolver problemas de origem tecnológica e/ou eletrónica. 

 

4.3.2.3.3 Textos em inglês 

 

Em inglês, fizemos a análise dos seguintes verbos modais: can, may, might, must, should e will. 

Além disso, analisamos os verbos to be e to have combinados com outros verbos. 

Para a análise do verbo can, o Sketch Engine detectou 57 ocorrências, conforme podemos ver na 

Figura 60: 
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Figura 60: Ocorrências do verbo can no corpus em inglês 

 

Fonte: Sketch Engine, 2021. 
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Para a análise do verbo can seguido de outro verbo, o Sketch detectou 39 ocorrências, conforme 

podemos ver na Figura 61: 

 

Figura 61: Ocorrências do verbo can + outro verbo no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo could, o Sketch detectou apenas uma ocorrência, conforme podemos ver 

na Figura 62: 

 

Figura 62: Ocorrência única do verbo could no corpus em inglês 

 

Fonte: Sketch Engine, 2021. 
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Para a análise do verbo may, o Sketch Engine detectou 34 ocorrências, conforme a Figura 63: 

 

Figura 63: Ocorrências do verbo may no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 
Para a análise do verbo may seguido de outro verbo, o Sketch Engine detectou 31 ocorrências, 

representadas na Figura 64: 

 
Figura 64: Ocorrências do verbo may + outro verbo no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 
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Para a análise do verbo might, o Sketch Engine detectou 13 ocorrências, conforme a Figura 65: 

 

Figura 65: Ocorrências do verbo might no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo might seguido de outro verbo, o Sketch Engine detectou 11 ocorrências, 

demonstradas na Figura 66: 

 

Figura 66: Ocorrências do verbo might + outro verbo no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 
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Para a análise do verbo must, o Sketch Engine detectou sete ocorrências, conforme a Figura 67: 

 

Figura 67: Ocorrências do verbo must no corpus em inglês 

 

Fonte: Sketch Engine, 2021. 

 

Nesta figura, apenas uma frase possui um advérbio como intermediário: “you must first create a 

user account”. 

Para a análise do verbo should, o Sketch Engine detectou somente três ocorrências, representadas 

na Figura 68: 

 

Figura 68: Ocorrências do verbo should no corpus em inglês 

 

Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo auxiliar will, o Sketch Engine detectou 23 ocorrências, conforme podemos 

ver na Figura 69: 
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Figura 69: Ocorrências do verbo auxiliar will no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo auxiliar will seguido de outro verbo, o Sketch Engine detectou 18 

ocorrências, representadas na Figura 70: 

 

Figura 70: Ocorrências do verbo auxiliar will + outro verbo no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise de todas as ocorrências do verbo to be, o Sketch Engine detectou 193 delas, 

conforme podemos ver uma parte na Figura 71: 



125 

 

Figura 71: Ocorrências do verbo to be no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo to be seguido de outro verbo, o Sketch Engine detectou 116 ocorrências, 

conforme podemos ver uma parte na Figura 72: 

 

Figura 72: Ocorrências do verbo to be + outro verbo no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 
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Nesses dados, podemos ver que há ocorrências de verbos que demonstram a utilização da voz 

passiva, como por exemplo: “Your AppData folder is redirected to a network location”, “These steps are 

provided in a specific order”, “If the problem is resolved, select Options on the File menu”, porém sem 

ter expresso o agente da passiva. 

Para a análise de todas as ocorrências do verbo to have, o Sketch Engine detectou 31 delas, 

conforme podemos ver uma parte na Figura 73: 

 

Figura 73: Ocorrências do verbo to have no corpus em inglês 

 

Fonte: Sketch Engine, 2021. 

 

Para a análise do verbo to have seguido de outro verbo, o Sketch Engine detectou somente 7 

ocorrências, conforme podemos ver na Figura 74: 
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Figura 74: Ocorrências do verbo to have + outro verbo no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

Baseado nos dados expostos a respeito dos verbos modais no corpus em inglês, conseguimos 

compilar os dados representados na Tabela 3: 

 
Tabela 3: Análise dos verbos modais e auxiliares no corpus em inglês 

Verbos Ocorrências 

can 57 

could 1 

may 34 

might 13 

must 7 

should 3 

will 23 

be 193 

have 31 

Fonte: Elaboração própria, 2021. 

 

Com esses dados, conseguimos elaborar o Gráfico 22: 

 

Gráfico 22: Análise dos verbos modais e auxiliares no corpus em inglês 

 
Fonte: Elaboração própria, 2021. 
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Para finalizar a análise sobre os verbos, dos 247 verbos diferentes, verificamos os 20 mais 

frequentes no corpus em inglês, conforme Figura 75: 

 

Figura 75: Os 20 verbos mais frequentes no corpus em inglês 

 

Fonte: Sketch Engine, 2021. 
 

Por meio da análise dos verbos modais no corpus em inglês, pela Tabela 3 e pelo Gráfico 22, 

verificamos uma alta frequência dos verbos be, can e may. Com base na análise geral dos verbos 

selecionados no corpus em inglês, é possível inferir que os textos tutoriais da Microsoft são técnicos e 

injuntivos, com orientações e recomendações para que o utilizador siga instruções e consiga resolver seu 

problema de origem eletrónica.18 A partir da Figura 75, notamos um alto uso dos verbos select, com 277 

ocorrências, be com 193 e create com 65. 

Em inglês, be é um verbo auxiliar que pode ser usado para expressar uma variedade de 

significados, como estado ou descrição de um incidente ou produto (“Your installed antivirus software is 

outdated”), localização (“Your AppData folder is redirected to a network location”), causa (“To determine 

whether this problem is caused by a corrupted user profile [...]”), ou uma situação hipotética de algo que 

está acontecendo ou pode acontecer (“When you are working with an Excel worksheet, you receive the 

following error message”). Nesses tutoriais, o verbo be é frequentemente usado para descrever o estado 

de um sistema ou aplicativo, ou para descrever a causa de um problema.  

 
18 A definição de texto injuntivo foi adaptada dos websites Ciberdúvidas da Língua Portuguesa e Brasil Escola, estando referenciados na lista 
de Bibliografia. 
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Já o verbo can é um verbo modal que pode ser usado para expressar uma variedade de 

significados, como permissão (“You cannot paste any attributes into a workbook in another instance of 

Excel”), possibilidade (“You can try to create a new file in PowerPoint and see whether the unexpected 

behavior occurs with the new file”) e capacidade (“This is not a PowerPoint Presentation. PowerPoint 

cannot open the type of file represented by <file_name>.ppt”). Nesses textos técnicos, o verbo can é 

muito usado para apresentar possíveis soluções para problemas, ou para descrever as capacidades de 

um sistema ou aplicativo.  

Além disso, may é um verbo modal que pode ser usado para expressar uma variedade de 

significados, como necessidade (“In this case, you may have to open each file to see whether one is the 

temporary copy of the presentation”) e possibilidade (“You may find it easier to follow the steps if you 

print this article first”). Nos tutoriais da Microsoft, o verbo may é geralmente usado para descrever as 

possibilidades de um problema ou de uma solução.  

Por fim, temos os verbos select e create como outros mais frequentes no corpus em inglês, sendo 

o primeiro usado para orientar os utilizadores sobre como selecionar um item ou uma opção (“On the 

File menu, select Save”), e o segundo para orientar os usuários sobre como criar um novo item ou uma 

nova configuração, por meio de um breve título (“Create a blank presentation”), ou para explicar a 

consequência de determinado processo (“This process creates a blank title slide”). É importante ressaltar 

que o significado desses verbos pode variar dependendo do contexto específico em que eles são usados. 

Essas interpretações são apoiadas pelo fato de que os textos tutoriais da Microsoft costumam 

abordar problemas técnicos que podem ter diversas causas. Portanto, a análise dos verbos selecionados 

em inglês sugere que os textos tutoriais da Microsoft são textos técnicos e injuntivos que visam orientar 

o leitor a resolver problemas de origem tecnológica e/ou eletrónica. 

 

4.3.2.4 Nível pragmático 
 

Para a análise no nível pragmático, verificamos a linguagem do texto em como se dirige ao 

utilizador. Para isso, analisamos todas as ocorrências de pronomes, e como esse pronomes se 

relacionam com os verbos (pronome + verbo). Dessa forma, pudemos ver se o texto é mais pessoal ou 

impessoal. 

Por meio desta análise, pudemos verificar que o texto tem frases ativas, apresentando uma 

construção com sujeito + verbo + objeto, mas também apresenta frases passivas (sujeito + “ser” ou 
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“estar” + verbo no particípio), em que o sujeito sofre a ação, mas o agente da passiva é um elemento 

desconhecido. 

 

4.3.2.4.1 Textos em português de Portugal 

 

Para a análise no nível pragmático no corpus em português de Portugal, a busca pela identificação 

de como o texto interage com o interlocutor foi um pouco mais trabalhosa, pois há poucas marcações 

diretas de pronomes a este. Há apenas uma ocorrência de “você”, e não há menção do pronome “tu”, 

pois, no português de Portugal, é muito comum dirigir-se às terceira e segunda pessoas sem fazer 

menção aos pronomes “você” e “tu”, já que a interação com o interlocutor pode ser determinada pela 

conjugação dos verbos. Sendo assim, o texto atenta-se em reforçar essa interação por meio dos verbos. 

Para a análise do pronome “você” no corpus em português de Portugal, o Sketch Engine detectou 

somente uma ocorrência, conforme podemos ver na Figura 76: 

 

Figura 76: Ocorrência única do pronome você no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Por isso, para encontrar a interação do texto com o interlocutor no corpus em português de 

Portugal, analisamos as desinências verbais e a quem se dirige os pronomes (se a segunda ou terceira 

pessoa), entre outros. 

Há apenas uma ocorrência do pronome possesivo “teus”, na segunda pessoa do singular, 

conforme podemos ver na Figura 77: 

 

Figura 77: Ocorrência única do pronome possesivo teus no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 
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Em contrapartida, as variantes do pronome possesivo na terceira pessoa do singular (“seu”, 

“seus”, “sua” e “suas”) aparecem numa totalidade de 58 ocorrências, demonstradas na Figura 78: 

 
Figura 78: Ocorrências dos pronomes possesivos da terceira pessoa do singular no corpus em português de 

Portugal 

 
Fonte: Sketch Engine, 2021. 

 

No corpus em português de Portugal, não há ocorrência dos pronomes “nós” e “vós”, nem dos 

possessivos “nosso” e “vosso” e seus variantes de gênero e número. Há apenas quatro indicações da 

primeira pessoa do plural por meio de duas ocorrências do verbo “recomendamos” e duas do verbo 

“sugerimos”, evidenciando o sujeito “nós” como oculto, conforme podemos ver nas Figuras 79 e 80: 

 

Figura 79: Ocorrência do verbo recomendar na primeira pessoa do plural no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

Figura 80: Ocorrências do verbo sugerimos na primeira pessoa do plural no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 
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Dessa forma, vemos que o corpus em português de Portugal mantém um caráter formal, 

dialogando com o leitor por meio da conjugação dos verbos tanto na segunda quanto na terceira pessoal 

do singular, tornando-o também um pouco impessoal. Essa variação dos verbos conjugados ora na 

segunda pessoa, ora na terceira pessoa do singular, demonstra pouca padronização no texto.  

Para a análise dos pronomes gerais, vemos que o Sketch Engine detectou 230 ocorrências, com 

uma variedade maior do que apenas os pronomes de caso reto ou possessivos, como podemos ver na 

Figura 81: 

 

Figura 81: Ocorrências dos pronomes no corpus em português de Portugal 

 
Fonte: Sketch Engine, 2021. 

 

A partir da análise dessas ocorrências, elaboramos a Tabela 4 com a frequência de cada pronome 

em português em Portugal: 

 
Tabela 4: Frequência dos pronomes no corpus em português de Portugal 

Pronomes Frequência 

que 84 

se 73 

o 11 

isto 9 

mesmo 7 

qual 7 

lhe 5 

isso 5 

tal 4 
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tudo 4 

te+o 3 

todo 2 

como 2 

este 2 

cujo 2 

me 1 

muito 1 

ambos 1 

alguém 1 

você 1 

algo 1 

algum 1 

si 1 

quanto 1 

nenhum 1 

Fonte: Elaboração própria, 2021. 

 

Como podemos ver, o Sketch Engine detectou o pronome “que” com a maior frequência (84), o 

pronome oblíquo “se” com 73 e o pronome oblíquo “o” com 11. 

 

4.3.2.4.2 Textos em português do Brasil 

 

Para a análise no nível pragmático no português do Brasil, a identificação de como o texto interage 

com o interlocutor se deu pela busca dos pronomes “você” e dos possessivos referentes à terceira 

pessoa do singular “seu”, “seus”, “sua” e “suas”. Não há menção do pronome “tu” no corpus do 

português do Brasil. 
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Para a análise do pronome “você”, o Sketch Engine detectou 129 ocorrências, conforme a  

Figura 82: 

 
Figura 82: Ocorrências do pronome você no corpus em português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise dos pronomes possessivos, as variantes na terceira pessoa do singular (“seu”, 

“seus”, “sua” e “suas”) aparecem numa totalidade de 33 ocorrências, representadas na Figura 83: 

 

Figura 83: Ocorrências dos pronomes possesivos da terceira pessoa do singular no corpus em português do 

Brasil 

 
Fonte: Sketch Engine, 2021. 
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Assim como no corpus em português de Portugal, no corpus em português do Brasil não há 

ocorrência dos pronomes “nós” e “vós”, nem dos possessivos “nosso” e “vosso” e seus variantes de 

gênero e número. Há apenas três indicações da primeira pessoa do plural por meio de uma ocorrência 

do verbo “recomendamos” e duas do verbo “sugerimos”, evidenciando o sujeito “nós” como oculto, 

conforme podemos ver nas Figuras 84 e 85 a seguir: 

 

Figura 84: Ocorrência única do verbo recomendar na primeira pessoa do plural no corpus em português do 

Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Figura 85: Ocorrências do verbo sugerimos na primeira pessoa do plural no corpus em português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Sendo assim, vemos que o corpus em português do Brasil mantém um caráter levemente informal, 

dialogando com o leitor na maioria das vezes por meio do pronome “você” e seus pronomes possessivos, 

e por poucas vezes com o pronome “nós” em forma do sujeito oculto, tornando também o texto um 

pouco mais pessoal. 
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Para a análise dos pronomes gerais, vemos que o Sketch Engine detectou 319 ocorrências, com 

uma variedade maior do que apenas os pronomes de caso reto ou possessivos, como podemos ver na 

Figura 86: 

 
Figura 86: Ocorrências dos pronomes no corpus em português do Brasil 

 
Fonte: Sketch Engine, 2021. 

 

Por meio dos dados extraídos do Sketch Engine, elaboramos a Tabela 5 com a frequência de cada 

pronome em Português do Brasil, conforme a seguir: 

 

Tabela 5: Frequência dos pronomes no corpus em português do Brasil 

Pronomes Frequência 

você 129 

que 64 

se 50 

isso 18 

ele 11 

qual 10 

mesmo 6 

tudo 5 

como 5 

te+o 3 

aquele 3 

o 3 

quanto 2 

cujo 2 

este 1 
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algo 1 

ambos 1 

alguém 1 

muito 1 

esse 1 

qualquer 1 

nenhum 1 

Fonte: Elaboração própria, 2021. 

 

Como podemos ver, o Sketch Engine detectou o pronome pessoal “você” com a maior frequência 

(84), o pronome “que” com 64 e o pronome oblíquo “se” com 50. 

 

4.3.2.4.3 Textos em inglês 

 

Para a análise no nível pragmático no corpus em inglês, verificamos todas as ocorrências de 

pronomes isolados e pronomes combinados com verbos. 

Para a análise dos pronomes de forma isolada, sendo ele pronome sujeito ou possessivo, o Sketch 

Engine detectou 341 ocorrências, conforme representadas na Figura 87: 

 

Figura 87: Ocorrências totais de pronomes no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 
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Para a análise do pronome you, o Sketch Engine detectou 218 ocorrências, conforme podemos 

ver na Figura 88: 

 

Figura 88: Ocorrências do pronome you no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 
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Para a análise do pronome possessivo your, o Sketch Engine detectou 72 ocorrências, como 

podemos ver na Figura 89: 

 

Figura 89: Ocorrências do pronome your no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do pronome it, o Sketch Engine detectou 21 ocorrências, conforme representadas 

na Figura 90: 

 

Figura 90: Ocorrências do pronome it no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 
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Para a análise do pronome possessivo its, o Sketch Engine detectou apenas duas ocorrências, 

conforme a Figura 91: 

 

Figura 91: Ocorrências do pronome its no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do pronome we, o Sketch Engine detectou apenas quatro ocorrências, 

demonstradas na Figura 92: 

 

Figura 92: Ocorrências do pronome we no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

Para a análise do pronome they, o Sketch Engine detectou apenas seis ocorrências, representadas 

na Figura 93: 

 

Figura 93: Ocorrências do pronome they no corpus em inglês 

 

Fonte: Sketch Engine, 2021. 
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Para a análise do pronome possessivo their, o Sketch Engine detectou apenas uma ocorrência, 

como podemos ver na Figura 94: 

 
Figura 94: Ocorrência única do pronome they no corpus em inglês 

 

Fonte: Sketch Engine, 2021. 

 

Na Figura 95, podemos ver a análise das corrências dos pronomes combinados com verbos: 

 

Figura 95: Ocorrências de pronomes + verbos no corpus em inglês 

 

Fonte: Sketch Engine, 2021. 
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Para a análise dos pronomes gerais em sua totalidade, o Sketch Engine detectou a frequência de 

cada um, conforme demonstra a Figura 96: 

 

Figura 96: Ocorrências de pronomes no corpus em inglês 

 
Fonte: Sketch Engine, 2021. 

 

A partir dessa figura, elaboramos a Tabela 6 com a frequência de pronomes no corpus em inglês: 

 

Tabela 6: Frequência de pronomes no corpus em inglês 

Pronomes Frequência 

you 218 

your 72 

it 21 

one 9 

they 6 

we 4 

them 3 

itself 3 

me 2 

its 2 

their 1 

Fonte: Elaboração própria, 2021. 

 

Como podemos ver, o Sketch Engine detectou o pronome pessoal you com a maior frequência 

(218), o pronome posessivo your com 72 ocorrências, e o pronome neutro it com 21. 
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Analisando em sua totalidade, as ocorrências dos pronomes combinados com verbos em inglês 

foram identificadas da seguinte forma na Tabela 7: 

 
Tabela 7: Ocorrências de pronomes + verbos no corpus em inglês 

Pronome + verbo Ocorrências 

You + verbo 141 

Your + verbo 5 

It + verbo 6 

We + verbo 4 

They + verbo 4 

One + verbo 2 

Fonte: Elaboração própria, 2021. 

 

De acordo com os dados expostos a respeito dos pronomes tanto quando ocorridos isoladamente 

quanto combinados por verbos no corpus em inglês, verificamos uma maior ocorrência dos pronomes 

you e your, caracterizando assim o texto com a dêixis mais pessoal, pois dirige-se ao utilizador para dar 

o suporte, explicar o passo a passo das funcionalidades das aplicações e das possibilidades de sua 

utilização. 

Quando o pronome we é utilizado, está combinado duas vezes por recommend e duas vezes por 

suggest, o que demonstra um caráter polido para recomendar e sugerir ações que o utilizador pode 

realizar a fim de resolver seu problema, tornando o texto um pouco mais polido, mas também pessoal. 

 

4.3.2.5 Análise linguística multinível 

 

Com a análise linguística de caráter qualitativo, podemos concluir que: i) no nível terminológico, 

foram identificados um grande número de termos técnicos, muitos dos quais são específicos da 

Microsoft; ii) no nível sintático, foram observados padrões de uso de estruturas mais simples, como 

orações coordenadas; iii) no nível semântico-enunciativo, foram identificadas estratégias de construção 

de significado que visam a facilitar a compreensão do conteúdo técnico; iv) no nível pragmático, foram 

observadas marcas de interatividade, como uso de pronomes como “você”, ou apenas a conjugação dos 

verbos na terceira pessoa do singular, seus respetivos possesivos e instruções diretas, que visam a 

envolver o leitor na aprendizagem. 

Os resultados da análise linguística dos tutoriais da Microsoft sugerem que esses materiais são 

produzidos com o objetivo de atender às necessidades de um público-alvo específico, composto por 

utilizadores de tecnologia com diferentes níveis de conhecimento. 
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A utilização de um vocabulário técnico específico, a estrutura simples das orações e as estratégias 

de construção de significado visam a facilitar a compreensão do conteúdo técnico. As marcas de 

interatividade, por sua vez, visam a envolver o leitor na aprendizagem e a garantir que ele possa tirar o 

máximo proveito dos tutoriais. 

A análise linguística miltinível dos textos tutoriais da Microsoft revela que eles são textos injuntivos, 

porque têm como objetivo orientar o leitor a realizar uma ação, usando uma variedade de estratégias 

linguísticas, como o uso de verbos modais, formas imperativas e marcadores discursivos. 

Com isso, podemos concluir também que esse tipo de linguagem dos tutoriais da Microsoft facilita 

o aprendizado técnico por parte do operador informático multilingue de service desk, para que este possa 

prestar assistência ao utilizador de maneira mais ágil e eficaz. Essa interpretação corrobora a ideia da 

autora desta dissertação de que esses textos são eficientes e possuem utilidade no atendimento 

multilingue de service desk. 
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 Conclusão 

A realização desta dissertação permitiu conhecer e aprofundar conhecimentos mais teóricos da 

área de globalização, localização, tradução, tradução automática e service desk, e um pouco sobre a 

experiência da Microsoft com o seu processo de localização nos anos 1990. 

Ao analisar os conceitos de globalização, verificamos que há um aumento da demanda por 

operadores informáticos multilingues de service desk. Empresas de todo o mundo estão expandindo suas 

operações para novos mercados e precisam de funcionários que possam atender clientes em diferentes 

idiomas. Os conceitos de internacionalização, localização e tradução demonstraram-se essenciais para 

o sucesso desses profissionais, que precisam ter um conhecimento profundo dos mercados 

internacionais e das culturas em que atuam. Por exemplo, o desenvolvimento de novos produtos e 

serviços pode levar a mudanças nas necessidades dos clientes, exigindo dos agentes de service desk um 

preparo para se adaptar a essas mudanças. 

Os conceitos de service desk, as certificações da ITIL e a experiência de relato da autora indicam 

que os operadores informáticos multilingues de service desk precisam ter um alto nível de qualificação 

e boas práticas. Esse nível deve incluir um conhecimento profundo de tecnologia, idiomas e atendimento 

ao cliente. Por isso, os desafios que os operadores informáticos multilingues de service desk podem 

enfrentar são: precisar se atualizar constantemente, desenvolvendo novas habilidades – técnicas, como 

conhecimento de tecnologia e obter certificações; e interpessoais, como comunicação e resolução de 

problemas –; realizar os treinamentos da empresa em que atua com seriedade e comprometimento; 

manter um perfil de adaptabilidade para um mercado em constante mudança e competitividade; 

construir relacionamentos com outros profissionais da área para aprender sobre novas oportunidades e 

obter apoio. 

Com a descrição das implicações teóricas e práticas da relação entre os operadores informáticos, 

as ferramentas de tradução automática e os textos tutoriais da Microsoft, revela-se uma sinergia criativa 

que transcende barreiras linguísticas e culturais. Este estudo não apenas examinou a viabilidade técnica, 

mas também explorou o impacto humano nas relações tecnológicas ao tratar do uso das ferramentas de 

tradução automática e da pós-edição dessas ferramentas, examinando as percepções e opiniões dos 

próprios operadores informáticos – da autora e de seus colegas de trabalho por meio do questionário 

para a análise quantitativa – sobre essas ferramentas e os textos de suporte da Microsoft (Anexos  

I, II e III).  

A pesquisa quantitativa com 50 agentes da empresa A propiciou uma análise de forma prática 

sobre a utilidade da tradução automática durante o atendimento multilingue de service desk, na qual a 
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maioria dos operadores informáticos (92%) apontaram sua utilização, eficácia e ajuda durante o serviço. 

Portanto, os resultados da pesquisa apontaram que as ferramentas de tradução automática 

demonstraram-se úteis para os operadores informáticos multilingues de service desk. No que se refere 

à pós-edição, os resultados da pesquisa apontaram que a maioria dos operadores informáticos (88%) 

corrige os erros encontrados nos textos gerados pelas ferramentas de tradução automática, 

preocupando-se com a formalidade dos textos. Esses dados contribuem para concluirmos que, além da 

agilidade e paciência necessárias para resolver incidentes e requisições de serviços, os agentes de 

service desk possuem como desafios ser proficientes em idiomas e ter conhecimentos básicos de 

gramática. Isso permite que eles traduzam e editem textos de documentos, e-mails e chats, 

comunicando-se de forma adequada e atendendo às necessidades dos clientes. 

Além disso, a análise quantitativa entre os mesmos agentes apontou que menos da metade (46%) 

afirmou usar os textos de suporte da Microsoft durante o atendimento de service desk, enquanto a 

maioria (54%) confirmou sua utilidade e eficiência no desenvolvimento de suas funções. 

Com esses resultados da pesquisa, concluiu-se que as ferramentas de tradução automática 

demonstram-se eficazes para uma porcentagem relevante dos profissionais, e que os tutoriais da 

Microsoft demonstraram-se úteis, ainda que de uma forma não predominante, no atendimento 

multilingue de service desk. 

Ademais, concluiu-se que a ferramenta de tradução automática mais usada durante o atendimento 

de service desk foi o Google Tradutor, com 84%, enquanto o DeepL foi a segunda, com 10%, sendo o 

Google Tradutor a ferramenta mais popular nesse público e a mais usada para essa finalidade. 

Com isso, conforme o relato de experiência da autora desta dissertação de atuar como operadora 

informática multilingue de service desk, falante de português, inglês e italiano, esta pesquisa corrobora 

a ideia de que a tradução automática e os textos da Microsoft são ferramentas aliadas e úteis no 

atendimento multilingue no campo da tecnologia da informação. 

Para enriquecer a prática relacionada à tradução automática e à localização com o atendimento 

multilingue de service desk, foi feita uma análise linguística de caráter qualitativo de textos de suporte da 

Microsoft nos níveis terminológico, sintático, semântico-enunciativo e pragmático. A partir isso, pudemos 

ver o que é transversal e diferente nos corpora das versões em português de Portugal (Anexo IV), 

português do Brasil (Anexo V) e inglês (Anexo VI). 

Sendo assim, verificamos que, no nível terminológico, o português de Portugal e o português do 

Brasil têm vocábulos diferentes para expor palavras de mesmo significado, como “ficheiro” e “arquivo”, 

“guardar” e “salvar”, “utilizar” e “usar”. Vimos que é transversal em todos os corpora uma grande 
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frequência dos verbos “selecionar”, “ser” e “poder”, assim como seus correspondentes em inglês: 

select, be e can. 

No nível sintático, constatamos que é transversal em todos os corpora a predominância das 

conjunções coordenativas, determinando assim uma maior quantidade de orações coordenadas, com 

uma menor quantidade de orações subordinadas. 

No nível semântico-enunciativo, notamos que o corpus em português de Portugal utiliza o verbo 

“ter” apenas seguido da preposição “de”, enquanto o corpus em português do Brasil utiliza o verbo “ter” 

seguido da conjunção “que”. Além disso, vimos que, para indicar ações em continuidade, o corpus em 

português de Portugal utiliza o verbo “estar” seguido da preposição “a” mais um verbo no infinitivo (por 

exemplo, “está a ser”), enquanto o português do Brasil utiliza o verbo “estar” mais um verbo no gerúndio 

(“está sendo”), assim como o inglês (is/are being). Além disso, pudemos observar um comportamento 

transversal a todos os corpora com relação à utilização da voz passiva sem ter expresso o agente da 

passiva. Vimos também, na análise de corpus dos três idiomas escolhidos, que os verbos modais são 

uma ferramenta importante para a expressão de significados complexos. A análise dos textos tutoriais 

da Microsoft revela que esses verbos são usados com frequência para expressar uma variedade de 

significados, como possibilidade, necessidade, obrigação, permissão, tentativa, capacidade, conclusão e 

desejo. A análise linguística dos textos tutoriais da Microsoft revela que eles são textos injuntivos. Isso 

porque eles têm como objetivo orientar o leitor a realizar uma ação, usando uma variedade de estratégias 

linguísticas, como o uso de verbos modais, formas imperativas e marcadores discursivos. 

No nível pragmático, verificamos que o corpus em português de Portugal pouco utiliza o pronome 

pessoal “você”, havendo referência ao leitor apenas pela indicação da conjugação dos verbos (desinência 

de terceira pessoa do singular), apresentando um texto menos pessoal. Em contrapartida, vimos que o 

corpus em português do Brasil apresentou uma quantidade muito maior do pronome pessoal “você”, 

apresentando um texto com uma dêixis mais pessoal, assim como o texto em inglês, que continha a 

maior quantidade de pronomes pessoais you, demonstrando o mesmo estilo de pessoalidade. 

Portanto, a análise qualitativa dos três corpora relacionados com a informática e o universo da 

Microsoft permitiu constatar como a tradução automática e a localização podem ser relevantes para o 

atendimento multilingue de service desk. Ademais, possibilitou o contacto mais detalhado das 

ferramentas Word Counter, Voyant Tools e Sketch Engine para a extração de dados dos corpora, e do 

Excel para detectação dos dados e da realização de gráficos que representaram de forma clara esses 

dados extraídos. 
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A partir disso, a análise qualitativa contribuiu muito para o desenvolvimento desta dissertação, a 

fim de obtermos um olhar mais acurado sobre os textos de informática, evidenciando que mesmo um 

texto de natureza altamente técnica, relacionado à tecnologia e a dispositivos eletrónicos, pode 

apresentar um léxico profícuo e diferenciado. 

Em resumo, esperamos que o relato de experiência e as análises quantitativa e qualitativa para a 

realização deste trabalho possam contribuir de maneira significativa e linguística para os estudos de 

tradução e localização e para a atuação de profissionais operadores da tecnologia da informação. 

Levando-se em consideração que os textos de informática são frequentemente complexos e específicos, 

esperamos também contribuir e incentivar organizações internacionais que atuam em um mercado 

global a desenvolverem novas ferramentas e metodologias de tradução e localização para textos técnicos 

em seu ambiente de trabalho, a fim de melhorar a formação de seus operadores informáticos e para a 

obtenção de um atendimento multilingue de service desk mais eficaz. 
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 Anexos 

Anexo I – Questionário para a pesquisa quantitativa19 

 

 
 

  

 
19 Questionário realizado por meio do Google Forms em novembro de 2021. Recuperado em 11 de dezembro de 2023, de 
https://forms.gle/iKwopNwi4UnDye5y7. 
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Anexo II – Respostas do questionário para a pesquisa quantitativa por resumo 
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Anexo III – Respostas do questionário para a pesquisa quantitativa por pergunta 
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Anexo IV – Tutoriais da Microsoft em português de Portugal 

 
OUTLOOK 
Como configurar regras 
EXPERIMENTE! 
Utilize regras para organizar o seu e-mail. Crie uma regra baseada numa mensagem ou a partir de um modelo. 
 
Criar uma regra baseada numa mensagem 
Clique com o botão direito do rato numa mensagem e selecione Regras > Criar Regra. 
Selecione uma condição e o que fazer com a mensagem com base na condição. 
Por exemplo, para mover mensagens com um determinado título para uma pasta específica, selecione a condição Assunto contém, 
selecione Mover o item para a pasta, selecione ou crie uma pasta ao clicar em Novo e, em seguida, selecione OK. 
Quando terminar a criação da regra, selecione OK. 
Para utilizar a regra imediatamente, selecione a caixa de verificação Executar esta regra nas mensagens que já estão na pasta atual e, em 
seguida, selecione OK. 
A mensagem é agora apresentada nessa pasta. 
Criar uma regra a partir de um modelo 
Selecione Ficheiro > Gerir Regras e Alertas > Nova Regra. 
Selecione um modelo. 
Por exemplo, para sinalizar uma mensagem: 
Selecione Sinalizar mensagens de alguém para seguimento. 
Edite a descrição da regra. 
Clique num valor sublinhado, selecione as opções pretendidas e, em seguida, selecione OK. 
Selecione Seguinte. 
Selecione as condições, adicione as informações relevantes e, em seguida, selecione OK. 
Selecione Seguinte. 
Conclua a configuração da regra. 
Atribua um nome à regra, configure as opções da regra e reveja a descrição da regra. Clique num valor sublinhado para editá-lo. 
Selecione Concluir. 
Algumas regras serão executadas apenas quando o Outlook estiver aberto. Se for apresentado este aviso, selecione OK. 
Selecione OK. 
 
Outlook não responde a erro ou Outlook congela quando abre um ficheiro ou envia correio 
Sintomas 
Quando abre um ficheiro ou envia uma mensagem de correio eletrónico nas versões do Microsoft Outlook 2010 ou posterior, o Outlook 
congela ou recebe a seguinte mensagem de erro: 
Perspetivas não respondem 
 
 
Causa 
Este problema ocorre por uma ou mais das seguintes razões: 
Não instalou as últimas atualizações. 
O Outlook está a ser usado por outro processo. 
O Outlook está a carregar conteúdo externo, como imagens numa mensagem de correio eletrónico. 
Um add-in previamente instalado está a interferir com o Outlook. 
As suas caixas de correio são muito grandes. 
A sua pasta AppData é redirecionada para uma localização de rede. 
Tens de reparar os teus programas do Office. 
Os ficheiros de dados do Outlook ficaram corrompidos ou danificados. 
O seu software antivírus instalado está desatualizado, ou entra em conflito com o Outlook. 
O seu perfil de utilizador foi corrompido. 
Outro programa entra em conflito com o Outlook. 
 
Nota 
Esta questão pode ocorrer por uma ou mais das razões nesta secção. Para corrigir este problema, poderá ter de seguir os passos de 
resolução de problemas na secção resolução. 
Muitos destes itens podem ser verificados automaticamente pelo Microsoft Support and Recovery Assistant (SaRA). Para iniciar as 
verificações automatizadas, siga estes passos: 
Instale a ferramenta De diagnóstico avançado do Outlook. 
Selecione Executar quando for solicitado pelo seu navegador. 
No relatório gerado, reveja os itens no separador Questões encontrados. Para obter detalhes de configuração sobre Outlook, Windows e seu 
computador, reveja as definições no separador Visualização Detalhada. 
 
Resolução 
Para resolver este problema, certifique-se de que o seu computador cumpre os requisitos do sistema Outlook 2016, os requisitos do sistema 
Outlook 2013 ou os requisitos do sistema Outlook 2010. 
 
Nota 
Estes passos são fornecidos numa ordem específica baseada na comunhão e complexidade. Siga estes passos na ordem dada. 
 

https://aka.ms/SaRA-OutlookAdvDiagnostics
https://aka.ms/SaRA-OutlookAdvDiagnostics
https://aka.ms/SaRA-OutlookAdvDiagnostics
https://www.microsoft.com/microsoft-365/microsoft-365-and-office-resources
https://docs.microsoft.com/pt-pt/previous-versions/office/office-2013-resource-kit/ee624351(v=office.15)
https://docs.microsoft.com/pt-pt/previous-versions/office/office-2013-resource-kit/ee624351(v=office.15)
https://docs.microsoft.com/pt-pt/previous-versions/office/office-2010/ee624351(v=office.14)
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Passo 1 - Instale as últimas atualizações 
A instalação do Office no seu computador pode não estar atualizada. Isto pode ser porque o Windows Update não está configurado no seu 
computador para descarregar e instalar automaticamente atualizações recomendadas. Ao instalar atualizações importantes, recomendadas e 
opcionais, pode corrigir problemas substituindo ficheiros desatualizados e corrigindo vulnerabilidades. Para instalar as últimas atualizações do 
Office, clique no link para a sua versão do Windows e, em seguida, siga os passos do artigo: 
Instalar atualizações do Windows no Windows 10 
Atualização do Windows FAQ para Windows 8.1 
Instalar atualizações do Windows no Windows 7 
Instalar atualizações do Windows no Windows Vista 
Instalar atualizações do Windows no Windows XP 
Certifique-se de que as últimas atualizações do Outlook estão instaladas. Para obter mais informações, consulte Como instalar as últimas 
atualizações aplicáveis para o Microsoft Outlook (apenas em inglês dos EUA). 
 
Passo 2 - Certifique-se de que o Outlook não está a ser utilizado por outro processo 
O desempenho pode ser diminuído se utilizar a funcionalidade Outlook AutoArchive ou sincronizar com o Outlook com um dispositivo móvel. 
Isto porque estes processos podem utilizar um grande número de recursos. 
Se o Outlook estiver a ser utilizado por outro processo, esta informação é apresentada na barra de estado na parte inferior do ecrã. Se tentar 
realizar outras ações enquanto o Outlook estiver em uso, o Outlook pode não responder. Deixe a tarefa em curso terminar o seu trabalho 
antes de tentar outra ação. 
 
Passo 3 - Verifique o problema causado pelo conteúdo externo 
Para resolver esta questão, utilize um dos seguintes métodos: 
Impedir que o Outlook descarregue conteúdos externos. Para isso, aceda a Opções de Arquivo > Options > Trust Center > Baixar automático, 
selecione as seguintes duas opções: 
Não descarregue automaticamente imagens ou outros conteúdos na opção de e-mail HTML. 
Avisa-me antes de descarregar conteúdo ao editar, encaminhar ou responder a e-mails. 
Evite enviar um e-mail com fonte externa. 
 
Passo 4 - Investigar possíveis problemas adicionais 
Embora os add-ins possam melhorar a sua experiência de utilizador, podem ocasionalmente interferir ou entrar em conflito com o Outlook. 
Tente iniciar o Outlook sem quaisquer add-ins em execução. 
Como iniciar o Outlook sem add-ins 
Faça o seguinte, conforme apropriado para o seu sistema operativo: 
Se estiver a executar o Windows 8, deslize pela borda direita do ecrã e toque em Procurar. (Se estiver a usar um rato, aponte para o canto 
superior direito do ecrã, mova o ponteiro do rato para baixo e, em seguida, selecione Search.) Digite executar na caixa de pesquisa e, em 
seguida, toque ou selecione Executar. 
Se estiver a executar o Windows 10, Windows 7 ou Windows Vista, selecione Start. 
Se estiver a executar o Windows XP, selecione Iniciar e, em seguida, selecione Executar. 
Digite Outlook.exe /seguro e, em seguida, selecione OK. 
Se o problema for resolvido, selecione Opções no menu 'Ficheiro' e, em seguida, selecione Add-Ins. 
Selecione Add-ins COM e, em seguida, selecione Go. 
Limpe todas as caixas de verificação da lista e, em seguida, selecione OK. 
Reinicie o Outlook. 
Se o problema não ocorrer após o reinício do Outlook, um dos add-ins é provavelmente a causa do problema. Restaurar os add-ins um de 
cada vez até que o problema ocorra para determinar que add-in está causando o problema. 
 
Passo 5 - Verifique se a sua caixa de correio é muito grande 
À medida que o tamanho da sua caixa de correio aumenta, são necessários mais recursos para abrir cada pasta. Se tiver um grande número 
de itens numa única pasta, poderá experimentar problemas de desempenho durante determinadas operações. Para obter mais informações, 
consulte os problemas de desempenho do Outlook quando há demasiados itens ou pastas num modo em cache .ost ou .pst file. 
Recomendamos que mova vários itens nas suas pastas maiores para pastas separadas, ou que arquive esses itens utilizando a função 
AutoArchive. 
Como criar uma pasta 
No separador Pasta, selecione Nova Pasta no novo grupo. 
Na caixa Nome, insira um nome para a pasta. 
Na lista De seleção onde colocar a lista de pastas, selecione a localização para a nova pasta. 
 Nota 
A nova pasta tornar-se-á uma sub-dobra da pasta selecionada. 
Selecione OK. 
Para gerir a sua caixa de correio reduzindo o tamanho do ficheiro de dados do Outlook, consulte Reduzir o tamanho dos Ficheiros de Dados 
do Outlook (.pst e .ost). 
Para gerir a sua caixa de correio utilizando a função AutoArchive, consulte as definições AutoArchive explicadas. 
 
Passo 6 - Verifique se a sua pasta AppData está a ser redirecionada para uma localização de rede 
O Outlook armazena certos dados, tais como assinaturas de email e o dicionário de verificação ortográfico, na pasta AppData. Se a rede 
estiver a funcionar lentamente, o Outlook tem de esperar pela leitura e pela escrita das operações para o diretório appData para terminar. 
Como desativar a reorientação do diretório appData 
Saia do Outlook. 
Inicie o Editor de Registo. Para tal, utilize um dos seguintes métodos consoante a sua versão do Windows: 
Windows 10 ou Windows 8: Prima a tecla do Windows+R para abrir uma caixa de diálogo Run. Digite regedit.exe e, em seguida, prima OK. 
Windows 7: Selecione Iniciar, digite regedit.exe na caixa de pesquisa e, em seguida, prima Enter. 
No Editor de Registos, localize e selecione o seguinte sub-chave: 

https://support.microsoft.com/hub/4338813/windows-help?os=windows-10
https://support.microsoft.com/hub/4338813/windows-help?os=windows-8.1
https://support.microsoft.com/help/12373/windows-update-faq
https://support.microsoft.com/help/22882/windows-vista-end-of-support
https://support.microsoft.com/help/14223/windows-xp-end-of-support
https://docs.microsoft.com/pt-pt/outlook/troubleshoot/installation/install-outlook-latest-updates
https://docs.microsoft.com/pt-pt/outlook/troubleshoot/installation/install-outlook-latest-updates
https://support.microsoft.com/help/2768656
https://support.microsoft.com/office/reduce-the-size-of-your-mailbox-and-outlook-data-files-pst-and-ost-e4c6a4f1-d39c-47dc-a4fa-abe96dc8c7ef
https://support.microsoft.com/office/reduce-the-size-of-your-mailbox-and-outlook-data-files-pst-and-ost-e4c6a4f1-d39c-47dc-a4fa-abe96dc8c7ef
https://support.microsoft.com/office/autoarchive-settings-explained-444bd6aa-06d0-4d8f-9d84-903163439114
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HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\User Shell Folders 
Localize e clique duas vezes no valor AppData. 
Na caixa de dados valor, digite o seguinte caminho e, em seguida, selecione OK: 
%USERPROFILE%\AppData\Roaming 
 

 
 
Saia do Editor de Registo. 
 
Passo 7 - Programas do Gabinete de Reparação 
Pode reparar automaticamente os ficheiros do seu programa office para resolver problemas como o congelamento do Outlook ou não 
responder. 
Como reparar automaticamente o Escritório 
Saia de quaisquer programas do Microsoft Office que estejam em execução. 
Abra o Painel de Controlo e, em seguida, abra o item Add or Remove Programs (se estiver a executar o Windows XP) ou programas e 
funcionalidades (se estiver a executar o Windows 10, Windows 8, Windows 7 ou Windows Vista). 
Na lista de programas instalados, clique com o botão direito Microsoft Office 2016, Microsoft Office 2013 ou Microsoft Office 2010, e, em 
seguida, selecione Reparação. 
 
Passo 8 - Ficheiros de dados do Outlook de Reparação 
Quando instala o Outlook, também é instalada no seu PC uma ferramenta de reparação de caixas de entrada (scanpst.exe). A ferramenta de 
reparação de caixa de entrada pode resolver problemas digitalizando os ficheiros de dados do Outlook e reparando erros. Para utilizar a 
ferramenta de reparação de caixa de entrada, saia do Outlook e, em seguida, siga os passos nos Ficheiros de Dados do Outlook de 
Reparação (.pst e .ost). 
 
Passo 9 - Verifique se o software antivírus está atualizado ou entra em conflito com o Outlook 
Se o seu software antivírus não estiver atualizado, o Outlook pode não funcionar corretamente. 
Como verificar se o software antivírus está atualizado 
Para acompanhar os novos vírus à medida que são criados, os fornecedores de software antivírus fornecem periodicamente atualizações que 
podem descarregar a partir da Internet. Descarregue as últimas atualizações visitando o site do seu fornecedor de software antivírus. 
Para obter uma lista de fornecedores de software antivírus, consulte os fornecedores de software antivírus do consumidor para windows. 
Como verificar se o software antivírus entra em conflito com o Outlook 
Se o seu software antivírus incluir integração com o Outlook, poderá experimentar problemas de desempenho. Pode desativar toda a 
integração do Outlook dentro do software antivírus. Ou pode desativar quaisquer add-ins de software antivírus instalados no Outlook. 
 
Importante 
Quando alterar as definições antivírus, isto pode tornar o seu PC vulnerável a ataques virais, fraudulentos ou maliciosos. Não recomendamos 
que tente alterar as definições antivírus. Use esta solução por sua conta e risco. 
Poderá ter de contactar o seu fornecedor de software antivírus para determinar como configurar o software para excluir qualquer integração 
com o Outlook ou para excluir a digitalização no Outlook. 
 
Nota 
Se também planeia realizar a verificação de vírus ao nível de ficheiros de .pst, .ost, Offline Address Book (.oab), ou outros ficheiros Outlook 
enquanto o Outlook estiver em uso, consulte o Plano de pesquisa antivírus para o Outlook 2010 ou considerações de 
Planeamento para a implementação do Outlook 2016 para o Windows. 
 
Passo 10 - Criar um perfil de utilizador no Outlook 
Para criar um perfil de utilizador, siga estes passos: 
No Painel de Controlo, selecione Programas, selecione Contas de Utilizador e, em seguida, selecione Mail para abrir itens de Correio. 
Selecione Mostrar Perfis. 
Selecione o perfil que pretende remover e, em seguida, selecione Remover. 
Selecione Adicionar. 
Na caixa de diálogo 'Nome perfil', escreva um nome para o perfil. 
Especifique o nome do utilizador, o endereço SMTP principal e a palavra-passe. Em seguida, selecione Seguinte. 
Pode receber o seguinte aviso: 
Permitir que este site configufique <alias@domain configurações de> do servidor? 
Neste pedido, selecione a Não Me pergunte sobre esta caixa de verificação novamente e, em seguida, selecione Permitir. 
 
Passo 11 - Executar uma Startup Seletiva (utilizadores avançados) 
Quando inicia o Windows normalmente, várias aplicações e serviços começam automaticamente e depois são executados em segundo plano. 
Estas aplicações e serviços podem interferir com o Outlook. Um processo seletivo de Arranque ou "arranque limpo" pode ajudá-lo a 
identificar problemas que são causados por conflitos de aplicações. 
Se utilizar a opção Seletiva de Arranque na Configuração do Sistema, pode ligar ou desligar os programas de serviços e de arranque 
individualmente para verificar se o problema ocorre na próxima vez que iniciar o computador. Na Configuração do Sistema, se selecionar 

https://support.microsoft.com/office/repair-outlook-data-files-pst-and-ost-25663bc3-11ec-4412-86c4-60458afc5253
https://support.microsoft.com/office/repair-outlook-data-files-pst-and-ost-25663bc3-11ec-4412-86c4-60458afc5253
https://support.microsoft.com/help/18900/consumer-antivirus-software-providers-for-windows#avtabs=win7
https://docs.microsoft.com/pt-pt/previous-versions/office/office-2010/hh550032(v=office.14)
https://docs.microsoft.com/pt-pt/outlook/troubleshoot/installation/plan-outlook-2016-deployment#outlook-security-considerations
https://docs.microsoft.com/pt-pt/outlook/troubleshoot/installation/plan-outlook-2016-deployment#outlook-security-considerations
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uma caixa de verificação, o serviço relacionado ou o programa de arranque é executado quando reinicia o computador. Se a caixa de 
verificação for desmarcada, o programa de serviço ou arranque não funciona quando reinicia o computador. 
Siga este procedimento para utilizar o processo de eliminação para identificar o problema no Windows 10, Windows 8, Windows 7 ou 
Windows Vista. 
 
Nota 
Para obter mais informações sobre a realização de uma bota limpa, consulte Como executar uma bota limpa no Windows. 
Como fazer uma startup seletiva 
No Painel de Controlo, selecione Sistema e Segurança, selecione Ferramentas Administrativas e, em seguida, clique duas vezes na 
Configuração do Sistema. 
 
Nota 
Se for solicitado uma palavra-passe do administrador ou para confirmação, digite a palavra-passe ou forneça a confirmação. 
Selecione o separador Geral, selecione Selete startup, e, em seguida, limpe os serviços do sistema De Carga e os itens de arranque de 
carga verificam as caixas. 
Selecione a caixa de verificação dos serviços do sistema de carga, selecione OK e, em seguida, selecione Restart. 
Se o problema se repetir após reiniciar o computador, faça uma ou ambas as seguintes tarefas, se necessário. 
Para determinar que serviço de sistema está a causar o problema 
Na Configuração do Sistema, selecione o separador Serviços, selecione Desativar tudo, selecione a caixa de verificação para o primeiro 
serviço que está listado e, em seguida, reinicie o computador. 
 
Nota 
Se o problema não se repetir, então pode eliminar o primeiro serviço como a causa do problema. 
Com o primeiro serviço selecionado, selecione a segunda caixa de verificação de serviço e, em seguida, reinicie o computador. 
Repita este processo até reproduzir o problema. 
 
Nota 
Se não conseguir reproduzir o problema, pode eliminar os serviços do sistema como a causa do problema. 
Para determinar que item de arranque está a causar o problema 
Na Configuração do Sistema, selecione o separador Geral e, em seguida, selecione a caixa de verificação de itens de arranque de carga. 
Selecione o separador Iniciar, selecione Desativar tudo, selecione a caixa de verificação para o primeiro item de arranque que está listado e, 
em seguida, reinicie o computador. 
 
Nota 
Se o problema não se repetir, pode eliminar o primeiro item de arranque como a causa do problema. 
Enquanto o primeiro item de arranque é selecionado, selecione a segunda caixa de verificação de item de arranque e, em seguida, reinicie o 
computador. Repita este processo até reproduzir o problema. 
 
Passo 12 - Criar um perfil de utilizador do Windows (utilizadores avançados) 
O seu perfil de utilizador é uma coleção de definições que lhe permitem personalizar a aparência e desempenho do computador. Contém 
definições para fundos de ambiente de trabalho, aforradores de ecrã, definições de som e outras funcionalidades. Os perfis do utilizador 
ajudam a garantir que as suas preferências pessoais são utilizadas quando inicia sessão no Windows. 
Para determinar se este problema é causado por um perfil de utilizador corrompido, crie um perfil de utilizador para ver se o problema ainda 
ocorre quando utiliza o novo perfil. 
 
Como reparar um perfil de utilizador corrompido no Windows 8 
 
Passo 1 - Criar uma conta de utilizador 
Para criar um perfil de utilizador, tem primeiro de criar uma conta de utilizador. Quando a nova conta é criada, também é criado um perfil. 
Deslize pela borda direita do ecrã e, em seguida, toque em Procurar. (Se estiver a usar um rato, aponte para o canto superior direito do ecrã, 
mova o ponteiro do rato para baixo e, em seguida, selecione Search.) Tipo pedido de comando na caixa de pesquisa, clique com o botão 
direito Command Prompt e, em seguida, selecione Executar como administrador. 
 
Nota 
Se lhe for solicitada uma palavra-passe do administrador ou para confirmação, digite a palavra-passe ou forneça a confirmação. 
Digite o utilizador net UsernamePassword /add, e, em seguida, prima Enter. 
 
Passo 2 - Copiar ficheiros antigos para o novo perfil do utilizador** Depois de criar o perfil, pode copiar os ficheiros a partir do perfil existente 
 
Nota 
Deve ter pelo menos três contas de utilizador no computador para completar estes passos. Isto inclui a nova conta que acabou de criar. 
Faça login como um utilizador diferente do utilizador que acabou de criar ou do utilizador a partir do que pretende copiar ficheiros. 
No Painel de Controlo, selecione Aparência e Personalização e, em seguida, selecione Opções de Pasta. 
Selecione o separador Ver e, em seguida, selecione Mostrar ficheiros, pastas e unidades ocultas. 
Limpe a caixa de verificação de ficheiros do sistema operativo protegidos Oculta, selecione Sim para confirmar e, em seguida, selecione OK. 
Abra o Explorador de Ficheiros. Para isso, deslize pela borda direita do ecrã e, em seguida, toque em Search. (Se estiver a usar um rato, 
aponte para o canto superior direito do ecrã, mova o ponteiro do rato para baixo e, em seguida, selecione Search.) Introduza o Explorador de 
Ficheiros na caixa de pesquisa, toque ou selecione Apps e, em seguida, toque ou selecione O Explorador de Ficheiros. Tipo pedido de 
comando na caixa de pesquisa, clique com o botão direito Command Prompt e, em seguida, selecione Executar como administrador. 
Localizar a pasta C:\Utilizadores\Old_Username, na qual C é a unidade em que o Windows está instalado, e Old_Username é o nome do 
perfil a partir do qual pretende copiar ficheiros. 
Selecione todos os ficheiros e pastas desta pasta, exceto os seguintes ficheiros: 

https://support.microsoft.com/help/929135/how-to-perform-a-clean-boot-in-windows
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Ntuser.dat 
Ntuser.dat.log 
Ntuser.ini 
No menu Editar, selecione Copy. 
 
Nota 
Se não vir o menu Editar, prima Alt. 
Localize a pasta C:\Users\New_Username, na qual C é a unidade em que o Windows está instalado, e New_Username é o nome do perfil de 
utilizador que criou anteriormente neste método. 
No menu Editar, selecione Pasta. 
Faça login e, em seguida, volte a iniciar sessão como novo utilizador. 
 
Nota 
Se tiver mensagens de correio eletrónico num programa de e-mail, deve importar as suas mensagens de correio eletrónico e endereços para 
o novo perfil do utilizador antes de eliminar o perfil antigo. Se tudo estiver a funcionar corretamente, pode agora eliminar o perfil antigo. 
 
Próximo passo 
Se as informações neste artigo não ajudarem a resolver o seu problema no Outlook 2016, Outlook 2013 ou Outlook 2010, consulte os 
seguintes recursos para mais informações: 
Realize uma pesquisa para encontrar mais artigos online sobre este erro específico 
Visite a Comunidade microsoft online para publicar a sua pergunta sobre este erro 
Encontre o número de telefone apropriado para contactar o Microsoft Support 
 
Referências 
Corrija um perfil de utilizador corrompido na Janela 7 
Criar uma conta de utilizador no Windows 
 

  

https://support.microsoft.com/
https://answers.microsoft.com/
https://support.microsoft.com/contactus/
https://support.microsoft.com/help/14039
https://support.microsoft.com/help/13951
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EXCEL 
Analisar e formatar no Excel 
Preencher automaticamente uma coluna com o Preenchimento Automático 
Por exemplo, preencha automaticamente uma coluna Nome Próprio a partir de uma coluna Nome Completo. 
Na célula por baixo de Nome Próprio, escreva Mariana e prima Enter. 
Na célula seguinte, escreva as duas primeiras letras do nome Araújo. 
Quando a lista de valores sugeridos for apresentada, prima Enter. 

Selecione Opções de Preenchimento Automático  para obter mais opções. 
Experimente!    Selecione Ficheiro > Novo, Faça um tour e, em seguida, selecione o separador Preenchimento. 
 

 
 
Calcular rapidamente com a Soma Automática 
Selecione a célula abaixo dos números que pretende somar. 

Selecione Base > Soma Automática  . 
Prima Enter. 
Sugestão Para mais cálculos, selecione a seta para baixo junto a Soma Automática e selecione um cálculo. 
Também pode selecionar um intervalo de números para ver cálculos comuns na barra de estado. Consulte Ver dados de resumo na barra de 
estado. 
 

 
 
Criar um gráfico 
Utilize a ferramenta Análise Rápida para escolher o gráfico certo para os seus dados. 
Selecione os dados que pretende mostrar num gráfico. 

Selecione o botão Análise Rápida  na parte inferior direita das células selecionadas. 
Selecione Gráficos, paire o cursor sobre as opções e escolha o gráfico que pretende. 
Experimente! Selecione Ficheiro > Novo, Ver uma apresentação e, em seguida, selecione o separador Gráficos. Para mais informações, 
consulte Criar gráficos. 
 

 
 
Utilizar a formatação condicional 
Utilize Análise Rápida para realçar dados importantes ou apresentar tendências de dados. 
Selecione os dados a formatar condicionalmente. 

https://support.microsoft.com/pt-pt/office/ver-dados-sum%C3%A1rios-na-barra-de-estado-f42a3ae1-3786-4294-a433-1b36a1c17ebb
https://support.microsoft.com/pt-pt/office/ver-dados-sum%C3%A1rios-na-barra-de-estado-f42a3ae1-3786-4294-a433-1b36a1c17ebb
https://support.microsoft.com/pt-pt/office/231c42d2-5e58-40e1-99f0-cbe618cfee1d
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Selecione o botão Análise Rápida  na parte inferior direita das células selecionadas. 
Selecione Formatação, paire o cursor sobre as opções e escolha a opção que pretende. 
Experimente!    Selecione Ficheiro > Novo, Faça um tour e, em seguida, selecione o separador Análise. 
 

 
 
Fixar a linha de cima dos cabeçalhos 
Fixe a linha de cima dos cabeçalhos de coluna para que apenas os dados se desloquem. 
Prima Enter ou Esc para assegurar que terminou de editar uma célula. 
Clique em Ver > Fixar Painéis > Fixar Linha de Cima. 
Para obter mais informações, consulte Fixar painéis. 
 

 
 
Uso da memória na edição de 32 bits do Excel 2013 e 2016 
Nota 
O Office 365 ProPlus está a ser renomeado para Aplicações do Microsoft 365 para empresas. Para obter mais informações sobre essa 
alteração, leia este post no blog. 
Sintomas 
Depois de fazer o upgrade para o Microsoft Office 2013 ou 2016, experimenta um ou mais dos seguintes sintomas:  
O computador utiliza mais memória quando abre vários ficheiros do Microsoft Excel, guarda ficheiros Excel ou faz cálculos em livros de 
trabalho do Excel. 
Já não podeabrir tantos livros de trabalho do Excel no mesmo caso que poderia antes de ser atualizado para o Excel. 
Quando insere colunas num livro do Excel, recebe um erro sobre a memória disponível. 
Quando estiver a trabalhar com uma folha de cálculo do Excel, recebe a seguinte mensagem de erro: 
adocCopiar 
There isn't enough memory to complete this action. 
Try using less data or closing other applications. 
To increase memory availability, consider: 
- Using a 64-bit version of Microsoft Excel. 
- Adding memory to your device  
 

 
 
Causa 
Embora as melhorias no Office 2013/2016 não afetem significativamente os requisitos do sistema, o Office 2013/2016 utiliza mais recursos 
do sistema disponíveis do que o Office 2010. O limite do espaço de endereço virtual para edições de 32 bits de aplicações baseadas no 
Windows é de 2 gigabytes (GB). Para o Excel, este espaço é partilhado pela própria aplicação Excel juntamente com quaisquer add-ins que 
funcionam no mesmo processo. O tamanho da própria folha de cálculo também afeta o uso do espaço de endereço virtual. Como o Excel 
carrega a folha de cálculo em memória endereçada, algumas folhas de cálculo com um tamanho de ficheiro inferior a 2 GB podem ainda 
exigir que o Excel utilize mais de 2 GB de memória endereçada. Esta situação resulta na mensagem de erro que é mencionada na secção 
"Sintomas". 
 
Resolução 
Os utilizadores especialistas do Excel que trabalham com folhas de cálculo complexas do Excel podem beneficiar da utilização da edição de 
64 bits do Office 2013/2016. Isto porque a edição de 64 bits do Office não impõe limites rígidos ao tamanho dos ficheiros. Em vez disso, o 
tamanho do livro é limitado apenas pela memória disponível e pelos recursos do sistema. Por outro lado, a edição de 32 bits do Office está 

https://support.microsoft.com/pt-pt/office/fixar-pain%C3%A9is-para-bloquear-linhas-e-colunas-dab2ffc9-020d-4026-8121-67dd25f2508f
https://go.microsoft.com/fwlink/p/?linkid=2120533
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limitada a 2 GB de espaço de endereço virtual, e este espaço é partilhado pelo Excel, o livro de trabalho, e add-ins que funcionam no mesmo 
processo. (Folhas de cálculo inferiores a 2 GB no disco podem ainda conter dados suficientes para ocupar 2 GB ou mais de memória 
endereçada.) 
 
As seguintes opções podem ajudar a melhorar o desempenho no Excel 2013/2016: 
Os utilizadores do Excel que trabalham regularmente com grandes e complexas folhas de cálculo do Excel podem beneficiar da utilização da 
edição de 64 bits do Office 2013, porque edições de 64 bits de aplicações baseadas no Windows podem endereçar até 8 terabytes (TB) de 
memória. Saiba mais sobre edições de 64 bits do Office 2013. 
A limitação de 2 GB é por exemplo de processo de janelas do Excel. Pode executar vários ficheiros num caso. No entanto, se os ficheiros 
forem realmente grandes e tiverem de ser abertos, considere abrir vários casos para os outros ficheiros. Para obter informações sobre os 
limites que pode encontrar, veja não pode colar quaisquer atributos num livro em outro caso do Excel. 
Se estiver a executar o Windows 7 ou windows 2008, sugerimos que instale a atualização da Plataforma para windows 7 SP1 e Windows 
Server 2008 R2 SP1. 
Desempenho do teste sem add-ins COM. Os add-ins COM podem utilizar a memória em detrimento da limitação de 2 GB. Para testes, 
desative os add-ins COM e, em seguida, inicie o Excel. Se os add-ins com estiverem a causar o problema de memória, contacte o seu 
fornecedor de terceiros para obter uma cópia atualizada ou uma versão de 64 bits dos add-ins COM. 
Desative a aceleração gráfica do hardware. Isto desliga as animações. Para isso, no menu 'Ficheiro', clique em Opções, clique em 
Avançado, clique em Display, e, em seguida, selecione Desativar a aceleração gráficado hardware . 
Mude o seu livro para agilizar áreas que usam a memória desnecessariamente. Para alterações sugeridas, consulte Como limpar um livro 
excel 2013para que use menos memória . 
 
Nota 
O Excel 2016 de 32 bits será ativado para O365 Current Channel Consciente com atualização 4 de maio de 2016 construir número 
16.0.6868.2060 para os subscritores do Canal Atual O365. Para mais informações sobre a Atualização consciente de endereço grande 
clique aqui. 
 
Mais Informações 
Pode utilizar o Process Explorer para verificar se está a aproximar-se do limite de 2 GB no Excel. Considere qualquer coisa acima de 1,75 GB 
como um máximo para a edição de 32 bits do Excel. A coluna para se concentrar não está lá por defeito e pode ser adicionada escolhendo> 
Selecione Colunas> separador de memória de processo e clicando no Tamanho Virtual. 
Antes de passar para uma versão de 64 bits do Office, por favor reveja as informações neste link: 
https://technet.microsoft.com/library/ee681792.aspx 
Outros Recursos 
Como resolver problemas com os erros dos "recursos disponíveis" no Excel 
 

  

https://technet.microsoft.com/library/ee681792.aspx
https://docs.microsoft.com/pt-pt/office/troubleshoot/excel/cannot-paste-attributes
https://support.microsoft.com/help/2670838
https://support.microsoft.com/help/2670838
https://docs.microsoft.com/pt-pt/office/troubleshoot/excel/clean-workbook-less-memory
https://docs.microsoft.com/pt-pt/office/troubleshoot/excel/clean-workbook-less-memory
https://support.microsoft.com/help/3160741
https://technet.microsoft.com/sysinternals/bb896653.aspx
https://technet.microsoft.com/library/ee681792.aspx
https://support.microsoft.com/help/2779852
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POWERPOINT 
Criar uma apresentação no PowerPoint 
Com o PowerPoint no seu PC, Mac ou dispositivo móvel: 

▪ Crie apresentações de raiz ou a partir de um modelo. 

▪ Adicione texto, imagens, ClipArt e vídeos. 

▪ Selecione um design profissional com o Estruturador do PowerPoint. 

▪ Adicione transições, animações e movimento. 

▪ Guarde no OneDrive para aceder às suas apresentações a partir do seu computador, tablet ou telemóvel. 

▪ Partilhe e trabalhe com outras pessoas onde quer que esteja. 
 
Criar uma apresentação 

1. Abra o PowerPoint. 
2. Selecione uma opção: 

▪ Selecione Apresentação em Branco para criar uma apresentação de raiz. 

▪ Selecione um dos modelos. 

▪ Selecione Faça um tour e, em seguida, selecione Criar para ver sugestões de utilização do PowerPoint. 

▪  

 
 
Adicionar um diapositivo 

1. Selecione o diapositivo a seguir ao qual pretende colocar um novo. 
2. Selecione Base > Novo Diapositivo. 
3. Selecione Esquema e selecione o esquema que pretende no menu pendente. 

 
 
Adicionar e formatar texto 

1. Coloque o cursor onde quiser e escreva algo. 
2. Selecione o texto e, em seguida, selecione uma opção no separador Base: Tipo de letra, Tamanho do tipo de 

letra, Negrito, Itálico, Sublinhado, ... 
3. Para criar listas numeradas ou com marcas, selecione o texto e, em seguida, selecione Marcas ou Numeração. 
4.  
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Adicionar uma imagem, forma ou gráfico 

1. Selecione Inserir. 
2. Para adicionar uma imagem: 

▪ Selecione Imagem. 

▪ Procure a imagem que pretende e selecione Inserir. 
3. Para adicionar uma forma, uma imagem ou um gráfico: 

▪ Selecione Formas, Ícones, SmartArt ou Gráfico. 

▪ Selecione o que pretende. 

▪  

 
 
Como resolver problemas com uma apresentação danificada no Powerpoint 
 Nota 
O Office 365 ProPlus está a ser renomeado para Aplicações do Microsoft 365 para empresas. Para obter mais informações sobre essa 
alteração, leia este post no blog. 
 
Resumo 
Poderá deparar-se com um comportamento inesperado ao trabalhar com uma apresentação do Microsoft PowerPoint. Esse comportamento 
pode ocorrer, porque a apresentação está danificada. Este artigo contém métodos passo a passo que podem ajudá-lo a restaurar a sua 
apresentação parcial ou totalmente. 
Este artigo destina-se a utilizadores inexperientes a intermédios. Poderá ser mais fácil seguir os passos descritos se imprimir primeiro este 
artigo. 
 
Sintomas 
Quando tenta abrir ou alterar uma apresentação que está danificada, poderá observar os seguintes sintomas: 

● Quando tenta abrir uma apresentação, recebe uma das seguintes mensagens de erro: 
Esta não é uma Apresentação do PowerPoint 
O PowerPoint não consegue abrir o tipo de ficheiro representado por <file_name>.ppt 
Falta parte do ficheiro. 

● Recebe os seguintes tipos de mensagem de erro: 
Falha de Proteção Geral 
Instrução Ilegal 
Falha de Página Inválida 
Recursos do sistema insuficientes 
Memória Esgotada 
 

Mais Informações 

Como determinar se tem uma apresentação danificada 
Existem várias maneiras de determinar se tem uma apresentação danificada. Pode tentar abrir o ficheiro noutro computador que tenha o 
PowerPoint instalado para ver se o comportamento inesperado ocorre no outro computador. Pode tentar criar um novo ficheiro no 
PowerPoint e ver se o comportamento inesperado ocorre com o novo ficheiro. Esta secção descreve como usar apresentações existentes e 
como criar um novo ficheiro no PowerPoint para determinar se as apresentações têm o mesmo comportamento. 
 
Método 1: Abra uma apresentação existente 

https://go.microsoft.com/fwlink/p/?linkid=2120533
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1. No menu Ficheiro , clique em Abrir . 
o No PowerPoint 2007, selecione o Botão do Microsoft Office . 

2. Selecione uma apresentação diferente e, em seguida, selecione Abrir. 
Se esta apresentação abrir e parecer não estar danificada, vá para o Método 3 nesta secção. Caso contrário, vá para o Método 2 para criar 
uma nova apresentação. 

 
Método 2: Criar uma nova apresentação 
Passo 1: Crie a apresentação 

1. No menu Ficheiro , selecione Novo e, em seguida, Bem-vindo ao PowerPoint (ou Introdução ao PowerPoint 2010 ). 
o No PowerPoint 2007, selecione Modelos Instalados e, de seguida, selecione Introdução ao PowerPoint 2007 . 

2. Selecione Criar . Este processo cria uma apresentação baseada no modelo. 
3. No menu Ficheiro , selecione Guardar . 

o No PowerPoint 2007, selecione o Botão do Microsoft Office e, em seguida, selecione Guardar . 
4. Escreva um nome para a apresentação e, em seguida, selecione Guardar . 
5. Sair do PowerPoint. 

Passo 2: Abrir a nova apresentação 
1. No menu Ficheiro , clique em Abrir . 

o No PowerPoint 2007, selecione o Botão do Microsoft Office e, em seguida, selecione Abrir . 
2. Selecione a nova apresentação e, em seguida, selecione Abrir . 

Se não conseguir abrir ou guardar a nova apresentação, vá para o Método 3. 
Se não conseguir criar uma nova apresentação, o PowerPoint pode estar danificado e deverá ser feita uma reparação. (Ver Método 3, Parte 2 
abaixo.) 

 
Método 3: Resolução de problemas geral 
Windows 10, Windows 8.1, Windows 8 e Windows 7 
 
Parte 1 
Este procedimento permite que o seu computador reinicie sem suplementos de arranque. Para um reinício limpo, siga estes passos: 

1. Inicie sessão no computador utilizando uma conta que tenha direitos de administrador. 
2. Clique em Iniciar, escreva msconfig.exe na caixa Iniciar Pesquisa e, em seguida, prima Enter para iniciar o utilitário de 

Configuração do Sistema. 
 
Nota 
Se lhe for pedido para introduzir uma palavra-passe de administrador ou para confirmar, deverá escrever a palavra-passe ou 
confirmar. 

3. No separador Geral , selecione a opção Arranque seletivo e, em seguida, clique para desmarcar a caixa de verificação Carregar 
itens de arranque . (A caixa de verificação Utilizar Boot.ini Original está indisponível). 

4. No separador Serviços, selecione a caixa de verificação Ocultar todos os serviços da Microsoft e, em seguida, selecione Desativar 
todos. 
 
Nota 
Este passo permite que os serviços da Microsoft continuem a ser executados. Depois de fazer um reinício limpo, deve verificar o 
desempenho do Office e, em seguida, retomar o arranque habitual. 

 
Parte 2 
Este procedimento fará com que o programa Office verifique os problemas e se repare autonomamente. 

1. Clique no botão Iniciar e escreva Painel de Controlo. 
2. Abra o Painel de Controlo, vá para Desinstalar ou alterar um programa (ou Adicionar ou Remover Programas ). 
3. Percorra a lista de programas e procure a sua versão do Microsoft Office. Clique com o botão direito do rato e, em seguida, 

selecione Alterar . 
 
Nota 
Sugerimos que escolha a opção de reparação online. 
 

Métodos para tentar se não conseguir abrir uma apresentação 
 
Método 1: Arraste a apresentação para o ícone de ficheiro do programa PowerPoint 
Windows 10, Windows 8.1 e Windows 8 

1. Clique com o botão direito no ícone do Windows na Barra de Tarefas e, em seguida, selecione Executar. 
2. Escreva um dos seguintes, consoante a sua versão do Powerpoint: 

PowerShellCopiar 
%ProgramFiles%\Microsoft Office 
%ProgramFiles(x86)%\Microsoft Office 

3. Selecione a tecla Enter. 
4. Localize o ícone Powerpnt.exe no Windows Explorer. 
5. Arraste o ícone da apresentação danificada de uma janela para o ícone Powerpnt.exe na outra janela. 

 
O PowerPoint tentará abrir a apresentação. Se o PowerPoint não abrir a apresentação, vá para o Método 2. 
Windows 7 

1. Selecione Iniciar e, em seguida, selecione Documentos. Ou selecione Iniciar e, em seguida, pesquise pelo Windows Explorer. 
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2. Se tiver a versão MSI do PowerPoint 2013 instalada, digite %ProgramFiles%\Microsoft Office\office15 (PowerPoint 2013 64 bits) ou 
%ProgramFiles(x86)%\Microsoft Office\office15 (PowerPoint 2013 32 bits) e, em seguida, pressione Enter. 
Se tiver o PowerPoint 2013 Select-to-Run instalado, digite C:\Program Files\Microsoft Office 15\root\office15 (PowerPoint 2013 64 
bits) ou C:\Program Files(x86)\Microsoft Office 15\root\office15 (PowerPoint 2013 32 bits) e, em seguida, pressione Enter. 
Se tiver a versão MSI do PowerPoint 2016 instalada, digite %ProgramFiles(x86)%\Microsoft Office\office16 e, em seguida, 
pressione Enter. 
Se tiver o PowerPoint 2016 Select-to-Run instalado, digite %ProgramFiles%\Microsoft Office\root\Office16 (PowerPoint 2016 64 
bits) ou %ProgramFiles(x86)%\Microsoft Office\root\Office16 (PowerPoint 2016 32 bits) e, em seguida, pressione Enter. 

3. Localize o ícone Powerpnt.exe no Windows Explorer. 
4. Arraste o ícone da apresentação danificada de uma janela para o ícone Powerpnt.exe na outra janela. 

 
Método 2: Tente inserir diapositivos numa apresentação em branco 
Passo 1: Criar uma apresentação em branco 

1. No menu Ficheiro, selecione Novo. 
o No PowerPoint 2007, clique no Botão do Microsoft Office e, em seguida, clique em Novo . 

2. Selecione Apresentação em Branco e, em seguida, selecione Criar. 
Esse processo cria um diapositivo com o título em branco. Pode excluir este diapositivo mais tarde depois de recriar a apresentação. 
 
Passo 2: Insira a apresentação danificada como diapositivos 

1. No separador Base, clique na seta ao lado de Novos diapositivos no grupo Diapositivos e, em seguida, selecione Reutilizar 
Diapositivos. 

2. No painel de tarefas Reutilizar Diapositivos, selecione Procurar. Selecione a apresentação danificada e, em seguida, selecione Abrir. 
3. Selecione Inserir Diapositivo para cada diapositivo na apresentação danificada. 
4. No menu Ficheiro , selecione Guardar. 

o No PowerPoint 2007, clique no Botão do Microsoft Office e, em seguida, clique em Guardar . 
5. Escreva um novo nome para a apresentação e, em seguida, selecione Guardar. 

 
Passo 3: Aplique a apresentação danificada como modelo 
Se a apresentação não se assemelhar ao esperado, depois de experimentar estes passos, tente aplicar a apresentação danificada como um 
modelo. Para tal, siga estes passos: 

1. No menu Ficheiro, selecione Guardar como. 
o No PowerPoint 2007, clique no Botão do Microsoft Office e, em seguida, clique em Guardar como . 

2. Escreva um novo nome para a apresentação e, em seguida, selecione Guardar. 
 
Nota 
Isto fará uma cópia de segurança da apresentação restaurada que poderá usar no caso da apresentação danificada danificar esta 
nova apresentação. 
 

3. No separador Estrutura, selecione Mais no grupo Temas e, em seguida, selecione Procurar Temas. 
4. Selecione a apresentação danificada e, em seguida, selecione Aplicar. O modelo global de diapositivos da apresentação danificada 

substitui o novo modelo global de diapositivos. 
 
Nota 
Se começar a observar um comportamento inesperado depois de seguir estes passos, o modelo pode ter danificado a apresentação. Neste 
caso, use a cópia de segurança para recriar o modelo global de diapositivos. 
Se a cópia de segurança da nova apresentação exibir o mesmo dano ou comportamento estranho que a apresentação original, vá para o 
Método 3. 

 
Método 3: Tente abrir a versão de ficheiro temporária da apresentação 
Quando edita uma apresentação, o PowerPoint cria uma cópia temporária do ficheiro. Este ficheiro temporário é designado por PPT 
####.tmp. 
 
Nota 
O marcador de posição #### representa um número aleatório de quatro dígitos. 
Este ficheiro temporário pode estar localizado na mesma pasta do local no qual foi guardada a apresentação. Ou pode estar localizado na 
pasta de ficheiros temporários. 
Mude o nome do ficheiro e, em seguida, tente abrir o ficheiro no PowerPoint 

1. Clique com o botão direito do rato no ficheiro e, em seguida, selecione Mudar o Nome. 
2. Altere a antiga extensão do nome de ficheiro de .tmp para .pptx para que o nome do ficheiro se assemelhe ao seguinte nome de 

ficheiro: 
PPT ####.pptx 

3. Iniciar o PowerPoint. 
4. No menu Ficheiro, clique em Abrir. 
5. Navegue até a pasta que contém o ficheiro renomeado. 
6. Tente abrir o ficheiro no PowerPoint. 

 
Nota 
Mais de um ficheiro poderá corresponder ao ficheiro temporário que foi criado da última vez que guardou a apresentação. Neste caso, 
poderá ter que abrir cada ficheiro para ver se algum é a cópia temporária da apresentação. 
Se não houver ficheiros temporários ou se os ficheiros temporários exibirem o mesmo tipo de dano ou comportamento estranho, vá para o 
Método 4. 
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Método 4: Faça uma cópia da apresentação danificada 

1. Clique com o botão direito do rato na apresentação e, em seguida, selecione Copiar. 
2. Na janela do Windows Explorer, clique com o botão direito do rato num espaço em branco e, em seguida, selecione Colar. 

Se não conseguir copiar o ficheiro, o ficheiro pode estar danificado ou o ficheiro pode residir numa parte danificada do disco rígido do 
computador. Neste caso, vá para o Método 5. 
Se puder copiar o ficheiro, tente abrir a cópia da apresentação danificada no PowerPoint. Se não conseguir abrir a cópia da apresentação 
danificada, tente repetir do Método 1 até ao Método 5 na secção "Métodos para tentar se não conseguir abrir uma apresentação" abaixo, 
utilizando a cópia da apresentação danificada. 

 
Método 5: Executar Verificação de Erros na unidade do disco rígido 
Windows 10, Windows 8.1 e Windows 8 

1. Saia de todos os programas abertos. 
2. Clique com o botão direito do rato no menu Iniciar e selecione Explorador de Ficheiros . 
3. Clique com o botão direito do rato na unidade de disco rígido que contém a apresentação danificada. 
4. Selecione Propriedades e, em seguida, selecione o separador Ferramentas. 
5. Na Verificação de erros, selecione Verificar Agora. 
6. Selecione a caixa de seleção Correção automática de erros do sistema de ficheiros. 
7. Selecione a caixa de seleção Procurar e tentar recuperar setores danificados. 
8. Selecione Iniciar. 

Windows 7 
1. Saia de todos os programas abertos. 
2. Selecione Iniciar e, em seguida, selecione Computador. 
3. Clique com o botão direito do rato na unidade de disco rígido que contém a apresentação danificada. 
4. Selecione Propriedades e, em seguida, selecione o separador Ferramentas. 
5. Na Verificação de erros, selecione Verificar Agora. 
6. Clique para selecionar a caixa de verificação Correção automática de erros do sistema de ficheiros. 
7. Clique para selecionar a caixa de verificação Procurar e tentar recuperar sectores danificados. 
8. Selecione Iniciar. 

 
Nota 
A verificação de erros pode verificar que a apresentação tem ligações cruzadas e tentar reparar a apresentação. No entanto, isso não é 
garantia de que o PowerPoint será capaz de ler a apresentação. 
 
Métodos para tentar se consegue abrir uma apresentação danificada 
Método 1: Tente aplicar a apresentação danificada como modelo 
Passo 1: Criar uma apresentação em branco 

1. No menu Ficheiro , selecione Novo . 
o No PowerPoint 2007, selecione o Botão do Microsoft Office e, em seguida, selecione Novo . 

2. Selecione Apresentação em Branco e, em seguida, selecione Criar . Esse processo cria um diapositivo com o título em branco. 
(Poderá eliminar este diapositivo depois de recriar a apresentação.) 

 
Passo 2: Insira a apresentação danificada na apresentação em branco 

1. No separador Base , selecione a seta ao lado de Novos diapositivos no grupo Diapositivos e, em seguida, selecione Reutilizar 
Diapositivos . 

2. No painel de tarefas Reutilizar Diapositivos , selecione Procurar . 
3. Selecione a apresentação danificada e, em seguida, selecione Abrir . 
4. Selecione Inserir Diapositivo para cada diapositivo na apresentação danificada. 
5. Selecione o botão do Microsoft Office e, em seguida, selecione Guardar . 
6. Escreva um novo nome para a apresentação e, em seguida, selecione Guardar. 

 
Passo 3: Aplique a apresentação danificada como modelo 
Se a apresentação não se assemelhar ao esperado, depois de tentar seguir estes passos, tente aplicar a apresentação danificada como um 
modelo. Para tal, siga estes passos: 

1. No menu Ficheiro , selecione Guardar como . 

● No PowerPoint 2007, selecione o Botão do Microsoft Office e, em seguida, selecione Guardar como . 
1. Escreva um novo nome para a apresentação e, em seguida, selecione Guardar . 

 
 Nota 
Isto fará uma cópia de segurança da apresentação restaurada que poderá usar no caso da apresentação danificada danificar esta 
nova apresentação. 

2. No separador Estrutura selecione Mais no grupo Temas e, em seguida, selecione Procurar Temas . 
3. Selecione a apresentação danificada e, em seguida selecione Aplicar . O modelo global de diapositivos da apresentação danificada 

substitui o novo modelo global de diapositivos. 
 
Nota 
Se começar a observar um comportamento inesperado depois de seguir estes passos, o modelo pode ter danificado a apresentação. Neste 
caso, use a cópia de segurança para recriar o modelo global de diapositivos. 
Se a cópia de segurança da nova apresentação ainda exibir danos ou comportamentos estranhos, vá para o Método 2. 

 
Método 2: Transfira os diapositivos da apresentação danificada para uma apresentação em branco 
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Passo 1: Criar uma apresentação em branco 
1. No menu Ficheiro no PowerPoint, selecione Abrir . 

o No PowerPoint 2007, selecione o Botão do Microsoft Office e, em seguida, selecione Abrir . 
2. Selecione a apresentação danificada e, em seguida, selecione Abrir . 
3. No menu Ficheiro no PowerPoint, selecione Novo . 

o No PowerPoint 2007, selecione o Botão do Microsoft Office e, em seguida, selecione Novo . 
4. Selecione Apresentação em Branco e, em seguida, selecione Criar . Esse processo cria um diapositivo com o título em branco. 

 
Passo 2: Copie os diapositivos da apresentação danificada para a nova apresentação 

1. No separador Ver , selecione Organização de Diapositivos . Se receber mensagens de erro ao mudar de vistas, tente utilizar a Vista 
de Destaques. 

2. Selecione o diapositivo que pretende copiar. No separador Base selecione Copiar . 
 
Nota 
Se quiser copiar mais de um diapositivo de cada vez, mantenha premida a tecla Shift e, de seguida, selecione cada diapositivo que 
deseja copiar. 
 

3. Mude para a nova apresentação. Para fazer isso, no separador Janela, selecione Mudar de Janela no grupo Ver e, de seguida, 
selecione a nova apresentação que criou na etapa 1. 

4. No separador Ver, selecione Organização de Diapositivos. 
5. No separador Base, selecione Colar. 
6. Repita os passos 2a a 2f até que toda a apresentação seja transferida. 

 
Nota 
Em alguns casos, um diapositivo danificado pode causar um problema a toda a apresentação. Se notar um comportamento inesperado na 
nova apresentação depois de copiar um diapositivo para a apresentação, é provável que esse diapositivo esteja danificado. Recrie o 
diapositivo ou copie secções do diapositivo para um novo diapositivo. 
Se a nova apresentação mostrar danos ou comportamentos estranhos, vá para o método 3. 

 
Método 3: Guarde a apresentação como um ficheiro de formato RTF (Rich Text Format) 
Se houver danos ao longo da apresentação, a única opção para recuperar a apresentação poderá ser guardar a apresentação como um 
ficheiro de formato RTF (Rich Text Format). Se este método for bem sucedido, apenas recupera o texto que aparece na Vista de Destaque. 
 
Passo 1: Guarde a apresentação no formato de ficheiro RTF 

1. Abra a apresentação. 
2. No menu Ficheiro , selecione Guardar Como , selecione um local para guardar o ficheiro e selecione Mais opções . 

o No PowerPoint 2007, selecione o Botão do Microsoft Office , selecione Guardar Como e, de seguida, selecione Outros 
Formatos . 

3. Na lista Guardar com o tipo , selecione Outline/RTF(*.rtf) . 
4. Na caixa Nome de Ficheiro , digite o nome que deseja utilizar, selecione um local para guardar a apresentação e, de seguida, 

selecione Guardar . 
5. Feche a apresentação. 

 
Nota 
Quaisquer gráficos, tabelas ou outro texto na apresentação original não serão guardados no ficheiro .rtf. 
 
Passo 2: Abra o ficheiro .rtf no PowerPoint 

1. No menu Ficheiro , clique em Abrir . 
2. Na lista Ficheiros do tipo , selecione Todos os Destaques ou Todos os Ficheiros . 
3. Selecione o ficheiro .rtf que guardou na etapa 1d e, em seguida, selecione Abrir . 

Este procedimento recriará a apresentação com base na vista de destaque da apresentação original. 
 
WORD 
Ativar e desativar a opção Registar Alterações 
Ativar a opção Registar Alterações permite que você e os seus colegas façam alterações fáceis de identificar. As alterações são como 
sugestões que pode rever e, em seguida, eliminar ou tornar permanentes. 
No separador Rever, vá ao Tracking e selecione Track Changes. 
 

 
 
Quando as Alterações de Pista estão em curso, as eliminações são marcadas com um strikethrough, e as adições são marcadas com um 
sublinhado. As alterações dos diferentes autores são indicadas com cores diferentes. 
Quando as Alterações de Faixa estão desligadas, o Word para de marcar alterações, mas os sublinhados coloridos e as alterações das suas 
alterações permanecem no documento até que sejam aceites ou rejeitados. 
 
Nota: Se a funcionalidade Alterações de Faixa não estiver disponível, poderá ter de desligar a proteção do documento. Vá rever > restringir a 
edição e, em seguida, selecione Stop Protection. (Pode ser necessário fornecer a senha do documento.) 
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Mostrar ou ocultar comentários ou alterações registadas 
Apresentar todas as alterações inline 
O padrão na Word é exibir supressões e comentários em balões nas margens do documento. No entanto, pode alterar a apresentação para 
mostrar comentários inline e todas as eliminações com rasurados em vez de dentro de balões. 
No separador Review, vá ao Tracking. 
Selecione Mostrar Marcação. 
 

 
 
Aponte para balões e selecione Mostrar todas as revisões Inline. 
Ver comentários inline como ScreenTips. 
Coloque o ponteiro sobre um comentário no documento. O comentário é apresentado numa descrição. 
 

 
 
Mostrar alterações por tipo de edição ou por revisor 
No separador Rever, vá ao Tracking e selecione Mostrar Markup. 
 

 
 
Siga um dos seguintes passos: 
Selecione o tipo de alteração que pretende apresentar. 
 
Por exemplo, selecione Comentários, Inserções e Supressões,ou Formatação. A marca de verificação junto ao item indica que o mesmo está 
selecionado. 
 

 
 
Importante: Mesmo que oculte um tipo de marcação ao desmarcá-lo no menu Mostrar Marcação, a marcação é apresentada automaticamente 
cada vez que o documento é aberto por si ou por um revisor. 
 
Aponte para pessoas específicas, e depois limpe todas as caixas de verificação, exceto as que estão ao lado dos nomes dos revisores cujas 
alterações e comentários pretende mostrar. 
 
Nota: Para selecionar ou limpar todas as caixas de verificação para todos os revisores da lista, selecione Todos os Revisores. 
 
Apresentar alterações e comentários de revisores específicos 
Normalmente, um editor ou revisor quer ver um documento tal como será apresentado após as alterações serem incorporadas. Este 
procedimento dá ao editor ou revisor a oportunidade de ver o aspeto que o documento terá com as alterações aplicadas. 
 
Vá rever> rastreio> display para revisão. 
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Selecione a opção que pretende: 
Para rever as alterações indicadas por uma linha vermelha na margem, selecione Marcação Simples. 
Para obter uma vista detalhada das alterações, selecione Todas as Marcações. 
Para pré-visualizar o aspeto do documento como se todas as alterações sugeridas fossem permanentes, selecione Sem Marcações. 
Para ver o documento original como se todas as alterações sugeridas tivessem sido removidas, selecione Original. 
Ocultar alterações registadas e comentários ao imprimir 
Ocultar as alterações não as remove do documento. Para remover a marcação do seu documento, utilize os comandos Aceitar e Rejeitar no 
grupo Alterações. 
Vá para > Imprimir > definições de >> Imprimir todas as páginas. 
Em Informações de Documento, selecione Print Markup para limpar a marca de verificação. 
 

 
 
Rever, aceitar, rejeitar e ocultar alterações registadas 
Rever um resumo das alterações registadas 
Utilizando o Painel de Revisão, pode assegurar-se rapidamente de que todas as alterações rastreadas foram removidas do seu documento. A 
secção de resumo na parte superior do Painel de Revisão apresenta o número exato de comentários e alterações registadas que permanecem 
no seu documento. 
O Painel de Revisão também lhe permite ler comentários longos que não cabem em balões de comentários. 
 
Nota: O Painel de Revisão, ao contrário do documento ou dos balões de comentários, não é a ferramenta mais indicada para fazer alterações 
ao seu documento. Em vez de eliminar texto ou comentários ou de efetuar outras alterações no Painel de Revisão, faça todas as alterações no 
documento. As alterações ficarão visíveis no Painel de Revisão. 
 
No separador 'Rever', vá ao Tracking e selecione Reviewing Panel. 
 

 
 
Siga um dos seguintes procedimentos: 
Para ver o resumo ao lado do ecrã, selecione Rever o Painel Vertical. 
Para ver o resumo na parte inferior do ecrã, selecione Reviewing Pane Horizontal. 
Por padrão, o Painel de Revisão mostra no topo quantas revisões totais estão no documento. Para ver o número e o tipo das alterações, 
selecione o quilate ao lado do número de revisões. 
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Reveja cada alteração na sequência 
Clique ou toque no início do documento. 
No separador Rever, vá a Alterações. 
Selecione Aceitar ou Rejeitar. À medida que aceitas ou rejeitas alterações, o Word passará para a próxima mudança. 
 

 
 
Repita até não haver mais alterações ou comentários rastreados no seu documento. 
 
Sugestão: Para rever as alterações no documento sem as aceitar ou rejeitar, selecione Next ou Previous. 
 
Aceitar ou rejeitar uma única alteração 
Em vez de se mover através de alterações de sequência, pode aceitar ou rejeitar uma única alteração. Quando aceitar ou rejeitar a alteração, 
o Word não passará para a próxima alteração do documento. 
Clique na alteração e selecione a opção de aceitá-la ou rejeitá-la. 
 

 
 
Rever alterações por tipo de edição ou por revisor específico 
Clique ou toque no início do documento. 
No separador Review, vá ao Tracking. 
 

 
 
Na lista de Marcação de Espetáculos, faça um dos seguintes: 
Limpe todas as caixas de verificação, exceto as que estão ao lado dos tipos de alterações que pretende rever. 
Aponte para Pessoas Específicas, e depois limpe todas as caixas de verificação, exceto as próximas dos nomes dos revisores cujas alterações 
pretende ver ou escolher Todos os Revisores para selecionar ou limpar as caixas de verificação para todos os revisores da lista. 
No separador Rever, vá a Alterações. 
Selecione Aceitar ou Rejeitar. À medida que aceitas ou rejeitas alterações, o Word passará para a próxima mudança. 
 

 
 
Repita até rever todas as alterações no seu documento. 
Aceitar todas as alterações ao mesmo tempo 
Vá reveralterações >. 
Na lista Aceitar, selecione Aceitar todas as alterações ou aceitar todas as alterações e parar de rastrear. 
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Aceitar ou rejeitar todas as alterações ao mesmo tempo 
No separador Rever, vá a Alterações. 
Siga um dos seguintes procedimentos: 
Na lista de "Aceitar a entrega", selecione Aceitar todas as alterações. 
Na lista de rejeição, selecione Rejeitar todas as alterações. 
 

 
 
Eliminar comentários 
Selecione um comentário. 
No separador Rever, vá a Comentários, e selecione Eliminar. 
 

 
 
Clique em Next ou Previous para passar para outro comentário. 
Eliminar todos os comentários 
Selecione um comentário. 
No separador Rever, vá a Comentários. 
Na lista de abandono de eliminar, selecione Eliminar todos os comentários no documento. 
 

 
 
Prática com Track Changes e outras funcionalidades de colaboração no Word, descarregando este guia de aprendizagem de Palavras. 
Nota: Esta página foi traduzida automaticamente e pode conter erros gramaticais ou imprecisões. O nosso objetivo é que estes conteúdos lhe 
sejam úteis. Pode indicar-nos se estas informações foram úteis? Eis o artigo em inglês para sua referência. 
 
 

  

https://go.microsoft.com/fwlink/?linkid=2041171
https://support.office.com/en-us/article/197ba630-0f5f-4a8e-9a77-3712475e806a
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WORD 
Como resolver problemas relacionados com documentos danificados no word 
Nota 
O Office 365 ProPlus está a ser renomeado para Aplicações do Microsoft 365 para empresas. Para obter mais informações sobre essa 
alteração, leia este post no blog. 
Resumo 
Este artigo descreve como identificar um documento danificado no Word 2007 e versões posteriores. Adicionalmente, este artigo inclui passos 
que explicam como recuperar o texto e os dados contidos num documento após ter identificado que o documento está danificado. 
Este artigo destina-se a utilizadores inexperientes a intermédios. Poderá ser mais fácil seguir os passos descritos se imprimir primeiro este 
artigo. 
 
Atualize o Microsoft Office e o Windows 
Muitos problemas de software podem ser resolvidos actualizando os programas do Microsoft Office e do Windows.  
FAQs do Windows Update 
Instalar atualizações do Office 
Atualização do Office com o Microsoft Update 
Um documento danificado ou um problema de software? 
Um documento do Word pode ser corrompido por várias razões que o impedirão de abri-lo. Este comportamento pode estar relacionado com 
danos no documento ou no modelo no qual o documento é baseado. Este comportamento poderá incluir o seguinte: 
Renumeração frequente das páginas existentes no documento 
Redefinição frequente das quebras de página existentes no documento 
Esquema e formatação incorretos do documento 
Carateres ilegíveis no ecrã 
Mensagens de erro durante o processamento 
O computador deixa de responder quando o ficheiro é aberto 
Qualquer outro comportamento inesperado que não possa ser atribuído ao funcionamento normal do programa 
Por vezes, este comportamento pode ser causado por factores que não estão relacionados com danos no documento. É importante determinar 
se o documento está danificado ou se o problema é um problema de software. Para eliminar outros fatores, siga estes passos: 
Verifique a existência de um comportamento semelhante noutros documentos. Tente abrir outros documentos do Word para ver se o mesmo 
problema ocorre. Se abrirem corretamente, então o problema pode ser do documento Word. 
Verifique a existência de um comportamento semelhante noutros programas do Microsoft Office. Se este for o caso, então o problema pode 
ser com outra aplicação ou com o sistema operativo. 
Se qualquer um destes passos indicar que o problema não reside no documento, terá de efetuar a resolução de problemas do Word, do 
conjunto de programas do Office ou do sistema operativo em execução no computador. 
 
Passos de resolução de problemas a tentar se não conseguir abrir o documento danificado 
Tente os métodos na ordem apresentada. Se um não funcionar na sua situação, tente o próximo. 
Método 1: Abrir o documento danificado no modo de rascunho sem atualizar as ligações 
Passo 1: Configurar o Word 
Inicie o Word. 
No separador Ver, selecione Rascunho no grupo Vistas. 
Seleccione o Menu Ficheiro, em seguida Opções e depois Avançadas. 
Na secção Mostrar conteúdo do documento, clique para selecionar Utilizar tipo de letra de Rascunho nas vistas de Rascunho e Destaques e 
Mostrar marcadores de posição de imagens. 
Desça até à seção Geral, limpe a caixa de seleção Atualize as hiperligações automáticas na abertura, selecione OK e, em seguida, feche o 
Word. 
 
Passo 2: Abrir o documento danificado 
Inicie o Word. 
Selecione o Menu de Ficheiros e, em seguida, selecione Abrir. 
Selecione o documento danificado e, em seguida selecione Abrir. 
Se conseguir abrir o documento, feche-o e abra-o novamente utilizando o método 6 e repare o documento. Caso contrário, avance para o 
método 2. 
 
Método 2: Inserir o documento como ficheiro num novo documento 
Passo 1: Criar um novo documento em branco 
Selecione o menu de Ficheiro e, em seguida, seleccione Novo. 
Clique em Documento em branco e, em seguida, clique em Criar. 
 
Nota 
Poderá ter de voltar a aplicar alguma formatação na última secção do novo documento. 
Passo 2: Inserir o documento danificado no novo documento 
No separador Inserir, clique em Inserir Objeto e, em seguida, clique em Texto de Ficheiro. 
Na caixa de diálogo Inserir Ficheiro, localize e delecione no documento danificado. Em seguida, seleccione Inserir. 
 
Nota 
Poderá ter de voltar a aplicar alguma formatação na última secção do novo documento. 
 
Método 3: Criar uma ligação para o documento danificado 
Passo 1: Criar um documento em branco 
No Word, clique no Menu do Ficheiro e, em seguida, clique em Novo. 
Clique em Documento em branco e, em seguida, clique em Criar. 

https://go.microsoft.com/fwlink/p/?linkid=2120533
https://support.microsoft.com/help/12373/windows-update-faq
https://support.office.com/article/install-office-updates-2ab296f3-7f03-43a2-8e50-46de917611c5
https://support.office.com/article/update-office-with-microsoft-update-f59d3f9d-bd5d-4d3b-a08e-1dd659cf5282
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No novo documento, escreva "Isto é um teste." 
Selecione o Menu Ficheiro e, em seguida, seleccione Guardar. 
Escreva "Hiperligação de recuperação" e, em seguida, selecione Guardar. 
 
Passo 2: Criar a ligação 
Selecione o texto que escreveu no passo 1-3. 
No separador Base, clique em Copiar no grupo Área de Transferência. 
Selecione o menu de Ficheiro e, em seguida, seleccione Novo. 
Clique em Documento em branco e, em seguida, clique em Criar. 
No separador Base, clique na seta existente no botão Colar no grupo Área de Transferência e, em seguida, clique em Colar Especial. 
Clique em Colar ligação e clique em Texto Formatado (RTF). 
Selecione OK. 
 
Passo 3: Alterar a ligação para o documento danificado 
Clique com o botão direito do rato no texto com hiperligação no documento, aponte para Objeto de Documento com Hiperligação e, em seguida, 
clique em Hiperligações. 
Na caixa de diálogo Ligações, clique no nome do ficheiro do documento com hiperligação e, em seguida, clique em Alterar Origem. 
Na caixa de diálogo Alterar Origem, clique no documento que não consegue abrir e, em seguida, clique em Abrir. 
Clique em OK para fechar a caixa de diálogo Hiperligações. 
 
Nota 
As informações do documento danificado serão apresentadas se existir texto ou dados recuperáveis. 
Clique com o botão direito do rato no texto com hiperligação, aponte para Objeto de Documento com Hiperligação e, em seguida, clique em 
Hiperligações. 
Na caixa de diálogo Hiperligações, selecione Quebrar Hiperligação. 
Quando receber a mensagem seguinte, selecione Sim: Tem a certeza de que pretende romper as ligações selecionadas? 
 
Método 4: Utilizar o conversor "Recuperar Texto de Qualquer Ficheiro" 
 
Nota 
O conversor "Recuperar Texto de Qualquer Ficheiro" tem limitações. Por exemplo, a formatação do documento será perdida. Além disso, 
gráficos, campos, objetos de desenho e quaisquer outros itens que não sejam texto serão perdidos. No entanto, texto de campos, cabeçalhos, 
rodapés, notas de rodapé e notas de fim serão retidos como texto simples. 
No Word, clique no Menu Ficheiro e, em seguida, clique em Abrir. 
Na caixa Ficheiros do tipo, selecione Recuperar Texto de Qualquer Ficheiro(.). 
Clique no documento a partir do qual pretende recuperar o texto. 
Selecione Abrir. 
Após ter recuperado o documento utilizando o conversor "Recuperar Texto de Qualquer Ficheiro", existirá algum texto binário que não foi 
convertido. Este texto está localizado principalmente no início e no fim do documento. Tem de eliminar este texto binário antes de guardar o 
ficheiro como um documento do Word. 
 
Nota 
Se estiver a utilizar o Word 2007 e não existir um botão de ficheiro na Interface de Utilizador; selecione o Botão Office e siga as indicações 
quando necessário. 
Passos de resolução de problemas a tentar se conseguir abrir o documento danificado 
 
Método 1: Copiar tudo exceto a última marca de parágrafo para um novo documento 
Passo 1: Criar um novo documento 
No Word, selecione Ficheiro no Friso e, em seguida, selecione Novo. 
Clique em Documento em branco e, em seguida, clique em Criar. 
 
Passo 2: Abrir o documento danificado 
No Word, clique em Ficheiro no Friso e, em seguida, clique em Abrir. 
Selecione o documento danificado e, em seguida selecione Abrir. 
 
Passo 3: Copiar o conteúdo do documento e colá-lo no documento novo 
 
Nota 
Se o documento contiver quebras de secção, copie apenas o texto entre as quebras de secção. Não copie as quebras de secção; se o fizer, 
poderá danificar o novo documento. Altere a vista do documento para a vista de rascunho quando copiar e colar entre documentos, para evitar 
transferir quebras de secção. Para mudar para a vista de rascunho, no separador Ver, clique em Rascunho no grupo Vistas do Documento. 
No documento danificado, prima CTRL+END e, em seguida, prima CTRL+SHIFT+HOME. 
No separador Base, clique em Copiar no grupo Área de Transferência. 
No separador Ver, clique em Mudar de Janelas no grupo Janela. 
Clique no novo documento que criou no passo 1. 
No separador Início, clique em Colar no grupo Área de Transferência. 
Se o comportamento estranho persistir, avance para o método 8. 
 
Método 2: Alterar o modelo utilizado pelo documento 
Passo 1: Determinar o modelo utilizado pelo documento 
Abra o documento danificado no Word. 
Selecione Ficheiro no Friso e, em seguida selecione Opções. 
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Selecione Complementos. 
Na caixa Gerir, selecione Modelos em Ver e gerir complementos do Office 
Selecione Ir. 
A caixa Modelo de documento irá listar o modelo utilizado pelo documento. Se o modelo listado for o modelo Normal, avance para o passo 2. 
Caso contrário, avance para o passo 3. 
 
Passo 2: Mudar o nome do modelo global (Normal.dotm) 
Saia do Word. 
Selecione o botão Iniciar. 
No seu sistema operativo, procure por normal.dotm. É normalmente encontrado neste local: 
%userprofile%\appdata\roaming\microsoft\templates 
Clique com o botão direito do rato em Normal.dotm e, em seguida, clique em Mudar o nome. 
Escreva "Oldword.old" e, em seguida, prima ENTER. 
Feche o Explorador de Ficheiros. 
Inicie o Word e, em seguida, abra o documento. 
 
Passo 3: Alterar o modelo do documento 
Abra o documento danificado no Word. 
Selecione Ficheiro no Friso e, em seguida selecione Opções. 
Selecione Complementos. 
Na caixa Gerir, clique em Modelos e, em seguida, clique em Ir. 
Seleccione Anexar. 
Na pasta Modelos, clique em Normal.dotm e, em seguida, clique em Abrir. 
Clique em OK para fechar a caixa de diálogo Modelos e Suplementos. 
Saia do Word. 
 
Passo 4: Verificar se a alteração dos modelos funcionou. 
Inicie o Word. 
Selecione Ficheiro no Friso e, em seguida selecione Opções. 
Selecione o documento danificado e, em seguida selecione Abrir. 
Se o comportamento estranho persistir, avance para o método 3. 
 
Método 3: Iniciar o Word com as predefinições 
Pode utilizar o parâmetro /a para iniciar o Word utilizando apenas as predefinições. Quando utiliza o parâmetro /a, o Word não carrega 
quaisquer suplementos. Além disso, o Word não utiliza o modelo Normal.dotm existente. Reinicie o Word utilizando o parâmetro /a. 
 
Passo 1: Iniciar o Word utilizando o parâmetro /a 
Saia do Word. 
Clique no botão Iniciar e procure por Executar. Na caixa de diálogo Executar, escreva o seguinte: 
winword.exe /a 
 
Passo 2: Abrir o documento 
No Word, selecione Ficheiro no Friso e, em seguida,selecione Abrir. 
Selecione o documento danificado e, em seguida selecione Abrir. 
Se o comportamento estranho persistir, avance para o método 4. 
 
Método 4: Alterar os controladores de impressora 
Passo 1: Tentar outro controlador de impressora 
No seu sistema operativo, procure por Dispositivos e Impressoras. 
Selecione Adicionar uma impressora. 
Na caixa de diálogo Adicionar Impressora, selecione Adicionar uma impressora local. 
Selecione Utilizar uma porta existente e em seguida, selecione Seguinte. 
Na lista Fabricante, selecione Microsoft. 
Selecione Microsoft XPS Document Writer e de seguida, selecione Seguinte. 
Selecione Utilizar o controlador atualmente instalado (recomendado) e de seguida, selecione Seguinte. 
Selecione para selecionar a caixa de verificação Definir como impressora predefinida e depois selecione Seguinte. 
Selecione Concluir. 
 
Passo 2: Verificar se a alteração dos controladores de impressora corrige o problema 
Inicie o Word. 
No Word, clique em Ficheiro no Friso e, em seguida, clique em Abrir. 
Selecione o documento danificado e, em seguida selecione Abrir. 
Se o comportamento estranho persistir, avance para o passo 3. 
 
Passo 3: Reinstalar o controlador de impressora original. 
Windows 10 e Windows 7 
No seu sistema operativo, procure por Impressoras. 
Seleccione a impressora predefinida original e, em seguida, selecione Eliminar. 
Se for pedido para introduzir uma palavra-passe de administrador ou para confirmar, escreva a palavra-passe ou clique em Continuar. 
Se lhe for perguntado se pretende remover todos os ficheiros associados à impressora, clique em Sim. 
Clique em Adicionar uma impressora ou scanner e siga as instruções apresentadas pelo Assistente para Adicionar Impressoras para reinstalar 
o controlador de impressora. 
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Passo 4: Verificar se a alteração dos controladores de impressora corrige o problema 
Inicie o Word. 
No Word, clique em Ficheiro no Friso e, em seguida, clique em Abrir. 
Selecione o documento danificado e, em seguida selecione Abrir. 
Se o comportamento estranho persistir, avance para o método 5. 
 
Método 5: Forçar o Word a tentar reparar um ficheiro 
Passo 1: Reparar o documento 
No Word, selecione Ficheiro no Friso e, em seguida,selecione Abrir. 
Na caixa de diálogo Abrir, clique uma vez para realçar o documento do Word. 
Selecione a seta no botão Abrir e, em seguida, selecione Abrir e Reparar. 
 
Passo 2: Verificar se a reparação do documento corrige o problema 
Verifique se o comportamento estranho deixa de ocorrer. Se o comportamento estranho persistir, reinicie o Windows e, em seguida, avance 
para o método 6. 
Método 6: Alterar o formato do documento e, em seguida, voltar a converter o documento novamente para o formato do Word 
 
Passo 1: Abrir o documento 
Inicie o Word. 
No Word, clique em Ficheiro no Friso e, em seguida, clique em Abrir. 
Selecione o documento danificado e, em seguida selecione Abrir. 
 
Passo 2: Guardar o documento noutro formato de ficheiro 
Clique em Ficheiro no Friso e, em seguida, clique em Guardar como. 
Seleccione Outros Formatos. 
Na lista Guardar como tipo de ficheiro, clique em Rich Text Format (*.rtf). 
Seleccione Guardar. 
Clique em Ficheiro no Friso e, em seguida, clique em Fechar. 
 
Passo 3: Abrir o documento e, em seguida, voltar a converter o documento para o formato de ficheiro do Word 
No Word, selecione Ficheiro e, em seguida, selecione Abrir. 
Selecione o documento convertido e, em seguida, selecione Abrir. 
Seleccione Ficheiro e, em seguida, seleccione Guardar como. 
Escolha Documento do Word para o tipo Guardar Como. 
Mude o nome do documento e, em seguida, selecione Guardar. 
 
Passo 4: Verificar se a conversão do documento corrige o problema 
Verifique se o comportamento estranho deixa de ocorrer. Se o comportamento persistir, tente guardar o ficheiro num outro formato de ficheiro. 
Repita os passos 1 a 4 e tente guardar o ficheiro nos seguintes formatos de ficheiro, pela seguinte ordem: 
Página web (.htm; .html) 
Qualquer outro formato de processamento de texto 
Texto Simples (.txt) 
 
Nota 
Quando guardar ficheiros no formato Texto Simples (.txt), poderá resolver o problema do documento. No entanto, irá perder toda a formatação 
do documento, o código das macros e os gráficos. Quando guardar ficheiros no formato Texto Simples (.txt), terá de reformatar o documento. 
Consequentemente, utilize o formato Texto Simples (.txt) apenas se os outros formatos de ficheiro não resolverem o problema. 
Se o comportamento estranho persistir, avance para o método 7. 
Método 7: Copiar as partes não danificadas do documento danificado para um novo documento 
 
Passo 1: Criar um novo documento 
No Word, selecione Ficheiro e, em seguida, selecione Novo. 
Clique em Documento em branco e, em seguida, clique em Criar. 
 
Passo 2: Abrir o documento danificado 
Seleccione Ficheiro e, em seguida, seleccione Abrir. 
Selecione o documento danificado e, em seguida selecione Abrir. 
 
Passo 3: Copiar as partes não danificadas do documento e colá-las no novo documento 
 
Nota 
Se o documento contiver quebras de secção, copie apenas o texto entre as quebras de secção. Não copie as quebras de secção porque se o 
fizer, poderá danificar o novo documento. Altere a vista do documento para a vista de rascunho quando copiar e colar entre documentos, para 
evitar transferir quebras de secção. Para mudar para a vista de rascunho, no separador Ver, clique em Rascunho no grupo Vistas do Documento. 
No documento danificado, localize e, em seguida, selecione um parte não danificada do conteúdo do documento. 
No separador Base, clique em Copiar no grupo Área de Transferência. 
No separador Ver, clique em Mudar de Janelas no grupo Janela. 
Clique no novo documento que criou no passo 1. 
No separador Início, clique em Colar no grupo Área de Transferência. 
Repita os passos 3a a 3e para cada uma das partes não danificadas do documento. Tem de recriar as secções danificadas do documento. 
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Método 8: Mudar a vista do documento para remover o conteúdo danificado 
Se o documento parecer estar truncado (não são apresentadas todas as páginas do documento), talvez seja possível mudar a vista do 
documento e remover o conteúdo danificado deste. 
Determine o número da página em que o conteúdo danificado está a fazer com o documento pareça estar truncado. 
No Word, selecione Ficheiro e, em seguida, selecione Abrir. 
Selecione o documento danificado e, em seguida selecione Abrir. 
Percorra o documento para ver a última página apresentada antes do documento parecer estar truncado. Anote o conteúdo apresentado nessa 
página. 
Mude a vista e, em seguida, remova o conteúdo danificado. 
No separador Ver, no grupo Vistas do Documento, clique em Esquema Web ou Vista de Rascunho. 
Percorra o documento para ver o conteúdo apresentado antes do documento parecer estar truncado. 
Selecione e elimine o próximo parágrafo, tabela ou objeto existente no ficheiro. 
No separador Ver, no grupo Vistas do Documento, selecione Esquema de Impressão. Se o documento continuar a parecer truncado, continue 
a mudar de vista e a eliminar conteúdo até que o documento deixe de aparecer truncado na vista Esquema de Impressão. 
Guarde o documento. 
 
Método 9: Abra o documento com o Bloco de Notas 
Se o documento for corrompido e nenhum dos métodos anteriores funcionar, tente recuperar o seu conteúdo abrindo o documento com o 
Notepad. 
 
Nota 
Ao utilizar este método, perderá toda a formatação. A intenção é recuperar o conteúdo. 
Localizar o documento danificado usando o Explorador de Ficheiros do Windows. 
Clique com o botão direito do rato no documento e seleccione Abrir com. 
Seleccione Bloco de Notas: 
 

  
 
4. O documento será aberto no Bloco de Notas com código extra e texto em torno do conteúdo. 
 
Nota 
Poderá ter de alterar o tipo de ficheiro de "Documentos de Texto (.txt)" para "Todos os Ficheiros(.*)". 5. Limpe o texto apagando todos ou a 
maioria dos caracteres extra. 6. Seleccione Ficheiro, e, em seguida, seleccione Guardar Como... Mude o nome do documento para se certificar 
de que não substitui o ficheiro danificado. 
Volte para o Word e abra o novo documento. Uma vez no Word, pode limpá-lo e tentar reaplicar o formato perdido. 
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Anexo V – Tutoriais da Microsoft em português do Brasil 

 
OUTLOOK 
Como configurar as regras 
Experimente! 
Use regras para organizar seu email. Crie uma regra com base em uma mensagem ou um modelo. 
Criar uma regra a partir de uma mensagem 
Clique com o botão direito do mouse em uma mensagem e selecione Regras > Criar Regra. 
Selecione uma condição e o que fazer com a mensagem com base na condição. 
Por exemplo, para mover mensagens com um determinado título para uma pasta específica, selecione a condição Assunto contém, Mover o 
item para pasta, selecione ou crie uma Nova pasta e clique em OK. 
Quando terminar de criar a regra, clique em OK. 
Para usar a regra imediatamente, marque a caixa de seleção Executar esta regra em mensagens existentes na pasta atual e escolha OK. 
A mensagem será exibida nessa pasta. 
Criar uma regra a partir de um modelo 
Selecione Arquivo > Gerenciar Regras e Alertas > Nova Regra. 
Selecione um modelo. 
Por exemplo, para sinalizar uma mensagem: 
Selecione Sinalizar as mensagens de alguém para acompanhamento. 
Edite a descrição da regra. 
Clique em um valor sublinhado, escolha as opções desejadas e selecione OK. 
Selecione Avançar. 
Selecione as condições, adicione as informações relevantes e, em seguida, clique em OK. 
Selecione Avançar. 
Conclua a configuração da regra. 
Nomeie a regra, configure as opções e verifique a descrição. Clique em um valor sublinhado para editá-lo. 
Selecione Concluir. 
Algumas regras serão executadas somente quando o Outlook estiver ativado. Se você vir este aviso, selecione OK. 
Selecione OK. 
 
 
O Outlook não está respondendo o erro ou o outlook congela ao abrir um arquivo ou enviar emails 
 
Sintomas 
Quando você abre um arquivo ou envia uma mensagem de email no Microsoft Outlook 2010 ou versões posteriores, o Outlook congela ou você 
recebe a seguinte mensagem de erro: 
O Outlook não está respondendo 
 
Motivo 
Esse problema ocorre por uma ou mais das seguintes razões: 

● Você não instalou as atualizações mais recentes. 

● O Outlook está em uso por outro processo. 

● O Outlook está carregando conteúdo externo, como imagens em uma mensagem de email. 

● Um suplemento instalado anteriormente está interferindo no Outlook. 

● Suas caixas de correio são muito grandes. 

● Sua pasta AppData é redirecionada para um local de rede. 

● Você precisa reparar os programas do Office. 

● Os arquivos de dados do Outlook foram corrompidos ou danificados. 

● Seu software antivírus instalado está desatualizado ou está em conflito com o Outlook. 

● Seu perfil de usuário foi corrompido. 

● Outro programa entra em conflito com o Outlook. 
 
Observação 

● Esse problema pode ocorrer por uma ou mais das razões desta seção. Para corrigir esse problema, talvez seja necessário seguir as 
etapas de solução de problemas na seção resolução. 

● Muitos desses itens podem ser verificados automaticamente pelo assistente de recuperação e suporte da Microsoft (SaRA). Para 
iniciar as verificações automatizadas, siga estas etapas: 

1. Instale a ferramenta de diagnóstico avançado do Outlook. 
2. Selecione executar quando for solicitado pelo navegador. 
3. No relatório que é gerado, revise os itens da guia problemas encontrados. Para obter detalhes de configuração sobre o 

Outlook, Windows e o computador, revise as configurações na guia exibição detalhada. 

 
Resolução 
Para resolver esse problema, verifique se o computador atende aos requisitos de sistema do outlook 2016, requisitos do sistema do Outlook 
2013 ou requisitos de sistema do Outlook 2010. 
 
Observação 
Essas etapas são fornecidas em uma ordem específica com base em semelhanças e complexidades. Siga estas etapas na ordem determinada. 

https://aka.ms/SaRA-OutlookAdvDiagnostics
https://www.microsoft.com/microsoft-365/microsoft-365-and-office-resources
https://docs.microsoft.com/pt-br/previous-versions/office/office-2013-resource-kit/ee624351(v=office.15)
https://docs.microsoft.com/pt-br/previous-versions/office/office-2013-resource-kit/ee624351(v=office.15)
https://docs.microsoft.com/pt-br/previous-versions/office/office-2010/ee624351(v=office.14)
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Etapa 1: instalar as atualizações mais recentes 
A instalação do Office em seu computador pode não estar atualizada. Isso pode ter ocorrido porque o Windows Update não está configurado 
no computador para baixar e instalar automaticamente as atualizações recomendadas. Ao instalar atualizações importantes, recomendadas e 
opcionais, você geralmente pode corrigir os problemas substituindo arquivos desatualizados e corrigindo vulnerabilidades. Para instalar as 
atualizações mais recentes do Office, clique no link da sua versão do Windows e siga as etapas descritas no artigo: 

● Instalar as atualizações do Windows no Windows 10 

● Perguntas frequentes sobre o Windows Update para Windows 8,1 

● Instalar as atualizações do Windows no Windows 7 

● Instalar as atualizações do Windows no Windows Vista 

● Instalar as atualizações do Windows no Windows XP 
Verifique se as atualizações mais recentes do Outlook estão instaladas. Para obter mais informações, consulte como instalar as atualizações 
aplicáveis mais recentes do Microsoft Outlook (apenas em inglês dos EUA). 

 
Etapa 2: Certifique-se de que o Outlook não está sendo usado por outro processo 
O desempenho pode ser reduzido se você usar o recurso AutoArquivar do Outlook ou sincronizar com o Outlook com um dispositivo móvel. 
Isso ocorre porque esses processos podem usar um grande número de recursos. 
Se o Outlook estiver sendo usado por outro processo, essas informações serão exibidas na barra de status na parte inferior da tela. Se você 
tentar executar outras ações enquanto o Outlook estiver em uso, o Outlook poderá não responder. Deixe a tarefa em andamento concluir o 
trabalho antes de tentar outra ação. 

 
Etapa 3: verificar o problema causado por conteúdo externo 
Para resolver esse problema, use um dos métodos a seguir: 

● Impedir que o Outlook Baixe conteúdo externo. Para fazer isso, vá para arquivo > Opções > Trust Center > download automático da 
central de confiabilidade, selecione as duas opções a seguir: 
o Não baixar imagens ou outro conteúdo automaticamente na opção de email em HTML. 
o Avisar antes de baixar conteúdo ao editar, encaminhar ou responder emails. 

● Evite enviar um email com fonte externa. 

 
Etapa 4: investigar possíveis problemas de suplemento 
Embora os suplementos possam aprimorar sua experiência de usuário, eles podem ocasionalmente interferir ou entrar em conflito com o 
Outlook. Tente iniciar o Outlook sem nenhum suplemento em execução. 
 
Como iniciar o Outlook sem suplementos 

1. Faça o seguinte, conforme apropriado para o seu sistema operacional: 
o Se você estiver executando o Windows 8, passe o dedo a partir da borda direita da tela e, em seguida, toque em Pesquisar. 

(Se você estiver usando um mouse, aponte para o canto superior direito da tela, mova o ponteiro do mouse para baixo e 
selecione Pesquisar.) Digite executar na caixa de pesquisa e toque ou selecione executar. 

o Se você estiver executando o Windows 10, Windows 7 ou Windows Vista, selecione Iniciar. 
o Se você estiver executando o Windows XP, selecione Iniciar e, em seguida, selecione executar. 

2. Digite Outlook.exe/Safe e, em seguida, selecione OK. 
3. Se o problema for resolvido, selecione Opções no menu arquivo e, em seguida, selecione suplementos. 
4. Selecione suplementos de com e selecione ir. 
5. Desmarque todas as caixas de seleção na lista e, em seguida, selecione OK. 
6. Reinicie o Outlook. 

 
Se o problema não ocorrer depois que você reiniciar o Outlook, um dos suplementos provavelmente será a causa do problema. Restaure os 
suplementos, um de cada vez, até que o problema ocorra para determinar qual suplemento está causando o problema. 

 
Etapa 5: verificar se sua caixa de correio é muito grande 
À medida que o tamanho da caixa de correio aumenta, mais recursos são necessários para abrir cada pasta. Se você tiver um grande 
número de itens em qualquer pasta única, poderá ter problemas de desempenho durante determinadas operações. Para obter mais 
informações, consulte problemas de desempenho do Outlook quando há muitos itens ou pastas em um arquivo de modo de cache. ost ou. 
pst. 
Recomendamos que você mova vários itens em pastas maiores para pastas separadas ou que arquive esses itens usando o recurso 
AutoArquivar. 
 
Como criar uma pasta 

1. Na guia pasta, selecione nova pasta no novo grupo. 
2. Na caixa nome, digite um nome para a pasta. 
3. Na lista selecionar onde colocar a pasta, selecione o local para a nova pasta. 

 
Observação 
A nova pasta se tornará uma subpasta da pasta selecionada. 
 

4. Selecione OK. 
 
Para gerenciar sua caixa de correio reduzindo o tamanho do arquivo de dados do Outlook, confira reduzir o tamanho dos arquivos de dados 
do Outlook (. pst e. ost). 

https://support.microsoft.com/hub/4338813/windows-help?os=windows-10
https://support.microsoft.com/hub/4338813/windows-help?os=windows-8.1
https://support.microsoft.com/help/12373/windows-update-faq
https://support.microsoft.com/help/22882/windows-vista-end-of-support
https://support.microsoft.com/help/14223/windows-xp-end-of-support
https://docs.microsoft.com/pt-br/outlook/troubleshoot/installation/install-outlook-latest-updates
https://docs.microsoft.com/pt-br/outlook/troubleshoot/installation/install-outlook-latest-updates
https://support.microsoft.com/help/2768656
https://support.microsoft.com/help/2768656
https://support.microsoft.com/office/reduce-the-size-of-your-mailbox-and-outlook-data-files-pst-and-ost-e4c6a4f1-d39c-47dc-a4fa-abe96dc8c7ef
https://support.microsoft.com/office/reduce-the-size-of-your-mailbox-and-outlook-data-files-pst-and-ost-e4c6a4f1-d39c-47dc-a4fa-abe96dc8c7ef
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Para gerenciar sua caixa de correio usando o recurso AutoArquivar, confira as configurações de AutoArquivar explicadas. 

 
Etapa 6: verificar se sua pasta AppData está sendo redirecionada para um local de rede 
O Outlook armazena determinados dados, como assinaturas de email e o dicionário de verificação ortográfica, na pasta AppData. Se a rede 
estiver executando lentamente, o Outlook deverá aguardar as operações de leitura e gravação no diretório AppData para concluir. 
 
Como desabilitar o redirecionamento do diretório AppData 

1. Saia do Outlook. 
2. Inicie o Editor do Registro. Para fazer isso, use um dos seguintes procedimentos, conforme apropriado para a versão do Windows: 

o Windows 10 ou Windows 8: Pressione a tecla Windows + R para abrir uma caixa de diálogo Executar. Digite regedit.exe e 
pressione OK. 

o Windows 7: selecione Iniciar, digite regedit.exe na caixa de pesquisa e pressione Enter. 
3. No editor do registro, localize e selecione a seguinte subchave: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\User Shell Folders 
4. Localize e clique duas vezes no valor AppData . 
5. Na caixa dados do valor , digite o seguinte caminho e, em seguida, selecione OK: 

%USERPROFILE%\AppData\Roaming 
 

 
 

6. Saia do Editor do Registro. 

 
Etapa 7: reparar os programas do Office 
Você pode reparar automaticamente seus arquivos de programa do Office para resolver problemas como o Outlook congelando ou não 
respondendo. 
 
Como reparar automaticamente o Office 

1. Saia de todos os programas do Microsoft Office em execução. 
2. Abra o painel de controle e, em seguida, abra o item Adicionar ou remover programas (se você estiver executando o Windows XP) ou 

programas e recursos (se estiver executando o Windows 10, Windows 8, Windows 7 ou Windows Vista). 
3. Na lista de programas instalados, clique com o botão direito do mouse em Microsoft office 2016, Microsoft Office 2013 ou Microsoft 

Office 2010 e selecione reparar. 

 
Etapa 8: reparar arquivos de dados do Outlook 
Quando você instala o Outlook, uma ferramenta de reparo da caixa de entrada (scanpst.exe) também é instalada no computador. A ferramenta 
de reparo da caixa de entrada pode resolver problemas examinando seus arquivos de dados do Outlook e reparando erros. Para usar a 
ferramenta de reparo da caixa de entrada, saia do Outlook e siga as etapas em reparar arquivos de dados do Outlook (. pst e. ost). 

 
Etapa 9: verificar se o software antivírus está atualizado ou em conflito com o Outlook 
Se o seu software antivírus não estiver atualizado, o Outlook pode não funcionar corretamente. 
 
Como verificar se o software antivírus está atualizado 
Para acompanhar os novos vírus à medida que são criados, os fornecedores de software antivírus fornecem atualizações periódicas que podem 
ser baixadas da Internet. Baixe as atualizações mais recentes visitando o site do fornecedor do software antivírus. 
Para obter uma lista de fornecedores de software antivírus, consulte Consumer Antivirus software Providers for Windows. 
 
Como verificar se o software antivírus está em conflito com o Outlook 
Se o seu software antivírus incluir a integração com o Outlook, você poderá ter problemas de desempenho. Você pode desabilitar toda a 
integração do Outlook no software antivírus. Ou você pode desabilitar os suplementos de software antivírus que estão instalados no Outlook. 
 
Importante 
Quando você altera as configurações de antivírus, isso pode tornar seu computador vulnerável a ataques viral, fraudulentos ou mal-
intencionados. Não é recomendável tentar alterar as configurações de antivírus. Você é responsável pelo uso dessa solução alternativa. 
Talvez seja necessário entrar em contato com o fornecedor do software antivírus para determinar como configurar o software para excluir 
qualquer integração com o Outlook ou para excluir a verificação no Outlook. 
 
Observação 
Se você também planeja executar a verificação de vírus no nível de arquivo de. pst,. ost, catálogo de endereços offline (. OAB) ou outros arquivos 
do Outlook enquanto o Outlook estiver em uso, consulte Plan Antivirus scanning for Outlook 2010 ou Planning Considerations for 
deploying Outlook 2016 for Windows. 

 
Etapa 10: criar um perfil de usuário no Outlook 
Para criar um perfil de usuário, siga estas etapas: 

https://support.microsoft.com/office/autoarchive-settings-explained-444bd6aa-06d0-4d8f-9d84-903163439114
https://support.microsoft.com/office/repair-outlook-data-files-pst-and-ost-25663bc3-11ec-4412-86c4-60458afc5253
https://support.microsoft.com/help/18900/consumer-antivirus-software-providers-for-windows#avtabs=win7
https://docs.microsoft.com/pt-br/previous-versions/office/office-2010/hh550032(v=office.14)
https://docs.microsoft.com/pt-br/outlook/troubleshoot/installation/plan-outlook-2016-deployment#outlook-security-considerations
https://docs.microsoft.com/pt-br/outlook/troubleshoot/installation/plan-outlook-2016-deployment#outlook-security-considerations
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1. No painel de controle, selecione programas, selecione contas de usuário e, em seguida, selecione email para abrir itens de email. 
2. Selecione Mostrar perfis. 
3. Selecione o perfil que você deseja remover e selecione remover. 
4. Clique em Adicionar. 
5. Na caixa de diálogo nome do perfil, digite um nome para o perfil. 
6. Especifique o nome de usuário, o endereço SMTP principal e a senha. Em seguida, selecione Avançar. 
7. Você pode receber a seguinte solicitação: 

Permitir que este site defina alias@domain as configurações do ? 
Nesse prompt, marque a caixa de seleção não perguntar novamente e, em seguida, selecione permitir. 

 
Etapa 11: realizar uma inicialização seletiva (usuários avançados) 
Quando você inicia o Windows normalmente, vários aplicativos e serviços são iniciados automaticamente e, em seguida, executados em 
segundo plano. Esses aplicativos e serviços podem interferir no Outlook. Um processo de inicialização seletiva ou "inicialização limpa" pode 
ajudá-lo a identificar problemas causados por conflitos de aplicativos. 
Se você usar a opção inicialização seletiva na configuração do sistema, poderá ativar ou desativar os programas de serviços e de inicialização 
individualmente para verificar se o problema ocorre na próxima vez que você iniciar o computador. Na configuração do sistema, se você 
selecionar uma caixa de seleção, o serviço relacionado ou o programa de inicialização será executado quando o computador for reiniciado. Se 
a caixa de seleção estiver desmarcada, o serviço ou programa de inicialização não será executado quando o computador for reiniciado. 
Siga este procedimento para usar o processo de eliminação para identificar o problema no Windows 10, Windows 8, Windows 7 ou Windows 
Vista. 
 
Observação 
Para obter mais informações sobre como executar uma inicialização limpa, confira como executar uma inicialização limpa no Windows. 
 
Como fazer uma inicialização seletiva 

1. No painel de controle, selecione sistema e segurança, selecione Ferramentas administrativas e clique duas vezes em configuração 
do sistema. 
 
Observação 
Se for solicitada uma senha de administrador ou uma confirmação, digite a senha ou forneça a confirmação. 
 

2. Selecione a guia geral, selecione inicialização seletiva e desmarque as caixas de seleção carregar Serviços do sistema e carregar itens 
de inicialização. 

3. Marque a caixa de seleção carregar serviços do sistema, selecione OK e, em seguida, selecione reiniciar. 
4. Se o problema ocorrer novamente após a reinicialização do computador, execute uma das tarefas a seguir, ou ambas, conforme 

necessário. 
Para determinar qual serviço do sistema está causando o problema 

1. Em configuração do sistema, selecione a guia Serviços, selecione desabilitar tudo, marque a caixa de seleção para o primeiro 
serviço listado e reinicie o computador. 
 
Observação 
Se o problema não ocorrer novamente, você poderá eliminar o primeiro serviço como a causa do problema. 
 

2. Com o primeiro serviço selecionado, marque a caixa de seleção segundo serviço e reinicie o computador. 
3. Repita esse processo até reproduzir o problema. 

 
Observação 
Se você não conseguir reproduzir o problema, poderá eliminar os serviços do sistema como a causa do problema. 
Para determinar qual item de inicialização está causando o problema 
 

4. Em configuração do sistema, selecione a guia geral e marque a caixa de seleção carregar itens de inicialização. 
5. Selecione a guia inicialização, selecione desabilitar tudo, marque a caixa de seleção para o primeiro item de inicialização listado 

e reinicie o computador. 
 
Observação 
Se o problema não ocorrer novamente, você pode eliminar o primeiro item de inicialização como a causa do problema. 
 

6. Enquanto o primeiro item de inicialização estiver selecionado, marque a caixa de seleção segundo item de inicialização e reinicie 
o computador. Repita esse processo até reproduzir o problema. 

 
Etapa 12: criar um perfil de usuário do Windows (usuários avançados) 
Seu perfil de usuário é uma coleção de configurações que permite personalizar a aparência e o desempenho do computador. Ele contém 
configurações para planos de fundo da área de trabalho, proteções de tela, configurações de som e outros recursos. Os perfis de usuário 
ajudam a garantir que suas preferências pessoais sejam usadas quando você fizer logon no Windows. 
Para determinar se esse problema é causado por um perfil de usuário corrompido, crie um perfil de usuário para ver se o problema ainda 
ocorre quando você usa o novo perfil. 
 
Como reparar um perfil de usuário corrompido no Windows 8 
Etapa 1: criar uma conta de usuário 
Para criar um perfil de usuário, você deve primeiro criar uma conta de usuário. Quando a nova conta é criada, um perfil também é criado. 

https://support.microsoft.com/help/929135/how-to-perform-a-clean-boot-in-windows
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1. Passe o dedo a partir da borda direita da tela e toque em Pesquisar. (Se você estiver usando um mouse, aponte para o canto superior 
direito da tela, mova o ponteiro do mouse para baixo e selecione Pesquisar.) Digite prompt de comando na caixa de pesquisa, clique 
com o botão direito do mouse em prompt de comando e selecione Executar como administrador. 
 
Observação 
Se for solicitada uma senha de administrador ou uma confirmação, digite a senha ou forneça a confirmação. 
 

2. Digite net user UserNamePassword/Add e pressione Enter. 

 
Etapa 2: copiar arquivos antigos para o novo perfil de usuário * * depois de criar o perfil, você pode copiar os arquivos do perfil existente 
 
Observação 
Você deve ter pelo menos três contas de usuário no computador para concluir estas etapas. Isso inclui a nova conta que você acabou de criar. 

1. Faça logon como um usuário que não seja o usuário que você acabou de criar ou do usuário do qual você deseja copiar os arquivos. 
2. No painel de controle, selecione aparência e personalização e, em seguida, selecione Opções de pasta. 
3. Selecione a guia Exibir e, em seguida, selecione Mostrar arquivos, pastas e unidades ocultos. 
4. Desmarque a caixa de seleção ocultar arquivos protegidos do sistema operacional, selecione Sim para confirmar e, em seguida, 

selecione OK. 
5. Abra o explorador de arquivos. Para fazer isso, passe o dedo na borda direita da tela e, em seguida, toque em Pesquisar. (Se você 

estiver usando um mouse, aponte para o canto superior direito da tela, mova o ponteiro do mouse para baixo e selecione Pesquisar.) 
Insira o Explorador de arquivos na caixa de pesquisa, toque ou selecione aplicativos e toque ou selecione o explorador de arquivos. 
Digite prompt de comando na caixa de pesquisa, clique com o botão direito do mouse em prompt de comando e selecione Executar 
como administrador. 

6. Localize a pasta C:\Users\ Old_Username, na qual C é a unidade em que o Windows está instalado e Old_Username é o nome do 
perfil do qual você deseja copiar arquivos. 

7. Selecione todos os arquivos e pastas nesta pasta, exceto os seguintes arquivos: 
o Ntuser. dat 
o Ntuser. dat. log 
o Ntuser.ini 

8. No menu Editar, selecione copiar. 
 
Observação 
Se você não vir o menu Editar , pressione ALT. 
 

9. Localize a pasta C:\Users\ New_Username, na qual C é a unidade na qual o Windows está instalado e New_Username é o nome do 
perfil de usuário que você criou anteriormente neste método. 

10. No menu Editar, selecione colar. 
11. Faça logoff e, em seguida, faça logon novamente como o novo usuário. 

 
Observação 
Se você tiver mensagens de email em um programa de email, você deve importar suas mensagens e endereços de email para o novo perfil de 
usuário antes de excluir o perfil antigo. Se tudo estiver funcionando corretamente, agora você pode excluir o perfil antigo. 
 
Próxima etapa 
Se as informações deste artigo não ajudarem a resolver seu problema no Outlook 2016, Outlook 2013 ou Outlook 2010, consulte os seguintes 
recursos para obter mais informações: 

● Executar uma pesquisa para encontrar mais artigos online sobre esse erro específico 

● Visite a comunidade online da Microsoft para postar sua pergunta sobre esse erro 

● Encontre o número de telefone apropriado para entrar em contato com o suporte da Microsoft 
 

Referências 

● Corrigir um perfil de usuário corrompido no Windows 7 

● Criar uma conta de usuário no Windows 
 

  

https://support.microsoft.com/
https://answers.microsoft.com/
https://support.microsoft.com/contactus/
https://support.microsoft.com/help/14039
https://support.microsoft.com/help/13951
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EXCEL 
Analisar e formatar no Excel 
Preencher uma coluna automaticamente com o Preenchimento Relâmpago 
Por exemplo, preencha automaticamente uma coluna de Nome a partir de uma coluna de Nome completo. 

1. Na célula, abaixo de Nome, digite Letícia e pressione Enter. 
2. Na célula seguinte, digite as iniciais de Humberto. 
3. Quando o programa exibir a lista de valores sugeridos, pressione Enter. 

Selecione Opções de Preenchimento Relâmpago  para ver mais opções. 
Experimente! Escolha Arquivo > Novo, escolha Fazer um Tour e escolha a guia Preenchimento. 
 

 
 
Calcular rapidamente com o recurso AutoSoma 

1. Selecione a célula abaixo dos números que deseja adicionar. 

2. Selecione Página Inicial > AutoSoma  . 
3. Pressione Enter. 

 
Dica Para mais cálculos, selecione o menu suspenso ao lado de AutoSoma e selecione um cálculo. 
Você também pode selecionar um intervalo de números para conferir os cálculos comuns na barra de status. Confira Exibir dados de resumo 
na barra de status. 
 

 
 
Criar um gráfico 
Use a ferramenta Análise Rápida para escolher o gráfico certo para seus dados. 

1. Escolha os dados que você deseja mostrar em um gráfico. 

2. Escolha o botão Análise Rápida  , no canto inferior direito das células selecionadas. 
3. Selecione Gráficos, passe o mouse sobre as opções e escolha o gráfico desejado. 

 
Experimente!Selecione Arquivo > Novo, selecione Fazer uma tour e em seguida selecione a guia Gráficos. Para saber mais, 
confira Criar gráficos. 
 

 
 
Usar a formatação condicional 
Use Análise Rápida para realçar dados importantes ou mostrar tendências de dados. 

https://support.microsoft.com/pt-br/office/exibir-dados-de-resumo-na-barra-de-status-f42a3ae1-3786-4294-a433-1b36a1c17ebb
https://support.microsoft.com/pt-br/office/exibir-dados-de-resumo-na-barra-de-status-f42a3ae1-3786-4294-a433-1b36a1c17ebb
https://support.microsoft.com/pt-br/office/231c42d2-5e58-40e1-99f0-cbe618cfee1d
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1. Selecione os dados para usar formatação condicional. 

2. Escolha o botão Análise Rápida  , no canto inferior direito das células selecionadas. 
3. Selecionar Formatação, passe o mouse sobre as opções e escolha a opção desejada. 

Experimente!    Escolha Arquivo > Novo, escolha Fazer um tour e escolha a guia Análise. 
 

 
 
Congelar a linha de títulos superior 
Congele a linha superior de títulos de coluna para permitir a rolagem somente dos dados. 

1. Pressione Enter ou Esc para garantir a conclusão da edição de uma célula. 
2. Selecione Exibir > Congelar Painéis > Congelar Linha Superior. 

Para saber mais, confira o artigo Congelar painéis. 
 
Próximo: Colaborar no Excel 
 
 
USO DE MEMÓRIA NA EDIÇÃO DE 32 BITS DO EXCEL 2013 E 2016 
Observação 
O Office 365 ProPlus está sendo renomeado como Microsoft 365 Apps para empresas. Para obter mais informações sobre essa 
mudança, leia esta postagem de blog. 
 
Sintomas 
Depois de atualizar para o Microsoft Office 2013 ou 2016, você encontrará um ou mais dos seguintes sintomas:  

● O computador usa mais memória quando você abre vários arquivos do Microsoft Excel, salva arquivos do Excel ou faz cálculos em 
pastas de trabalho do Excel. 

● Você não pode mais abrir quantas pastas de trabalho do Excel na mesma instância possível antes de atualizar para o Excel. 

● Ao inserir colunas em uma pasta de trabalho do Excel, você recebe um erro sobre a memória disponível. 

● Ao trabalhar com uma planilha do Excel, você recebe a seguinte mensagem de erro: 
adocCopiar 
There isn't enough memory to complete this action. 
Try using less data or closing other applications. 
To increase memory availability, consider: 
- Using a 64-bit version of Microsoft Excel. 
- Adding memory to your device  
 

 

 
Motivo 
Embora melhorias no Office 2013/2016 não afetem significativamente os requisitos do sistema, o Office 2013/2016 usa mais recursos de 
sistema disponíveis do que o Office 2010. O limite de espaço de endereço virtual para edições de 32 bits de aplicativos baseados no 
Windows é de 2 gigabytes (GB). Para o Excel, esse espaço é compartilhado pelo próprio aplicativo do Excel junto com qualquer suplemento 
executado no mesmo processo. O tamanho da própria planilha também afeta o uso do espaço de endereço virtual. Como o Excel carrega a 
planilha na memória endereçável, algumas planilhas com um tamanho de arquivo inferior a 2 GB podem exigir que o Excel use mais de 2 GB 
de memória endereçável. Essa situação resulta na mensagem de erro mencionada na seção "sintomas". 

 
Resolução 

https://support.microsoft.com/pt-br/office/congelar-pain%C3%A9is-para-bloquear-linhas-e-colunas-dab2ffc9-020d-4026-8121-67dd25f2508f
https://support.microsoft.com/pt-br/office/colaborar-no-excel-a8af741e-00f2-44c0-a94b-38abd51af01f
https://go.microsoft.com/fwlink/p/?linkid=2120533
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Os usuários do Excel expert que trabalham com planilhas complexas do Excel podem se beneficiar usando a edição de 64 bits do Office 
2013/2016. Isso ocorre porque a edição de 64 bits do Office não impõe limites rígidos de tamanho de arquivo. Em vez disso, o tamanho de 
pasta de trabalho é limitado apenas pela memória e recursos do sistema disponíveis. Por outro lado, a edição de 32 bits do Office está limitada 
a 2 GB de espaço de endereço virtual, e esse espaço é compartilhado pelo Excel, a pasta de trabalho e os suplementos executados no mesmo 
processo. (Planilhas menores que 2 GB em disco ainda podem conter dados suficientes para ocupar 2 GB ou mais de memória endereçável.) 
As opções a seguir podem ajudar a melhorar o desempenho no Excel 2013/2016: 

• Os usuários do Excel que trabalham regularmente com planilhas do Excel grandes e complexas podem se beneficiar com o uso 
da edição de 64 bits do Office 2013 porque as edições de 64 bits de aplicativos baseados no Windows podem resolver até 8 
terabytes (TB) de memória. Saiba mais sobre as edições de 64 bits do Office 2013. 

• A limitação de 2 GB é por instância de processo do Windows do Excel. Você pode executar vários arquivos em uma instância. No 
entanto, se os arquivos são realmente grandes e precisam ser abertos, considere abrir várias instâncias para os outros arquivos. 
Para obter informações sobre os limites que você pode encontrar, consulte não é possível colar atributos em uma pasta de trabalho 
em outra instância do Excel. 

• Se você estiver executando o Windows 7 ou o Windows 2008, sugerimos que você instale a atualização de plataforma para o 
Windows 7 SP1 e o Windows Server 2008 R2 SP1. 

• Teste o desempenho sem suplementos de COM. os suplementos de COM podem usar a memória à custa da limitação de 2 GB. 
Para testar, desabilite os suplementos de COM e inicie o Excel. Se os suplementos de COM estiverem causando o problema de 
memória, entre em contato com o fornecedor de terceiros para obter uma cópia atualizada ou uma versão de 64 bits dos 
suplementos de COM. 

• Desabilitar a aceleração gráfica de hardware. Isso encerra as animações. Para fazer isso, no menu arquivo, clique em Opções, 
clique em avançado, clique em Exibire, em seguida, selecione Desabilitar aceleração de gráficos de hardware. 

• Altere a pasta de trabalho para simplificar as áreas que usam a memória desnecessariamente. Para obter alterações sugeridas, 
consulte como limpar uma pasta de trabalho do Excel 2013 para que ela use menos memória. 

 
Observação 
32-bit o Excel 2016 será habilitado para o grande reconhecimento de endereços com a atualização 4 de maio de 2016, o número de compilação 
16.0.6868.2060 para assinantes do canal atual do O365. Para obter mais informações sobre atualização com reconhecimento de endereço 
grande clique aqui. 
 
Informações adicionais 
Você pode usar o Process Explorer para verificar se está se aproximando do limite de 2 GB no Excel. Considere algo mais de 1,75 GB como 
máximo para a edição de 32 bits do Excel. A coluna a ser focalizada não está ali por padrão e pode ser adicionada escolhendo exibir> selecionar 
colunas> guia memória de processo e clicar em tamanho virtual. 
Antes de mudar para uma versão de 64 bits do Office, revise as informações neste link: 
https://technet.microsoft.com/library/ee681792.aspx 
 
Outros recursos 
Como solucionar erros de "recursos disponíveis" no Excel 
 
 

  

https://technet.microsoft.com/library/ee681792.aspx
https://docs.microsoft.com/pt-br/office/troubleshoot/excel/cannot-paste-attributes
https://docs.microsoft.com/pt-br/office/troubleshoot/excel/cannot-paste-attributes
https://support.microsoft.com/help/2670838
https://support.microsoft.com/help/2670838
https://docs.microsoft.com/pt-br/office/troubleshoot/excel/clean-workbook-less-memory
https://support.microsoft.com/help/3160741
https://technet.microsoft.com/sysinternals/bb896653.aspx
https://technet.microsoft.com/library/ee681792.aspx
https://support.microsoft.com/help/2779852
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POWERPOINT 
Criar uma apresentação no PowerPoint 
Com o PowerPoint no PC, Mac ou dispositivo móvel, é possível: 

▪ Criar apresentações do zero ou usar um modelo. 

▪ Adicionar texto, imagens, arte e vídeos. 

▪ Escolher um design profissional com o Designer do PowerPoint. 

▪ Adicionar transições, animações e movimentos. 

▪ Salvar no OneDrive para acessar suas apresentações no computador, tablet ou telefone. 

▪ Compartilhe e trabalhe com outras pessoas, onde quer que elas estejam. 
 
Criar uma apresentação 

1. Abra o PowerPoint. 
2. Escolha uma opção: 

▪ Escolha Apresentação em Branco para criar uma apresentação do zero. 

▪ Escolha um dos modelos. 

▪ Escolha Fazer um Tour e, em seguida, escolha Criar para ver dicas de como usar o PowerPoint. 

▪  

 
 
Adicionar um slide 

1. Selecione o slide que ficará antes do novo slide. 
2. Selecione Página Inicial > Novo Slide. 
3. Selecione layout e o tipo desejado na lista suspensa. 

 

 
 
Adicionar e formatar texto 

1. Coloque o cursor do mouse no local de sua preferência e digite. 
2. Escolha o texto e, em seguida, escolha uma opção na guia Página Inicial: Fonte, Tamanho da fonte, Negrito, Itálico, Sublinhado... 
3. Para criar listas numeradas ou com marcadores, selecione o texto e escolha Marcadores ou Numeração. 
4.  
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Adicionar uma imagem, forma ou gráfico 

1. Escolha Inserir. 
2. Para adicionar uma imagem: 

▪ Escolha Imagem. 

▪ Procure a imagem desejada e escolha Inserir. 
3. Para adicionar uma forma, arte ou gráfico: 

▪ Escolha Formas, Ícones,SmartArt, ou Gráfico. 

▪ Escolha o item desejado. 
 

 
 
COMO SOLUCIONAR PROBLEMAS DE UMA APRESENTAÇÃO DANIFICADA NO POWERPOINT 
Observação 
O Office 365 ProPlus está sendo renomeado como Microsoft 365 Apps para empresas. Para obter mais informações sobre essa mudança, leia 
esta postagem de blog. 
 
Resumo 
Você poderá observar um comportamento inesperado ao trabalhar com uma apresentação do Microsoft PowerPoint. Esse comportamento 
pode ocorrer porque a apresentação está danificada. Este artigo contém métodos passo a passo que podem ajudá-lo a restaurar a apresentação 
parcial ou totalmente. 
Este artigo destina-se a usuários de computador iniciantes e intermediários. Poderá ser fácil executar as etapas se você imprimir este artigo 
primeiro. 
 
Sintomas 
Ao tentar abrir ou alterar uma apresentação que está danificada, você pode observar os seguintes sintomas: 

● Ao tentar abrir uma apresentação, você recebe uma das seguintes mensagens de erro: 
Esta não é uma apresentação de PowerPoint 
O PowerPoint não consegue abrir o tipo de arquivo representado por <file_name>.ppt 
Parte do arquivo está ausente. 

● Você recebe os seguintes tipos de mensagens de erro: 
Falha de Proteção Geral 
Instrução Ilegal 
Falha de Página Inválida 
Poucos recursos do sistema 
Sem memória 

 
Informações adicionais 
Como determinar se você tem uma apresentação danificada 
Existem várias maneiras de determinar se você tem uma apresentação danificada. Você pode tentar abrir o arquivo em outro computador 
que tenha o PowerPoint instalado para ver se o comportamento inesperado ocorre no outro computador. Você pode tentar criar um novo 

https://go.microsoft.com/fwlink/p/?linkid=2120533
https://go.microsoft.com/fwlink/p/?linkid=2120533


212 

 

arquivo no PowerPoint e ver se o comportamento inesperado ocorre com o novo arquivo. Esta seção descreve como usar apresentações 
existentes e como criar um novo arquivo no PowerPoint para determinar se as apresentações têm o mesmo comportamento. 

 
Método 1: Abrir uma apresentação existente 

1. No menu Arquivo, selecione Abrir. 
o No PowerPoint 2007, selecione o Botão do Microsoft Office. 

2. Selecione outra apresentação e, depois, Abrir. 
Se essa apresentação for aberta e parecer não estar danificada, vá para o Método 3 nesta seção. Caso contrário, vá para o Método 2 para 
criar uma nova apresentação. 

 
Método 2: Criar uma nova apresentação 
Etapa 1: criar a apresentação 

1. No menu Arquivo, selecione Novo e Bem-vindo ao PowerPoint (ou Apresentando o PowerPoint 2010). 
o No PowerPoint 2007, selecione Modelos Instalados e Apresentando o PowerPoint 2007. 

2. Selecione Criar. Esse processo cria uma apresentação baseada no modelo. 
3. No menu Arquivo, selecione Salvar. 

o No PowerPoint 2007, selecione o Botão do Microsoft Office e Salvar. 
4. Digite um nome para a apresentação e selecione Salvar. 
5. Saia do PowerPoint. 

 
Etapa 2: Abrir a nova apresentação 

1. No menu Arquivo, selecione Abrir. 
o No PowerPoint 2007, selecione o Botão do Microsoft Office e Abrir. 

2. Selecione a nova apresentação e, depois, Abrir. 
Se você não puder abrir ou salvar a nova apresentação, vá para o Método 3. 
Se você não puder criar uma nova apresentação, talvez o PowerPoint esteja danificado e um reparo deva ser iniciado. (Consulte o Método 3, 
Parte 2 abaixo.) 
 
Método 3: Solução geral de problemas 
Windows 10, Windows 8.1, Windows 8 e Windows 7 
 
Parte 1 
Este procedimento permite que o computador seja reiniciado sem complementos de inicialização. Para uma inicialização limpa, siga estas 
etapas: 

1. Entre no computador usando uma conta com direitos de administrador. 
2. Selecione Iniciar, digite msconfig.exe na caixa Iniciar Pesquisa e pressione Enter para iniciar o utilitário de Configuração do Sistema. 

 
Observação 
Se for solicitada uma senha de administrador ou sua confirmação, você deverá digitar a senha ou fornecer a confirmação. 

3. Na guia Geral , selecione a opção Inicialização seletiva e desmarque a caixa de seleção Carregar itens de inicialização . (A caixa de 
seleção Usar Boot.ini Original não está disponível.) 

4. Na guia Serviços, marque a caixa de seleção Ocultar todos os serviços Microsoft e selecione Desabilitar tudo. 
 
Observação 
Essa etapa permite que os serviços Microsoft continuem a ser executados. Depois de executar uma reinicialização limpa, você deve 
verificar o desempenho do Office e, em seguida, retomar a inicialização usual. 

 
Parte 2 
Este procedimento fará com que o programa Office verifique se há problemas e os repare por conta própria. 

1. Selecione o botão Iniciar e digite Painel de Controle. 
2. Abra o Painel de Controle e vá para Desinstalar ou alterar um programa (ou Adicionar ou Remover Programas). 
3. Role pela lista de programas e encontre sua versão do Microsoft Office. Clique com o botão direito do mouse e selecione Alterar. 

Observação 
Sugerimos que você escolha a opção de reparo online. 

 
Métodos a serem tentados se você não conseguir abrir uma apresentação 
Método 1: Arraste a apresentação para o ícone do arquivo do programa PowerPoint 
Windows 10, Windows 8.1 e Windows 8 

1. Clique com o botão direito do mouse no ícone do Windows na Barra de Tarefas e selecione Executar. 
2. Digite um dos seguintes métodos, dependendo de sua versão do PowerPoint: 

PowerShellCopiar 
%ProgramFiles%\Microsoft Office 
%ProgramFiles(x86)%\Microsoft Office 

3. Selecione a tecla Enter. 
4. Localize o ícone de Powerpnt.exe no Windows Explorer. 
5. Arraste o ícone da apresentação danificada de uma janela para o ícone de Powerpnt.exe na outra janela. 

O PowerPoint tentará abrir a apresentação. Se o PowerPoint não abrir a apresentação, vá para o Método 2. 
 
Windows 7 

1. Selecione Iniciar e Documentos. Ou selecione Iniciar e, em seguida, procure pelo Windows Explorer. 
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2. Se você tiver a versão MSI do PowerPoint 2013 instalada, digite %ProgramFiles%\Microsoft Office\office15 (PowerPoint 2013 de 64 
bits) ou %ProgramFiles(x86)%\Microsoft Office\office15 (PowerPoint 2013 de 32 bits) e, em seguida, pressione Enter. 
Se você tiver o PowerPoint 2013 Select-to-Run instalado, digite C:\Program Files\Microsoft Office 15\root\office15 (PowerPoint 
2013 de 64 bits) ou C:\Program Files(x86)\Microsoft Office 15\root\office15 (PowerPoint 2013 de 32 bits) e, em seguida, 
pressione Enter. 
Se você tiver a versão MSI do PowerPoint 2016 instalada, digite %ProgramFiles(x86)%\Microsoft Office\office16 e pressione Enter. 
Se você tiver o PowerPoint 2016 Select-to-Run instalado, digite %ProgramFiles%\Microsoft Office\root\Office16 (PowerPoint 2016 
de 64 bits) ou %ProgramFiles(x86)%\Microsoft Office\root\Office16 (PowerPoint 2016 de 32 bits) e pressione Enter. 

3. Localize o ícone de Powerpnt.exe no Windows Explorer. 
4. Arraste o ícone da apresentação danificada de uma janela para o ícone de Powerpnt.exe na outra janela. 

 
Método 2: Tente inserir slides em uma apresentação em branco 
Etapa 1: Crie uma apresentação em branco 

1. No menu Arquivo, selecione Novo. 
o No PowerPoint 2007, clique no Botão do Microsoft Office e clique em Novo. 

2. Selecione Apresentação em Branco e, depois, Criar. 
Esse processo cria um slide de título em branco. Você pode excluir esse slide mais tarde, depois de recriar a apresentação. 
 
Etapa 2: Insira a apresentação danificada como slides 

1. Na guia Início, selecione a seta ao lado de Novos slides, no grupo Slides, e selecione Reutilizar Slides. 
2. No painel de tarefas Reutilizar Slides, selecione Procurar. Selecione a apresentação danificada e, depois, Abrir. 
3. Selecione Inserir Slide para cada slide na apresentação danificada. 
4. No menu Arquivo, selecione Salvar. 

o No PowerPoint 2007 clique no Botão do Microsoft Office e clique em Salvar. 
5. Digite um novo nome para a apresentação e selecione Salvar. 

 
Etapa 3: Aplique a apresentação danificada como modelo 
Se a apresentação não tiver a aparência que você espera após experimentar essas etapas, tente aplicar a apresentação danificada como um 
modelo. Para fazer isso, siga estas etapas: 

1. No menu Arquivo, selecione Salvar como. 
o No PowerPoint 2007, clique no Botão do Microsoft Office e clique em Salvar como. 

2. Digite um novo nome para a apresentação e selecione Salvar. 
 
Observação 
Isso criará uma cópia de backup da apresentação restaurada, que você poderá usar caso a apresentação danificada danifique essa 
nova apresentação. 
 

3. Na guia Design, selecione Mais no grupo Temas e selecione Procurar Temas. 
4. Selecione a apresentação danificada e, depois, Aplicar. O slide mestre da apresentação danificada substitui o novo slide mestre. 

 
Observação 
Se você começar a observar um comportamento inesperado depois de seguir essas etapas, talvez o modelo tenha danificado a apresentação. 
Nesse caso, use a cópia de backup para recriar o slide mestre. 
Se a cópia de backup da nova apresentação exibir o mesmo dano ou comportamento estranho que a apresentação original, vá para o 
Método 3. 
 
Método 3: Tente abrir a versão de arquivo temporário da apresentação 
Quando você edita uma apresentação, o PowerPoint cria uma cópia temporária do arquivo. Esse arquivo temporário é chamado PPT 
####.tmp. 
 
Observação 
O espaço reservado #### representa um número aleatório de quatro dígitos. 
Esse arquivo temporário pode estar localizado na mesma pasta em que a apresentação é salva. Ou pode estar localizado na pasta de 
arquivos temporários. 
Renomeie o arquivo e, em seguida, tente abri-lo no PowerPoint 

1. Clique com o botão direito do mouse no arquivo e selecione Renomear. 
2. Altere a antiga extensão de nome de arquivo de .tmp para .pptx para que o nome do arquivo se assemelhe ao seguinte: 

PPT ####.pptx 
3. Inicie o PowerPoint. 
4. No menu Arquivo, selecione Abrir. 
5. Navegue até a pasta que contém o arquivo renomeado. 
6. Tente abrir o arquivo no PowerPoint. 

 
Observação 
Mais de um arquivo pode corresponder ao arquivo temporário que foi criado da última vez que você salvou a apresentação. Nesse caso, você 
pode ter que abrir cada arquivo para ver se é a cópia temporária da apresentação. 
Se não houver arquivos temporários ou se os arquivos temporários exibirem o mesmo tipo de dano ou comportamento estranho, vá para o 
Método 4. 

 
Método 4: Fazer uma cópia da apresentação danificada 

1. Clique com o botão direito do mouse na apresentação e selecione Copiar. 
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2. Na janela do Windows Explorer, clique com o botão direito do mouse em um espaço em branco e selecione Colar. 
Se você não puder copiar o arquivo, talvez ele esteja danificado ou resida em uma parte danificada do disco rígido do computador. Nesse 
caso, vá para o Método 5. 
Se você puder copiar o arquivo, tente abrir a cópia da apresentação danificada no PowerPoint. Se você não puder abrir a cópia da 
apresentação danificada, tente repetir do Método 1 até o Método 5 na seção "Métodos a serem tentados se você não puder abrir uma 
apresentação" abaixo usando a cópia da apresentação danificada. 

 
Método 5: Executar Verificação de Erros na unidade de disco rígido 
Windows 10, Windows 8.1 e Windows 8 

1. Saia de todos os programas abertos. 
2. Clique com o botão direito do mouse no menu Iniciar e selecione Explorador de Arquivos . 
3. Clique com o botão direito do mouse na unidade de disco rígido que contém a apresentação danificada. 
4. Selecione Propriedades e a guia Ferramentas. 
5. Na Verificação de erros, selecione Verificar Agora. 
6. Marque a caixa de seleção Corrigir erros do sistema de arquivos automaticamente. 
7. Marque a caixa de seleção Procurar setores defeituosos e tentar recuperá-los. 
8. Selecione Iniciar. 

 
Windows 7 

1. Saia de todos os programas abertos. 
2. Selecione Iniciar e Computador. 
3. Clique com o botão direito do mouse na unidade de disco rígido que contém a apresentação danificada. 
4. Selecione Propriedades e a guia Ferramentas. 
5. Na Verificação de erros, selecione Verificar Agora. 
6. Marque a caixa de seleção Corrigir erros do sistema de arquivos automaticamente. 
7. Marque a caixa de seleção Procurar setores defeituosos e tentar recuperá-los. 
8. Selecione Iniciar. 

 
Observação 
A verificação de erros pode verificar se a apresentação está com vínculo cruzado e tentar repará-la. No entanto, isso não é uma garantia de 
que o PowerPoint será capaz de ler a apresentação. 
 
Métodos a serem tentados se você puder abrir uma apresentação danificada 
Método 1: Tente aplicar a apresentação danificada como modelo 
Etapa 1: Crie uma apresentação em branco 

1. No menu Arquivo, selecione Novo. 
o No PowerPoint 2007, selecione o Botão do Microsoft Office e Novo. 

2. Clique em Apresentação em branco e depois em Criar. Esse processo cria um slide de título em branco. (Você pode excluir esse 
slide depois de recriar a apresentação.) 

 
Etapa 2: Insira a apresentação danificada na apresentação em branco 

1. Na guia Início , selecione a seta ao lado de Novos slides , no grupo Slides e selecione Reutilizar Slides . 
2. No painel de tarefas Reutilizar Slides , selecione Navegar . 
3. Selecione a apresentação danificada e Abrir . 
4. Selecione Inserir Slide para cada slide na apresentação danificada. 
5. Selecione o botão do Microsoft Office e, em seguida, Salvar . 
6. Digite um novo nome para a apresentação e selecione Salvar. 

 
Etapa 3: Aplique a apresentação danificada como modelo 
Se a apresentação não estiver da maneira que você espera após seguir essas etapas, tente aplicar a apresentação danificada como um 
modelo. Para fazer isso, siga estas etapas: 

1. No menu Arquivo, selecione Salvar como. 

● No PowerPoint 2007, selecione o Botão do Microsoft Office e Salvar como . 
1. Digite um nome novo para a apresentação e selecione Salvar . 

 
Observação 
Isso criará uma cópia de backup da apresentação restaurada, que você poderá usar caso a apresentação danificada danifique essa 
nova apresentação. 
 

2. Na guia Design, selecione Mais no grupo Temas e selecione Procurar Temas. 
3. Selecione a apresentação danificada e Aplicar. O slide mestre da apresentação danificada substitui o novo slide mestre. 

 
Observação 
Se você começar a observar um comportamento inesperado depois de seguir essas etapas, talvez o modelo tenha danificado a apresentação. 
Nesse caso, use a cópia de backup para recriar o slide mestre. 
Se a cópia de backup da nova apresentação ainda exibir danos ou comportamento estranho, vá para o Método 2. 

 
Método 2: Transfira os slides da apresentação danificada para uma apresentação em branco 
Etapa 1: Crie uma apresentação em branco 

1. No menu Arquivo no PowerPoint, selecione Abrir. 
o No PowerPoint 2007: clique no Botão do Microsoft Office e clique em Abrir. 
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2. Localize a apresentação danificada e clique em Abrir. 
3. No menu Arquivo no PowerPoint, selecione Novo. 

o No PowerPoint 2007: clique no Botão do Microsoft Office e clique em Novo. 
4. Clique em Apresentação em branco e depois em Criar. Esse processo cria um slide de título em branco. 

 
Etapa 2: Copiar slides da apresentação danificada para a nova apresentação 

1. Na guia Exibir, selecione Classificação de Slides. Se você receber mensagens de erro ao alternar visualizações, tente usar o Modo 
de exibição de estrutura de tópicos. 

2. Selecione um slide que você queira copiar. Na guia Inicial, selecione Copiar. 
 
Observação 
Se você quiser copiar mais de um slide de cada vez, mantenha pressionada a tecla Shift e selecione cada slide que deseja copiar. 
 

3. Alterne para a nova apresentação. Para fazer isso, na guia Janela, selecione Alternar Janela no grupo Exibir e selecione a nova 
apresentação que você criou na etapa 1. 

4. Na guia Exibir, selecione Classificação de Slides. 
5. Na guia Inicial, selecione Colar. 
6. Repita as etapas 2a a 2f até que toda a apresentação seja transferida. 

 
Observação 
Em alguns casos, um slide danificado pode causar um problema durante toda a apresentação. Se você notar um comportamento inesperado 
na nova apresentação depois de copiar um slide para a apresentação, esse slide provavelmente será danificado. Recrie o slide ou copie 
seções dele para um novo slide. 
Se a nova apresentação mostrar danos ou comportamentos estranhos, vá para o método 3. 

 
Método 3: Salve a apresentação como um arquivo RTF (Formato Rich Text) 
Se houver danos em toda a apresentação, a única opção para recuperá-la poderá ser salvá-la como um arquivo RTF (Formato Rich Text). Se 
este método for bem sucedido, ele recuperará apenas o texto que aparece no Modo de exibição de estrutura de tópicos. 
 
Etapa 1: Salvar a apresentação no formato de arquivo RTF 

1. Abra a apresentação. 
2. No menu Arquivo, clique em Salvar Como, selecione um local para salvar o arquivo e clique em Mais opções. 

o No PowerPoint 2007, selecione o Botão do Microsoft Office, clique em Salvar Como e depois em Outros Formatos. 
3. Na lista Salvar como tipo, clique em Estrutura de tópicos/RTF (*.rtf). 
4. Na caixa Nome do Arquivo, digite o nome que você deseja usar, selecione um local para salvar a apresentação e selecione Salvar. 
5. Feche a apresentação. 

 
Observação 
Quaisquer gráficos, tabelas ou outro texto na apresentação original não serão salvos no arquivo .rtf. 
Etapa 2: Abrir o arquivo .rtf no PowerPoint 

1. No menu Arquivo, selecione Abrir. 
2. Na lista Arquivos do tipo, selecione Todas as Estruturas de Tópicos ou Todos os Arquivos. 
3. Selecione o arquivo .rtf que você salvou na etapa 1d e selecione Abrir. 

Este procedimento recriará a apresentação com base no modo de exibição de estrutura de tópicos da apresentação original. 
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WORD 
 
Controlar alterações no Word 
A ativação do recurso Controlar Alterações oferece a você e seus colegas de trabalho uma maneira de fazer alterações fáceis de identificar. 
Elas são como sugestões que você pode revisar e depois removê-las ou torná-las permanentes. 
 
Ativar e desativar o recurso Controlar Alterações 

▪ Na guia revisão, vá para controle e selecione controlar alterações. 
 

 
▪  

▪ Quando o recurso controlar alterações está ativado, as exclusões são marcadas com um tachado, e os acréscimos são marcados com um 
sublinhado. Alterações de diferentes autores são indicadas com cores diferentes. 

▪ Quando a opção controlar alterações está desativada, o Word para de marcar as alterações, mas os sublinhados coloridos e tachado de suas 
alterações permanecem no documento até serem aceitos ou rejeitados. 

▪  
Observação: Se o recurso controlar alterações não estiver disponível, talvez seja necessário desativar a proteção do documento. Vá para 
revisão > restringir edição e, em seguida, selecione parar proteção. (Talvez você precise fornecer a senha do documento). 

 
Mostrar ou ocultar comentários ou alterações controladas 
Exibir todas as alterações embutidas 
O padrão no Word é exibir exclusões e comentários em balões nas margens do documento. No entanto, você pode alterar a exibição para 
mostrar comentários embutidos e todas as exclusões com tachados, em vez de dentro de balões. 

1. Na guia revisão , vá para controle. 
2. Selecione Mostrar marcação. 
3.  

 
 

4. Aponte para balões e selecione Mostrar todas as revisões embutidas. 
Exiba comentários embutidos como dicas de tela. 

▪ Coloque o ponteiro sobre um comentário no documento. O comentário aparece em uma Dica de Tela. 

▪  

 
 
Exibir alterações por tipo de edição ou por revisor 

1. Na guia revisão , vá para controle e selecione Mostrar marcação. 
2.  

 
 

3. Siga um destes procedimentos: 

▪ Selecione o tipo de alteração que você deseja exibir. 

▪ Por exemplo, selecione comentários, inserções e exclusõesou formatação. A marca de seleção ao lado do item indica que ele foi 
selecionado. 
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▪  
▪  

Importante: Mesmo se você ocultar um tipo de marcação desmarcando-a no menu Mostrar Marcação, ela será exibida 
automaticamente sempre que o documento for aberto por você ou por um revisor. 

▪  

▪ Aponte para pessoas específicas e desmarque todas as caixas de seleção, exceto aquelas ao lado dos nomes dos revisores cujas 
alterações e comentários você deseja mostrar. 

▪  
Observação: Para marcar ou desmarcar todas as caixas de seleção de todos os revisores na lista, selecione todos os revisores. 
 
Exibir alterações e comentários de revisores específicos 
Um editor ou revisor geralmente quer exibir um documento como ele aparecerá depois que as alterações forem incorporadas. Esse 
procedimento oferece a um editor ou revisor a oportunidade de ver a aparência do documento com as alterações. 

1. Vá para revisão > rastreamento > Exibir para revisão. 
 

   
2.  
3. Escolha a opção desejada: 

▪ Para revisar as alterações, indicadas por uma linha vermelha na margem, escolha Marcação Simples. 

▪ Para ver os detalhes das alterações, escolha Todas as Marcações. 

▪ Para ter uma visualização de como ficará o documento se todas as alterações sugeridas passarem a ser permanentes, escolha Sem 
Marcação. 

▪ Para exibir o documento original como se todas as alterações sugeridas tivessem sido removidas, escolha Original. 
Ocultar comentários e alterações controladas ao imprimir 
Ocultar as alterações não as remove do documento. Para remover a marcação do documento, use os comandos aceitar e rejeitar no 
grupo alterações . 

1. Vá para arquivo > > configurações de impressão> imprimir todas as páginas. 
2. Em informações do documento, selecione Imprimir marcação para desmarcar a marca de seleção. 
3.  
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Revisar alterações controladas e comentários 
Revisar um resumo das alterações controladas 
Usando o painel de revisão, você pode garantir que todas as alterações controladas tenham sido removidas do seu documento. A seção de 
resumo na parte superior do Painel de Revisão exibe o número exato de alterações controladas e comentários que permanecem no 
documento. 
O Painel de Revisão permite ler comentários longos que não cabem em um balão. 
 
Observação: Ao contrário do documento ou dos balões de comentário, o Painel de Revisão não é melhor ferramenta para fazer alterações 
no documento. Em vez de excluir texto ou comentários ou fazer outras alterações no Painel de Revisão, faça todas as alterações editoriais no 
documento. Elas ficarão visíveis no Painel de Revisão. 

1. Na guia revisão , vá para controle e selecione painel de revisão. 
2.  

3.  
4.  
5. Siga um destes procedimentos: 

▪ Para exibir o resumo na lateral da tela, selecione Painel de revisão vertical. 

▪ Para exibir o resumo na parte inferior da tela, selecione o painel de revisão horizontal. 
Por padrão, o painel de revisão mostra na parte superior quantas revisões totais estão no documento. Para ver o número e o tipo das 
alterações, selecione o Carat ao lado do número de revisões. 
 

 
 
Revisar cada alteração controlada em sequência 

1. Clique ou toque no início do documento. 
2. Na guia revisão , vá para alterações. 
3. Selecione aceitar ou rejeitar. À medida que você aceita ou rejeita alterações, o Word se moverá para a próxima alteração. 
4.  

 
 
Repita até que não haja mais alterações controladas ou comentários no documento. 
 
Dica: Para revisar as alterações no documento sem aceitá-las ou rejeitá-las, selecione próximo ou anterior. 
 
Aceitar ou rejeitar uma única alteração 
Em vez de percorrer alterações na sequência, você pode aceitar ou rejeitar uma única alteração. Quando você aceita ou rejeita a alteração, o 
Word não se move para a próxima alteração no documento. 

▪ Clique com o botão direito do mouse na alteração e selecione a opção para aceitá-la ou rejeitá-la. 
 

 
 
Revisar alterações por tipo de edição ou por revisor específico 

1. Clique ou toque no início do documento. 
2. Na guia revisão , vá para controle. 
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3.  
4.  
5. Na lista Mostrar marcação , siga um destes procedimentos: 

▪ Desmarque todas as caixas de seleção, exceto aquelas ao lado dos tipos de alterações que você deseja revisar. 

▪ Aponte para pessoas específicase desmarque todas as caixas de seleção, exceto aquelas ao lado dos nomes dos revisores cujas 
alterações você deseja ver ou escolha todos os revisores para marcar ou desmarcar as caixas de seleção de todos os revisores na lista. 

6. Na guia revisão , vá para alterações. 
7. Selecione aceitar ou rejeitar. À medida que você aceita ou rejeita alterações, o Word se moverá para a próxima alteração. 
8.  

9.  
10.  
11. Repita até revisar todas as alterações no documento. 

Aceitar todas as alterações simultaneamente 
1. Vá para revisão > alterações. 
2. Na lista aceitar , selecione aceitar todas as alterações ou aceite todas as alterações e pare de acompanhar. 

 
 
Aceitar ou rejeitar todas as alterações simultaneamente 

1. Na guia revisão , vá para alterações. 
2. Siga um destes procedimentos: 

▪ Na lista suspensa aceitar , selecione aceitar todas as alterações. 

▪ Na lista suspensa rejeitar , selecione rejeitar todas as alterações. 

▪  

 
 
Excluir comentários 

1. Selecione um comentário. 
2. Na guia revisão , vá para comentáriose selecione excluir. 

 

 
3.  
4. Clique em próximo ou anterior para mover para outro comentário. 

Excluir todos os comentários 
1. Selecione um comentário. 
2. Na guia revisão , vá para comentários. 



220 

 

3. Na lista suspensa excluir , selecione excluir todos os comentários no documento. 
 

 
4.  

Pratique com o recurso controlar alterações e outros recursos de colaboração no Word ao fazer o download do guia de aprendizagem do 
Word para colaborar 

 
 
Como solucionar problemas de documentos danificados no Word 
 
Observação 
O Office 365 ProPlus está sendo renomeado como Microsoft 365 Apps para empresas. Para obter mais informações sobre essa 
mudança, leia esta postagem de blog. 

 
Resumo 
Este artigo descreve como identificar um documento danificado no Word 2007 e versões posteriores. Além disso, o artigo inclui etapas que 
explicam como recuperar o texto e os dados contidos em um documento depois de ter identificado que o documento está danificado. 
Este artigo destina-se a usuários de computador iniciantes e intermediários. Poderá ser fácil executar as etapas se você imprimir este artigo 
primeiro. 
 
Atualizar o Microsoft Office e o Windows 
Muitos problemas de software podem ser resolvidos atualizando os programas Microsoft Office e Windows. 
Perguntas frequentes sobre o Windows Update 
Instalar atualizações do Office 
Atualizar o Office com o Microsoft Update 

 
Um documento danificado ou um problema de software? 
Um documento do Word pode ser corrompido por várias razões, que o impedirão de abri-lo. Esse comportamento talvez esteja relacionado ao 
documento ou ao modelo que serve de base para o documento. Este comportamento pode incluir o seguinte: 

● Renumera repetidamente as páginas existentes no documento 

● Renumera repetidamente as quebras de página no documento 

● Layout e formatação do documento incorretos 

● Caracteres ilegíveis na tela 

● Mensagens de erro durante o processamento 

● Um computador que deixa de responder quando você abre o arquivo 

● Algum outro comportamento inesperado que não pode ser atribuído à operação normal do programa 
 
Às vezes, esse comportamento pode ser causado por outros fatores além do documento danificado. É importante determinar se o documento 
está danificado ou se a questão é um problema de software. Para eliminar esses outros fatores, execute as seguintes etapas: 

1. Procure por comportamento semelhante em outros documentos. Tente abrir outros documentos do Word para ver se o mesmo 
problema ocorre. Se abrirem corretamente, então o problema poderá estar no documento do Word. 

2. Procure por comportamento semelhante em outros programas do Microsoft Office. Se esse for o caso, então o problema poderá 
estar em outro aplicativo ou no sistema operacional. 

Se qualquer dessas etapas indicar que o problema não está no documento, será necessário solucionar problemas do Word, do pacote do 
Office ou do sistema operacional que estiver em execução no computador. 

 
Etapas da solução de problemas para tentar abrir o documento danificado 
Tente os métodos na ordem indicada. Se um não funcionar, tente o seguinte. 
Método 1: Abrir o documento danificado no modo de rascunho sem atualizar links 
 
Etapa 1: Configurar o Word 

1. Inicie o Word. 
2. Na guia Exibir, selecione Rascunho no grupo Modos de exibição. 
3. Selecione o Menu Arquivo, **Opções **e depois Avançado. 
4. Na seção Mostrar conteúdo do documento, selecione **Usar fonte de rascunho nos modos de exibição Estrutura de Tópicos e 

Rascunho ** e Mostrar espaços reservados a imagens. 
5. Role para baixo até a seção Geral, desmarque a caixa de seleção Atualizar links automaticamente ao abrir, clique em OK e feche o 

Word. 

 
Etapa 2: Abrir o documento danificado 

1. Inicie o Word. 

https://go.microsoft.com/fwlink/?linkid=2041171
https://go.microsoft.com/fwlink/?linkid=2041171
https://go.microsoft.com/fwlink/p/?linkid=2120533
https://support.microsoft.com/help/12373/windows-update-faq
https://support.office.com/article/install-office-updates-2ab296f3-7f03-43a2-8e50-46de917611c5
https://support.office.com/article/update-office-with-microsoft-update-f59d3f9d-bd5d-4d3b-a08e-1dd659cf5282
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2. Selecione o Menu Arquivo e clique em Abrir. 
3. Selecione o documento danificado e clique em Abrir. 

Se for possível abrir o documento, feche o documento e reabra-o usando o método 6, e corrija o documento. Caso contrário, vá para o 
método 2. 
 
Método 2: Inserir o documento como um arquivo em um novo documento 
 
Etapa 1: Criar um novo documento em branco 

1. Selecione o Menu Arquivo e depois Novo. 
2. Clique em Documento em branco e depois em Criar. 

 
Observação 
Talvez seja necessário reaplicar alguma formatação à última seção do novo documento. 

 
Etapa 2: Inserir o documento danificado no novo documento 

1. Na guia Inserir, clique em Inserir Objeto e depois em Texto de Arquivo. 
2. Na caixa de diálogo Inserir Arquivo, localize e selecione o documento danificado. Em seguida, selecione Inserir. 

 
Observação 
Talvez seja necessário reaplicar alguma formatação à última seção do novo documento. 

 
Método 3: Criar um link para o documento danificado 

 
Etapa 1: Criar um documento em branco 

1. No Word, clique em Menu Arquivo e em Novo. 
2. Clique em Documento em branco e depois em Criar. 
3. No documento novo, digite "Teste". 
4. Clique no Menu Arquivo e em Salvar. 
5. Digite "Link de salvamento" e clique em Salvar. 

 
Etapa 2: Criar um link 

1. Selecione o texto digitado nas etapas 1-3. 
2. Na guia Início, clique em Copiar no grupo Área de Transferência. 
3. Selecione o Menu Arquivo e depois Novo. 
4. Clique em Documento em branco e depois em Criar. 
5. Na guia Início, clique na seta no botão Colar, no grupo Área de transferência, e depois em Colar Especial. 
6. Clique em Colar link e selecione Texto Formatado (RTF). 
7. Selecione OK. 

 
Etapa 3: Alterar o link do documento danificado 

1. Clique com o botão direito no texto vinculado do documento, aponte para Objeto de Documento Vinculado e clique em Vínculos. 
2. Na caixa de diálogo Vínculos, clique no nome de arquivo do documento vinculado e depois em Alterar Origem. 
3. Na caixa de diálogo Alterar Origem, selecione o documento que você não consegue abrir e clique em Abrir. 
4. Clique em OK para fechar a caixa de diálogo Vínculos. 

 
Observação 
A informação do documento danificado será exibida se houver dados ou textos recuperáveis. 

5. Clique com o botão direito do mouse no texto vinculado, aponte para Objeto de Documento Vinculado e clique em Vínculos. 
6. Na caixa de diálogo Vínculos, clique em Interromper Vínculo. 
7. Quando a seguinte mensagem for exibida, clique em Sim: Tem certeza de que deseja quebrar os links selecionados? 

 
Método 4: Usar o conversor “Recuperar Texto de Qualquer Arquivo” 
 
Observação 
O conversor "Recuperar Texto de Qualquer Arquivo" tem limitações. Por exemplo, a formatação do documento é perdida. Além disso, 
gráficos, campos, objetos de desenho e todos os outros itens que não são texto são perdidos. No entanto, o texto de campo, cabeçalhos, 
rodapés, notas de rodapé e notas de fim são retidos como texto simples. 

1. No Word, clique em Menu Arquivo e depois em Abrir. 
2. Na caixa Arquivos do tipo, selecione Recuperar Texto de Qualquer Arquivo(.) 
3. Selecione o documento do qual deseja recuperar o texto. 
4. Selecione Abrir. 

Após a recuperação do documento usando o conversor "Recuperar Texto de Qualquer Arquivo", alguns dados binários não são convertidos. 
Geralmente, esse texto está no início e no fim do documento. É necessário excluir esses dados binários antes de salvar um arquivo como 
documento do Word. 
 
Observação 
Se você estiver usando o Word 2007, não haverá um botão de arquivo na Interface do Usuário. Escolha o Botão do Office e siga as 
instruções quando necessário. 
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Etapas da solução de problemas para tentar abrir o documento danificado 
Método 1: Copiar tudo, menos a marca do último parágrafo para um novo documento 
Etapa 1: Criar um novo documento 

1. No Word, clique em Arquivo na Faixa de Opções e selecione Novo. 
2. Clique em Documento em branco e depois em Criar. 

 
Etapa 2: Abrir o documento danificado 

1. Clique em Arquivo na Faixa de Opções e depois em Abrir. 
2. Selecione o documento danificado e clique em Abrir. 

 
Etapa 3: Copiar o conteúdo do documento e colá-lo no novo documento 
 
Observação 
Caso o documento contenha quebras de seção, copie apenas o texto entre as quebras de seção. Não copie as quebras de seção, já que isso 
talvez danifique o novo documento. Altere o modo de exibição do documento para o modo de exibição de rascunho ao copiar e colar entre 
documentos para evitar a transferência de quebras de seção. Para mudar para o modo de exibição de rascunho, na guia Modo de Exibição, 
selecione Rascunho no grupo Modos de Exibição do Documento. 

1. No documento danificado, pressione CTRL+END e CTRL+SHIFT+HOME. 
2. Na guia Início, clique em Copiar no grupo Área de Transferência. 
3. Na guia Exibir, clique em Alternar Janelas no grupo Janela. 
4. Selecione o novo documento criado na etapa 1. 
5. Na guia Início, clique em Colar no grupo Área de Transferência. 

Se o comportamento estranho persistir, vá para o método 8. 
 
Método 2: Alterar o modelo usado pelo documento 
Etapa 1: Determinar o modelo usado pelo documento 

1. Abra o documento danificado no Word. 
2. Selecione Arquivo na Faixa de Opções e clique em Opções. 
3. Selecione Suplementos. 
4. Na caixa Gerenciar, clique em Modelos em Exibir e gerenciar suplementos do Office. 
5. Selecione Ir. 

 
A caixa Modelo de documento listará o modelo usado pelo documento. Se o modelo listado for Normal, vá para a etapa 2. Caso contrário, vá 
para a etapa 3. 

 
Etapa 2: Renomeie o modelo global (Normal.dotm) 

1. Saia do Word. 
2. Selecione o botão Iniciar. 
3. No sistema operacional, procure por normal.dotm. Normalmente é encontrado neste local: 

%userprofile%\appdata\roaming\microsoft\templates 
4. Clique com o botão direito do mouse em Normal.dotm e depois selecione Renomear. 
5. Digite "Oldword.old" e pressione ENTER. 
6. Feche o Explorador de Arquivos. 
7. Inicie o Word e abra o documento. 

 
Etapa 3: Alterar o modelo do documento 

1. Abra o documento danificado no Word. 
2. Selecione Arquivo na Faixa de Opções e clique em Opções. 
3. Selecione Suplementos. 
4. Na caixa Gerenciar, clique em Modelos e depois em Ir. 
5. Selecione Anexar. 
6. Na pasta Modelos, selecione Normal.dotm e depois clique em Abrir. 
7. Clique em OK para fechar a caixa de diálogo Modelos e Suplementos. 
8. Saia do Word. 

 
Etapa 4: Verificar se os modelos modificados funcionaram. 

1. Inicie o Word. 
2. Selecione Arquivo na Faixa de Opções e clique em Opções. 
3. Selecione o documento danificado e clique em Abrir. 

Se o comportamento estranho persistir, vá para o método 3. 

 
Método 3: Iniciar o Word usando as configurações padrão 
Você pode usar a opção /a para iniciar o Word usando somente as configurações padrão no Word. Quando você usa a opção /a, o Word não 
carrega nenhum suplemento. Além disso, o Word não usa o modelo Normal.dotm existente. Reinicie o Word usando a opção /a. 
 
Etapa 1: Inicie o Word usando a opção /a 

1. Saia do Word. 
2. Selecione o botão Iniciar e pesquise Executar. Na caixa de diálogo Executar, digite o seguinte: 

winword.exe /a 
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Etapa 2: Abrir o documento 
1. No Word, clique em Arquivo na Faixa de Opções e depois em Abrir. 
2. Selecione o documento danificado e clique em Abrir. 

Se o comportamento estranho persistir, vá para o método 4. 
Método 4: Alterar os drivers de impressora 
 
Etapa 1: Tentar um driver de impressora diferente 

1. No sistema operacional, pesquise Dispositivos e Impressoras. 
2. Clique em Adicionar uma impressora. 
3. Na caixa de diálogo Adicionar Impressora, clique em Adicionar uma impressora local. 
4. Clique em Usar uma porta existente e depois em Avançar. 
5. Na lista Fabricante, selecione Microsoft. 
6. Clique em Microsoft XPS Document Writer e clique em Avançar. 
7. Clique em Usar o driver já instalado (recomendável) e clique em Avançar. 
8. Marque a caixa de seleção Definir como impressora padrão e clique em Avançar. 
9. Selecione Concluir. 

 
Etapa 2: Certificar-se de que os drivers da impressora alterados corrigem o problema 

1. Inicie o Word. 
2. Clique em Arquivo na Faixa de Opções e depois em Abrir. 
3. Selecione o documento danificado e clique em Abrir. 

Se o comportamento estranho persistir, vá para a etapa 3. 
 
Etapa 3: Reinstalar o driver da impressora original. 
Windows 10 e Windows 7 

1. No sistema operacional, pesquise Impressoras. 
2. Selecione a impressora original padrão e clique em Excluir. 

Caso uma senha de administrador ou uma confirmação seja solicitada, digite a senha ou selecione Continuar. 
3. Se for solicitado que todos os arquivos associados à impressora sejam removidos, clique em Sim. 
4. Clique em Adicionar uma impressora ou scanner e siga as instruções no Assistente para Adicionar Impressora para reinstalar o 

driver da impressora. 
 
Etapa 4: Certificar-se de que os drivers da impressora alterados corrigem o problema 

1. Inicie o Word. 
2. Clique em Arquivo na Faixa de Opções e depois em Abrir. 
3. Selecione o documento danificado e clique em Abrir. 

Se o comportamento estranho persistir, vá para o método 5. 
 
Método 5: Forçar o Word a tentar recuperar um arquivo 
Etapa 1: Corrigir o documento 
No Word, clique em Arquivo na Faixa de Opções e depois em Abrir. 

1. Na caixa de diálogo Abrir, clique uma vez para realçar o documento do Word. 
2. Clique na seta no botão Abrir e clique em Abrir e Reparar. 

 
Etapa 2: Verificar se os drivers da impressora alterados corrigem o problema 
Verifique se o comportamento estranho não ocorre mais. Se o comportamento estranho persistir, reinicie o Windows e vá para o método 6. 
 
Método 6: Alterar o formato do documento e converter o documento de volta para o formato do Word 
Etapa 1: Abrir o documento 

1. Inicie o Word. 
2. Clique em Arquivo na Faixa de Opções e depois em Abrir. 
3. Selecione o documento danificado e clique em Abrir. 

 
Etapa 2: Salvar o documento em um formato de arquivo diferente 

1. Clique em Arquivo na Faixa de opções e depois em Salvar como. 
2. Selecione Outros Formatos. 
3. Na lista Salvar como tipo de arquivo, clique em Formato Rich Text (*.rtf). 
4. Selecione Salvar. 
5. Clique em Arquivo na Faixa de Opções e depois em Fechar. 

 
Etapa 3: Abrir o documento e converter o documento de volta para o formato de arquivo do Word 

1. No Word, selecione Arquivo e clique em Abrir. 
2. Selecione o documento convertido e clique em Abrir. 
3. Selecione Arquivo e clique em Salvar como. 
4. Escolha Documento do Word para o tipo Salvar Como. 
5. Renomeie o arquivo do documento e clique em Salvar. 

 
Etapa 4: Verificar se a conversão do formato de arquivo do documento corrige o problema 
Verifique se o comportamento estranho não ocorre mais. Se o comportamento persistir, tente salvar o arquivo em outro formato. Repita as 
etapas de 1 a 4 e tente salvar o arquivo nos seguintes formatos de arquivo, na seguinte ordem: 

● Página da Web (.htm; .html) 
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● Outro formato de processamento de texto 

● Texto sem formatação (.txt) 
 
 
Observação 
Ao salvar arquivos no formato Texto sem formatação (.txt), você pode solucionar o problema do arquivo danificado. No entanto, toda a 
formatação, os códigos de macros e os elementos gráficos do documento serão perdidos. Quando você salva arquivos no formato Texto sem 
Formatação (.txt), é necessário reformatar o documento. Portanto, use o formato Texto sem formatação (.txt) somente se outros formatos de 
arquivo não resolverem o problema. 
Se o comportamento estranho persistir, vá para o método 7. 
 
Método 7: Copiar as partes não danificadas do documento danificado para um novo documento 
Etapa 1: Criar um novo documento 

1. No Word, clique em Arquivo e depois em Novo. 
2. Clique em Documento em branco e depois em Criar. 

 
Etapa 2: Abrir o documento danificado 

1. Selecione Arquivo e clique em Abrir. 
2. Selecione o documento danificado e clique em Abrir. 

 
Etapa 3: Copie as partes não danificadas do documento e cole-as no novo documento 
 
Observação 
Caso o documento contenha quebras de seção, copie apenas o texto entre as quebras de seção. Não copie as quebras de seção, já que isso 
pode danificar o novo documento. Altere o modo de exibição do documento para o modo de exibição de rascunho ao copiar e colar entre 
documentos para evitar a transferência de quebras de seção. Para mudar para o modo de exibição de rascunho, na guia Modo de Exibição, 
selecione Rascunho no grupo Modos de Exibição do Documento. 

1. No documento danificado, localize e selecione uma parte não danificada do conteúdo do documento. 
2. Na guia Início, clique em Copiar no grupo Área de Transferência. 
3. Na guia Exibir, clique em Alternar Janelas no grupo Janela. 
4. Selecione o novo documento criado na etapa 1. 
5. Na guia Início, clique em Colar no grupo Área de Transferência. 
6. Repita as etapas de 3a a 3e para cada parte não danificada do documento. É necessário reconstruir as seções danificadas do 

documento. 
 
Método 8: Alternar o modo de exibição do documento para remover o conteúdo danificado 
Se o documento aparentar estar truncado (nem todas as páginas do documento são exibidas), talvez seja possível alternar a exibição do 
documento e remover o conteúdo danificado do documento. 

1. Determine o número de páginas no qual o conteúdo danificado faz com que o documento pareça estar truncado. 
1. No Word, selecione Arquivo e clique em Abrir. 
2. Selecione o documento danificado e clique em Abrir. 
3. Role para exibir a última página que é exibida antes de o documento parecer estar truncado. Observe o conteúdo exibido na 

página. 
2. Alterne modos de exibição e remova o conteúdo danificado. 

1. Na guia Exibir do grupo Exibições do Documento, selecione Layout da Web ou Modo de Exibição de Rascunho. 
2. Role para exibir o conteúdo exibido antes de o documento parecer estar truncado. 
3. Selecione e exclua o próximo parágrafo, tabela ou objeto do arquivo. 
4. Na guia Exibir no grupo Exibições do Documento, clique em Layout de Impressão. Se o documento continuar aparentando 

estar truncado, continue a alternar os modos de exibição e exclua o conteúdo até que o documento não aparente mais estar 
truncado no modo de exibição Layout de Impressão. 

5. Salve o documento. 
 
Método 9: Abra o documento com o Bloco de Notas 
Se o documento está corrompido e nenhum dos métodos anteriores funciona, tente recuperar o conteúdo abrindo o documento com o Bloco 
de Notas. 
 
Observação 
Usando esse método, você perderá toda a formatação. A intenção é recuperar o conteúdo. 

1. Localize o documento danificado por meio do Explorador de Arquivos do Windows. 
2. Clique com o botão direito do mouse no arquivo e selecione Abrir com. 
3. Selecione Bloco de Notas: 
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4. O documento será aberto no Bloco de Notas com código extra e texto em torno do conteúdo. 
 
Observação 
Você pode ter que alterar o tipo de arquivo de “Documentos de Texto (.txt)” para “Todos os Arquivos (.*)”. 5. Para limpar o texto, apague 
todos os caracteres extras ou a maioria deles. 6. Selecione Arquivo e Salvar como.... Renomeie o documento para não substituir o danificado. 
Volte para o Word e abra o novo documento. Uma vez no Word, você pode limpar o arquivo e tentar reaplicar o formato perdido. 
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Anexo VI – Tutoriais da Microsoft em inglês 

 
OUTLOOK 
How to set up rules 
 
Try it! 
Use rules to organize your email. Create a rule based on a message, or from a template. 

 
Create a rule on a message 

1. Right-click a message and select Rules > Create Rule. 
2. Select a condition, and what to do with the message based on the condition. 

For example, to move messages with a certain title to a specific folder, select the Subject contains condition, select Move the item to 
folder, select or create a New folder, and then select OK. 

3. When you're done creating the rule, select OK. 
4. To use the rule right away, select the Run this new rule now on messages already in the current folder checkbox, and then 

select OK. 
The message now appears in that folder. 
 
Create a rule from a template 

1. Select File > Manage Rules & Alerts > New Rule. 
2. Select a template. 

For example, to flag a message: 

▪ Select Flag messages from someone for follow-up. 
3. Edit the rule description. 

▪ Click an underlined value, choose the options you want, and then select OK. 
4. Select Next. 
5. Select the conditions, add the relevant information, and then select OK. 
6. Select Next. 
7. Finish the rule setup. 

▪ Name the rule, setup rule options, and review the rule description. Click an underlined value to edit. 
8. Select Finish. 

Certain rules will only run when Outlook is on. If you get this warning, select OK. 
9. Select OK. 

 
 
Outlook not responding error or Outlook freezes when you open a file or send mail 
 
Symptoms 
When you open a file or send an email message in Microsoft Outlook 2010 or later versions, Outlook freezes, or you receive the following error 
message: 
Outlook not responding 
 
Cause 
This problem occurs for one or more of the following reasons: 

● You have not installed the latest updates. 

● Outlook is in use by another process. 

● Outlook is loading external content, such as images in an email message. 

● A previously installed add-in is interfering with Outlook. 

● Your mailboxes are too large. 

● Your AppData folder is redirected to a network location. 

● You have to repair your Office programs. 

● Outlook data files have become corrupted or damaged. 

● Your installed antivirus software is outdated, or it conflicts with Outlook. 

● Your user profile has become corrupted. 

● Another program conflicts with Outlook. 
 
Note 

● This issue may occur for one or more of the reasons in this section. To fix this issue, you may have to follow the troubleshooting 
steps in the Resolution section. 

● Many of these items can be automatically checked by the Microsoft Support and Recovery Assistant (SaRA). To start the automated 
checks, follow these steps: 

1. Install the Outlook Advanced Diagnostics tool. 
2. Select Run when you are prompted by your browser. 
3. In the report that's generated, review the items on the Issues found tab. For configuration details about Outlook, Windows, 

and you computer, review the settings on the Detailed View tab. 
 
Resolution 

https://aka.ms/SaRA-OutlookAdvDiagnostics
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To resolve this problem, make sure that your computer meets the Outlook 2016 system requirements, Outlook 2013 system 
requirements or Outlook 2010 system requirements. 
 
 
 
Note 
These steps are provided in a specific order based on commonality and complexity. Follow these steps in the given order. 

 
Step 1 - Install the latest updates 
The Office installation on your computer might not be up to date. This might be because Windows Update is not configured on your computer 
to automatically download and install recommended updates. By installing important, recommended, and optional updates, you can often 
correct problems by replacing out-of-date files and fixing vulnerabilities. To install the latest Office updates, click the link for your version of 
Windows, and then follow the steps in the article: 

● Install Windows updates in Windows 10 

● Windows Update FAQ for Windows 8.1 

● Install Windows updates in Windows 7 

● Install Windows updates in Windows Vista 

● Install Windows updates in Windows XP 
 
Make sure that the latest updates for Outlook are installed. For more information, see How to install the latest applicable updates for Microsoft 
Outlook (US English only). 
 
Step 2 - Make sure that Outlook is not in use by another process 
Performance may be decreased if you use the Outlook AutoArchive feature or sync to Outlook with a mobile device. This is because these 
processes can use a large number of resources. 
If Outlook is in use by another process, this information is displayed in the status bar at the bottom of the screen. If you try to perform other 
actions while Outlook is in use, Outlook may not respond. Let the task in process finish its job before you try another action. 
 
Step 3 - Check the problem that caused by external contents 
To resolve this issue, use one of the following methods: 

● Prevent Outlook to download external contents. To do this, go to File > Options > Trust Center > Automatic Download, select the 
following two options: 
o Don't download pictures or other content automatically in HTML e-mail option. 
o Warn me before downloading content when editing, forwarding, or replying e-mail. 

● Avoid sending such an email with external source. 
 
Step 4 - Investigate possible add-in issues 
Although add-ins can enhance your user experience, they can occasionally interfere or conflict with Outlook. Try to start Outlook without any 
add-ins running. 
 
How to start Outlook without add-ins 

1. Do the following, as appropriate for your operating system: 
o If you are running Windows 8, swipe in from the right edge of the screen, and then tap Search. (If you are using a mouse, 

point to the upper-right corner of the screen, move the mouse pointer down, and then select Search.) Type Run in the 
search box, and then tap or select Run. 

o If you are running Windows 10, Windows 7 or Windows Vista, select Start. 
o If you are running Windows XP, select Start, and then select Run. 

2. Type Outlook.exe /safe, and then select OK. 
3. If the problem is resolved, select Options on the File menu, and then select Add-Ins. 
4. Select COM Add-ins, and then select Go. 
5. Clear all the check boxes in the list, and then select OK. 
6. Restart Outlook. 

 
If the problem does not occur after you restart Outlook, one of the add-ins is likely the cause of the problem. Restore the add-ins one at a time 
until the problem does occur to determine which add-in is causing the problem. 
 
Step 5 - Check whether your mailbox is too large 
As your mailbox size increases, more resources are required to open each folder. If you have a large number of items in any single folder, you 
may experience performance issues during certain operations. For more information, see Outlook performance issues when there are too 
many items or folders in a cached mode .ost or .pst file. 
We recommend that you move several items in your larger folders to separate folders, or that you archive those items by using the 
AutoArchive feature. 

 
How to create a folder 

1. On the Folder tab, select New Folder in the New group. 
2. In the Name box, enter a name for the folder. 
3. In the Select where to place the folder list, select the location for the new folder. 

 Note 
The new folder will become a subfolder of the folder you select. 

4. Select OK. 
To manage your mailbox by reducing the size of the Outlook data file, see Reduce the size of Outlook Data Files (.pst and .ost). 

https://www.microsoft.com/microsoft-365/microsoft-365-and-office-resources
https://docs.microsoft.com/en-us/previous-versions/office/office-2013-resource-kit/ee624351(v=office.15)
https://docs.microsoft.com/en-us/previous-versions/office/office-2013-resource-kit/ee624351(v=office.15)
https://docs.microsoft.com/en-us/previous-versions/office/office-2010/ee624351(v=office.14)
https://support.microsoft.com/hub/4338813/windows-help?os=windows-10
https://support.microsoft.com/hub/4338813/windows-help?os=windows-8.1
https://support.microsoft.com/help/12373/windows-update-faq
https://support.microsoft.com/help/22882/windows-vista-end-of-support
https://support.microsoft.com/help/14223/windows-xp-end-of-support
https://docs.microsoft.com/en-us/outlook/troubleshoot/installation/install-outlook-latest-updates
https://docs.microsoft.com/en-us/outlook/troubleshoot/installation/install-outlook-latest-updates
https://support.microsoft.com/help/2768656
https://support.microsoft.com/help/2768656
https://support.microsoft.com/office/reduce-the-size-of-your-mailbox-and-outlook-data-files-pst-and-ost-e4c6a4f1-d39c-47dc-a4fa-abe96dc8c7ef


228 

 

To manage your mailbox by using the AutoArchive feature, see AutoArchive settings explained. 
 
Step 6 - Check whether your AppData folder is being redirected to a network location 
Outlook stores certain data, such as email signatures and the spelling checker dictionary, in the AppData folder. If the network is performing 
slowly, Outlook must wait for read and write operations to the AppData directory to finish. 
 
How to disable redirection of the AppData directory 

1. Exit Outlook. 
2. Start Registry Editor. To do this, use one of the following procedures, as appropriate for your version of Windows: 

o Windows 10 or Windows 8: Press Windows Key+R to open a Run dialog box. Type regedit.exe and then press OK. 
o Windows 7: Select Start, type regedit.exe in the search box, and then press Enter. 

3. In Registry Editor, locate and then select the following subkey: 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\User Shell Folders 

4. Locate and then double-click the AppData value. 
5. In the Value data box, type the following path, and then select OK: 

  %USERPROFILE%\AppData\Roaming 
 

 
 

6. Exit Registry Editor. 
 
Step 7 - Repair Office programs 
You can automatically repair your Office program files to resolve such problems as Outlook freezing or not responding. 
How to automatically repair Office 

1. Exit any Microsoft Office programs that are running. 
2. Open Control Panel, and then open the Add or Remove Programs item (if you are running Windows XP) or Programs and 

Features (if you are running Windows 10, Windows 8, Windows 7, or Windows Vista). 
3. In the list of installed programs, right-click Microsoft Office 2016, Microsoft Office 2013 or Microsoft Office 2010, and then select 

Repair. 
 
Step 8 - Repair Outlook data files 
When you install Outlook, an Inbox repair tool (scanpst.exe) is also installed on your PC. The Inbox repair tool can resolve problems by 
scanning your Outlook data files, and repairing errors. To use the Inbox repair tool, exit Outlook, and then follow the steps in Repair Outlook 
Data Files (.pst and .ost). 
 
Step 9 - Check whether antivirus software is up-to-date or conflicts with Outlook 
If your antivirus software is not up-to-date, Outlook may not function correctly. 
 
How to check whether antivirus software is up to date 
To keep up with new viruses as they are created, antivirus software vendors periodically provide updates that you can download from the 
Internet. Download the latest updates by visiting your antivirus software vendor's website. 
For a list of antivirus software vendors, see Consumer antivirus software providers for Windows. 
 
How to check whether antivirus software conflicts with Outlook 
If your antivirus software includes integration with Outlook, you may experience performance issues. You can disable all Outlook integration 
within the antivirus software. Or, you can disable any antivirus software add-ins that are installed in Outlook. 
 
Important 
When you change your antivirus settings, this may make your PC vulnerable to viral, fraudulent, or malicious attacks. We do not recommend 
that you try to change your antivirus settings. Use this workaround at your own risk. 
You may have to contact your antivirus software vendor to determine how to configure the software to exclude any integration with Outlook or 
to exclude scanning in Outlook. 
 
Note 
If you also plan to perform file-level virus scanning of .pst, .ost, Offline Address Book (.oab), or other Outlook files while Outlook is in use, 
see Plan antivirus scanning for Outlook 2010 or Planning considerations for deploying Outlook 2016 for Windows. 
 
Step 10 - Create a user profile in Outlook 
To create a user profile, follow these steps: 

1. In Control Panel, select Programs, select User Accounts, and then select Mail to open Mail items. 
2. Select Show Profiles. 
3. Select the profile that you want to remove, and then select Remove. 
4. Select Add. 
5. In the Profile Name dialog box, type a name for the profile. 
6. Specify the user name, the primary SMTP address, and the password. Then, select Next. 

https://support.microsoft.com/office/autoarchive-settings-explained-444bd6aa-06d0-4d8f-9d84-903163439114
https://support.microsoft.com/office/repair-outlook-data-files-pst-and-ost-25663bc3-11ec-4412-86c4-60458afc5253
https://support.microsoft.com/office/repair-outlook-data-files-pst-and-ost-25663bc3-11ec-4412-86c4-60458afc5253
https://support.microsoft.com/help/18900/consumer-antivirus-software-providers-for-windows#avtabs=win7
https://docs.microsoft.com/en-us/previous-versions/office/office-2010/hh550032(v=office.14)
https://docs.microsoft.com/en-us/outlook/troubleshoot/installation/plan-outlook-2016-deployment#outlook-security-considerations
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7. You may receive the following prompt: 
Allow this website to configure <alias@domain server> settings? 
In this prompt, select the Don't ask me about this again checkbox, and then select Allow. 

 
 
Step 11 - Perform a Selective Startup (advanced users) 
When you start Windows normally, several applications and services start automatically and then run in the background. These applications 
and services can interfere with Outlook. A Selective Startup or "clean boot" process can help you identify problems that are caused by 
application conflicts. 
If you use the Selective Startup option in System Configuration, you can turn services and startup programs on or off individually to check 
whether the problem occurs the next time that you start your computer. In System Configuration, if you select a check box, the related service 
or startup program runs when you restart the computer. If the check box is cleared, the service or startup program does not run when you 
restart the computer. 
Follow this procedure to use the process of elimination to identify the problem in Windows 10, Windows 8, Windows 7, or Windows Vista. 
 
Note 
For more information about performing a clean boot, see How to perform a clean boot in Windows. 
How to do a Selective startup 

1. In Control Panel, select System and Security, select Administrative Tools, and then double-click System Configuration. 
 
Note 
If you are prompted for an administrator password or for confirmation, type the password or provide confirmation. 
 

2. Select the General tab, select Selective startup, and then clear the Load system services and the Load startup items check boxes. 
3. Select the Load system services check box, select OK, and then select Restart. 
4. If the problem reoccurs after you restart the computer, do one or both of the following tasks, as necessary. 

To determine which system service is causing the problem 
1. In System Configuration, select the Services tab, select Disable all, select the check box for the first service that is listed, and 

then restart the computer. 
 
Note 
If the problem doesn't reoccur, then you can eliminate the first service as the cause of the problem. 
 

2. With the first service selected, select the second service check box, and then restart the computer. 
3. Repeat this process until you reproduce the problem. 

 
Note 
If you can't reproduce the problem, you can eliminate system services as the cause of the problem. 

To determine which startup item is causing the problem 
 

4. In System Configuration, select the General tab, and then select the Load startup items check box. 
5. Select the Startup tab, select Disable all, select the check box for the first startup item that is listed, and then restart the 

computer. 
 
Note 
If the problem doesn't reoccur, you can eliminate the first startup item as the cause of the problem. 
 

6. While the first startup item is selected, select the second startup item check box, and then restart the computer. Repeat this 
process until you reproduce the problem. 
 

Step 12 - Create a Windows user profile (advanced users) 
Your user profile is a collection of settings that let you customize the computer appearance and performance. It contains settings for desktop 
backgrounds, screen savers, sound settings, and other features. User profiles help make sure that your personal preferences are used when 
you log on to Windows. 
To determine whether this problem is caused by a corrupted user profile, create a user profile to see whether the problem still occurs when 
you use the new profile. 
 
How to repair a corrupted user profile in Windows 8 
Step 1 - Create a user account 
To create a user profile, you must first create a user account. When the new account is created, a profile is also created. 

1. Swipe in from the right edge of the screen, and then tap Search. (If you are using a mouse, point to the upper-right corner of the 
screen, move the mouse pointer down, and then select Search.) Type Command Prompt in the search box, right-click Command 
Prompt, and then select Run as administrator. 
 
Note 
If you're prompted for an administrator password or for confirmation, type the password or provide confirmation. 
 

2. Type net user UsernamePassword /add, and then press Enter. 
 
Step 2 - Copy old files to the new user profile** After you create the profile, you can copy the files from the existing profile 
 
 

https://support.microsoft.com/help/929135/how-to-perform-a-clean-boot-in-windows
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Note 
You must have at least three user accounts on the computer to complete these steps. This includes the new account you just created. 

1. Log on as a user other than the user that you just created or the user that you want to copy files from. 
2. In Control Panel, select Appearance and Personalization, and then select Folder Options. 
3. Select the View tab, and then select Show hidden files, folders, and drives. 
4. Clear the Hide protected operating system files check box, select Yes to confirm, and then select OK. 
5. Open File Explorer. To do this, Swipe in from the right edge of the screen, and then tap Search. (If you are using a mouse, point to 

the upper-right corner of the screen, move the mouse pointer down, and then select Search.) Enter File Explorer in the search box, 
tap or select Apps, and then tap or select File Explorer. Type Command Prompt in the search box, right-click Command Prompt, and 
then select Run as administrator. 

6. Locate the C:\Users\Old_Username folder, in which C is the drive that Windows is installed on, and Old_Username is the name of 
the profile that you want to copy files from. 

7. Select all the files and folders in this folder, except the following files: 
o Ntuser.dat 
o Ntuser.dat.log 
o Ntuser.ini 

8. On the Edit menu, select Copy. 
 
Note 
If you don't see the Edit menu, press Alt. 
 

9. Locate the C:\Users\New_Username folder, in which C is the drive that Windows is installed on, and New_Username is the name 
of the user profile that you created earlier in this method. 

10. On the Edit menu, select Paste. 
11. Log off, and then log back on as the new user. 

 
Note 
If you have email messages in an email program, you must import your email messages and addresses to the new user profile before you 
delete the old profile. If everything is working correctly, you can now delete the old profile. 
 
Next step 
If the information in this article does not help resolve your problem in Outlook 2016, Outlook 2013 or Outlook 2010, see the following 
resources for more information: 

● Perform a search to find more online articles about this specific error 

● Visit the Microsoft Community online to post your question about this error 

● Find the appropriate phone number to contact Microsoft Support 
 
References 

● Fix a corrupted user profile in Window 7 

● Create a user account in Windows 
 
  

https://support.microsoft.com/
https://answers.microsoft.com/
https://support.microsoft.com/contactus/
https://support.microsoft.com/help/14039
https://support.microsoft.com/help/13951
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EXCEL 
Analyze and format in Excel 
Automatically fill a column with Flash Fill 
For example, automatically fill a First Name column from a Full Name column. 

1. In the cell under First Name, type Molly and press Enter. 
2. In the next cell, type the first few letters of Garret. 
3. When the list of suggested values appears, press Return. 

Select Flash Fill Options  for more options. 
Try it! Select File > New, select Take a tour, and then select the Fill Tab. 
 

 
 
Quickly calculate with AutoSum 

1. Select the cell below the numbers you want to add. 

2. Select Home > AutoSum  . 
3. Press Enter. 

Tip For more calculations, select the down arrow next to AutoSum, and select a calculation. 
You can also select a range of numbers to see common calculations in the status bar. See View summary data on the status bar. 
 

 
 
Create a chart 
Use the Quick Analysis tool to pick the right chart for your data. 

1. Select the data you want to show in a chart. 

2. Select the Quick Analysis button  to the bottom-right of the selected cells. 
3. Select Charts, hover over the options, and pick the chart you want. 

Try it!    Select File > New, select Take a tour, and then select the Charts tab. For more information, see Create charts. 

 
 
Use conditional formatting 
Use Quick Analysis to highlight important data or show data trends. 

1. Select the data to conditionally format. 

2. Select the Quick Analysis button  to the bottom-right of the selected cells. 
3. Select Formatting, hover over the options, and pick the one you want. 

Try it!    Select File > New, select Take a tour, and then select the Analyze Tab. 
 

https://support.microsoft.com/en-us/office/view-summary-data-on-the-status-bar-f42a3ae1-3786-4294-a433-1b36a1c17ebb
https://support.microsoft.com/en-us/office/231c42d2-5e58-40e1-99f0-cbe618cfee1d
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Freeze the top row of headings 
Freeze the top row of column headings so that only the data scrolls. 

1. Press Enter or Esc to make sure you're done editing a cell. 
2. Select View > Freeze Panes > Freeze Top Row. 

For more information, see Freeze panes. 
 

 
 
Next: Collaborate in Excel 
 
Memory usage in the 32-bit edition of Excel 2013 and 2016 
 
Note 
Office 365 ProPlus is being renamed to Microsoft 365 Apps for enterprise. For more information about this change, read this blog post. 
 
Symptoms 
After you upgrade to Microsoft Office 2013 or 2016, you experience one or more of the following symptoms:  

● The computer uses more memory when you open multiple Microsoft Excel files, save Excel files, or make calculations in Excel 
workbooks. 

● You can no longer open as many Excel workbooks in the same instance as you could before you upgraded to Excel. 

● When you insert columns in an Excel workbook, you receive an error about available memory. 

● When you are working with an Excel worksheet, you receive the following error message: 
adocCopy 
There isn't enough memory to complete this action. 
Try using less data or closing other applications. 
To increase memory availability, consider: 
- Using a 64-bit version of Microsoft Excel. 
- Adding memory to your device  
 

 
 
Cause 
Although improvements in Office 2013/2016 did not significantly affect system requirements, Office 2013/2016 does use more available 
system resources than Office 2010 did. The limit of virtual address space for 32-bit editions of Windows-based applications is 2 gigabytes 
(GB). For Excel, this space is shared by the Excel application itself together with any add-ins that run in the same process. The size of the 
worksheet itself also affects the usage of virtual address space. Because Excel loads the worksheet into addressable memory, some 
worksheets that have a file size of less than 2 GB may still require Excel to use more than 2 GB of addressable memory. This situation results 
in the error message that is mentioned in the "Symptoms" section. 
 
Resolution 

https://support.microsoft.com/en-us/office/freeze-panes-to-lock-rows-and-columns-dab2ffc9-020d-4026-8121-67dd25f2508f
https://support.microsoft.com/en-us/office/collaborate-in-excel-a8af741e-00f2-44c0-a94b-38abd51af01f
https://support.microsoft.com/en-us/office/collaborate-in-excel-a8af741e-00f2-44c0-a94b-38abd51af01f
https://go.microsoft.com/fwlink/p/?linkid=2120533
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Excel expert users who work with complex Excel worksheets can benefit from using the 64-bit edition of Office 2013/2016. This is because 
the 64-bit edition of Office does not impose hard limits on file size. Instead, workbook size is limited only by available memory and system 
resources. On the other hand, the 32-bit edition of Office is limited to 2 GB of virtual address space, and this space is shared by Excel, the 
workbook, and add-ins that run in the same process. (Worksheets smaller than 2 GB on disk might still contain enough data to occupy 2 GB 
or more of addressable memory.) 
The following options can help improve performance in Excel 2013/2016: 

● Excel users who regularly work with large, complex Excel worksheets may benefit from using the 64-bit edition of Office 2013 
because 64-bit editions of Windows-based applications can address up to 8 terabytes (TB) of memory. Learn more about 64-bit 
editions of Office 2013. 

● The 2-GB limitation is per windows process instance of Excel. You can run multiple files in one instance. However, if the files are 
really large and have to be open, consider opening multiple instances for the other files. For information about limits that you may 
encounter, see You cannot paste any attributes into a workbook in another instance of Excel. 

● If you are running Windows 7 or Windows 2008, we suggest that you install Platform update for Windows 7 SP1 and Windows 
Server 2008 R2 SP1. 

● Test performance without COM add-ins. COM add-ins can use memory at the expense of the 2-GB limitation. For testing, disable 
COM add-ins, and then start Excel. If COM add-ins are causing the memory issue, contact your third-party vendor for an updated 
copy or a 64-bit version of the COM add-ins. 

● Disable hardware graphics acceleration. This shuts off animations. To do this, on the File menu, click Options, click Advanced, 
click Display, and then select Disable hardware graphics acceleration. 

● Change your workbook to streamline areas that use memory unnecessarily. For suggested changes, see How to clean up an Excel 
2013 workbook so that it uses less memory. 
 

Note 
32-bit Excel 2016 will be enabled for Large Address Aware with update May 4, 2016 build number 16.0.6868.2060 for the O365 Current 
Channel subscribers. For more information on Large Address Aware Update click here. 
 
More Information 
You can use Process Explorer to check whether you are approaching the 2-GB limit in Excel. Consider anything over 1.75 GB as a maximum 
for the 32-bit edition of Excel. The column to focus is not there by default and can be added by Choosing View> Select Columns> Process 
Memory tab and clicking on Virtual Size. 
Before moving to a 64-bit version of Office, please review the information at this link: 
https://technet.microsoft.com/library/ee681792.aspx 
Other Resources 
How to troubleshoot "available resources" errors in Excel 
 
 
  

https://technet.microsoft.com/library/ee681792.aspx
https://technet.microsoft.com/library/ee681792.aspx
https://docs.microsoft.com/en-us/office/troubleshoot/excel/cannot-paste-attributes
https://support.microsoft.com/help/2670838
https://support.microsoft.com/help/2670838
https://docs.microsoft.com/en-us/office/troubleshoot/excel/clean-workbook-less-memory
https://docs.microsoft.com/en-us/office/troubleshoot/excel/clean-workbook-less-memory
https://support.microsoft.com/help/3160741
https://technet.microsoft.com/sysinternals/bb896653.aspx
https://technet.microsoft.com/library/ee681792.aspx
https://support.microsoft.com/help/2779852
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POWERPOINT 
Create a presentation in PowerPoint 
With PowerPoint on your PC, Mac, or mobile device: 

▪ Create presentations from scratch or a template. 

▪ Add text, images, art, and videos. 

▪ Select a professional design with PowerPoint Designer. 

▪ Add transitions, animations, and motion. 

▪ Save to OneDrive, to get to your presentations from your computer, tablet, or phone. 

▪ Share and work with others, wherever they are. 
Create a presentation 

1. Open PowerPoint. 
2. Select an option: 

▪ Select Blank Presentation to create a presentation from scratch. 

▪ Select one of the templates. 

▪ Select Take a Tour, and then select Create, to see tips for using PowerPoint. 

 
 
Add a slide 

1. Select the slide you want your new slide to follow. 
2. Select Home > New Slide. 
3. Select Layout and the you type want from the drop-down. 

 
 
Add and format text 

1. Place the cursor where you want, and type. 
2. Select the text, and then select an option on the Home tab: Font, Font size, Bold, Italic, Underline, ... 
3. To create bulleted or numbered lists, select the text, and then select Bullets or Numbering. 
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Add a picture, shape, or chart 

1. Select Insert. 
2. To add a picture: 

▪ Select Picture. 

▪ Browse for the picture you want and select Insert. 
3. To add a shape, art, or chart: 

▪ Select Shapes, Icons, SmartArt, or Chart. 

▪ Select the one you want. 

▪  

 
 
How to troubleshoot a damaged presentation in PowerPoint 
Note 
Office 365 ProPlus is being renamed to Microsoft 365 Apps for enterprise. For more information about this change, read this blog post. 
 
Summary 
You may experience unexpected behavior when you work with a Microsoft PowerPoint presentation. This behavior may occur because the 
presentation is damaged. This article contains step-by-step methods that may help you partly or fully restore your presentation. 
This article is intended for a beginning to intermediate computer user. You may find it easier to follow the steps if you print this article first. 
 
Symptoms 
When you try to open or change a presentation that is damaged, you may experience the following symptoms: 

● When you try to open a presentation, you receive one of the following error messages: 
This is not a PowerPoint Presentation 
PowerPoint cannot open the type of file represented by <file_name>.ppt 
Part of the file is missing. 

● You receive the following kinds of error messages: 
General Protection Fault 
Illegal Instruction 
Invalid Page Fault 
Low system resources 
Out of memory 
 

More Information 
How to determine whether you have a damaged presentation 
There are several ways to determine whether you have a damaged presentation. You can try to open the file on another computer that has 
PowerPoint installed to see whether the unexpected behavior occurs on the other computer. You can try to create a new file in PowerPoint 
and see whether the unexpected behavior occurs with the new file. This section describes how to use existing presentations and how to create 
a new file in PowerPoint to determine whether the presentations have the same behavior. 
 
Method 1: Open an existing presentation 

1. On the File menu, select Open. 
o In PowerPoint 2007 select the Microsoft Office Button. 

2. Select a different presentation, and then select Open. 

https://go.microsoft.com/fwlink/p/?linkid=2120533
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If this presentation opens and seems to be undamaged, go to Method 3 in this section. Otherwise, go to Method 2 to create a new 
presentation. 
 
Method 2: Create a new presentation 
Step 1: Create the presentation 

1. On the File menu, select New, and then Welcome to PowerPoint (or Introducing PowerPoint 2010). 
o In PowerPoint 2007, select Installed Templates, and then select Introducing PowerPoint 2007. 

2. Select Create. This process creates a presentation that is based on the template. 
3. On the File menu, select Save. 

o In PowerPoint 2007 select the Microsoft Office Button, and then select Save. 
4. Type a name for the presentation, and then select Save. 
5. Exit PowerPoint. 

 
Step 2: Open the new presentation 

1. On the File menu, select Open. 
o In PowerPoint 2007 select the Microsoft Office Button, and then select Open. 

2. Select the new presentation, and then select Open. 
If you cannot open or save the new presentation, go to Method 3. 
If you cannot create a new presentation, PowerPoint may be damaged and a repair should be initiated. (See Method 3, Part 2 below.) 
 
Method 3: General troubleshooting 
Windows 10, Windows 8.1, Windows 8, and Windows 7 
Part 1 
This procedure allows your computer to restart without startup add-ons. For a clean restart, follow these steps: 

1. Sign in to the computer by using an account that has administrator rights. 
2. Select Start, type msconfig.exe in the Start Search box, and then press Enter to start the System Configuration utility. 

 
Note 
If you are prompted for an administrator password or for confirmation, you should type the password or provide confirmation. 
 

3. On the General tab, select the Selective startup option, and then clear the Load startup items check box. (The Use Original Boot.ini 
check box is unavailable.) 

4. On the Services tab, select the Hide all Microsoft services check box, and then select Disable all. 
 
Note 
This step lets Microsoft services continue to run. After you do a clean restart, you should check Office performance and then resume 
usual startup. 

 
Part 2 
This procedure will cause the Office program to check for issues and repair itself. 

1. Select the Start button and type Control Panel. 
2. Open the Control Panel, go to Uninstall or change a program (or Add or Remove Programs). 
3. Scroll through the list of programs and find your version of Microsoft Office. Right-select and then select Change. 

 
Note 
We suggest that you do the online repair option. 

 
Methods to try if you cannot open a presentation 
Method 1: Drag the presentation to the PowerPoint program file icon 
Windows 10, Windows 8.1, and Windows 8 

1. Right-click the Windows icon on the Taskbar, and then select Run. 
2. Type one of the following depending on your version of PowerPoint: 

PowerShellCopy 
%ProgramFiles%\Microsoft Office 
%ProgramFiles(x86)%\Microsoft Office 

3. Select the Enter key. 
4. Locate the Powerpnt.exe icon in Windows Explorer. 
5. Drag the damaged presentation icon from one window to the Powerpnt.exe icon in the other window. 

PowerPoint will try to open the presentation. If PowerPoint does not open the presentation, go to Method 2. 
 
Windows 7 

1. Select Start, and then select Documents. Or select Start and then search for Windows Explorer. 
2. If you have the MSI version of PowerPoint 2013 installed, type %ProgramFiles%\Microsoft Office\office15 (PowerPoint 2013 64 bit) 

or %ProgramFiles(x86)%\Microsoft Office\office15 (PowerPoint 2013 32 bit), and then press Enter. 
If you have PowerPoint 2013 Select-to-Run installed, type C:\Program Files\Microsoft Office 15\root\office15 (PowerPoint 2013 64 
bit) or C:\Program Files(x86)\Microsoft Office 15\root\office15 (PowerPoint 2013 32 bit), and then press Enter. 
If you have the MSI version of PowerPoint 2016 installed, type %ProgramFiles(x86)%\Microsoft Office\office16, and then press 
Enter. 
If you have PowerPoint 2016 Select-to-Run installed, type %ProgramFiles%\Microsoft Office\root\Office16 (PowerPoint 2016 64 bit) 
or %ProgramFiles(x86)%\Microsoft Office\root\Office16 (PowerPoint 2016 32 bit), and then press Enter. 

3. Locate the Powerpnt.exe icon in Windows Explorer. 
4. Drag the damaged presentation icon from one window to the Powerpnt.exe icon in the other window. 
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Method 2: Try to insert slides into a blank presentation 
Step 1: Create a blank presentation 

1. In the File menu, select New. 
o In PowerPoint 2007, click the Microsoft Office Button, and then click New. 

2. Select Blank Presentation, and then select Create. 
This process creates a blank title slide. You can delete this slide later after you re-create the presentation. 
 
Step 2: Insert the damaged presentation as slides 

1. On the Home tab, select the arrow next to New slides in the Slides group, and then select Reuse Slides. 
2. In the Reuse Slides task pane, select Browse. Select the damaged presentation, and then select Open. 
3. Select Insert Slide for each slide in the damaged presentation. 
4. In the File menu, select Save. 

o In PowerPoint 2007 click the Microsoft Office Button, and then click Save. 
5. Type a new name for the presentation, and then select Save. 

 
Step 3: Apply the damaged presentation as a template 
If the presentation does not look the way that you expect after you try these steps, try to apply the damaged presentation as a template. To do 
this, follow these steps: 

1. On the File menu, select Save as. 
o In PowerPoint 2007 click the Microsoft Office Button, and then click Save as. 

2. Type a new name for the presentation, and then select Save. 
 
Note 
This will make a backup copy of the restored presentation that you can use in case the damaged presentation damages this new 
presentation. 
 

3. On the Design tab, select More in the Themes group, and then select Browse for Themes. 
4. Select the damaged presentation, and then select Apply. The slide master of the damaged presentation replaces the new slide 

master. 
 
Note 
If you start to experience unexpected behavior after you follow these steps, the template may have damaged the presentation. In this case, 
use the backup copy to re-create the master slide. 
If the backup copy of the new presentation exhibits the same damage or strange behavior as the original presentation, go to Method 3. 
 
Method 3: Try to open the temporary file version of the presentation 
When you edit a presentation, PowerPoint creates a temporary copy of the file. This temporary file is named PPT ####.tmp. 
 
Note 
The placeholder #### represents a random four-digit number. 
This temporary file may be located in the same folder as the location to which the presentation is saved. Or it may be located in the temporary 
file folder. 
 
Rename the file, and then try to open the file in PowerPoint 

1. Right-select the file, and then select Rename. 
2. Change the old file-name extension from .tmp to .pptx so that the file name resembles the following file name: 

PPT ####.pptx 
3. Start PowerPoint. 
4. On the File menu, select Open. 
5. Browse to the folder that contains the renamed file. 
6. Try to open the file in PowerPoint. 

 
Note 
More than one file may correspond to the temporary file that was created the last time that you saved the presentation. In this case, you may 
have to open each file to see whether one is the temporary copy of the presentation. 
If there are no temporary files, or if the temporary files display the same kind of damage or strange behavior, go to Method 4. 
 
Method 4: Make a copy of the damaged presentation 

1. Right-select the presentation, and then select Copy. 
2. In the Windows Explorer window, right-select in a blank space, and then select Paste. 

If you cannot copy the file, the file may be damaged, or the file may reside on a damaged part of the computer's hard disk. In this case, go to 
Method 5. 
If you can copy the file, try to open the copy of the damaged presentation in PowerPoint. If you cannot open the copy of the damaged 
presentation, try to repeat Method 1 through Method 5 in the “Methods to try if you cannot open a presentation” section below by using the 
copy of the damaged presentation. 
 
Method 5: Run Error Checking on the hard disk drive 
Windows 10, Windows 8.1, and Windows 8 

1. Exit all open programs. 
2. Right-click the Start menu and select File Explorer. 
3. Right-select the hard disk drive that contains the damaged presentation. 
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4. Select Properties, and then select the Tools tab. 
5. In Error-checking, select Check Now. 
6. Select the check box Automatically fix file system errors. 
7. Select the check box Scan for and attempt recovery of bad sectors. 
8. Select Start. 

 
Windows 7 

1. Exit all open programs. 
2. Select Start, and then select Computer. 
3. Right-click the hard disk drive that contains the damaged presentation. 
4. Select Properties, and then select the Tools tab. 
5. In Error-checking, select Check Now. 
6. Select to select the Automatically fix file system errors check box. 
7. Select to select the Scan for and attempt recovery of bad sectors check box. 
8. Select Start. 

 
Note 
Error checking may verify that the presentation is cross-linked and attempt to repair the presentation. However, this is not a guarantee that 
PowerPoint will be able to read the presentation. 

 
Methods to try if you can open a damaged presentation 
Method 1: Try to apply the damaged presentation as a template 
 
Step 1: Create a blank presentation 

1. On the File menu, select New. 
o In PowerPoint 2007, select the Microsoft Office Button, and then select New. 

2. Select Blank Presentation, and then select Create. This process creates a blank title slide. (You can delete this slide after you re-
create the presentation.) 

 
Step 2: Insert the damaged presentation into the blank presentation 

1. On the Home tab, select the arrow next to New slides in the Slides group, and then select Reuse Slides. 
2. In the Reuse Slides task pane, select Browse. 
3. Select the damaged presentation, and then select Open. 
4. Select Insert Slide for each slide in the damaged presentation. 
5. Select the Microsoft Office button, and then select Save. 
6. Type a new name for the presentation, and then select Save. 

 
Step 3: Apply the damaged presentation as a template 
If the presentation does not look the way that you expect it to look after you try follow these steps, try to apply the damaged presentation as a 
template. To do this, follow these steps: 

1. On the File menu, select Save as. 

● In PowerPoint 2007, select the Microsoft Office Button, and then select Save as. 
1. Type a new name for the presentation, and then select Save. 

 
Note 
This will make a backup copy of the restored presentation that you can use in case the damaged presentation damages this new 
presentation. 
 

2. On the Design tab, select More in the Themes group, and then select Browse for Themes. 
3. Select the damaged presentation, and then select Apply. The slide master of the damaged presentation replaces the new slide 

master. 
 
Note 
If you start to experience unexpected behavior after you follow these steps, the template may have damaged the presentation. In this case, 
use the backup copy to re-create the master slide. 
If the backup copy of the new presentation still displays damage or strange behavior, go to Method 2. 
 
Method 2: Transfer the slides from the damaged presentation to a blank presentation 
Step 1: Create a blank presentation 

1. On the File menu in PowerPoint, select Open. 
o In PowerPoint 2007, select the Microsoft Office Button, and then select Open. 

2. Locate the damaged presentation, and then select Open. 
3. On the File menu in PowerPoint, select New. 

o In PowerPoint 2007, select the Microsoft Office Button, and then select New. 
4. Select Blank Presentation, and then select Create. This process creates a blank title slide. 

 
Step 2: Copy slides from the damaged presentation to the new presentation 

1. On the View tab, select Slide Sorter. If you receive error messages when you switch views, try to use Outline view. 
2. Select a slide that you want to copy. On the Home tab, select Copy. 

 
Note 
If you want to copy more than one slide at a time, hold down the Shift key, and then select each slide that you want to copy. 
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3. Switch to the new presentation. To do this, on the Window tab, select Switch Window in the View group, and then select the new 

presentation that you created in step 1. 
4. On the View tab, select Slide Sorter. 
5. On the Home tab, select Paste. 
6. Repeat steps 2a through 2f until the whole presentation is transferred. 

 
Note 
In some cases, one damaged slide may cause a problem for the whole presentation. If you notice unexpected behavior in the new 
presentation after you copy a slide to the presentation, that slide is likely to be damaged. Re-create the slide, or copy sections of the slide to a 
new slide. 
If the new presentation shows damage or strange behavior, go to method 3. 
 
Method 3: Save the presentation as a Rich Text Format (RTF) file 
If there is damage throughout the presentation, the only option to recover the presentation may be to save the presentation as a Rich Text 
Format (RTF) file. If this method is successful, it recovers only the text that appears in Outline view. 
 
Step 1: Save the presentation in the RTF file format 

1. Open the presentation. 
2. On the File menu, select Save As, select a location to save the file, and then select More options. 

o In PowerPoint 2007, select the Microsoft Office Button, select Save As, and then select Other Formats. 
3. In the Save as type list, select Outline/RTF(*.rtf). 
4. In the File Name box, type the name that you want to use, select a location in which to save the presentation, and then select Save. 
5. Close the presentation. 

 
Note 
Any graphics, tables, or other text in the original presentation will not be saved in the .rtf file. 
 
Step 2: Open the .rtf file in PowerPoint 

1. On the File menu, select Open. 
2. In the Files of type list, select All Outlines or All Files. 
3. Select the .rtf file that you saved in step 1d, and then select Open. 

This procedure will re-create the presentation based on the original presentation's outline view. 
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WORD 
Track changes in Word 
Turning on Track Changes gives you and your coworkers a way to make changes that are easy to spot. The changes are like suggestions that 
you can review, and then remove them or make them permanent. 
 
Turn Track Changes on and off 

▪ On the Review tab, go to Tracking and select Track Changes. 

▪  

▪  
▪  

▪ When Track Changes is on, deletions are marked with a strikethrough, and additions are marked with an underline. Different authors' changes 
are indicated with different colors. 

▪ When Track Changes is off, Word stops marking changes, but the colored underlines and strikethrough from your changes remain in the 
document until they're accepted or rejected. 

▪  
Note: If the Track Changes feature is unavailable, you might need to turn off document protection. Go to Review > Restrict Editing, and 
then select Stop Protection. (You might need to provide the document password.) 
 
Show or hide comments or tracked changes 
Display all changes inline 
The default in Word is to display deletions and comments in balloons in the margins of the document. However, you can change the display to 
show comments inline and all deletions with strikethroughs instead of inside balloons. 

1. On the Review tab, go to Tracking. 
2. Select Show Markup. 
3.  

 
 

4. Point to Balloons and select Show All Revisions Inline. 
View inline comments as ScreenTips. 

▪ Rest the pointer on a comment in the document. The comment appears in a ScreenTip. 

▪  

 

 
Display changes by type of edit or by reviewer 

1. On the Review tab, go to Tracking and select Show Markup. 
2.  

 
3.  
4. Do one of the following: 

▪ Select the type of change that you want to display. 

▪  

▪ For example, select Comments, Insertions and Deletions, or Formatting. The check mark next to the item indicates that the item is 
selected. 
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▪  

Important: Even if you hide a type of markup by clearing it on the Show Markup menu, the markup automatically appears each time the 
document is opened by you or a reviewer. 

▪  

▪ Point to Specific People, and then clear all check boxes except the ones next to the names of the reviewers whose changes and comments 
you want to show. 

▪  
Note: To select or clear all check boxes for all reviewers in the list, select All Reviewers. 
 
Display changes and comments for specific reviewers 
An editor or reviewer usually wants to view a document as it will appear after their changes are incorporated. This procedure gives an editor or 
reviewer the opportunity to see how the document will look with the changes. 

1. Go to Review > Tracking > Display for Review. 
 

 
2.  
3. Choose the option you want: 

▪ To review the changes, indicated by a red line in the margin, choose Simple Markup. 

▪ For a detailed view of the changes, choose All Markup. 

▪ For a preview of how the document will look if you make all the suggested changes permanent, choose No Markup. 

▪ To view the original document as if all the suggested changes were removed, choose Original. 
Hide tracked changes and comments when printing 
Hiding changes does not remove changes from the document. To remove markup from your document, use the Accept and Reject 
commands in the Changes group. 

1. Go to File > Print > Settings > Print All Pages. 
2. Under Document Info, select Print Markup to clear the check mark. 
3.  
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Review, accept, reject, and hide tracked changes 
Review a summary of tracked changes 
Using the Reviewing Pane you can quickly ensure that all tracked changes have been removed from your document. The summary section at 
the top of the Reviewing Pane displays the exact number of tracked changes and comments that remain in your document. 
The Reviewing Pane also allows you to read long comments that don't fit within a comment bubble. 
 
Note: The Reviewing Pane, unlike the document or the comment bubbles, is not the best tool for making changes to your document. Instead 
of deleting text or comments or making other changes in the Reviewing Pane, make all editorial changes in the document. The changes will 
then be visible in the Reviewing Pane. 

1.  
2. On the Review tab, go to Tracking and select Reviewing Pane. 
3.  

4.  
5.  
6. Do one of the following: 

▪ To view the summary at the side of your screen, select Reviewing Pane Vertical. 

▪ To view the summary across the bottom of your screen, select Reviewing Pane Horizontal. 
By default, the Reviewing Pane shows at the top how many total revisions are in the document. To see  the number and type of the changes, 
select the carat next to the number of revisions. 
 

 
 
Review each tracked change in sequence 

1. Click or tap at the beginning of the document. 
2. On the Review tab, go to Changes. 
3. Select Accept or Reject. As you accept or reject changes, Word will move to the next change. 
4.  

 
 

5. Repeat until there are no more tracked changes or comments in your document. 
Tip: To review changes in the document without accepting or rejecting them, select Next or Previous. 
 
Accept or reject a single change 
Rather than move through changes in sequence, you can accept or reject a single change. When you accept or reject the change, Word will 
not move to the next change in the document. 

▪ Right-click the change and select the option to accept or reject it. 

▪  

 
▪  

Review changes by type of edit or by a specific reviewer 
1. Click or tap at the beginning of the document. 
2. On the Review tab, go to Tracking. 
3.  
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4.  
5.  
6. In the Show Markup list, do one of the following: 

▪ Clear all check boxes except for those next to the types of changes that you want to review. 

▪ Point to Specific People, and then clear all check boxes except those next to the names of the reviewers whose changes you want to see or 
choose All Reviewers to select or clear the check boxes for all reviewers in the list. 

7. On the Review tab, go to Changes. 
8.  
9. Select Accept or Reject. As you accept or reject changes, Word will move to the next change. 
10.  

11.  
12.  
13. Repeat until you've reviewed all of the changes in your document. 

 
Accept all changes at the same time 

1. Go to Review > Changes. 
2. In the Accept list, select Accept All Changes or Accept All Changes and Stop Tracking. 
3.  

 
 
Accept or reject all changes at the same time 

1. On the Review tab, go to Changes. 
2. Do one of the following: 

▪ In the Accept drop-down list, select Accept All Changes. 

▪ In the Reject drop-down list, select Reject All Changes. 

▪  

 
 
Delete comments 

1. Select a comment. 
2. On the Review tab, go to Comments, and select Delete. 
3.  

4.  
5.  
6. Click Next or Previous to move to another comment. 

Delete all comments 
1. Select a comment. 
2. On the Review tab, go to Comments. 



244 

 

3. In the Delete drop-down list, select Delete All Comments in Document. 

4.  
 

Practice with Track Changes and other collaboration features in Word by downloading this Collaborate in Word learning guide. 
 
How to troubleshoot damaged documents in Word 
Note 
Office 365 ProPlus is being renamed to Microsoft 365 Apps for enterprise. For more information about this change, read this blog post. 
 
Summary 
This article describes how to identify a damaged document in Word 2007 and later versions. Additionally, this article includes steps that 
explain how to recover the text and data that is contained in a document after you have identified the document as damaged. 
This article is intended for a beginning to intermediate computer user. You may find it easier to follow the steps if you print this article first. 
 
Update Microsoft Office and Windows 
Many software issues can be resolved by updating the Microsoft Office and Windows programs.  
Windows Update FAQ 
Install Office updates 
Update Office with Microsoft Update 
 
A damaged document or a software issue? 
A Word document can become corrupted for several reasons that will prevent you from opening it. This behavior may be related to damage to 
the document or to the template on which the document is based. This behavior might include the following: 

● Repeatedly renumbers the existing pages in the document 

● Repeatedly redoes the page breaks in the document 

● Incorrect document layout and formatting 

● Unreadable characters on the screen 

● Error messages during processing 

● A computer that stops responding when you open the file 

● Any other unexpected behavior that cannot be attributed to the typical operation of the program 
Sometimes, this behavior can be caused by factors other than document damage. It is important to determine whether the document is 
damaged or whether the problem is a software issue. To eliminate these other factors, follow these steps: 

1. Look for similar behavior in other documents. Try to open other Word documents to see whether the same problem occurs. If they 
open correctly, then the problem might be with the Word document. 

2. Look for similar behavior in other Microsoft Office programs. If this is the case, then the issue might be with another application or 
the operating system. 

If any of these steps indicate that the problem is not in the document, you will then have to troubleshoot Word, the Office suite, or the 
operating system that is running on the computer. 
 
Troubleshooting steps to try if the damaged document does not open 
Try the methods in the order given. If one does not work for you, try the next one. 
Method 1: Open the damaged document in draft mode without updating links 
 
Step 1: Configure Word 

1. Start Word. 
2. On the View tab, select Draft in the Views group. 
3. Select the File Menu, and then Options, and then Advanced. 
4. In the Show document content section, select Use draft font in Draft and Outline views and Show picture placeholders. 
5. Scroll down to the General section, clear the check box Update automatic links at open, select OK, and then close Word. 

 
Step 2: Open the damaged document 

1. Start Word. 
2. Select the File Menu, and then select Open. 
3. Select the damaged document, and then select Open. 

If you can open the document, close the document and then reopen it by using method 6, and repair the document. Otherwise go to method 
2. 
 
Method 2: Insert the document as a file in a new document 
Step 1: Create a new blank document 

1. Select the File Menu, and then select New. 
2. Select Blank document, and then select Create. 

 
Note 
You might have to reapply some formatting to the last section of the new document. 

https://go.microsoft.com/fwlink/?linkid=2041171
https://go.microsoft.com/fwlink/p/?linkid=2120533
https://support.microsoft.com/help/12373/windows-update-faq
https://support.office.com/article/install-office-updates-2ab296f3-7f03-43a2-8e50-46de917611c5
https://support.office.com/article/update-office-with-microsoft-update-f59d3f9d-bd5d-4d3b-a08e-1dd659cf5282
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Step 2: Insert the damaged document into the new document 

1. On the Insert tab, select Insert Object, and then select Text From File. 
2. In the Insert File dialog box, locate and then select the damaged document. Then, select Insert. 

 
Note 
You might have to reapply some formatting to the last section of the new document. 

 
Method 3: Create a link to the damaged document 
Step 1: Create blank document 

1. In Word, select the File Menu, and then select New. 
2. Select Blank document, and then select Create. 
3. In the new document, type "This is a test." 
4. Select the File Menu, and then select Save. 
5. Type "Rescue link," and then select Save. 

 
Step 2: Create link 

1. Select the text you typed in step 1-3. 
2. On the Home tab, select Copy in the Clipboard group. 
3. Select the File Menu, and then select New. 
4. Select Blank document, and then select Create. 
5. On the Home tab, select the arrow on the Paste button in the Clipboard group, and then select Paste Special. 
6. Select Paste link, select Formatted Text (RTF). 
7. Select OK. 

 
Step 3: Change the link to the damaged document 

1. Right-click the linked text in the document, point to Linked Document Object, and then select Links. 
2. In the Links dialog box, select the file name of the linked document, and then select Change Source. 
3. In the Change Source dialog box, select the document that you cannot open, and then select Open. 
4. Select OK to close the Links dialog box. 

 
Note 
The information from the damaged document will appear if there was any recoverable data or text. 

5. Right-click the linked text, point to Linked Document Object, and then select Links. 
6. In the Links dialog box, select Break Link. 
7. When you receive the following message, select Yes: Are you sure you want to break the selected links? 

 
Method 4: Use the "Recover Text from Any File" converter 
 
Note 
The "Recover Text from Any File" converter has limitations. For example, document formatting is lost. Additionally, graphics, fields, drawing 
objects, and any other items that are not text are lost. However, field text, headers, footers, footnotes, and endnotes are retained as simple 
text. 

1. In Word, select the File Menu, and then select Open. 
2. In the Files of type box, select Recover Text from Any File(.). 
3. Select the document from which you want to recover the text. 
4. Select Open. 

 
After the document is recovered by using the "Recover Text from Any File" converter, there is some binary data text that is not converted. This 
text is primarily at the start and end of the document. You must delete this binary data text before you save the file as a Word document. 
 
Note 
If you are using Word 2007 and there is not a file button in the User Interface, choose the Office Button and follow the directions when 
necessary. 
 
Troubleshooting steps to try if you can open the damaged document 
 
Method 1: Copy everything except the last paragraph mark to a new document 
Step 1: Create a new document 

1. In Word, select File on the Ribbon, and then select New. 
2. Select Blank document, and then select Create. 

 
Step 2: Open the damaged document 

1. Select File on the Ribbon, and then select Open. 
2. Select the damaged document, and then select Open. 

 
Step 3: Copy the contents of document, and then paste the contents into the new document 
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Note 
If your document contains section breaks, copy only the text between the sections breaks. Do not copy the section breaks because this may 
bring the damage into your new document. Change the document view to draft view when you copy and paste between documents to avoid 
transferring section breaks. To change to draft view, on the View tab, select Draft in the Document Views group. 

1. In the damaged document, press CTRL+END, and then press CTRL+SHIFT+HOME. 
2. On the Home tab, select Copy in the Clipboard group. 
3. On the View tab, select Switch Windows in the Window group. 
4. Select the new document that you created in step 1. 
5. On the Home tab, select Paste in the Clipboard group. 

If the strange behavior persists, go to method 8. 
 
Method 2: Change the template that is used by the document 
Step 1: Determine the template that is used by the document 

1. Open the damaged document in Word. 
2. Select File on the Ribbon, and then select Options. 
3. Select Add-Ins. 
4. In the Manage box, select Templates under View and manage Office add-ins. 
5. Select Go. 

The Document template box will list the template that is used by the document. If the template that is listed is Normal, go to step 2. 
Otherwise, go to step 3. 
 
Step 2: Rename the global template (Normal.dotm) 

1. Exit Word. 
2. Select the Start button. 
3. In your operating system, search for normal.dotm. It's typically found in this location: 

%userprofile%\appdata\roaming\microsoft\templates 
4. Right-click Normal.dotm, and then select Rename. 
5. Type "Oldword.old", and then press ENTER. 
6. Close File Explorer. 
7. Start Word, and then open the document. 

 
Step 3: Change the document template 

1. Open the damaged document in Word. 
2. Select File on the Ribbon, and then select Options. 
3. Select Add-Ins. 
4. In the Manage box, select Templates, and then select Go. 
5. Select Attach. 
6. In the Templates folder, select Normal.dotm, and then select Open. 
7. Select OK to close the Templates and Add-ins dialog box. 
8. Exit Word. 

 
Step 4: Verify that changing templates worked. 

1. Start Word. 
2. Select File on the Ribbon, and then select Options. 
3. Select the damaged document, and then select Open. 

If the strange behavior persists, go to method 3. 
 
Method 3: Start Word using default settings 
You can use the /a switch to start Word by using only the default settings in Word. When you use the /a switch, Word does not load any add-
ins. Additionally, Word does not use your existing Normal.dotm template. Restart Word by using the /a switch. 
 
Step 1: Start Word by using the /a switch 

1. Exit Word. 
2. Select the Start button and search for Run. In the Run dialog box type the following: 

winword.exe /a 
 
Step 2: Open the document 

1. In Word, select File on the Ribbon, and then select Open. 
2. Select the damaged document, and then select Open. 

If the strange behavior persists, go to method 4. 
 
Method 4: Change printer drivers 
Step 1: Try a different printer driver 

1. In your operating system search for Devices and Printers. 
2. Select Add a printer. 
3. In the Add Printer dialog box, select Add a local printer. 
4. Select Use an existing port, and then select Next. 
5. In the Manufacturer list, select Microsoft. 
6. Select Microsoft XPS Document Writer, and then select Next. 
7. Select Use the driver that is currently installed (recommended), and then select Next. 
8. Select to select the Set as the default printer check box, and then select Next. 
9. Select Finish. 
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Step 2: Verify that changing printer drivers fixes the problem 
1. Start Word. 
2. Select File on the Ribbon, and then select Open. 
3. Select the damaged document, and then select Open. 

If the strange behavior persists, go to step 3. 
 
Step 3: Reinstall original printer driver. 
Windows 10 and Windows 7 

1. In your operating system search for Printers. 
2. Select the original default printer, and then select Delete. 

If you are prompted for an administrator password or for a confirmation, type the password, or select Continue. 
3. If you are prompted to remove all the files that are associated with the printer, select Yes. 
4. Select Add a printer or scanner, and then follow the instructions in the Add Printer Wizard to reinstall the printer driver. 

 
Step 4: Verify that changing printer drivers fixes the problem 

1. Start Word. 
2. Select File on the Ribbon, and then select Open. 
3. Select the damaged document, and then select Open. 

If the strange behavior persists, go to method 5. 
 
Method 5: Force Word to try to repair a file 
Step 1: Repair document 
In Word, select File on the Ribbon, and then select Open. 

1. In the Open dialog box, click once to highlight your Word document. 
2. Select the arrow on the Open button, and then select Open and Repair. 

 
Step 2: Verify that repairing the document fixes the problem 
Verify that the strange behavior no longer occurs. If the strange behavior persists, restart Windows, and then go to method 6. 
 
Method 6: Change the document format, and then convert the document back to the Word format 
 
Step 1: Open the document 

1. Start Word. 
2. Select File on the Ribbon, and then select Open. 
3. Select the damaged document, and then select Open. 

 
Step 2: Save the document in a different file format 

1. Select File on the Ribbon, and then select Save as. 
2. Select Other Formats. 
3. In the Save as file type list, select Rich Text Format (*.rtf). 
4. Select Save. 
5. Select File on the Ribbon, and then select Close. 

 
Step 3: Open the document, and then convert document back to Word file format 

1. In Word, select File, and then select Open. 
2. Select the converted document, and then select Open. 
3. Select File, and then select Save as. 
4. Choose Word Document for the Save As type. 
5. Rename the document's file name, and then select Save. 

 
Step 4: Verify that converting the document file format fixes the problem 
Verify that the strange behavior no longer occurs. If the behavior persists, try to save the file in another file format. Repeat step 1 to step 4, 
and then try to save the file in the following file formats, in the following order: 

● Webpage (.htm; .html) 

● Any other word processing format 

● Plain Text (.txt) 
 
Note 
When you save files in the Plain Text (.txt) format, you might resolve the damage to the document. However, all document formatting, macro 
codes, and graphics are lost. When you save files in the Plain Text (.txt) format, you must reformat the document. Therefore, use the Plain 
Text (.txt) format only if the other file formats do not resolve the problem. 
If the strange behavior persists, go to method 7. 
 
Method 7: Copy the undamaged parts of the damaged document to a new document 
 
Step 1: Create a new document 

1. In Word, select File, and then select New. 
2. Select Blank document, and then select Create. 

 
Step 2: Open the damaged document 

1. Select File, and then select Open. 
2. Select the damaged document, and then select Open. 
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Step 3: Copy the undamaged parts of document, and then paste the undamaged parts to the new document 
 
Note 
If your document contains section breaks, copy only the text between the sections breaks. Do not copy the section breaks because this might 
bring the damage into your new document. Change the document view to draft view when you copy and paste between documents to avoid 
transferring section breaks. To change to draft view, on the View tab, select Draft in the Document Views group. 

1. In the damaged document, locate and then select an undamaged part of the document's contents. 
2. On the Home tab, select Copy in the Clipboard group. 
3. On the View tab, select Switch Windows in the Window group. 
4. Select the new document that you created in step 1. 
5. On the Home tab, select Paste in the Clipboard group. 
6. Repeat steps 3a to 3e for each undamaged part of the document. You must reconstruct the damaged sections of your document. 

 
Method 8: Switch the document view to remove the damaged content 
If the document appears to be truncated (not all pages in the document are displayed), it might be possible to switch the document view and 
remove the damaged content from the document. 

1. Determine the page number on which the damaged content is causing the document to appear to be truncated. 
1. In Word, select File, and then select Open. 
2. Select the damaged document, and then select Open. 
3. Scroll to view the last page that is displayed before the document appears to be truncated. Make a note of the content which 

appears on that page. 
2. Switch views, and then remove the damaged content. 

1. On the View tab in the Document Views group, select Web Layout or Draft view. 
2. Scroll to view the content that was displayed before the document appeared to be truncated. 
3. Select and delete the next paragraph, table, or object in the file. 
4. On the View tab in the Document Views group, select Print Layout. If the document continues to appear to be truncated, 

continue to switch views and delete content until the document no longer appears truncated in Print Layout view. 
5. Save the document. 

 
Method 9: Open the document with Notepad 
If the document is corrupted and none of the previous methods work, try to recover its content by opening the document with Notepad. 
 
Note 
By using this method, you will lose all formatting. The intention is to recover the content. 

1. Locate the damaged document using Windows File Explorer. 
2. Right click the document and select Open with. 
3. Select Notepad: 

 

 
 
4. The document will open in Notepad with extra code and text around the content. 
 
Note 
You may have to change the file type from "Text Documents (.txt)" to "All Files (.*)". 5. Clean the text by deleting all or most of the extra 
characters. 6. Select File, and then select Save As… Rename the document to make sure that you don't overwrite the damaged one. 
Go back to Word and open the new document. Once in Word, you can clean it up and try to reapply the lost format. 
 


